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About Unipro

Established in 1992 Unipro company has its headquarters located in Novosibirsk Akademgorodok (the home of Siberian Branch of Russian
Academy of Sciences). The company’s primary activity is IT outsourcing solutions. To learn more about the company, please, visit the compa

ny website.


http://unipro.ru/
http://unipro.ru/
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About UGENE

Unipro UGENE is a free cross-platform genome analysis suite. It is distributed under the terms of the GNU General Public License.
To learn more about UGENE visit UGENE website.

It works on Windows, Mac OS X or Linux and requires only a few clicks to install.

Key Features

User Interface

High Performance Computing
Cooperation

Key Features

® Creating, editing and annotating nucleic acid and protein sequences

® Search through online databases: NCBI, ENSEMBL, PDB, SWISS-PROT, UniProtkKB/Swiss-Prot, UniProtKB/TrEMBL, UniProt(D
AS), Ensembl Human Genes (DAS)

® Multiple sequence alignment: ClustalW, ClustalO, MUSCLE, Kalign, MAFFT, T-Coffee

® Online and local BLAST and BLAST+ search

® Restriction analysis with integrated REBASE restriction enzyme database

® Integrated Primer3 package for PCR primers design

® Search for direct, inverted and tandem repeats in DNA sequences

® Constructing dotplots for nucleic acid sequences

® Search for transcription factor binding sites (TFBS) with weight matrix and SITECON algorithms

® Aligning short reads with Bowtie, Bowtie 2, BWA, BWA-SW and UGENE Genome Aligner

® Contig assembly with CAP3

® Search for ORFs

® Cloning in silico

® 3D structure viewer for files in PDB and MMDB formats, anaglyph view support

® Protein secondary structure prediction with GOR IV and PSIPRED algorithms

* HMMER2 and HMMER3 packages integration

® Building (using integrated PHYLIP and MrBayes packages) and viewing phylogenetic trees

® Local sequence alignment with optimized Smith-Waterman algorithm

® Combining various algorithms into custom workflows with UGENE Workflow Designer

® Search for a pattern of various algorithms' results in a nucleic acid sequence with UGENE Query Designer

® Visualization of next generation sequencing data (BAM files) using UGENE Assembly Browser

® PCRinsilico

® Spade de novo assembler

User Interface

® Visual and interactive genome browsing including circular plasmid view

® Multiple alignment editor

® Chromatograms visualization

® 3D viewer for files in PDB and MMDB formats with anaglyph stereo mode support

® Phylogenetic tree viewer

® Easy to use Workflow Designer for custom computational workflows

® Easy to use Query Designer for analyze a nucleotide sequence using different algorithms at the same time
® Assembly Browser for visualize and efficiently browsing large next generation sequence assemblies

High Performance Computing

® Complete support of modern multicore processors and SSE instructions
® Qut of the box support of modern GPUs using NVIDIA CUDA and ATI Stream
® [ntegrated solutions for Cell Broadband Engine

Cooperation

® Can be used for education purposes in schools and universities
® Features to be included into the next release are initiated by users
®* UGENE team is ready for collaboration in related projects, both free and commercial


http://www.gnu.org/licenses/old-licenses/gpl-2.0.html
http://ugene.unipro.ru/
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Download and Installation

UGENE is compatible with the three most common operating systems: Windows, Mac OS X, and Linux. It has some minimum system
requirements. If your system fits these requirements, you're welcome to download UGENE from http://ugene.unipro.ru/download. The
program can be used and distributed under the terms of GPLv2.

Follow these recommendation to choose which UGENE package to download.

Below you can also find links to the guides on UGENE installation on different operating systems.

System Requirements

UGENE Packages

Installation on Windows

Installation on Mac OS X

Installation on Linux
® Native Installation on Ubuntu
® Native Installation on Fedora

System Requirements

The system requirements for UGENE are these:

® Operating system (32 or 64 bit):
® Windows XP, Windows Vista, Windows 7, Windows 8
Using a zip package it is possible to use UGENE without administrative rights on Windows

® Mac OS X 10.5 or later
For older Mac OS X versions (PowerPC, 10.4) UGENE version 1.10.3 is avaialble.

® Linux
® Ubuntu 12.04 or later
® Fedora 19 or later
® If you have another Linux system, you may use a universal binary package

* RAM:
® 512 Mb RAM is required.
® Atleast 2 Gb RAM is recommended.

® Disk space:
The minimum required disk space depends on the UGENE package:
¢ Standard package: 200-300 Mb
® Full package: 500-900 Mb
®* NGS package: 21-24 Gb

® Display:
® Itis recommended to set the screen resolution to a value greater than 1280x720.

® Internet:
® Internet connection is required for some tasks like loading data from online databases.

UGENE takes care to use capabilities of your system: the more RAM and cores you have, the more quickly you'll get results of
your calculations.

Also, if you have an OpenCL-capable video card, you can use GPU-optimized versions of the following tools:

® Smith-Waterman Search
®* UGENE Genome Aligner

UGENE Packages

Besides selecting an appropriate package for your operating system (Windows, Mac OS X, or Linux; 32 or 64 bit), you should take into
account the following considerations.

Should I download standard, full, or NGS package?

@ In most cases the full package is the best choice. Exceptions are:

® Use the standard package, if:

10
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® You're going to use only basic UGENE features and don't want to waste Internet traffic
® You have limited disk space

® Use the NGS package, if:
® You're going to analyze ChIP-Seq data with the Cistrome pipeline

Explanation of the tip above: Some tools are embedded into UGENE as external. To be launched from the UGENE graphical interface, an
external tool needs a corresponding executable file. The list of the external tools can be found on this page.

The standard package does not include the tools, whereas the full package include all the required tools.
The NGS package, besides containing the external tools, contains sample data for the Cistrome pipeline (hg19 genome, reference genes,
etc.), so you can run it out of the box.

@ In 2013 we worked on extending of the UGENE NGS framework with three popular pipelines for analyzing NGS data:

® Variant calling with SAMtools
® RNA-Seq data analysis with Tuxedo
® ChlIP-Seq data analysis with Cistrome.

The NGS package was added as the result of this work. We decided to add it as we want our users to be able to use all UGENE
features out of the box. However, it appears that the first two pipelines are also available out of the box in the full UGENE package.

The work was supported by grant RUB1-31097-NO-12 from NIAID.

| have Windows. Should | download installer package or portable zip bundle?

If you have administrative rights on Windows, use the installer package. It will make integration with your Windows system more tight. For
example, it will add associations for bioinformatics formats supported by UGENE, so that corresponding files are opened in it by default.

I have Linux. Which package should | use?

If your Linux is not Ubuntu or Fedora, then universal binary package is the only choice. Otherwise, for more tight integration with the systems,
you can install UGENE from corresponding repositories, following these guides:

® Native installation on Ubuntu
® Native installation on Fedora

Please note that the repositories may be updated a little later the official UGENE release date.

Installation on Windows

To install UGENE on Windows:

* Download UGENE Windows installation package:

My
Hr” Windows

Packages for Windows XP, Windows Vista, Windows 7 and higher Windows versions

Installers:

» Download 32-bit Standard or Full installer package
s Download 64-bit Standard or Full installer package

Zip bundels:

s Download 32-bit portable Standard or Full zip bundle
s Download 64-bit portable Standard or Full zip bundle
s Download 64-bit NGS portable zip bundle (caution: zip bundle size is about 4Gh)

® Launch the downloaded *.exe le and follow the Unipro Setup wizard:

11
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) Unipro Setup

Welcome to the UGENE Setup

Setup wil guide you through the installation of UGENE.

It is recommended that you close all other applications before
starting Setup. This wil make it possible to update relevant
system files without having to reboot your cornputer.

Click Next to continue.

1 Be sure that you launch the installer with an administrative Windows account. If you have a problem with installation, try to do the
following: right-click on the installer ‘.exe’ le and select Run as administrator item.

Alternatively, to use UGENE without installing:

* Download UGENE zip package:

N, )
tlﬁ Windows

Packages for Windows XP, Windows Vista, Windows 7 and higher Windows versions
Installers:

« Download 32-bit Standard or Full installer package
» Download 64-bit Standard or Full installer package

Z£ip bundels:

* Download 32-bit portable Standard or Full zip bundle
« Download 64-bit portable Standard or Full zip bundle
» Download 64-bit NG5 portable zip bundle (caution: zip bundle size is about 4Gb)

® Unpack it.
® Launch the ugeneui.exe le.

Installation on Mac OS X

* Download the Mac OS X Disk image le using the appropriate link on the download page:

12
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K Mac OSX

Packages for Mac OS X 10.5 and higher:

* Download 32-bit Standard or Full package (for Mac OS X 10.5 and higher)
* Download 64-bit Standard or Full package (for Mac OS X 10.6 and higher)
+ Download 64-bit NGS package (caution: package size is ahout 4Gh) (for Mac OS X 10.6 and higher)

Also, find below UGENE packages for old Mac OS X versions. Note, that they updated from time to time (not in each release).

« PowerPC: the latest available version is 1.10.3 (download).
s Mac OS5 X 10.4 Tiger (Intel): the latest available version is 1.10.3 (download).

® Launch the *.dmg le and accept the GNU license agreement. The following window will appear:

|| Unipro LGEME
1 of 2 selected, Dero KB available

Applications

® To start UGENE click on the ugeneui icon. You can also copy UGENE to the Applications folder by dragging it.
Installation on Linux

* Download the appropriate version of the installation package (32-bit or 64-bit). The downloaded le has *.tar.gz extension:

Linuxﬂ
QL
Universal binary packages:

» Download 32-bit Standard or Full package
+ Download 64-bit Standard or Full package
+ Download 64-bit NGS package (caution: package size is about 4Gb)

® Unpack the archive. You can use this command:

tar -xf [nane of the downl oaded *.tar.gz file]

13
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® Change the working directory to the unpacked UGENE directory:

cd [nane of the unpacked directory]

® Launch the UGENE GUI version using the command:

.lugene -ui

or the command line version using the command:

.l ugene

1 Several native packages for specic Linux distributions are also available. UGENE is a part of Ubuntu and Fedora Linux
distributions. See the next chapter.

® Native Installation on Ubuntu
® Native Installation on Fedora

Native Installation on Ubuntu

Ugene packages for different Ubuntu versions are available on the Personal Package Archives (PPA). To start installing and using software
from the UGENE PPA do the following steps:

® Open a terminal and enter:

sudo add-apt-repository ppa:iefrenov/ppa

®* Now, as a one-off, you should tell your system to pull down the latest list of software from ugene archive it knows about, including
the PPA:

sudo apt-get update

* Now you're ready to start installing UGENE:

sudo apt-get install ugene

® To install the non-free UGENE plugins do the following:

sudo apt-get install ugene-non-free

UGENE will appear in the applications list.
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@

® ‘| ® UGENE

Eii Applications

Unipro UGENE

(@ Files & Folders

ugene-1.13.0 ugene

Native Installation on Fedora

Ugene packages for different Fedora versions are available on the Fedora. To start installing and using software do the following:

® Open aterminal and enter:

sudo yuminstall ugene

® Now the latest available UGENE appears in the applications list.
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Basic Functions

® UGENE Terminology
® UGENE Window Components
Welcome Page
Project View
Task View
Log View
* Notifications
Main Menu Overview
Creating New Project
Creating Document
Renaming Object
Opening Document
® Opening for the First Time
® Advanced Dialog Options
® Opening Document Present in Project
® Opening Several Documents
® Opening Unloaded Documents
® Opening from Clipboard
Opening Containing Folder
Exporting Documents
Locked Documents
Using Objects and Object Views
Exporting Objects
® Exporting Sequences to Sequence Format
Exporting Sequences as Alignment
Exporting Alignment to Sequence Format
Exporting Nucleic Alignment to Amino Translation
Export Sequences Associated with Annotation
Using Bookmarks
Exporting Project
Search in Project
Options Panel
Adding and Removing Plugins
Searching NCBI Genbank
Fetching Data from Remote Database
UGENE Application Settings
General
Resources
Network
File Format
Directories
Logging
Alignment Color Scheme
External Tools Settings
Workflow Designer Settings
OpenCL

UGENE Terminology

Project

Storage for a set of data files and visualization options.

Document

Unipro UGENE Manual, Version 1.26

A single file (can be stored on a local hard drive or be a remote web page). Each document contains a set of objects.

Object

A minimal and complete model of biological data. For example: a single sequence, a set of annotations, a multiple sequence

alignment.

Task

A process, usually asynchronous, that works in background. For example: some computations, loading and writing files.

Plugin

A dynamically loaded module that adds new functionality to UGENE.
Object View

A graphical view for a single or a set of objects.

Project View

16
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A visual component used to manage active project.
Task View
A visual component used to manage active tasks.
Log View
A visual component used to show logs.
Notifications
A visual component used to show natifications. Generally it is used to open tasks reports.
Plugin Viewer
A visual component used to manage plugins.
Sequence View

An Object View aimed to visualize DNA, RNA or protein sequences along with their properties like annotations, chromatograms, 3D
models, statistical data, etc.

Annotation
Additional information about a sequence, identified by its name and the sequence region.
Alignment Editor
An Object View used to visualize and edit DNA, RNA or protein multiple sequence alignments.
Options Panel
An Options Panel it is the panel with different information tabs and tabs with settings for Sequence View and Assembly Browser.

In the image below you can see a typical UGENE window with a Project View and a single Object View window opened:

% File Actions Settings Tools Window Help
@B O BH| & 5 2 53 2 Ha % (Got) & v 11 - 8 W wy F
Project X | @ncooizs O &, L U » v " |InFormaﬁon

Name filter 1k 2k 3K K tk 5833 ) Length: 5833 Options panel
PI"DjECt view NP_040335.1 NP_MP_[NP_04033 -

o3 '!@ \ RS * Characters Occurrence

aln.gz =

5 il 1k 2k 3k . 4k | 33 A 1427 24.5%

AF177870.emb 6bject vleww& G 1e73 o8
human_TL.fa 4 {sequence with annotation} - G: 1484 25.4%

. ::-_‘;T;B E * E T 2P 7 5 G T: 1249 214
' N E R H P * 7

+=| L Project

| murine.gb M E T = T b= b= W » Dinudeotides

@ 2] NC_001363 features A RATCARAGACCCCACCCGTAGGTG(

12 4 6 8 10 12 14 16 18 20 22 2426 —
T TTACTTTCTGGGEGETGEGECATCCACC || Annotations Highlighting

% [s] NC_001363

- - - T o Select an annotation type:

H ! = G E E Anneotation
<[] cDs
Bookmarks Narne misc_feature

L0 ty3 [m]ty3 @ Auto-annotations [murine.gb | NC_001363]

7 AF177870 [s] AFL77E70 stand... [ (9 MNC_001363 features [murine.gh]

7 human_T1 [s] human_T1 (UC...

.0 eas[s] Sequence Configure the annotation type:

.1 1CFI.PDB

10 murine [s] NC_001363

¢ murine [s] NC_001363 2 Show on translation

[ 1CFi.PDB2 Show value of qualifier:
Task view Bookmarks

Log view

source

Show all annotation types

Shaw annotations of this type

protein_id locus_tag,gene, function,p

Notifications
O 2 Tesks 0 5:Log Active task —3m= Noactve tesks |5 1]

UGENE Window Components

This chapter describes UGENE main window components Project View, Task View, Log View and the Notifications popup window.
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Welcome Page
Project View
Task View

Log View
Notifications

Welcome Page

The Welcome Page is the first page that will appear when UGENE has been launched.

From the Welcome Page you can open files, create sequence, create workflow, open the Quick Start Guide and open recent files directly.

[0 UGENE - [Start Page] e
[0 File Actions Settings Tools Window Help [=]=] =]}
2 G

Welcome to UGENE

Recent files

r = - 538117317 misc3_copyl.aln

I M - 538117317_misc3.nwk
- 538117317 misc3.aln
- P027682.nwk

Open File(s) Create Sequence _ P027682.2Iut\1[
- P19121.gb
- P49822.gb
l PN Recent projects
{ No opened projects yet
Create Workflow Quick Start Guide

T DR M o G it

Cite UGENE: Follow UGENE:
"Unipro UGENE: a unified bioinformatics toolkit" + §
Okonechnikov; Golosova; Fursov; the UGENE team n u m L&J E n .
Bioinformatics 2012 28: 1166-1167

) 2 Tasks L] 3:Log No active tasks ‘g’ []

To return to the Welcome Page go to the Window->Start Page main menu item.

Project View

The Project View shows documents and bookmarks of the current project. The documents are files added to the project. And the bookmarks
are visual view states of the documents. Read Using Bookmarks to learn more about bookmarks.

To show/hide the Project View, click the Project button in the main UGENE window:
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i ™
-+ UGENE ESEE™

File Actions Settings Teols Window Help
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Project =
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% &, Search...

: Objects

I | chriM.sam bam.ugen... |
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r] EI human_T1.fa

i LLLRAN L Ll Ll i L
o S S B

]
!
8.7k 8737C 146 8.8k

Project view

i E B R EEEE B OEET :
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You can also use the Alt+1 hotkey to show/hide the Project View.

To create a new project, refer to Creating New Project. Note that if you have no project created when opening file with a sequence, an
alignment or any other biological data, a new anonymous project is created automatically.

Task View

The Task View shows active tasks, for example, algorithms computations.

To show/hide the Task View, click the Tasks button in the main UGENE window:

Task name Task state description Task progress
Ll } Loading decuments Running 84%
4 ; Opening view for document: Mycobacterium.sorted.... Running 84%
4 } Adding document to project: Mycobacterium.se., Running 84%
Task View 4 } BAM/SAM file import: Mycobacterium.sorte..  Running 84%
; Load BAM info Finished 100%
§ Prepare assembly file to import Finished 100%
i Convert BAM to UGENE database (Myco.. Importing reads 68%
' i | b
| @ 2:Tasks || L 3:Leg | Rurining task: Loading documents | 5% Tasks: 1 @' [

The hotkey for showing/hiding the Task View is Alt+2.

The Task name column of the Task View shows the tasks names. Task state description shows the status of the active tasks: Started,
Running, Finished and so on. The Task progress column shows the percentage of the tasks progress. If you want to cancel a task, click the
red cross button in the Actions column for the task.

Log View
The Log View shows the program log information.

To show/hide the Log View click the Log button in the main UGENE window:
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Log X
[IMFO][07:08] Converting assembly from Mycobacterium. sorted. bam to Mycobacterium.sorted.bam.ugenedb started -
[IMFQ][07:07] Converting assembly from Mycobacterium, sorted. bam to Mycobacterium.sorted.bam.ugenedb succesfully finished:
imported 567272 reads, total time 50 s, pack time 0 s
[IMFO][07:07] BAMImporter task total time is 53 sec i
[IMFO][07: 10] Converting assembly from Mycobacterium. sorted. bam to Mycobacterium.sorted.bam.ugenedb started
Log View [IMFQ][07: 11] Converting assembly from Mycobacterium, sorted.bam to Mycobacterium.sorted.bam.ugenedb succesfully finished: =

imported 567272 reads, total time 49 s, pack time 0 s 3
[INFO][07: 11] BAMImporter task total time is 52 sed| 8

| ) 2: Tasks || L] 3:Log | No active tasks &' [

The hotkey for this action is Alt+3.

It is possible to configure the Log View settings: the level of the log to show (ERROR, INFO, DETAILS, TRACE) , the category (Algrorithms,
Tasks, etc.), and the format of the log messages (format of the dates, etc.). This settings can be configured in the UGENE Application
Settings.

Notifications

The Notifications component shows notifications for tasks reports.

Bookmarks Log Notifications

[INFO][18:54] Converting assembly from Klebsislla.sort.bam to Klebsislla |
[DETAILS] [15:54] Importing assembly 'pkF70" (1 of 3)

[DETAILS][15:55] Succesfully imported 136066 reads for assembly 'pkF7g € [15:27:31] Report for task: ' X
[DETAILS][16:55] Importing assembly 'pkf140' (2 of 3)

[DETAILS][16:57] Succesfully imported 416287 reads for assembly 'plkf14
[DETAILS][15:57] Importing assembly 'pKFS4 (3 of 3)

[INFO][17:01] Canceling task: Conwvert BAM to UGEME database {Klebsis| &9 [16:26:51] Repart for task: '... X

[INFO][17:01] Canceling task: BAM/SAM fille import: Klebsislla.sort.bam
[INFO][17:01] Canceling task: Convert BAM to UGEME database {Klebsisl
[TREAITA 7011 Canceling tack: Adding dariment toonroiect: Klehaiclla anr

A

b

| G zrse || Dal Natificatians-_..______._ @
w2 3 3: Log

If a task has finished without errors, the notification is blue. If an error has occured during the task execution, the notification is red. If a
warning has occured during the task execution, the notification is yellow.

To open a task report, click on the corresponding notification. See an example of a task report below:
U Task report [DigestSequenceTask] | - || O |[5_(|
N

Task report r
[DigestSequenceTask]

status Finished
time 0.00.00.015

Digest into fragments murine.gb (linear)

Generated 10 fragments,
From EcoRV (138) To EcoRY (214) - 77 bp
From EcoRY (214) To EcoRV (3227) - 3014 bp
From EcoRV (3227) To Balll {3693) - 472 bp
From BglII {3702) To HindIII (5023) - 1322 bp

From HindIII {5027) To Clal {5104) - 78 bp

To remove a notification from the Notifications popup window, click the notification cross button.

Note that you can click on the clip button of the Notifications popup window to show the window always on top.
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Main Menu Overview

Menu

File

Actions

Settings

Tools

Window

Help

Unipro UGENE (Mac OS only)
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Description
A set of project level operations.

List of operations: new project, new document from text, new
workflow, open, open as, open from clipboard, access remote
database, search NCBI genbank, connect to UGENE shared
database, save all, save project as, export project, close project,
recent files, recent projects, exit.

Various actions associated with the active window.

List of operations: go to position, add, copy/paste, analyze, align,
cloning, export, remove, edit (for the Sequence View); go to
position, add, copy/paste, colors, highlighting, edit, align, tree, stati
stics, view, export, advanced, consensus mode, close active
window (for the Alignment Editor).

Preferences and plugin settings.
Various tools. This menu is extended by different plugins.

List of operations: sanger data analysis, NGS data analysis, BLA
ST, multiple sequence alignment, cloning, primer, search for TFBS,
HMMER tools, build dotplot, random sequence generator, show
counters, expert discovery, query designer, workflow designer.

A list of active windows and basic manipulations with the windows.

List of operations: close active view, close all windows, tile
windows, cascade windows, next window, previous window.

Application help and check for updates.

List of operations: open UGENE user manual, open workflow
designer manual, open query designer manual, view UGENE
documentation online, visit UGENE website, check for updates, op
en start page, about.

List of operations: about Unipro UGENE, preferences, services,
hide Unipro UGENE, hide others, show all, quit Unipro UGENE.

The menus can be dynamically populated with new actions added by plugins. Check the Plugins documentation to learn how each plugin

affects global and context menus.

Creating New Project

A project stores links to the data files, cross-file data associations and visualization settings.

Below is the description on how to create a new project manually. Note that if you have no project created when opening file with a
sequence, an alignment or any other biological data, a new anonymous project is created automatically.

To create a new project select the File New project menu or click the New project button on the main toolbar.

The dialog will appear:

[¥] Create New Project

? | |

Project name  Mew Project

Project folder

Project file project

L]

| [ Create ][ Cancel H Help ]|
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Here you need to specify the visual name for the project and the directory and file to store it.

After you click the Create button the Project View window is opened.

Creating Document

To create a new sequence file from text, select the File New document from text main menu item:

rm -* UGEME - [Worldflow Designer - New workflow]
4a| File | Actions Settings Tools Window Help_
Q Mew project...
— Mew document from text...
+ ﬁ] Access remote database...
E & Connect to shared database... Ctrl+L
|I - cg;l Search MCEI Genbank...
| [ I Open... Ctrl+ 0
— @ Open as... Ctrl+Shift+0

The Create Document dialog appears:

i '
[ Create Document M

Paste data here

[7] custom zettings
Alphabet: Standard DMA
i@ Skip unknown symbaols

Replace unknown symbaols with

Document location: | E]
Document format: [FASTA - ]
Sequence name:  Sequence

[7] save file immediately

[ Create J[ Cancel ][ Help

W &

You can input the created sequence to the Paste data here field. You can type or paste sequences in FASTA or text format.

The following Custom settings are available:

Alphabet — here you can select the alphabet:
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Custom settings

Alphabet: [Standard DA - |

Standard DMA

@ Skip unknown symbols

Extended DMA

Extended RMA

Standard amino

Document location: Extended amina l
All symbals

Document format:  |FASTA - ]

The following alphabets are available: Standard DNA, Standard RNA, Extended DNA, Extended RNA, Standard amino, Extended
amino.

7 Replace unknown symbaols w

Skip unknown symbols / Replace unknown symbols with — you can select either to skip unknown input symbols or to replace them
with the specified symbol.

Document location — location of the created document.

Document format — format of the created document. Currently available formats are FASTA and Genbank.

Sequence name — name of the sequence in the created document.

Save file immediately — check this option if you want to save the document immediately after the Create button is pressed.

The created document will be added to the current project and opened in the Sequence View.

Renaming Object

To rename an object in the project tree view use the F2 shotcut or Rename context menu item:

Ohjects “ i 500
P murine.gb *
7 IsI NC 001 .
(9 [a] NC_001 Open view »
Add to view r
Export/Import r
& Remove selected iterns Del
Rename... F2
Mark as circular
Open containing folder
eg =

Opening Document

UGENE stores information about documents you are working with in a project. Once a document has been opened, the information about it
is saved in the current project.

® Opening for the First Time

® Advanced Dialog Options
Opening Document Present in Project
Opening Several Documents
Opening Unloaded Documents
Opening from Clipboard

Opening for the First Time

To open a document that is not yet presented in the current project use either an advanced Open dialog, a simple open file dialog or just drag
the document to the UGENE window.
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UGENE automatically detects the format of the document, but if you use the advanced dialog you can choose the format manually.
To open the advanced dialog select one of the following:

® Add Existing document item in the Project View context menu
® File Open As item in the main menu

To simply open the document select one of the following:

® Open item in the main toolbar
® File Open item in the main menu

or drag the file to the UGENE window. Also it is able to drag and drop documents (not objects) between opened UGENESs.

Documents created not by UGENE are locked. To be able to edit the document you should save a copy of the document and
continue working with the copy.

® Advanced Dialog Options

Advanced Dialog Options

Open the Select Correct Document Format dialog by Add Existing document item in the Project View context menu or by File Open As item
in the main menu. The foolowing dialog will appear:

I B!
[7] select Correct Document Format @Iﬂ_ﬁJ

Options for human_T1.fa

@ FASTA format. Score: 13 (Perfect matah)
1 Plain text format. Score: 2 (Low simianiy)

)
) BED format. Score: 2 (Low simianity)

~1 Raw sequence format. Score: 1 {Wery dow simiarity)
) MSF format. Score: 1 (Very low similanity)

1 Choose format manually

File preview

=human_T1 (UCSC April 2002 chr7:115977709-117855134)
TTGETCAGATTCACCAAAGTTGAAATGAAGGAAAAAATGCTAAGGGCAGCC
AGAGAGAGGTCAGETTACCCACAAAGGGAAGCCCATCAGACTAACAGCGG
ATCTCTCGECAGAAACCCTACAGGCCAGAAGAGAGTGEEGECCAATATTC
CATATTCTTAAAGAAAAGAATTTTCAACCCAGAATTTCATATCCAGCCAA

Here you can choose how to interpret the data stored in the file. The format is detected automatically, but you can select it manually.

Opening Document Present in Project

To open a document that is already present in the current project select it in the Project View and click Enter, double-click on it or drag it to
an empty space of the UGENE window.

Opening Several Documents

To open several documents that are not yet presented in the current project use the File Open item in the main menu. The Select files
open dialog will appear. Select the documents with a help of the Ctrl button and click on the Open button. The following dialog will appear:
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[¥] sequence Reading Options @I&J

The document selected contains multiple sequence instances.

Please select the way UGEME will read these sequences:

@ As separate sequences in seguence viewer

() Merge sequences into a single sequence to show in sequence viewer

Mumber of ‘unknown' symbals (% for nudeic or X for aming) between parts: | 10 bases

(7) Join sequences into alignment and open in multiple alignment viewer

() Align reads to reference sequence

File preview:

=d o
GACTAGC
=a
GACTAGC
=

GACTAGC il
"l

m

Ok ][ Cancel ][ Help

by

Select the reading options and click on the OK button.
Opening Unloaded Documents

The [unloaded] prefix indicates that document is unloaded:

[5] hurnan_T1 (UCSC April

To open unloaded document use the Load selected document context menu, Enter key or double click on the document. To unload the
document use the corresponding context menu item.

Opening from Clipboard

It is possible in UGENE opening text data and files by pasting them into the Project View from the clipboard.

Select text data in a browser or in a text editor or file(s) from your system and press Ctrl+C (Cmd+C for Mac OS X).
Switch to UGENE with an opened project, click the project area and press Ctrl+V (Cmd+V).

The copied data or file(s) will be opened in UGENE.

Another way for file(s) is drag’n’drop. Using your mouse, drag and drop the files from the file system to UGENE, and they will be opened by
the program.

Opening Containing Folder

To open a containing folder of the document that is already present in the current project select it in the Project View and click on the Open
containing folder context menu item.

Exporting Documents

If a document has a format that supports writing in UGENE (see the Supported File Formats chapter), you can export the document to a new
document in a required format.

To do it use the Export document item in the context menu:
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4 [[] human T** 1h

[s] hus Open view L
Add to view
[  Unload selected documents

Lock document for editing

Add 3
Import 2
Export 2
Edit 3
Remowve r

& Export document... )

Save selected documents

The following dialog appears:

+=| Export Document I. ? ﬁJ
Save to file E]

File format |FASTA -

[] compress file
Add to project

[ Export J[ Cancel H Help ]

L -

Here you may select the name of the output file in the Save to file field and, optionally, choose the format of the output file in the File format fi
eld. Use the Compress file checkbox to compress the file. The Add to project checkbox, checked by default, adds the output file to the
current project. After choosing all parameters click the Export button.

Locked Documents

The lock icon in the document element indicates that the document can’t be modified:

4 1CF7.PDB
oL [3d]1CF7

Y [a]1CF7 chain A annotation
% [s]1CF7 chain A sequence
(};’ [a] 1CFT chain B annotation
“ [s]1CF7 chain B sequence

UGENE does not allow modification of some formats that were created not by UGENE.

If UGENE is able only to read a document (see the Supported File Formats chapter), you can export the document objects to a file. To do it
use the built-in export utilities.

Also, you can export the document objects of unlocked documents.

Using Objects and Object Views

The document always contains one or more objects. An object is a structured biological data that can be visualized by different Object Views.

A single Object View can visualize one or several objects of different types. For example a single view can show a sequence, annotations for
the sequence, 3D model for the part of the sequence or its chromatogram simultaneously.

The type of an object is indicated by the symbol in the square brackets and the icon near the object:
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Y [s]hal#berezikoy

INS chain 1 sequence
INS chain 1 annokation
INS chain 2 sequence
INS chain 2 annokation
INS chain 3 sequence
INS chain 3 annokation
INS chain 4 sequence
INS chain 4 annokation

Below is the list of object types supported by the current version of UGENE.

Object types:

Symbol Icon Description

[3d] A 3D model.

[a] Annotations for DNA sequence regions.
[as] An assembly.

[c] Chromatogram data.

[i1 A file with index information for a set of

other, usually large files.

[m] A multiple sequence alignment.

[s] A nucleic, protein or raw sequence.
[t] A plain text.

[tr] A phylogenetic tree.

You can edit names of particular objects, such as sequence objects, by selecting them in the Project View and then pressing F2. To be able
to do so, the document containing the target object must be unlocked.

To see the list of all available views for a given object select the object and activate the context menu inside the Project View window and
select the Open view submenu:
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Project x |f9mc_m13&3 sequence
Marme Filker ' ﬂ 500 1k 15k 2k .
Oblect [ NP 040335.1
Erpcs 5 terminal rep
{yi| Open view » || Open new view; Sequence view :
‘v‘ I. - R
" Unload selected documents L E T = = I ¥ A e
Add F E R P H E * W
Impart b E D P T 34 R 1]
g : : CAAAGACCCCACCCGTAGET G
s € § 10 12 14 16 18 20 22 24 :
Remaove P CTTTCTGEEETEEECATCOAC
ﬁ Save a copy.. F 8 = W E L H
s L G W G Y T .
' : : F v &G & T F F
&L
Mame

+ Ey MNC_001363 Features [murine.gb]

The picture above illustrates an option to visualize the selected DNA sequence object using the Sequence View — a complex and extensible
Object View that focuses on visualization of sequence objects in combination with different kinds of related data: sequence annotations,
graphs, chromatograms, sequence analysis algorithms. Note, that the Sequence View is described in more details in the separate document
ation section.

Exporting Objects
The document objects can be exported into a new document. For more details see the following chapters:

Exporting Sequences to Sequence Format
Exporting Sequences as Alignment

Exporting Alignment to Sequence Format
Exporting Nucleic Alignment to Amino Translation
Export Sequences Associated with Annotation

Exporting Sequences to Sequence Format

Select a single or several sequence objects in the Project View window and click the Export Export sequences context menu item:
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% File Actions Settings Tools Window Help EEE
'E@E A Ca da Ga Un Ga Ta (Got] & - 1a ~ w5 W v JF »
Project @ phareropt ) [&. P, © m T, | & o,

Name filter
Objects

x

50100 150 200 250 300 350 400 450 500 SSDBEH-l@ 4

A

4 @ fasta_example_fasta

[s] Phaneroptera_falcata

[s] Isophya_altaica_EF540820

I5] Bicolorana_bicolor_EF240830

1 .50

L3

y E T

100 150 200

250

Is] Roeseliana_roeseli
[s] Montana_montana
[s] Metrioptera_japonica_E

Open view

Add to view

300 350 400 450 500 550504

E P | * v N

el

05}
]

TCGAGCCGAATTAGGTCAAC

4 16 18 20 22 24 26 28 30 33

B 55/ 0 5 A5 A0 |n0| =0 |5El0 <0 =

Bookmarks

. fasta_example_fasta

Save selected documents

[s] Gampsocleis_sedakovii_| @ Unload selected objects ACCTCRECTTAATCCACTTE

[s] Deracantha_deracantoi Lock docurment for editing E L 3 N = * 5

[s] Zychia baranovi Add v E R I T D ¥

[s] Tettigonia_viridissima 5 e F * T b

[s] Conocephalus_discolor Import 4

[s] Conocephalus_sp. Export 4 Export sequences ) ]
Edit b Export sequences as alignment j
Remove 4

250

300 350 400 450 500 550504 T

| Q 2: Tasks || L 3:Log

The Export Selected Sequences dialog will appear:

-
m Export Selected Sequences

Export to file

C:fworkfugene/data/samples/FASTA human_T1_region_new.fa

File format to use [FASTA

Export with annotations

Add document to the project

|:| Use custom sequence name
Convertion options
@ Save direct strand
[7] Translate to amino alphabet

Use custom translation table

human_T1_region

(71 Save complement strand
Save all amino frames

1. The Standard Genetic Code

() Save both strands

Merge oplions
@ Save as separate sequences () Merge sequences

Add gap symbals between sequences

| Export || cancel

Help

J

Here you can select the location of the result file and a sequence file format. You can choose to add newly created document to the current

project and use custom sequence name. To do it check the corresponding checkboxes.

Use the Conversion options to choose a strand for saving sequence(s). Also you can translate sequence(s) to amino alphabet.

Also it is possible to specify whether to merge the exported sequences into a single sequence or store them as separate sequences. If you
merge the sequences, you're allowed to select the gap symbols between sequences. This is the length of the insertion region between

sequences that contain N symbols for nucleic or X for protein sequences.

Export sequence with annotations
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To export sequence with annotations choose Genbank or GFF format. The Export with annotations checkbox will ba available. Check the
checkbox and sequence will be exported with annotations .

Exporting Sequences as Alignment

Suppose, we want to interpret FASTA file as multiple alignment. To do this, select a single or several sequence objects in the Project View wi
ndow, click right mouse button to open the context menu and select the Export Export sequences as alignment item:

[m—* UGENE - [fasta_example

HEE

W 3
- —5

Sy v 11 v w

(% Phaneropt 0 =, T/v

-
(czlT3) »*

1

% File Actions Settings Tools Window Help
o B A& G 22 58 28 ba Za
Project X
-% Name filter
< | Objects .

4 @ fasta_example
[s] Phaneroptera_falcata

[s] Isophya_altaica_EF540820 |
Is] Bicolorana_bicolor_EF340830
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[s] Conocephalus_di Import 3
[s] Conocephalus_sp Export » }
[s] Conocephalus_p« it 3
[s] Mecopoda elong

Remove 2

Save selected docurments
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Export sequences as alignment )

4

(9 Auto-annotations [fasta_example | Bicolorana...

B A tnoannntstinne [facks avarnnla | Canncanh
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=

1+ [ »

2

Q 2: Tasks

|| [ 3:Log

Mo active tasks @' []

The Export Sequences as Alignment dialog will appear where you can point the result alignment file location, to select a multiple alignment
file format, to use Genbank “SOURCE" tags as a name of sequences for Genbank sequences and optionally add the created document to
the current project:

-
[7] Export Sequences as Alignment

A=)

Export to file | D
File format to use | CLUSTALW - |
Add document to the project
| [] Use Genbank "SOURCE™ tags as a name of sequences (for Genbank sequences only)
| EBpot || cancel || Heb |
L% A

Exporting Alignment to Sequence Format

Select a single object with a sequence alignment in the Project View window and click the Export Export alignment to sequence format conte

xt menu item:
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"[ - UGENE - [ain_example [m] aln_example o= [

I File Actions Settings  Tools Window Help E@E
: B O H| & & & & L, ¥ B @ § » 3 = [
Project x
eme fiter Consensus
Objects TcAGatTatTAATTCGAG
4 [f] aln_example.aln 12 4 6 8 10 12 14 18 1
i Oper;view » TAA A{I.TT'i'C'i'AAT'i'C AR 18 =~
Add to view , ITEAGTTTATTAATTCG A 18
[ Unload selected ohjects E AN ANEE AN A AJNSIECE AL 18
Lock document for editing
Add 3
Irnport »
( Export % Export alignment to sequence format... )
Bookmarks Edit b Export nucleic alignment to amineo translation...
X aln_ea Remove 3
= Save selected documents = > il
Find: 4= = Lnl/3 Coll/604 Pos 1/601 _‘E]
| &) 2: Tasks || [ 3:Log | Mo active tasks &' [

The Convert Alignment to Separate Sequences dialog will appear:

i A’
Convert Alignment to Separate Sequences m
Expaort to file E]

File format to use [FASTA - ]

Add document to the project .
Gap characters (-

@ Keep () Trim

Here it is possible to specify the result file location, to select a sequence file format, to define whether to keep or remove gaps (‘—' chars) in
the aligned sequences and optionally add the created document to the current project.

Exporting Nucleic Alignment to Amino Translation

Select a single object with a nucleic sequence alignment in the Project View window and click the Export Export nucleic alignment to amino
translation context menu item:
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, |

.z File Actions Settings Teools Window Help EEE
@ @ E '+"J -, ’. - Y @ &l b = g s_: %
Project x
Name filter T
Consensus
Objects TTtAGLEItTacTAATTCGAGCTtGAA
i ) 12 4 6 & 10 12 14 16 18 20 2
Open view » L L . |
- _— 1TTAGATTGCTAA 231~
Add to view 3
1TCAGTTTATTAA 23
@5 Unload selected docurnents
i 1TTAGTCTACTAA 23
Lock docurnent for editing
Add 2
Import 3
Export » Export alignment te sequence format...

Edit Al Export nucleic alignment to amine translation... )

Remowve »
% Export document...
Bookmy |2 Save selected documents

L TESt I TEE I
< [ r <[ r -
Find: &= = Lnij3 Colif604 Pos1/589 (5
| &) 2: Tasks ” L 3:Log | Mo active tasks &' [ ]

The Export Nucleic Alignmemt to Amino Translation dialog will appear:

i '
Export Nucleic Alignment to Amino Translation m

Export to file C: fworkfugene fdata/samples/CLUSTALW /COI_transl.aln E]
File format to use | CLUSTALW x|
Amino translation [1. The Standard Genetic Code - ]

Add document to the project
Export range
i@ Whole alignment

Selected rows

Export ][ Cancel ][ Help ]

L A

Here it is possible to specify the result file location, to select a file format and an amino translation, to export whole alignment or selected
rows and optionally add the created document to the current project.

Export Sequences Associated with Annotation

In UGENE you can export a sequence associated with an annotation. To do it select the annotation in the Project View window and click the
Export/Import Export corresponding sequence context menu item:
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4 @ human_T1.fa 5 terminal repeat
; 7 -

% [s] human_T1 (UCSC April 2002 ... 200 400 600 800 1k 12k 14k 16k 18k 2k 22
4 {0 murine.gb
% [s] NC_001363

A

[a]l NC_OOT™ .
Open view r
Add to view k
_ P H P * Vv A 5 *
Edit »
Export/Import r Export annotations... Ia
EE; Remove selected iterns Del Export corresponding sequence... ?;ET
T Import anneotations from CSV file...
| | r *

The Export Selected Sequences dialog will appear:

g !
m Export Selected Sequences @Iﬂ—h,l
Export to file | E]

File format to use FASTA -

Export with annotations
Add document to the project
[ Use custom sequence name muring
Convertion options
@ Save direct strand ) Save complement strand ) Save both strands
[7] 5ave both strands Save all amino frames

Use custom translation table | 1. The Standard Genetic Code

Merge options
3 Save as separate sequences Merge sequences

I Add gap symbols between sequences 0= |

Export H Cancel H Help

L8 ’

Here you can select the location of the result file and a sequence file format. You can choose to add newly created document to the current
project and use custom sequence name. To do it check the corresponding checkboxes.

Use the Conversion options to choose a strand for saving sequence(s). Also you can translate sequence(s) to amino alphabet.

Also it is possible to specify whether to merge the exported sequences into a single sequence or store them as separate sequences. If you
merge the sequences, you're allowed to select the gap symbols between sequences. This is the length of the insertion region between
sequences that contain N symbols for nucleic or X for protein sequences.

Export sequence with annotations

To export sequence with annotations choose Genbank or GFF format. The Export with annotations checkbox will ba available. Check the
checkbox and sequence will be exported with annotations .

Using Bookmarks

One of the most important features supported by most Object Views is an ability to save and restore visual view state. Saving and restoring
visual state of an Object View enables rapid switching between different data regions and is similar to bookmarks used in Web browsers.

Initially an Object View is created as transient. It means that its state is not saved. To save current state of a view select an item with the view
name in the Bookmarks part of the Project View windows and select the Add bookmark item in the context menu:
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B LAl M1 _Usdles rearures L sasan
(‘_‘;‘ [s] MT_073122 sequence I *
F E
Y] 1
<0
Bookrnarks Mame

W hs_che¥ NT_01187

Ackivake view Space

o5 Add bookmark
o

For every persistent view UGENE automatically saves the state of the view in the Auto saved bookmark when the view is closed.

Now, by activating bookmarks you can restore the original view state. For example for the Sequence View bookmarks you can store a visual
position and zoom scale for the sequence region.

5 [2]NT_025441 Features 1 5 10 15 20 25
@ [sINT_025441 sequence CTTAAGTAAGCTTATCTTAACTTAGC

@ [a]NT_025975 features I * E F L I & D
5 [s1NT_025975 sequence F E N 8 Y F © I =8
@ [a]NT_078122 Features N M R I 8 N F R

Y [s]NT_078122 sequence £

Bookmarks MNams a

[= cha T_D11875
. - = i) NT_ 011875 fml-"."- M
hs_chr ”5 0 sequence & NT_ [hs_che¥.gbk.gz]

. Actieate view Space
Add bookmark
Rename bookmark: F2

Remove bookmark Del

IR

Use the F2 keyboard shortcut to rename a bookmark. To remove a bookmark press the Delete key.

UGENE has limited set of built-in Object Views. Extensions modules or plugins can be used to adjust the existing views or to add new views
to the tool.

Exporting Project

All the opened documents and bookmarks (along with the corresponding views states) can be saved within a project file. To do so, select File
Export Project. It will invoke the Export project dialog, where you can select the destination folder and the project file name.
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To load a saved project later, select File Open and specify the path to the project file.

Search in Project

Use the search field in the project view to search in the whole project:

Project x

L 4 »
Objects
4 Dbject name
2 EASS54 6_R1_2_ 1 413 324
eas.fastg
EAS54 6 R1 2 1 443 348
ezs.fastg
EAS54 6_R1_2_1 540 792
eas.fastg
human_T1 (UCSC April 2002 chr7: 115977709-117355134)
human_T1.fa

MC_001363 features
maxine.gh

@ £ £ £ £

4 DS
Ei;i MC_001363 features

maxine.gh
4 comment
Ei;i MC_001363 features

maxine.gh
4 gource
Ei;i MC_001363 features

maxine.gh

Options Panel

The Options Panel is available in the Sequence View and in the Assembly Browser. By default, it is closed. To open a tab of the Options
Panel click on the corresponding icon at the right side of a Sequence View or Assembly Browser window. To close the tab click again on the
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tab icon.
More detailed information about different Options Panel tabs can be found in the following chapters:

® Options Panel in Sequence View
® |nformation about Sequence
® Search in Sequence
® Highlighting Annotations
® Options Panel in Assembly Browser
® Navigation in Assembly Browser
® Assembly Browser Settings
® Assembly Statistic

Adding and Removing Plugins

A plugin is a dynamically loaded module that adds a new functionality to UGENE.

To manage plugins select the Settings Plugins main menu item. The Plugin Viewer window will appear:

'U] New Project* UGENE - [Plugin Viewer] CBX
(¥} Fil= Actions Settings Tools  Window  Help - g x
=N
. DNA Export Marme Skate Description -
[
LT
.:?_ Routines ko esport or align Lﬁ B:ﬁ.LL . . on .ﬁ.. pDrF of BALL Framewnr.k For m...
E multiple DMA sequences Lﬁ BioStruck3D Viewer Plugin - On Binlogical 30 Struckure Yiewer D...
Lﬁ Bowtie on &n ulerafast memory-efficient sh...
@ Lﬁ DA Support: n LItility plugin For ClUDA-enabled ...
M Descriptiﬂn of Lﬁ C!‘uru:uma'-.-'.iew on Chrnmatu:ugral.'ns visualization
the selected Circulartiew on En?al:ules u?lrawmg .DF DNF'..sequen...
Iuain 4 DMA Annokakor n This plugin contains routines to ...
plug WA Expork on R.outin ork or align muli....
4% DMA GraphPack on This plugin contains a sek of gra...
4% DMA Statistics on Provides statistical reports For s...
Lﬁ Dokplot on Build dotplat For sequences
Lﬁ External kool sup on Runs other external toals
Lﬁ GORIY on GORIY protein secondary skruck ...
Lﬁ HIMM2 Rased on HMMER. 2.3.2 package
The list of plugin$ jinlogical sequence analysis usin...
Lﬁ HMM3 1M prafile boals, Plugin is base...
Lﬁ Kalign n & port of Kalign package For mul...
3 MUSCLE on & port of MUSCLE package For ...
Lﬁ ORF Marker on Finds open reading frames (ORF..
Lﬁ Cptimized Smith-Waterm...  On Various implementations of Smit...
Lﬁ Phelip plugin on PHYLIP(the PHYLogeny Inferenc...
Lﬁ Primer 3 n Integrated tool For PCR primers ...
% PsiPred on PsiPred protein secondary struc... o
|
| L) 2 Tasks | | L] 3 Log | »

The window shows the list of available plugins.

To add or remove plugins use the Add plugin and the Remove plugin items available in the Plugin Viewer context menu:

DMA Annokatar on

&% DNa G Add plugin on
% DNA St Remove plugin on
6%, Direct SSEREE Transport on

When you select the Remove plugin item for a plugin, the plugin’s status is changed to the to remove after restart value. The Remove plugin i
s no more available in the context menu of the plugin. Instead the Enable plugin item appears in the context menu:
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On
to remove after r

=

Add plugin

Enable plugin on

On

If you select this item the plugin will be enabled again, i.e. it will not be removed after restart. Otherwise, the plugin will not be available after
UGENE restart.

Searching NCBI Genbank

UGENE allows searching data in NCBI GenBank remote database. To do this open the following dialog by File->Search NCBI Genbank main
menu:

m MCEI Sequence Search @lﬂ_hj
Term: |All fields | |

(AND | [Allfilds | (-]

Search query:

History...

Results:

D Desc Size

Result imit: 20 =

Download Close ] [ Help ]

L A

To search data in the nucleotide or protein databases enter a general text query to the search field, select the database and click on the Sear
ch button. You can use a protein name, gene name, or gene symbol directly. Searching with a submitter or author name in the following
format will produce the best results.

Use the boolean operator AND to find records that contain every one of your search terms, the intersection of search results.
Use the boolean operator OR to find records that include one of several search terms, the union of search results.

Use the boolean operator NOT to exclude records matching a search term.

To limit results use the Result limit field.

After you click the Search button, UGENE searches the biological objects and shows it in the Results field. You can download the object(s).
Select one or several objects (for selecting several objects use the Ctrl button) and click the Download button. The dialog will appear:
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[1] Fetch Data from Remote Database

7 -t |

Qutput format: [gb

Resource ID: KJES0775

Database: [NCBI GenBank (DMA sequence) - ]

Save to directory: | E]
d

Ok

][ Cancel H Help ]

L

After you click the OK button, UGENE downloads the biological objects and adds it to the current project.

Fetching Data from Remote Database

UGENE allows fetching data from remote biological databases such as NCBI GenBank, NCBI protein sequence database and some others.

To fetch data select the File Access remote database... item in the main menu.

The dialog will appear:

m Fetch Data from Remote Database

B

Output format: [gb

Fesource ID: MF_130109
Database: [NCBI GenBank (DNA sequence) *]
Save to directory: | E]

Force download the appropriate sequence

-

Cancel | | Help |

L

o

Here you need to enter unique id of the biological object and choose a database. The following databases are available: NCBI Genbank
(DNA sequence), NCBI protein sequence database, ENSEMBL, PDB, SWISS-PROT, UniProtKB/Swiss-Prot, UniProtKB/TrEMBL. Unique
identifiers are different for various databases. For example, for NCBI GenBank such unique id could be Accession Number or NCBI Gl

number. Optionally, you can browse for a directory to save the fetched file to.

After you click the OK button, UGENE downloads the biological object (DNA sequence, protein sequence, 3d model, etc.) and adds it to the

current project.

If something goes wrong check the Log View, it will help you to diagnose the problem.

UGENE Application Settings

To open UGENE Application Settings dialog choose the Settings Preferences item in the main menu.

To open UGENE Application Settings dialog in Mac OS use the Unipro UGENE->Preferences menu item.

The following settings are available:

General

Resources

Network

File Format

Directories

Logging

Alignment Color Scheme
External Tools Settings
Workflow Designer Settings
OpenCL
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General

e Application Settings 25
~General

Resources

Network —Language of User Interface (applied after restart)

File Format

Directories |EN English & _|
Logging

Alignment Color Scheme - Appearance

workFlow Designer

OpenCL [windows =]

External Tools

~Window Layout

' Mulktiple documents % Tabbed documents

—Project

¥ Open last project at startup

|Don‘t save new project on exit j

—Statistical reports

¥ Enable statistical reports collecting

—Updates

¥ check for updates when UGENE starts

—Default settings

[ Reset settings to default on the next run

Help | Cancell OK I

The following settings are available on the tab:

Language of User Interface (applied after restart) — here you can select UGENE localization. Currently available localizations are EN and
RU. The default value (Autodetection) specifies that UGENE should use the operating system regional options to select the localization. This
setting is applied only after UGENE is reopened.

Appearance — defines the appearance of the application.
Window Layout — this option allows to control the behavior of windows, multiple or tabs.

Open last project at startup — if the option is checked, the last project is opened when UGENE is started. Also you can choose default
settings for saving project.

Enable statistical reports collecting — collects information about UGENE usage and sends it to the UGENE team to help improve the
application.
1 The collected information includes:

1. System info: UGENE version, OS name, Qt version, etc.
2. Counters info: number of launches of certain tasks (e.g. HMM search, MUSCLE align).

The collected information DOESN'T include any personal data.

Default settings — this option resets the default settings on the next run.

Resources
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m Application Settings M

General Resources

Resources

Metwork Application resources

File Format Optimize for CPU count 8 s
Directories

Logging Tasks memory limit 15386Mb =
Alignment Color Scheme Threads limit 1000 =

External Tools
Genome Aligner
Workflow Designer
OpenCL

[ Ok l [ Cancel ] ’ Help ]

On the Resources tab you can set resources that can be used by the application: Optimize for CPU count, Tasks memory limit and Threads
limit.

Network
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Application Settings M

General Network

Resources |
Network Preferred Web browser

File Format @ System default browser

Directories () Custom browser

Logging

Alignment Color Sch... Remote request settings

External Tools

Remote request timeout 60 sec =
Genome Aligner
Workflow Designer Proxy
OpenCL
ben Type: Server: Port:
[] HTTP 0

Use authentication with HTTP proxy:
N Login

Password

Do not use proxy on following addresses (separate line for each):

SSL settings

Secure Socket protocol: |SslV3 ~

| ok || cancdl || Hep

" S

On the Network settings tab of the dialog you can specify Proxy server parameters, select SSL settings and configure the Remote request
timeout.

Preferred Web browser — you can use either System default browser or specify some other browser.

File Format
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[ 2pplication Settings M

General File Format

Resources
Metwork Sequence annotations

File Format Create annotations for case switchings: Don't use case annotations  +
Logging

Alignment Color Scheme
External Tocls

Genome Aligner

OpenCL

Workflow Designer

][ Cancel ][ Help

The Sequence Annotations settings allows to use upper/lower case annotations during the file reading process.
Format options:

1. Don't use case annotations (default mode) — usual sequence reading and writing.

2. Use lower case annotation — sequences are read and annotations with names lower_case are added. When these sequences are
written to file then the case becomes like original the file case (the case is saved).

3. Use upper case annotation — there is a similar behavior but with “upper_case” annotations.

Directories

e Application Settings oo

General Directories
Resources

Netwo rk Downloaded data
File Format

D|rectorle5 /home/../ UGENE_downloaded
Logging

Alignment Color Scheme

OpencL Documents

Workflow Designer
External Tools /home/../Documents/UGENE_Data

Temporary files
femp

File storage

lfhomef..}'.UGEN E_Files

Cleanup storage

Build indexes

J/tmpfugene_tmp/p17364/aligner

Help Cancel

The following settings are available on the tab:
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Downloaded data — specifies the path where files downloaded from the remote databases will be stored.

Documents - the path where will be stored UGENE data.

Temporary files — the path where will be stored temporary files.

File storage — the path where will be stored UGENE files.

Build indexes - the path where will be stored UGENE Genome Aligner indexes.

Logging

-
[¥] Application Settings

General

Resources

MNetwork

File Format

Legging

Alignment Color 5cheme
External Tools

Genome Aligner

OpenCL

Worlflow Designer

Logging

Category
<<all=>
Algorithms
Conscle
Core Services
Input/CQutput
Performance
Remote Service
Scripts
Tasks

Teamcity
Integration

Teamcity Log
User Actions

User Interface

TRACE DETAILS INFO ERROR
[[] Sampletedt [] Sampletext Sample text Sample text

EEEEEEEE
EEEEEEEE

OOoo 0o ooooEooE@
=
=

o000 O ooooooEEO

EEE
BEEE

Log format
Show date

Date format: hhimm

Show log level ] Show log category Enable colored log output

Save output to file: |

On the Logging tab you can select type of log information (ERROR, INFO, DETAILS, TRACE) for each Category that will be output to the Lo

g View.

You can select format for each log message by checking the Show date, Show log level and Show log category options.

Log

[INFQ][05:59] Starting {Open new 'Sequence view'} task
[IMFCO][09: 58] Task {Open new "Sequence view'} finished
[INFQ][05:59] Starting {Open new 'Sequence view'} task
[IMFQ] [05:59] Task {Open new 'Sequence view'} finished
MFO] [09:59] Starting {Open new 'Sequence view'} task
MFQ] [09:59] Task {Open new 'Sequence view'} finished

1 [m |

Alignment Color Scheme
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[ 2pplication Settings M

General Alignment Color Scheme

Resources
Metwork Create and modify custom color schemes

File Format Directory to save color scheme:

Logging | E]

Alignment Color Scheme
External Tools Change color scheme

Genome Aligner
s e

Workflow Designer

Delete

][ Cancel ][ Help

On the Alignment Color Scheme tab you can create, change and delete custom color schemes.
External Tools Settings

Here you can set the paths to the external tools executable files.

Fa
M Application Settings

[E2RS)
General External Tools
Resources
MNetwork
File Format You can select path for external tools package
Logging
Alignment Color Scheme Supported tools
External Tools Name Path o
Genome Aligner
OpenCL ! 4 @ Bowtie2
Workflow Designer B Bowtie 2 index ...

B Bowtie 2 build in...

@ Bowtie 2 aligner
4 @l Bowtie

@ Bowtie build ind...

@ Bowtie aligner

m

laalggal
J

4 = BLAST+
= BlastDBCmd Ciworkiext_tools_win_64-bit\blast+-2.2.28\bin\blastdbemd.exe [ ][5
= RPSBlast Ciwork\ext_tools_win_64-bif\blast+-22.28\bin\rpsblastece [ J[32]
= TBlastx Ciwork\ext_tools_win_64-bit\blast+-2.2.28\bin\tblastx.exe [)(22)
= TBlastN Cwork\ext_tools_win_64-bit\blast+-2.2.28\bin\tblastn.exe (=)

~— Blast¥ Chworkext_tools_win_64-bit\blast+-2.2.28\bin'\blast:.exe

Additional information

Select an external tool to view more information about it.

][ Cancel ][ Help

Workflow Designer Settings

Use this tab to configure the Workflow Designer settings:
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' A
Application Settings m

General Workflow Designer
Resources
Network Scene appearance
File Format Shaw arid
Legging .
Alignment Color Schemne Il Snap to grid
External Tools Element style [Ekhended - ]
Genome Aligner Element font MS Shell Dig 2 -
OpenCL

Runtime settings

Track running progress
Enable debugger

Directories
Use directory for output files

Directory for custom elements with scripts

Directory for custom elements with command line tools

Directory for induded schema elements

OpenCL

If you have a video card that supports OpenCL you can use it to speed up some calculations in UGENE.

To do it install the latest video card driver and check the corresponding check box:

Applicaticn Settings @Ig

General OpenCL

Resources
Metwork The following OpenCL-enabled GPUs are detected.
Check the GPUSs to use for accelerating algorithms computations.

Intel(R) Corporation Intel{R) HD Graphics 4600 1297 Mb

File Format
Logging

Alignment Color Scheme MVIDIA Corporation GeForce GT 740M 2048 Mb
External Tools

Genome Aligner
OpenCL
Worlflow Designer

Now you can, for example, use OpenCL optimization for the Smith-Waterman algorithm.
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Sequence View

Sequence View Components
Global Actions
Sequence Toolbars
Sequence Overview
Sequence Zoom View
Sequence Details View
Sequence Multi-line Details View
Information about Sequence
Manipulating Sequence
® Going To Position
Toggling Views
Exporting Sequence Image
Zooming Sequence
Creating New Ruler
Selecting Amino Translation
Showing and Hiding Translations
Selecting Sequence
Copying/Pasting Sequence
Search in Sequence
® Load Patterns from File
® Search Algorithm
® Searchin
® Other Settings
® Annotations Settings
Editing Sequence
Exporting Selected Sequence Region
Exporting Sequence of Selected Annotations
Locking and Synchronize Ranges of Several Sequences
® Multiple Sequence Opening
® Annotations Editor
® "db_xref" Qualifier
® Automatic Annotations Highlighting
® The "comment" Annotation
® Manipulating Annotations
® Creating Annotation
® Selecting Annotations
¢ Editing Annotation
® Highlighting Annotations
® Annotations Color
® Annotations Visability
® Show on Translation
® Captions on Annotations
Creating and Editing Qualifier
Adding Column for Qualifier
Copying Qualifier Text
Finding Qualifier
Deleting Annotations and Qualifiers
Importing Annotations from CSV
Exporting Annotations

Sequence View Components

The Sequence View is one of the major Object Views in UGENE aimed to visualize and edit DNA, RNA or protein sequences along with their
properties like annotations, chromatograms, 3D models, statistical data, etc.

For each file UGENE analyzes the file content and automatically opens the most appropriate view.

To activate the Sequence View open any file with at least one sequence. For example you can use the SUGENE/data/samples/EMBL/AF177
870.emb file provided with UGENE.

After opening the file in UGENE the Sequence View window appears:
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-* UGENE - [murine [s] NC_001363]

Uy File Actions Settings Tools Window Help |;||E||i||
[ o B 4 G @ G2 @ " % (G &y~ 11~ g  ® JF »
& NC_001363 [dna] O™ i Ew

|
Zh 500 1k 1.5k 2k 2.5k 4.5k Sk 5833
& WP 040335.1

Type
Misc. Feature

[» @ misc_feature

I I misc_feature : Misc. Feature

[ 'a source (0, 1)

Value

2..590
5245,.5833

4

| Q 2: Tasks

[ 3:Log

Mo active tasks 5 E]J

——

After the view is opened you can see a set of new buttons in the toolbar area. The actions provided by these buttons are available for all
sequences opened in the view. In the picture below these buttons are pointed by the “Global actions” arrow.

Below the toolbar there is an area for a single or several sequences. For each sequence a smaller toolbar with actions for the sequence and
the following areas are available:

i A

7 File Actions Settings Tools Window Help [-]=] ]
‘D OB A G % G & G G [Got) & v 1a v % K W F »
% NC_D01363 [dna] —aff—— Sequence name O & . | Em v

1 |
L h s00d 1k 1.5k 2f 2.5k 3k 3.5k 4k 45k 5k 5833
2 400 s00 200 1k 1.2k 1.4k 1.6k 1.8k 2048
¥ |I| Zoom View
....................... 1'_-':‘ -
- T T In P P P
T3 i’ Eletaﬁs Vigw T ®¥ ® R E ¥ S5 W ° A T ¥ L C
TI CCCAGGGECCACCGRCCCACCACCGGGHGGTAAGCTGGCCRGCMCTTETCTGTG
] i 522 825 630 635 540 545 650 655 660 665 670 676
;GGGTCCCTGGTGGCTGGGTGGTGGCCCTCC.?LTTCGECCGGTCGTTGMTAGRCHC
C WP GGV W W R S T L ¢ G AL ¥V * R H
G P W v 3 G G G P P L 3 sy L L E D T
« |:| 8
MName . Type Value a
4 ﬁ misc_feature (0, 2)
> @ misc_feature Misc. Feature 2..590
> @ misc_feature Misc. Feature 5245,.5833 D
[» 9 source (0, 1) i

[ 3:Log

| Q 2: Tasks

Mo active tasks @' [ ]
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An example of the Sequence View with several sequences:

' ™
[¥] -* UGENE - [murine [s] NC_001363] e

% File  Actions Settings Toels  Window Help |;||i||i|
Ao B4 9@ 2 9 2 % % (Got) &y v 1a v f8 W W F »
@ NC_001363 [dna] O g% [l 8%

& 500 1k 1.5k 2k 2.5k 3k 3.5k 4k 4.5k Sk 5533:

L
b4 o L 3

L2 ECCP;CCGGGAGGTAAGCTGGCCAGCMCTTATCTGTGTCTGTCCGATTGTCTAGTGT

TS 541 645 850 835 850 885 870 675 £30 885 890 595
i Sre—— s =
€ human_T1 (UCSC April 2002 chr7:115977709-117855134) [dnal Q B Gl B

&, 99583 99.7k 599.8k 99.9k 100k 100.1k 100.2k 100 384 ©
v o« = ¥ )=

=
= ITTGTCAGATTCACCAAAGTTGARATGAAGGAARARARRTGCTAAGGGCAGCCAGAGAG
T§ 12 4 & & 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40 42 44 45 48 50 52 5456

e < [ P
Mame . Type Value il
(9 Auto-annotations [huma... |J
(9 Auto-annotations [murin... it
a4 KE AN IED £onk r
u 2: Tasks || [ 3:Log Mo active tasks ‘&' [ ]

You can change the focus by clicking on the corresponding sequence area. All sequences that are not in focus have the sequence name and

icon disabled.

The bottom area of the Sequence View is the Annotations Editor. It contains a tree-like structure of all annotations available for all sequences
shown in the Sequence View and can be used to perform various actions on annotations: create a new annotation, modify the existing one,

group, sort, etc.

Global Actions

&oov 1l o~

The global action toolbar provides possibility to go to the specified position (in all sequences at the same time).

Also it allows to lock or adjust ranges of sequences in the same Sequence View. See this paragraph for details.
Sequence Toolbars

A brief description of the sequence toolbars buttons is shown on the picture below:
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2 human_T14UCSE April 2002 chrZ: 1159 9:117855134) [dna s £ 1
ol - 'FJofgannoalon ensity grap [dna] s, i s O

s
2y 20k 40K 25 60K sk /- 1}6&: I 120k 1‘ 130k 160k % 180k 2uf'ﬂﬁi

i 1) LY 1
@ 734 10k 20k 30k 40k SOk 160k 70k 80k o0k gBok 110k [ 120k 130k\14uk‘\150k 180k 170K\ 180k 200
Automatic annotations highlighting Capture screen Graphs  Toggle view

~4#t- Show domplement stéand

-ai— Show amino translatiohs n
TCTTCGGACTCTCAGCAGCTAGTTCCTCTCACAGTCTCARACCCCCTTCTCCTCCCCCRATCAC

Tp :
T iSs7gs saroy 54785 Sask S4BD5  S4BI0 54815 54870 54825 5430 54835 54840 54848 |
MGAAGCCTGAGAGTCGTCGATCAAGGAGAGTGTCAGAGTTTGGGGGAAGAGGAGGGGETTAGTG
3 * :
Amino transiation * I L
T * * L *

4L 4L

See also:

® Toggling Views

® Capturing Screenshot

® Zooming Sequence

¢ Showing and Hiding Translations
® Selecting Sequence

® Sequence Multi-line Details View

Sequence Overview

The Sequence overview is an area of the Sequence View below the sequence toolbar. It shows the sequence in whole and provides handy
navigation in the Sequence zoom view and the Sequence details view.

€ NC_001363 [dnz] Q & " 1 aw
LY =00 1% i 1|5k 2k 2.5k 1 q% ﬁ 4.5k £k "5a33
#1459 18k 2 22k 24k 2Bk| 28k 3k 34k 3Bk 3Bk dk 4375 *

17 bp] —————————— 2658 \ A
|

{1 E|r

Scrolls the sequence zoom view

- 4
“Scrolls the sequence details view

C2

When the sigma button (in the left part of the Sequence overview) is pressed, density of annotations in the sequence is shown. For example
in the picture below there are annotations in the parts of the sequence that are marked with dark grey color:

I r | . . I I = r r = r = = = r ]
[1 |2EIEI 400 E00 go0 1k 1.2k 1.4k 1.6k | 1.8k 2k 2.2k 24k 26k 2.8k 3123 @

See also:

® Sequence Zoom View
® Sequence Details View

Sequence Zoom View

The Sequence zoom view is designed to provide flexible tools for navigation in large annotated sequence regions.
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The most Sequence zoom view space is used to visualize annotations for the sequence. The annotations are organized in rows by their
names. If two annotations with the same name overlap, an extra row is created. For every row the name and the total number of annotations
in the row are shown with a light grey text at the left part of the area.

@ NC_014267 [dnal Q) & . iE ¥
I ]

L 10k 20k 30k 40K S0k |60k 70k 80k £ 90F 100k 110k 120k 130k140 426

& : [ S5C; small zingle copy  ~

& -alf— Name and number of annotations in the row

W T Zooming  Annotations TR (ooreat vesson)

=Y Ruler\ I

8 55167 50k 62k 64k 66k &8k 70k 72k T4k 78k 78k B0k 82k 84K 8Bk 8Bk B1274|
o L 3 :

Below the annotation rows there is a ruler to show coordinates in the sequence.

Sequence Details View

The Sequence details view is a supplementary component of the Sequence overview. It is used to show sequence content without zooming.
Every time you double click the sequence in the Sequence overview area or select an annotation, the corresponding sequence position is
made visible in the Sequence details view.

For a DNA sequence the Sequence details view automatically shows complement DNA strand and 6 amino translation frames.
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See also:

® Navigating the Sequence details view using the Sequence overview
® Selecting Amino Translation
® Showing and Hiding Translations
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Sequence Multi-line Details View

The Sequence multi-line details view is used to show sequence in a few rows.

To use it click the Wrap sequence button:

GTel _
EAT L

*
TCATCCTGATACCAAR

T 1967 1975 1980
AGTAGGACTATGGTTT!

M

After that the sequence will be divided into several parts. The width of the parts is enough for fitting into the sequence area. The multi-line
mode is often more convenient than single-line, because, in this case, the analysis of a sequence is like working with a text in a text editor.
Information is shown left-to-right, up-to-down.

?ETEC CAARARGCCAGGCAGAGACACAACARRD

G, 1975 1980 1385 1990 1995 %
T TATGGTTTCGGTCCGTCTCTGTGTTGTTT

Eu]

4 4 o 4

GTGGGCTTCATCCCTGGGATACAAGGCTG
L2116 2120 2125 2130 2135 2140 2
CACCCGAAGTAGGGACCCTATGTTCCGAC

]

M
*

Click the button Wrap sequence again to switch the mode off.

Information about Sequence

Context information about a sequence can be found on the Statistics tab in the Options Panel. All information is contextual, i.e. it shows
statistics about the currently selected region (on the selected sequence). The tab includes information about:

® Common statistics
® Length - number of bases in the analyzed sequence
® GC content - the molar percentage of guanine and cytosine bases in an oligonucleotide sequence
® Molar weight - is the sum of the atomic masses of the constituent atoms for 1 mole of oligonucleotide
® Molar ext. coefficient - the molar extinction coefficient is a physical constant that is unique for each sequence and describes
the amount of absorbance at 260nm (A,¢,) of 1 mole/L DNA solution measured in 1 cm path-length cuvette
® Melting TM - melting temperature is the temperature at which an oligonucleotide duplex is 50% in single-stranded form and

50% in double-stranded form
* nmole/OD,, - the amount of oligonucleotide in nanomoles that, when dissolved in 1 mL volume, results in 1 unit of

absorbance at 260 nm with a standard 1 cm path-length cuvette
® g/OD,g, - the amount of oligonucleotide in micrograms that, when dissolved in 1 mL volume, results in 1 unit of absorbance

at 260 nm with a standard 1 cm path-length cuvette
® Characters occurrence
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® Dinucleotides occurrence (for sequences with the standard DNA and RNA alphabets)

% NC_001353 [dnal O & " O (c2]T2) b m & = & 7 | | statistics
1 500 1k 1.5k 2k 2.5k Sk 3.5k 4k 4.5k Sk 5 @E] * Common Statistics
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S S H C 53 T D E = C 53 o] ay N H = T ay T Melting TM: 85.13C Eﬁil
nmole/0Dzz: 0.16 —
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ATCGTCGGTARACGGCATGACTGTTTCCTACGTCCGTTCGATTGGTACCCTGTCGGTG b Characters Occurrence (o]
n n M n T S v F S n P L S v M P C = =] Dinucleotides
L L W *] E v S L 5 H L C n L W P v n v
¥ © & N 6 Y §© © L I o A L * G H s L AA: 50
v ’:‘ b AC: 28
= AG: 44
MName Type Value AT: 29
[ (9 Auto-annotations [murine.gb | NC_001363] CA: 41
4 (9 NC_001363 features [murine.gb] o 54
4@ s @ 27
- @ CDS cDs 1042..2658 . 41
- @ CDS cDs join(2970..3413, GA: 37
- @ CDS cDs 3875.4999 GC: 38
- @ CDS cDs 5048..5203 GG: 37
[ ﬁ comment (0, 1) -~ 32
4 ﬁ misc_feature (0, 2) TA: 22
i+ O misc_feature Misc, Feature 2,590 TC: 43
i+ O misc_feature Misc, Feature 5245,5833 TG: 35
[ ﬁ source (0,1) - 29
Help
i+ I |

To copy the statistical information about a sequence select it on the Options Panel and choose the copy item in the context menu, or use the
Ctrl+C shortcut.

Manipulating Sequence

Going To Position
Toggling Views
Exporting Sequence Image
Zooming Sequence
Creating New Ruler
Selecting Amino Translation
Showing and Hiding Translations
Selecting Sequence
Copying/Pasting Sequence
Search in Sequence
® Load Patterns from File
® Search Algorithm
® Searchin
® Other Settings
® Annotations Settings
Editing Sequence
Exporting Selected Sequence Region
Exporting Sequence of Selected Annotations
Locking and Synchronize Ranges of Several Sequences
Multiple Sequence Opening

Going To Position

To go to a position, use the global actions toolbar:

Or use the Go to position context menu or the Actions main menu item.
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= W H N E M E ey E
. 1 % Goto position... Cti+G | .
T ii  Select sequence region... Ctr+A B a
~ ] 4, MNew annotation... Ctrl+N [ 4
'A':‘: ’ Rename item rT
. Copy/Paste 3 I

Also you can use the shortcut Ctrl-G.

Toggling Views

It is possible to switch the Sequence overview, Sequence zoom view and the Sequence details view visibility using the rightmost button in
the toolbar:

The sequence can be removed from the view using the same menu. Once you remove the last sequence in the view, the view is
automatically closed.

Exporting Sequence Image

Use a sequence toolbar Export image button to save a screenshot of the sequence:

Q & P o

The Export Image dialog will appear where you should set name, location, export settings and format of the picture:

s Exportimage

Export settings

Area Region

) Currently viewed [selecte = - l

O Zoomed annotations

® Sequence details

Export to File

File name [| l

Format Quality {1} |80 |=
Cancel H Export |

UGENE supports export to the BMP, JPEG, JPG, PNG, PPM, TIF, TIFF, XBM, XPM and SVG image formats. You can export currently
viewed, zoomed annotations or sequence detailes areas. Also you can export whole sequence or custom region. Use the Region settings to
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do it.
Zooming Sequence

To zoom a sequence in the Sequence zoom view you can use one of the zoom button on the sequence toolbar:

There are standard Zoom In and Zoom Out buttons. Additionally you can zoom to a selected region using the Zoom to Selection button. To
restore the default view of the Sequence zoom view (when the sequence is not zoomed) use the Zoom to Whole Sequence button.

Creating New Ruler

You can create any number of additional rulers by clicking the Ruler Create new ruler context menu item:

g  Goto position... Ctrl+G )
i Select sequence region... Ctrl+A | . "
o 45 Mew annotation... Ctrl+N [ TTTTTGRAACCRACG]
) Rename item 1245 1250 1255
C A\ AARRRACTTTGGETTGC"
Copy/Paste r
Select r | -
Add 3
Analyze O O
= Align 3
Cloning r
Export r
Edit 4
Remove r
A Rulers.., e Create new ruler...
il statistics v Show Main Ruler
v | Show Custom Rulers

The following dialog will appear:

i B
[¥] Create New Ruler M

Ruler name | Mew ruler|
Ruler start 99975 |5
Ruler color Sample Text E]
[ Create J [ Cancel ] [ Help ]
L% =

The new ruler will be shown right above the default one:
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[ mat peptide
[ mat_peptide
Repeat ruler 5 g5 -2000 1500 1000 ] 500 1k 1.5k 2k 2.5k Sk 3714
1 500 1k 1.5k 2k 2.5k 4k 4 5k 2k 5.5k Bk 5.5k Th T 435 —
{_ ................ e Z ..‘:
T L & F ¥ L F Iiew |;Ie| u—.'.itln 1-c||sn:|n nf?set 5 T 5 c R 5 ¥ L *
b * W F T Y =] ‘ ) R a L W D L F a E
I I3 F L FP T Q E K =] T | L D L L * I C 51 L I
TATTAGGTTTTTACCTACCCAGGAAAAGCCAACCAACCTCGATCTCTTGTAGATCTGTTCTCTAAM

Selecting Amino Translation

The default value for the genetic code is read by UGENE from the sequence file when it is available. You can also select the genetic code for
the sequence using the Amino translation menu button on the sequence toolbar.

1 All analysis routines (like HMMER, OFR finding, etc.) will use this code by default.

|E] @ 1. The Standard Genetic Code
) 2. The Vertebrate Mitochondrial Code
) 3. The Yeast Mitochondrial Code

[

O 4. The Mold, Protozoan, and Coelenterate Mitochondria and the Mycoplasma Code ;
O 5. The Invertebrate Mitochondrial Code

O 6. The Ciliate, Dasycladacean and Hexamita Nuclear Code
O 9. The Echinoderm and Flatworm Mitochondrial Code

O 10. The Euplotid Muclear Code

O 11. The Bacterial and Plant Plastid Code

O 12. The Alternative Yeast Nuclear Code .
O 13. The Ascidian Mitochondrial Code L
O 14. The Alternative Flatworm Mitochondrial Code

O 15. Blepharisma Nuclear Code

O 16. Chlorophycean Mitochondrial Code

O 21. Trematode Mitochondrial Code

=
—.IE

O 22. Scenedesmus obliquus Mitochondrial Code

(0 23. Thraustochytrium Mitochondrial Code
The numbering of the genetic codes corresponds the NCBI Genbank database numbering.
Showing and Hiding Translations

You can turn on/off the direct and complement amino translations visualization in the Sequence details view using the Show complement
strand and the Show/hide amino acid translations buttons.

ETTGTCﬁGﬁTTCﬁCCEﬁEG

TR i12 4 6 B 10 12 14 16 18
AACAGTCTAAGTGGTTTC.
: * *

To select a translation frames use the Show/hide amino acid translations button:
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- I L I *
@ show/hide translations ,
|@ Show direct only A
show complementary only o
Show all
1 direct translation frame -
N::': 2 direct translation frame P
1 ] 3 direct translation frame 3
1 complementary translation frame
2 complementary translation frame
3 complementary translation frame
Selecting Sequence
You can use different items from the Select submenu of the context menu to select a sequence.
""""""" [ * I
* 5 (Goto position.. Ctrl+G *
EE:C: [0 Select SEQUENCE regicn... Ctrl+ A 'I'T"!_"TTTGIILRRCC%&BCGRGEECB%&RGI—!
5 N tation.. Ctrl+N 1245 1250 1255 1260 1265
Fpg ‘b Mewannotation M IAARARACTTTGGTTGCTCTTGTTTCT
Rename item
______ Copy/Paste f E &) E 7] B =1 e I
Select ¥ | I} Sequence region...
___________ Add » Sequence between selected annotations
— Analyze » Sequence around selected annotations -
Align r l

Selecting the Sequence region context menu item opens the Select range dialog:
I R
% Region Selection l 2 ﬁj

@ Single Range Selection
Region: @ 13 - 58 Max

() Multiple Range Selection

Multi Region: 13..58

GO ][ Cancel H Help

L A

Here you can specify the sequence range you would like to select.
You can open the same dialog using the Select sequence region button on a sequence toolbar or using the Ctrl-A key sequence.

To use the Sequence between selected annotations item, select two annotations in the Annotations editor (holding the Ctrl key at the same
time):
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AT GARACACCCCACCCETAGGTGECAACCTAGCTTAACTALCCCACTTT GCA
12 4 E 8 1EI12141E182EI222428283EI323438384042444848505254

nmm /MMM My M T T R MR T T MM T M TR AMM T /MmN m T /R R T m

Marne Yalue
[=} @ MC_001363 Features [murine_copyz.gb)

W oS (0,4

[=} ﬁ misc_feature (0, 2)

nake g (2o ko position... k45

_| 1 Select sequence region.. kel
note Mew annokation, .. ChrlHM

ﬁ source (0, ]
Copy 3

selected annokations

analyze Sequence around selecked annokations

Align
Export
Edit sequence

4
4
4
4
4
4

Remove

A Rulers. .,

El_r Annotations highlighting. ..

-

And select the Select Sequence between selected annotations item in the context menu.

The Sequence around selected annotations item selects the selected annotations and the sequences between these annotations.

(5 NC_001363 sequence | S R IE"E, TR N

1 500 1.8k h 2 25K 4.5k 5333‘0
| WP _1)10335.1 lﬁ ssra'?-mw 9774 H‘F 040336.1 )E}

B terminsl rep) termanal ri

i S00 1k 1 Sk 25k 35 1 4.5 Sk 5833

1?12*1? Sequence &rﬂund selected annotations

z G N G 2 L ¥ W P S 8 § D L Y N W _ K N|
E E

R K E T

GAGGAAACGGAC‘ ST A, T ' sk BC T T T GGAAAAAT

700 1705 T 1715 172h 1 a0 1735 1740
CTCCTTTGOCTGL CGRAAGT A

L F R ¥V A E I & K C 8 3 F ¥
5 8§ VvV S [II»ZZZZIIZZZZ """"""""""""""""""""""""" ""IIZIZZZZZ‘.TEIE P F I
P F P C 8§ Sequence hetween selected annotatmns r Q@ F F
< | >
Ieame “ alue e

= % annotations [MyDocument_11.gb] *
= B misc_featurs (0, 3)
B misc_feakure
O misc_feature 1728..1737

B misc_feature
=6 Me NN1AAS Frakiires Miorine.nh]

Another way to select a sequence around annotations is to hold Shift and Ctrl keys while clicking on the annotations either in the Sequence
details view or in the Sequence zoom view.

Copying/Pasting Sequence
The selected sequence region, an annotation sequence or their amino translations can be copied to clipboard:

® By pressing the corresponding buttons in the global toolbar.
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58 E2 Ga G2 e Za D

® Using the following shortcuts:
® Ctrl-C — copies direct sequence strand
® Ctrl-T — copies direct amino translation
® Ctrl-Shift-C — copies reverse-complement sequence
® Ctrl-Shift-T — copies reverse-complement amino translation

® Using the Copy submenu of the context menu:

v za e - an an iz a La an iz — v - iz an —

i L M
- e Chrl+ G TTGCAAGGCATGGAARARATACATARCTCAGAATA)
- . 55 60 65 70 75 80 :
e Ctr+A A ACGTTCCETACCTTTTTATGTATTGACTCTTAT!
45 Mew annotation... Ctrl+M | M M
______ Rename item B
............ Capyflrpaste ’ _-;ﬂ CDP}[ sequence Ctr|+c
Select » | Z& Copy reverse-complement sequence Ctrl+Shift+C
Add y |Ef  Copy translation Ctrl+T
Analyze y | 26 Copy reverse-complement translation Ctrl+Shift+T
Align y |58 Copy annotation sequence
Cloning v | Ed  Copy annotation sequence translation
Export » I Paste SEQUENCE Ctrl+V
Edit *
Remaowe »
_‘_{43 Rulers... 4

To paste sequence use the corresponding context menu item or Ctrl+V shortcut.

Search in Sequence
To search for a pattern(s) in a sequence go to the Search in Sequence tab of the the Options Panel in the Sequence View.

Input the value you want to search in the text field and click the Search button. To search multiple patterns input the patterns separated by a
new line in the pattern text field. To add a new line symbol Ctrl+Enter may be used. You can input the value as sequence or name of the
sequence in the FASTA format and sequence after that.

&, 7 *||searchin Sequence
3,833 Search far;
-~

el |
peat ACG

—_—

3833

ik

|
FTW]

By default, misc_feature annotations are created for regions that exactly match the pattern. Find below the description of the available
settings.

Load Patterns from File
Search Algorithm
Search in

Other Settings
Annotations Settings
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Load Patterns from File

Load patterns from file

Path: E]

Use this checkbox to load patterns from file. When this option is active the Search for field is disabled.

Search Algorithm

 Search algorithm

Algorithm  |Exact -

This group specifies the algorithm that should be used to search for a pattern. The algorithm can be one of the following:

® |nsDel — there could be insertions and/or deletions, i.e. a pattern and the searched region can vary in their length. You can specify
the percentage of the pattern and a searched region match in the field nearby. Note that this value also depends on the pattern
length and is disabled when the pattern hasn't been specified.

® Substitute — a pattern may contain characters different from the characters in the searched region. When this algorithm has been
selected you can also specify the match percentage and additionally it is possible to take into account ambiguous bases.

® Regular expression — a regular expression may be specified instead of a pattern. For example character ‘.’ matches any character,
** matches zero or more of any characters. There is also the Limit result length option that specifies the maximum length of a result.

® Exact - find a place where one or several patterns are found within a larger pattern.

Search in

w Searchin
Strand |Both - |
Search in [Sequence - ]
Region [Whnle SEQUENCE ¥ ]

In this group you can specify where to search for a pattern: in what region and in which strand (for nucleotide sequences). Also for nucleotide
sequences it is possible to search for a pattern on the sequence translations.

Strand — for nucleotide sequences only. Specifies on which strand to search for a pattern: Direct, Reverse-complementary or Both strands.

Search in — for nucleotide sequences you can select the Translation value for this option. In this case the input pattern will be searched in
the amino acid translations.

Region — specifies the sequence range where to search for a pattern. You can search in the whole sequence, specify a custom region or
search in the selected region.

Other Settings

* (ther settings
[] Remove overlapped results

[ Limit results number to:

This group contains additional common settings:
Remove overlapped results — annotates only one of the overlapped results.

Limit results number to — limits number of the searched results to the specified value.
Annotations Settings
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 Save annotation(s) to
@ Existing table:

| € NC_014267 features [ + | [if"]
() Create new table:

* Annotation parameters
Group name:

<auto >

Annotation type:
Misc. Feature - ]

Annotation name:

by type

Description:

|:| Use pattern name

In the Save annotation(s) to group you can set up a file to store annotations. It could be either an existing annotation table object or a new
annotation table.

In the Annotation parameters group you can specify the name of the group and the name of the annotation. If the group name is set to
<auto> UGENE will use the group name as the name for the group. You can use the '/’ characters in this field as a group name separator to
create subgroups. If the annotation name is set to by type UGENE will use the annotation type from the Annotation type: table as the name
for the annotation. Also you can add a description in the corresponding text field. To use a pattern name for the annotations check the
corresponding checkbox.

After that click the Create annotations button. The annotations will be created. Also you can see the result statistic and navigation under the
Search for: field:

Results: 1/1

Previous | | Mext

Searching for one or several patterns and names of the result annotations

If you search for one pattern only, than input the required name into the Annotation name field and leave the Use pattern name check box
unchecked.

You can also search for several patterns at a time by:

® Inputting several patterns into the search field (click <Ctrl> + <Enter> keys to insert to a new line):

Search in Sequence

Search for:

TGECAAGCTAGE
TITGCAAGGCATG|

® |nputting several patterns into the search filed in FASTA format:
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Search in Sequence

Search for:

>patternl
TGGCAAGCTAGC

=pattern?
TITGCAAGGCATG|

® |oading patterns from a FASTA file

Even when you search for several patterns, names of the found annotations will be identical by default (the name is specified in the Annotatio

n name field).

If you want to assign different names to annotations found for different patterns, than you should:

® Input the patterns in FASTA format (the latter two cases above)
® Check the Use pattern name checkbox in the Annotation parameters group

Here is an example of the found annotations in the Annotations Editor:

4 E‘_‘,-' Annotations [MyDocument_1.gb] *
4 ’ﬁ misc_feature (0, 4) :
> W patternl 24,35

> B patternl 5267.5278
> O pattern 50.62
> O pattern2 5293.5305

Editing Sequence

If the document is not locked, it is possible to edit the sequence:

Tttt L | il
Insert subsequence.. Crl+
Close active view  Chrl+w Replace subsequence... Ctrl+R

" Remove subsequence...
Reverse-complement sequence  Ctrl+Shift+R

Reverse sequence

Complement sequence

T T e &

The Edit sequence submenu is available in the Actions main menu and in the Sequence View context menu. Also you can use the

corresponding shortcuts.

When you press the Ctrl+| shortcut or select the Insert subsequence context menu item the following dialog is opened:
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% Insert Sequence I. ? ﬁ]

Paste data here

Annotations region resolving mode Position to insert

@ Expand affected annotation 7

7 Remove affected annotation

end

4|k

1 5plit (join annotation parts)
Selection

7..39 after

) Split (separate annotations parts)
[7] Recalculate values of gualifiers
[ save to new file

Merge annotations to this file
Docurment location:

Document format: | FASTA

Ok ][ Cancel H Help

Description of the dialog parameters:
Paste data here — you must input the inserted subsequence. This parameter is mandatory.

Annotated regions resolving mode — defines either to Expand affected annotation, Remove affected annotation, Split (join annotation parts)
or Split (separate annotation parts) in case when the subsequence is inserted to the sequence position where some annotations are
presented.

Recalculate values of qualifiers - recalculates regions in qualifiers when sequence is modified.
Position to insert — the sequence position where to insert the subsequence.

Save to new file — the result sequence can be saves to a new file instead of modifying the current file. You must select the Document
location. FASTA and Genbank file formats are available when you do not include annotations to the result file. If you check the Merge
annotations to this file item, the annotations will also be saved to the result file (Genbank file format is only available in this case).

In case a subsequence has been selected, the Replace subsequence is available from the context menu or by the Ctrl+R shortcut. The
dialog opened in this case is similar to the dialog described above, except it already contains the sequence to be edited an doesn't allow to
input the start position.

Also it is possible to remove selected subsequence from a sequence. When you select corresponding item (in the context menu or in the Acti
ons menu), the Remove subsequence dialog appears:
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% Remeove Subsequence

? S |

Region to remove

Annotations region resolving mode

@ Crop corresponding annotation

(71 Remove corresponding annotation
[ Recaloulate values of gualifiers

[ save to new file

Merge annotations to this file

Document format:  |FASTA

37..74|

Document location: \ples,Genbank/murine_new.fa | | ...

Remove ][ Cancel

] [ Help

Region to remove — specifies the region of the sequence that will be removed in the form. This parameter is mandatory.

Annotated regions resolving mode— specifies what to do with annotations that overlap with the region that is removed. You can select either

Crop corresponding annotation (i.e. make it smaller) or Remove corresponding annotation.

Recalculate values of qualifiers - recalculates regions in qualifiers when sequence is modified.

Save to new file — similar to the same parameter in the Insert subsequence dialog (described above).

Also it is possible to invert sequence. When you select the Reverse complement sequence, Complement sequence or Reverse sequence ite

ms (in the context menu or in the Actions menu), the sequence will be inverted correspondingly.

Exporting Selected Sequence Region

Open a sequence object in the Sequence View and select a region by pressing and moving the left mouse button over the sequence.

Use the Export Export selected sequence region context menu item to save selection into a file of a sequence format.
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, I

4 File Actions Settings Tools Window Help HEER
E‘E &%@@ﬁﬁ—ﬂrﬂﬁ #ﬁ’ﬂv'l:'l"»

I - A S I I - Il =11 == | T =
o I
E % Goto position... Ctrl+G L3k 35k 4k 45k
@' i Select sequence region.., Ctrl+ & g:k 3_:5k 4:;{ 4.:5k Sk u 5
4, Mew annotation... Ctrl+M [42 bp] 5334 §5375

Rename item

Copy/Paste

Select

Add

Analyze

Align . F z = F v L z
Claning 3 _'._._3____::___f.:-_:__._“._::"_'F_-{"?:;i;"':':! -
Export 4 Export selected sequence region...
=r Edit b Export sequence of selected annotations...
Remove b Export annotations...
A Rulers... * CDs 1042..2658 i

The Export Selected Sequence Region dialog will appear which is similar to the Export Selected Sequences dialog described here.
Exporting Sequence of Selected Annotations

Q 2: Tasks Mo active tasks ‘@' [

Open the Sequence View with document that contains annotations. A good candidate here could be any file in Genbank format with both
sequence and annotations. Select a single or several annotations or annotation groups in the Annotation editor, click the right mouse button
to open the context menu and select the Export Export sequence of selected annotations item:
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UGENE-In @  Find qualifier...
% File  Action Invert annotation selection
[ = | Rename item F2
Paste annotations Ctrl+5Shift+V
@ NC_oo1
- & (o to position... Ctrl+G
1 . Select sequence region... Ctri+A
& 45 Mew annotation... Ctrl+M
¥ 4 Copy/Paste P
GTs Select 4
CJn:rJ T
o] * Add ,
D
»
CAC Analyze
1 b
T qo1g A9
CTG Cloning »
. _ Fetch sequences from remote database v L.
v Export b Export selected sequence region...
. 5 -
a Edit Export sequence of selected annotaticns...
Remove D Export annotations...
MName
a P £ Rulers... 4
b [0S oS T092..2658 |
@ CDS CcDs join(2970..3413,3412..3873) [
@ CDs cDs 3875.4999
> @ CDS cDs 5048..5203
13 'ﬁ comment (0, 1)
4 T8 risr feature 0 7 i

L] 3:Log | No active tasks '@’ [

| (_-j 2: Tasks

The Export Sequence of Selected Annotations dialog will appear which is similar to the Export Selected Sequences dialog described here.

Locking and Synchronize Ranges of Several Sequences

An important feature of the Sequence zoom view is the ability to synchronize and lock visual ranges of different sequences shown in the Seq
uence View.

This feature is available when there are two or more sequences opened in the same Sequence View.

If we click the Lock scales button the second sequence scale will be adjusted to be the same as the focused sequence scale and is locked.
Now if we move a scrollbar or use zoom buttons for any of the sequence, visual ranges for the rest sequences will also be adjusted.

Go! & 11 - | Be5 SW
-

=

- Lockscales button — Synchronize
* 10k {without lock)

F ¥ 1 p g scales Inmon_

LS

To unlock the scales click the same button again.
You may use the Adjust scales button to synchronize scales without locking them.

Note, that if you have a selected sequence region or a selected annotation the scales will be synchronized by the start position of the region
or the annotation. If there are no active selection the regions are synchronized by the first visible sequence position on the screen.

Multiple Sequence Opening

To open several sequences use the File->Open menu item or Open toolbar button and using Ctrl select the several sequences and click the
Open button. The following dialog will appear:
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m Multiple Sequence Reading Made lllﬂ_hJ

@ Separate sequence mode

(71 Merge sequence mode

Mumber of unknown symbals (M 'for nudeic acid or X' for amino acd) between sequences | 10
(71 Join sequences into alignment

Mew document name E]

Save document

. NC_014267.1.gb
. PBR322.gb
. sars.gb

g g

K ] [ Cancel ] [ Help ]

The following parameters are available:
Separate sequence mode - opens the sequences as separate sequences.
Merge sequence mode - merges sequences into one sequence with selected number of unknown symbols between sequences.
Join sequences into alignment - joins sequences into alignment.
Save document - save document to the selected document.
Also you can change the order of the sequences by up and down arrows.
Choose the parameters and click the Open button. Sequences will be opened in the selected mode.

In the Separate sequence mode sequences will be opened as separate sequences in selected order. You can change the sequences order
by drag and drop in the sequence view.

Annotations Editor

The Annotations editor contains tools to manipulate annotations for a sequence. It provides a convenient way to organize, view and modify a
single annotation as well as annotation groups.

An annotation for a sequence consists of:

®* Name (or key) — indicates the biological nature of the annotated feature.

® |Location — coordinates in the sequence.

® The list of qualifiers — qualifiers are the general mechanism for supplying information about annotation. Qualifiers are stored as
pairs of (name, value) strings.

Below is the default layout of the Annotations editor with an extra column for the “note” qualifier added:
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murine NC_001363 sequence |Z| |E| E|
M

[ NE 040335.1 .) NP_EB?TFF‘_SB?T@ NE 040336.1 } =

Loy _ cecoco:
' terminal re] E terminal re,
AXICENTITENEIIN X I T 1

1 500 1k 1.5k 2k 25k 3k 3.5k 4k 4.5k =k "ca3

[589 bp]-»580
3 3
N CE R P CH R E OV UAR SR UL K Y RTHTE R T R—
M L

PR 3 PR T P A RS B R A AT T AR, R B R R SR, T PR, TR R PR R T AT AR T S e SR TR T o

MName Value note
@ Auto-annotations [murine.gb | NC_001363] - . . Column with
= @ NC_001363 features [murine.gh] .‘b Objects with annotations " . qualifier
=@ cos (0,4 values
O cos Gli}llpﬁ 1042,. 2653
O cos join{2970..3413,3412..36873) Predicted By GeneMark; artific
O cos 3875..4999
O cos Annotation 5048..5203 Predicted by GeneMark
=) 'ﬁ mizc_feature [Dy
=0 misc_feature 2..590 5 terminal repeat
note Qualifier's 5' terminal repeat
O misc_feature name and valile 5245,,5333 3 terminal repeat
'ﬁ source (0, 1)
< | >
— —

There are usually several objects with annotations in the Annotations editor. A special Auto-annotations object is always presented for each
sequnce opened. It contains annotations automatically calculated for the sequence (see below for details).

An object contains groups of annotations used by UGENE for logical organization of the annotations. An annotation must always belongs to
some group.

For documents created not by UGENE annotations are grouped by their names. For annotations created in UGENE it is possible to use
arbitrary group names.

Groups can contain both annotations and other groups. The numbers in the brackets after a group name in the Annotations editor are the
count of subgroups and annotations in the current group.

A single annotation is allowed to be presented in several groups simultaneously. An annotation is physically removed from the document
when it does not belong to any group.

® "db_xref" Qualifier
® Automatic Annotations Highlighting
® The "comment" Annotation

"db_xref" Qualifier

Some files in Genbank format contain the db_xref qualifier. A value of this qualifier is a reference to a database.
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4 @ MNC_004718 features [sars.gh]
- @ IUTR (0, 1)
- @ 5'UTR (0,1)

4 @ cDs (0,14

4 @ CDs | CDS join(265..13398,13398..21485)
codaon_start 1
db_xref GL30124074
db_xref Genellk]1 459680
gene orflab
locus_tag sarsl

When you click on the value a web page is opened or a file is loaded specified in the reference. The loaded file is added to the current project

Automatic Annotations Highlighting

Enabling the automatic annotations highlighting allows you to automatically calculate and highlight annotations on each nucleotide sequence
opened.

Currently, the following annotations types support the automatic highlighting:

® Open reading frames
® Restriction sites
® Plasmid features

The corresponding groups of annotations found are stored in the Auto-annotations object in the Annotations editor, for example:

= {_}r' Auto-annotations [murine.gb | MC_001363]
e
¥ enzyme (5, 0)
s
W of (0,27

To disable/enable the automatic annotations calculations use the Automatic Annotations Highlighting menu button on the Sequence View too
Ibar:

k2, - Tr,
Plasmid features ﬁ
ORFs

v | Restriction Sites

ol

To create a permanent annotation click on the Make auto-annotations persistent context menu item and choose the annotation parameters in
the Create Permanent Annotation dialog.

The "comment" Annotation

General information about a file in GenBank or Vector NTI Sequence format, stored in the COMMENT sections of the file, is shown in
UGENE in a special comment annotation in the Annotations Editor.

The information, for example, may include the name of the file author, creation date and last modification date for the file, and so on:

@ 2xCyPET-3xFLAG-6 features [2xCyPet-3xFLAG-...

- @ CDs (0,2)
4 'ﬁ comment (0, 1)
4 @ comment Comment 1..4340

0 This file is created by Vector NTI http://www.invitrogen.com/
Author name Demao User
Creation date Thu Dec 23 13:29:
Last modification date Thu Dec 2313:29:
Object name 2xCyPET-3xFLAG-6xHIS/pDOMNRPZR-P3 (p37)
Cwrner

J 'ﬁ misc_feature (0, 11)

Manipulating Annotations
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Creating Annotation
Selecting Annotations
Editing Annotation
Highlighting Annotations

® Annotations Color

® Annotations Visability

® Show on Translation

® Captions on Annotations
Creating and Editing Qualifier
Adding Column for Qualifier
Copying Qualifier Text
Finding Qualifier
Deleting Annotations and Qualifiers
Importing Annotations from CSV
Exporting Annotations

Creating Annotation

To create a new annotation for the active sequence press the Ctrl-N key sequence, select the New annotation toolbar button or use the Add
New annotation or New annotation context menu item:

i B’
-* UGENE - [sars [5] NC_004718] =] B ]

Y File Actions Settings Tools Window Help |;||i||i|
B 6 B (& Gt @ 8D (o] | &~ 1~ = =
€5 NC_004718 [dna) ol om | Q&g @ ' = X
A I ,
s L |1 2k 4k Bk Bk 10k 12k &l“ 16k 18k 20k
o
@' Go to position... Ctrl+G I22k 24k 26k 29751 * | Acs
Select sequence region... Ctrl+A 21428 D
New annotation... Ctrl+N rITEE
Renameitem BB F M 08 I iilla
N P * Cc 3 L
Copy/Paste » - L o A v c g
Select v MACCCTTGATGCACTCTGL
Add U 45 Mew annotation... Ctrl+N
Analyze L Objects with annotations...
Align ’ Qualifier..

Cloning 4

i = Fetch sequences from remote database 4
Name Export .
(9 Auto-annotations [sars.gh Edit D

a @ NC_004718 features [sars.g
. Remave 4

» @ 3UTR @0, 1)
- @ 5UTR (0.1)

41 Rulers... 4
a @ cDs (0,14)
4 @ CDs B  Disable 'CDS' highlighting 483)
codon_start T
dh wref RT3 24074
| ) 2:Tasks ” [ 3:Log Mo active tasks &' []

This will activate a dialog where to set up annotation parameters:
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i Create Annotation l 7 -i_:h]

Annotation type: Group name source
Glycosylation Site -

Homeodomain Annotation name pe

iDMA L

Insertion Description

Intron 3 Location

J-Region @ Simple format

J-Segment

Leucine Zipper Domain }

Loci [C] Complement

LTR

Mature Peptide *) GenBank/EMBL format

Misc, Binding Site

Misc. Difference

Misc, Feature -

@) Existing table \ () NC_001363 features [murine.gh] - I

Create new table

MNOEuons able

LUIse guto-ar L

Create ]I Cancel II Help

L8 &

The dialog asks where to save the annotation. It could be either an existing annotation table object, a new annotation table or
auto-annotations table (if it is available).

You can also specify the name of the group and the name of the annotation. If the group name is set to <auto> UGENE will use the group
name as the name for the group. You can use the ‘/’ characters in this field as a group name separator to create subgroups. If the annotation
name is set to by type UGENE will use the annotation type from the Annotation type: table as the name for the annotation. Also you can add
a description in the corresponding text field.

The Location field contains annotation coordinates. The coordinates must be provided in the Genbank or EMBL file formats. If you want to
annotate complement strand sequence check the corresponding checkbox for the simple format or surround the coordinates with the
“complement()” word or press the last button in the corresponding row to do it automatically.

Note, that by default the Location field contains the coordinates of the selected sequence region.

Once the Create button is pressed the annotation is created and highlighted both in the Sequence overview and the Sequence details view a
reas:

: M K D b T E E W A 2 L = N A T
AAATGAAAGACCCCACCCGTAGGT GGCAAGCTAGC T TAAGTAACGCCAC |
12 4 B B 10 12 14 16 18 20 22 24 25 25 30 32 34 36 36 40 42 44 45 49 |
TTTACTTTCTGGGGTGGGECATCCACCGTTCGAT CGAATTCATTGCGGTG :
., I F § G ¥ R L H C A L K L L A ¥

Marne Yalue
=% Annotations [MyDocument, gb] *
2§ misc_feature {0, 13
O misc_feature 9,.39
= % MC_001363 features [WC_001363,gb] *
- B DS 0, 4

Selecting Annotations
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To select one annotation click on it. To select several annotations hold Ctrl key while clicking on the annotations. To invert the selection use
the Invert annotation selection item in the Annotations editor context menu.

Editing Annotation

If the document is not locked, it is possible to edit an annotation or an annotation group using the Rename item context menu from the Annot
ation Editor or from the Sequence View or with a help F2 key in the Annotation Editor. The result of pressing for an annotation:

e Edit Annotation oo
A,

~ Annotation name [CDS l
-10 Signal |4
_ -35Signal _ | Description [ l F
3' Clip
3'UTR
| ; SITIFF: ® Simple format [
Allele

Assembly gap 1042 ] - [2658 ]
1 |Attenuator
« |bHLH Domain [ Complement
! |C-Region
CAAT Signal ' GenBank/EMBL format

Annotation type:

Location

Ll o

o

Cellular 1042..2658
Centromere - =

Conflict

(<]

1| Help | Cancel |[ Edit |!

tvper 'Value

The result of pressing for an annotation group:

e Edit Group

DS .
2]

Highlighting Annotations

To configure settings of annotation names go to the Annotation Highlighting tab in the Options Panel.

By default the tab shows annotations names of the opened Sequence View.
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@ncooze Q & ", O (c2lT2) T & = »»| | Annotations Highlighting
1 500 1k 15k 2k 25k 3k 35k Sk 45k Sk 5333@ ol a1 crmioa o memes
terminy | [Eriemn -
Annotation Colar
1 500 1k 1.5k 2k 25k 3k 3.5k 4k 4.5k k 5833
3BTE —[1125 bp] —¥ 4093 ||| |Baar O
1 P | |BaeGl |
G P 3 =] R L '_[‘ W R T o R H
Sacll =
comment .
misc_feature .
B source O
3 o G R 3 0 C ) n N L LM Show all annotation names
4 F
= [ Configure the annotations:
Mame Type =
yp Show annotations
> W CDS cDs )
b W CDS 0% [ Show on translation
[> |I CDs i CDS Show value of qualifier:
> W CDS CcDs
) label,note
[ ﬁ comment (0, 1)
4 'ﬁ misc_feature (0, 2) E
[ O misc_feature Misc E E
[ O misc_feature Misc
[2 'ﬁ source (0, 1) - Help

4| n |

to the previous or to the next annotation of the view correspondingly.

Find below information about annotations names’ properties that you can configure.

Annotations Color
Annotations Visability
Show on Translation
Captions on Annotations

Annotations Color

To change a color of all annotations of a certain type click on the corresponding color box in the annotations types table and select the
required color in the appeared Select Color dialog.

Annotations Visability

To show/hide annotations with a certain name, select this name in the annotations names table and check/uncheck the Show annotations ch
eck box below. Another way to show/hide the annotations is to select the Enable/Disable highlighting item in the context menu of an
annotation.
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7
-* UGENE - [sars [s] NC_004718]
% File Actions Settings Tools Window Help
2o B = 1o Ba B Pa B Ba W &y~ 11 -~ | B W ey
., Find qualifier...
" @ N _oo4718 Invert annotation selection »| | Amoiatons Highihing
% T Rename item F2 Select an annotation name:
o 1 28751
] Paste annotations Ctrl+Shift+V L., i Annotation Calor
751
u FUTR
IE Go to position... Ctrl+G L4 O
EUTR
Select sequence region... Ctrl+A ] & O
D5
Mew annotation... Ctrl+M At A
|~ comment .
Copy/Paste P o .
Select » mat peptide O
Add » misc_feature D
Analyze » il .
Align » Show all annotation names
Clening b Configure the annotations:
J Fetch sequences from remote database 4 b Fire o srrTETIE
Name Export » | ] Show on wanslation
@& Auto- Edit » EI Show vale of qualifier:
4 NC_00
(D9 ﬁ _3'L Remove 4 Izbel
4 ﬁ 5 ‘@} Rulers... 4
% -
4 0 cf @ Disable 'CDS' highlighting
4 |’ cO% TCOS Join(265.1339¢
codon_start 1 A
(] u . — nm..ﬂl...-..P
| &) 2: Tasks || L] 3:Log

Show on Translation

This option is available for nucleotide sequences only. It specifies to show the annotation on the corresponding amino sequence instead of
the original nucleotide sequence in the Sequence Detailed View, for example:

E F T E Kt E
\GATTCACCAAAGTTGAAR

i B 10 12 14 16 18 20 22 24
[CTAAGTGGETTTCAACTTT
I * W L Q F

& E © F N F

You can enable/disable this option by checking/unchecking the Show on translation checkbox.
Captions on Annotations

It is possible to show a value of a qualifier of an annotation instead of the annotation type name in the Sequence Zoom View. To enable this
option for an annotation type check the Show value of qualifier check box and input the values of the required qualifiers in the text field
nearby this check box. See the image below.
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@ncoowzead Q & e, [ (celTe) Tr. m ®, = 65 +»| | Annotations Highlighting
T s00 1k 15k 2k 28k 3k 36k 4k 45 ok |i5833%) B s e T
Show value of gualifier ;"
Annotation Caolor
5245 53k 5350 5.4%5450 55k 5580 568k 5850 57k 5750 5833
[5582 bp] 3 | | Badi ]
/ BaeGl O
Bael .
cos [
Sacl O
comment .
misc_feature .
source O
1 Show all annotation names
4 F
— ’:I Configure the annotations:
Mame Type Walue it
L il Show annotations
4§ NC_001363 features [m.. _
[» ﬁ source (0,1) 3 [7] Show on translation
4 ﬁ misc_feature (0, 2) Show value of qualifier:
4 |I misc_feature | Misc, Feature  5245..5833 | note
[note Show value of gualifier |
> O misc_feature Misc, Feature  2..590
[ ﬁ comment (0, 1) E E
4 @ CDs @4
[ W CDS CcDs 5048..5203 Help
4 W CDS cDs 3875..4999 ¥

If you input several qualifiers names (separated by comma), then the first found qualifier is taken into account and shown on the annotation.

Creating and Editing Qualifier

To add a qualifier to an annotation select it in one of the Sequence View subviews and press the Insert key, or use the Add Qualifier context
menu or the Actions main menu item.

4 ﬁ S'UTR Select r |
4 O5UT
evic Add * | 4 Mew annotation... Ctrl+N
4 ﬁ CDS (0 Analyze b Objects with annotations...
4 @ DS Align Y Qualifier... Ins
cod Cloning ’
db_; Export y 20124074
db_; - R nell:14536580
gen ! lab
loct Remove L]
not (é} Rulers... , lMas assumed that the SARS orflab polyprotein
Epro ab polyprotein (pplak)

protein_id MP_828849.2

The dialog will appear:
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-

)
9, Add New Qualifier -2 -

MName new_gualifier|

Value

F | ok || cancel || Hep ]J

Here you can specify the name and the value of the qualifier.

You can use the F2 key to rename a qualifier:

" Rename Qualifier @lﬂ

new_gualifier|

To edit a qualifier, select the qualifier and press the F4 key or use the Edit qualifier context menu item:

Marne Yalue
[=} (9 MC_001353 Features [murine_copy2.gb]
@ cos (0, 4)
= 'ﬁ misc_feature (0, 23
=} O misc_feature 2,590
O mi Copy qualifier ‘note’ value 4c,
@ sour 221 _Add ‘noke’ column
( Edit qualifier F4 )
£ (30 ko position, . Chrl+3
I Select sequence region, ., k48
() 2: Tasks [ A Mew annotation... Chrl+M
Copy k
Seleck ]
add k
Analyze 3
Align 3

Adding Column for Qualifier

It is possible to add a column with the qualifier values to the Annotations editor. To add the column, select the Add ‘[the qualifier name]’
column qualifier context menu item.

Copying Qualifier Text

Use the Copy qualifier ‘[the qualifier name]’ text qualifier context menu item to copy the qualifier value.

Finding Qualifier

To find a qualifier select annotation(s) or group(s) of annotations and use the Find qualifier context menu.
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Mame Value
@& Auto-annotations [CVUS5T62.9b | CYUS5T62]
4 @ CyussTe2 features [CWU55762.gb]
PR
W D5 0,2 Find qualifier...
4 [ CD5
codon start Invert annotation zelection
db_xref Rename item F2
gene N
product g Goto position.., Ctrl+G
protein_id i} Select sequence region... Ctrl+A
transzl_table 4 Mew annotation... Ctrl+M
translation
- O CDs Copy »

The dialog will appear:

%, Find Qualifier L2 |

Search in: CDS

Qualifier
Marme:

Value:

Match Parameter

(7 Exact match

i@ Contains substring

[ Select all ][ Mext ][ Cancel ][ Help

. —

Here you can specify the name and the value of the qualifier and select the searching parameter: Exact match or Contains substring.

Deleting Annotations and Qualifiers
Selected annotations, groups and qualifiers can be deleted using the Delete key.

To remove an annotation object from the active view, select the object in the Annotations editor and press the Shift-Delete. Note that the
object will not be removed from the project, but just from the active Sequence View. To add object again just drag and drop it to the Sequenc
e View.

Importing Annotations from CSV

It is possible to import annotations for a sequence from an annotations table stored in the CSV format.

To import annotations from a CSV file, right-click on a Project View and select Import Import annotations from CSV. The following dialog box
will appear:
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r ™y
m Import Annctations from C5V @Iﬂ
File to read [:]

Results
Result file B
File format [Genbank v]

Add result file to project

Column separator value: [], hex: [2c], length: 1

File parsing

@ Column separator B

(C) Seript Edit |
First lines to skip Do not skip (= I
Skip all lines starts with the text #

[7] Interpret multiple separators like a single separator (iry when separator is a whitespace character)
Remove quotes

Default annotation name misc_feature

Results preview

Raw file preview:

[ Run ] [ Cancel ] [ Help ]
L s
Basically you need to specify the file to read annotations table from (required):
File to read |D:fpru:njectsfu:levfugeneftrunk,."test,.’_u:ommon_cIatafscenariosfannotaﬁons_importfannsl.csv | E]
And the format of and the path to the file to write the annotations table into (required):
Results
Result file |D:J"|:|rojeu:tsfu:levfugenE,."trunK."test,."_u:u:urnmon_data,."scenari0sfannu:utaﬁons_impu:urt,f’result.gl:u | E
File format |Genbank vl

Check Add result file to project to link the annotations to the currently opened sequence.

Add result file to project

To use a separator to split the table, check the Column separator item and specify the separator symbols. Also you can press Guess to try to
detect the separator from the input file.

File parsing

@ Column separator ' I Guess

Alternatively, you can press Edit and edit the script which will specify the separator for each parsed line. It is possible to use line number in
the script.

7



Unipro UGENE Manual, Version 1.26

— . "
@ Scipt | W] Script Editor
First lines ta
Used script
Skip all lines Seript text
[ Interpref ffThe script parses input line
Remov I ar!d returns an array of parsed elements as the result
var line; [finput line
var lineMum; //parsed line number
Default annotg)

Results previel

var firstColumn = flineMum];
var otherColumns = line.split{" 7);
result =firstColumn. concat{otherColumns);

Chedk syntax Save Line: 1
[ Clear ] [ Save as..
Raw file previg
Done ] [ Cancel

Do not skip 5

misc_feature

Preview

Using the arrows, you exclude the necessary number of lines at the beginning of the document from parsing. You can also skip all lines that

start with the specified text.

First lines to skip

By pressing Preview one can bring up the view of the current annotations table (which is produced from the input file with the specified

1line(s) & |

parameters values). The input file contents will also be shown at the bottom part of the dialog.

Results preview

Preview

[ignored] [ignored] [ignored]

al 10 20 pp

al 19 40 ppe

[ignored]

Raw file preview:

name, start,end,qual 1
a1,10,20,pp
a1,19,40,ppe

23

The preview table headline indicates the types of the information contained in the corresponding columns. By default the values are [ignored]

. To specify a column role, click on the corresponding headline element:
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i '
[¥] select the Role of the Column m

Column role
(7 Annotation start position Add offset Obp (2
(71 Annotation end position Indusive

(71 Annotation length

() Complement strand mark Mark value

(71 Annotation name

) Annotation group

) Qualifier
1]
i @ Ignore this column
[ QK ] [ Cancel ] [ Help
~ "

The annotation start and end positions must be specified. It is possible to add an offset to every read start position by checking the Add offset
checkbox, and to shorten annotations by one from the end by uncheking the Inclusive checkbox.

When all the roles are specified, press Run. With the Add to project checkbox specified and a Sequence View opened, on success you will
see the Sequence View with annotations linked:

@ s1

—— 7

12 4 6 B8 10 12 14 16 18 20 22 24 26 28 30 32 34 36 38 40 42
CCAGATTCAGTTCCTTTAATAAAGAGATTAATTTCAATATTAR

Mame Value
= (9 Annotations [result.gh]
= al (0,2
= al 19..40
the_gualifier ppe
=@ a1 10..20
the_gualifier pp

Exporting Annotations

To export annotation(s) open the Sequence View with document that contains annotations. Select a single or several annotations or
annotation groups in the Annotation editor, select the Export Export annotations context menu item.

Also you can export annotation(s) from the Project View by the Export Export annotations context menu item.

The Export Annotations dialog will appear:
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- B
[M] Export Annctations M

Export to file:  C:jworkjugene/data/samples/Genbank/CVUS5752_annotations. csv E]

File format: [cs'u' - ]

|:| Save sequences under annotations

[7] save sequence names

K. H Cancel ][ Help J

L A

Here you can set the path to the file, choose the file format and optionally for CSV format you can save the sequence along with annotations
and save sequence names.
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Sequence View Extensions

The functionality of the Sequence View can be significantly increased with Sequence View Extensions. Below is the demonstration its
functionality.

The Circular Viewer shows the circular view of a sequence:

mRMN& AAB59343.1

FRMA RN

repeat_region AN - _IRMNA

misc_binding ™, e
misc_recomb
N *, f_old_sequence
.\_\ \ y
. .',-'
\'\ -. //
p PR

L

" ARBS3340.1
T ewon

YSCPLASM sequence
6318 bp

misc_binding =00 j; i _--hcnnﬂict
RN . \'\ / _:exon
. o ... conflict
TS _ MRNA
... BABS9340.1
.. repeat_reqion
. ... tonflick
- ., conflict
mRNA canflick
AABEI34Z.1 : _ canflict
MR % conflict
%, conflict
misc_recomb

1 kY
5 S, conflict
\ RN
AABSS341,1

The 3D Structure Viewer adds 3D visualization for PDB and MMDB files:
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W 3D Struckure Yiewer Active view: 1 1¥eC - P & Display  Links Add =7

5 1V6C chain 1 sequence [amino]

3 90 95 100 105 MO0 M5 120 125 130 135 140 145 150 155 160 165
M N ONANIHI VT FNEA G GY S 38 LW AAT D TCVN S GLANV VTS L GG 3G ST TTE RN ALNTHYHNG VL LIA LA GHAGD 85T,

misc feature

21 22 23 24 25 XM X XM 24
G C = A G A C =z C T:

C A R D = I A R R W = R a3 T L [ R = I
GETGETGCAC GCGATNGCAT TGCGAGACGCT GGAG{CCGGAGCACCCTAT GTCGCAGTATCT
12 4 B & 10 12 14 16 18 20 22 24 26 26 30 32 34 356 35 40 42 44 46 45 30 52 54 56 5860
CCACACGTGCGCTATCGTAACGCTCTGCGACCTCGGCCTCGT GEGATACAGCETCATAGA
T H v E ¥ C Q 2 W 2 3 G 2 c c I D c ¥ R

T D
H A R 5] L M A L R Q L R L W R H R L I 2
< >
Marne Walue
=+ €% Annotations [MyDocurnent_9,gb] *
= misc_feature (0, 13
O misc_Feature 16,.34

The DNA Graphs Package shows various graphs for sequences:
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% AYDZ7935 standard sequence P& T C?:-’ &, = G 7

[ Cb8 | cbs | @i [ @i FCDZ p[cOpCDs

11814 125k 13k 1335k 14k 143k 15k 135k 16k 1685k 17k 175k 18k 185k 19k 19693

2 5 P A E F T L KE I ©C WV F 2 ¥ R F Q2 N
CTTCCTCCCCCGCCGAAT TTACGT TAAAAAT T TCGTGTTTTTTCAGTTAGATTTCARARAATA

12 4 6 & 10 12 14 16 156 20 22 24 26 26 30 32 34 36 35 40 42 44 46 45 S0 52 54 56 5560
4 >

Mame Yalue
+ (5 AY027935  standard Features [Haemophilus, enb]

The Dotplot provides a tool to build dotplots for DNA or RNA sequences.
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110k

120k

140 426

10k
20k
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40k
S0k
60k
70k
80k
90k
100k

110k

116k
MNC_014267 sequence (min length 11, identity 100%%)

A number of other instruments add graphical interface for popular sequence analysis methods:

aauanbas sa7ET0 ON
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U -* UGEME - [murine NC_001363 sequence]

(¥} Fil= Actions Settings  Tools  Window  Help
Qo B A B | % @ G g S %a [ (e & - o1 | wg s
(9 MC_001363 sequence [dna] @' U
' - 2k 25k 3k 3.5k 4k
% Go to position... Cl+s B335, 1 Y F 597742 JNP_507742 2
T terming . Select sequence region... Chrl+a
1_ ;"-6 Mews annokation, . Chrl+M K a5k 3k 3.5k Ak
Copy 3
»
K select G K L A * Vv T P L C I
N Add » A =] * L E * E H F =
b Find pattern... Chrl+F & Q .
AT' F'.Ilgn [ GCAJ
g Find pattern [Smith-wWaterman]. .. Chkrl+Shift+F
12 4 Clonning 3 2 54 5
Find ORFs. .. r
TTTa& Export , ACET
T N Find annotated reqions. .. [
F Remove , Build dakplat... A ]
H - Find repeats. .. . L
s ‘-@j Rulers... ' Find tandems. ..

Mame | = annotations highlighting. ..

(9 MC_00135363 Features [murine, gb]

RiMISEROSILE BN T 2 E

Find query designer patkern...
Find restriction sites. ..
Query MCEI BLAST database. ..

Search HMM signals with HMMER3, .

Search with HMM model, .

Search TFES with SITECOM. ..
Search TFBS with makrices. ..
Prirmer3...
= Query with SLAST..
= Query with BLAST+...
£
| L 2 Tasks || L 3 Log

For details see the next sections of the documentation:

® Circular Viewer

® Circular View Settings
® 3D Structure Viewer

® Opening 3D Structure Viewer

® Changing 3D Structure Appearance

® Selecting Render Style
Selecting Coloring Scheme
Calculating Molecular Surface
Selecting Background Color
Selecting Detail Level
® Enabling Anaglyph View

Moving, Zooming and Spinning 3D Structure
Selecting Sequence Region
Selecting Models to Display
Structural Alignment
Exporting 3D Structure Image

® Working with Several 3D Structures Views
® Chromatogram Viewer

® Exporting Chromatogram Data

® Viewing Two Chromatograms Simultaneously
®* DNA/RNA Graphs Package

® Description of Graphs

® Graph Settings

® Saving Graph Cuttoffs as Annotations
® Dotplot

® Creating Dotplot

® Navigating in Dotplot
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Zooming to Selected Region
Selecting Repeat

Editing Parameters

Filtering Results

Saving Dotplot as Image

Saving and Loading Dotplot

Building Dotplot for Currently Opened Sequence
Comparing Several Dotplots

Circular Viewer
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Interpreting Dotplot: Identifying Matches, Mutations, Invertions, etc.

The Circular Viewer plugin provides capability to show the circular view of a nucleotide sequence.

Usage example:

Open a nucleotide sequence object in the Sequence View. The Show circular view button is available on the sequence toolbar:

ate re-

) cvus5752 [dnal O & ™. [
200 1k 1.0k 2k 2.5k

[BEB02574.1 ;
X . .

eatey Show circular view

1 200 1k 1.5k 2k 2.5k
Pressing the button will show the circular view of the sequence:

“ ™
[T -* UGENE - 555 [5] AF013258] [E=SREER
% File Actions Settings Toels Window Help \;"il&l

OB & G @ b @ @ feo) & -1 - % W o\ [ oo P CONE - S
+ pBR322_arigin . .
S EBV _rev_primer K Restriction Sites Map
&= T7_promoter - . [ BamHI: 0 sites
) . .
a PCAG_F_primer, . [ Bhbsl: 0 sites
—| i [Z) Bglll: O sites =
W El [0 Clal: 0 sites _
=) Dral: 0 sites =
bGlob_int || EcoRI: 0 sites —
"""" [ HindII : O sites illa
/ 600 AF013253 2.6k [ Pstl: 0 sites
- 4076 bp [ Sall: 0 sit:
Annotations =
\ [0 Smal: 0 sites
- 200 Scale marks * [ Xrmal: 0 sites
sv40pro_F_primer "
SV40_origin
SV40_promoter . - o .
pBABE_3 primer AmpR._promater Restriction Sites Map
M13_forward20_primer H
M13_pUC_fwd_primer pGEX_3_primer
] ™ G
[ ' pGEX 3 primer ] i
3242 3244 3245 3248 3250 3252 3254 3256 3258 3260 3262 3264 3266 3268 3270 3273
G A A A ACCT CT GGATCATCATGCOCAGOCTOCUCTOCGGAT©GH-AC
] DIl —
s A H s P P H G * L I F F I ¥ A E A E r L 5 p: 3 E I F
v P P I L R P M A D * F F L F M ¢ R P R P P R P L 8 ¥
F E P F S Y P W L T I F F Y L C B = R G E L = L * Y I E
T
240 245 250 255 260 265 270 275 280 285 280 295 300 305 310 315 320
AARGGCGGGTRAAGAGGCGEGGTACCGACTGATTARRAARRAATARATACGTCTCCEGCTCCGGCGGAGCCGGAGACTCGATAR
‘ MName ° Value
r @ AFD13258 features [pSG5.gb]
b @ Auto-annotations [pSG5.gb | AF013258]
< [ r
| © 2 Tasks || L] 3:Log | No active tasks ' [
L

)

If you work with file with many sequences the button closes circular views if some circular views are opened and if all circullar views are

closed, it opens all of them.

Also you can mark sequences as circular in UGENE by the Mark as circular sequence context menu item. When the sequences are marked
as Circular, the Circular View is automatically opened for them in all opened Sequence View windows.

The Restriction Sites Map will appear automatically. To show restriction sites the Show Restriction Sites menu should be checked. To hide

the map click on the following button:
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‘%'-g File Actions Settings

== N

atl

-{E 1: Project

1 The Circular Viewer is opened automatically when the Sequence View is opened for a plasmid.
The inner circle represents the sequence clockwise and the scale marks show the corresponding sequence positions. The sequence
annotations are represented as curved colored regions at the outer side of the circle.

The Circular Viewer helps to navigate within the sequence. You can select an annotation on the circular view and the annotation will also be
focused and highlighted in all Sequence View areas: Sequence overview, Sequence zoom view, Sequence details view and Annotations
editor.

You can also select a sequence region:

] EB'I.-'_rE'u'J:urimer_ _pEiF'.322_nrigin
' T7_promoter
= pCAG_F_pg :
EO bGlob_int :
AFD13253
4076 bp
"ﬂ
5"."4'D|:IFD_FJ:IFiIT|EFI
SV40_origin
SV40_promoter
pBABE_3_primer g 3 AmpR._promoter
M13_forward20_primer pGEX_3_primer
4 (i
| ]
' (pEREZZ_orign |
A + ‘I + + t + +—
1 500 1k 15k 2k 2.5k 3k 3.5k 4078
B50 € [479 bp] #1138
1| 1] [ » -
E = — s E F G D B * L F F
L = E M F E W =S L = T L D C = F
= I L E T = E * = = L I v L
CGATCCTGAGAACTTCAC R CCEGACCCTTCATTGTTCHTY

This will also affect the Sequence View. You can select a sequence region with Ctrl and the selection will be inverted.

Note that the circular view is zoomed automatically when the Circular Viewer area is resized:
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i EBV_rev_primer pBR.322_origin 3
T7_promoter ’
pCAG_F_primer Resizing thE
it N circular view area
is resizing the
AF013253
4076 bp sequ ence
........... circular view
SV40_promoter " T
SV4lpro_F_primer 3.5k
SV40_origin .-
M13_forward20_primer AmpR._promoter
g
= )
g | L
500 1 15k 2k 2.5k 3k 3.5k 1076

So you can adjust it to an appropriate size.

It is possible to rotate the circular view using the mouse wheel. Also it is possible to shift the start point of a circular molecule by Edit
sequence -> Set new sequence origin context menu item.

Use the Export Save circular view as image context menu or the Actions main menu item to save the image of the circular view.

EB"J_rev_primer‘ pBR.322_origin
T7_promoter ’?‘u
pCAG_F_primer ‘{1
| =
| bGlob_int
AF013258
g Goto position.., Ctrl+ G
{1 Select sequence region... Ctrl+ &
4 Mew annotation... Ctrl+M
Copy 4 AmpR._promater
Select » pGEX_3_primer
3
Add L3 | -
Analyze 3 |j
Align 2
Cloning (3 | i
Export P [B= Save circular view as image ]
Edit sequence - Export selected sequence region...

The Export Image dialog will appear:
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e ExporktImage e

Export settings
L] Include position marker

M Include selection

Export to File

File name [ l |:|
Format |:png = | Quality {1 ] ' |80 §|
width | 1073px |2 Height | 262px |2

| Help | | Cancel | | Export |

Here you can browse for the file name, select the width, height and resolution of the image as well as its

format: svg, ps, pdf, bmp, jpeg, jpg, png, ppm, tif or tiff. Also you can include position and selection markers
to the image by the corresponding checkboxes.

Note, that if a sequence file contains several sequences it is possible to view the circular views of the
sequences in the same Circular Viewer area.

N W e i

NP_597742.2
NP_597744.1

3 terminal repeat

" 5Y40_origin
8 4,5k
2,5k

CVUS5762 4733
4733bp

AABD2574.1

NC_001363
5333bp

. Itis possible to
“ugp  Tesizethe areas

'S terminal repeat

pBABE_SJ:rimer_
o ]J(

15k

MP_040335.1

You can work with these circular views at the same time.

Circular View Settings

To configure circular view settings go to the Circular View Settings tab in the Options Panel.

Activate the circular view for a sequence and the following settings will appear:
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| Circular View Settings |

w Title
Show title AE
2
Show length b
=
Font M3 Shell Dlg 2 b Iﬂg
Size 10 =
Attribute g
* Ruler

Show ruler line
Show coordinates

Label font size 10 -

* Annotations
Label position [Lnsidefﬂutside v]

Font size 7 -

In the title section you can show or hide title and length, change font, size and attribute.

In the ruler section you can show or hide ruler line and coordinates and change the label font size.

In the annotation section you can select the label position and change the label size.

The following label positions are available:

® inside - all labels are inside of the annotations

® outside -

all labels are outside of the annotations

® inside/outside - if the label can fit the annotation and it is not auto-annotation, it's located inside. Otherwise outside.
® none - no labels at all

3D Structure Viewer

The 3D Structure Viewer is intended for visualization of 3D structures of biological molecules.

Using the 3D Structure Viewer you can work with data from the Protein Data Bank (PDB) - a repository for the 3D structural data of large
biological molecules, such as proteins and nucleic acids, maintained by the Worlwide Protein Data Bank (wwPDB).

You can work as well with data from the NCBI Molecular Modeling DataBase (MMDB), also known as “Entrez Structure”, a database of
experimentally determined structures obtained from the RCSB Protein Data Bank.

Find the description of the 3D Structure Viewer’ features below.

® Opening 3D Structure Viewer
® Changing 3D Structure Appearance

Selecting Render Style
Selecting Coloring Scheme
Calculating Molecular Surface
Selecting Background Color
Selecting Detail Level
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® Enabling Anaglyph View
® Moving, Zooming and Spinning 3D Structure
® Selecting Sequence Region
® Selecting Models to Display
® Structural Alignment
® Exporting 3D Structure Image
® Working with Several 3D Structures Views

Opening 3D Structure Viewer
The 3D Structure Viewer is opened automatically when you open a PDB or MMDB file.

For example, open $UGENE/data/samples/PDB/1CF7.PDB. The 3D Structure Viewer adds a view to the upper part of the Sequence View:

1{5 3D Structure Viewer Active view:l 1: 1CF7 v| Display Links 7

Y 1CF7 chain 1 sequence [amino] 2, T, D E e

™ [ alpha helix .} |a|pha_helix.} [ _alpha helix .,‘} heta_stra.;} |beta_s.i;} -

12 4 6 8 10 12 14 16 18 20 22 24 25 28 30 32 34 35 38 40 42 44 46 48 50 52 54 56 58 60 62 54 BT
SRHEESLGLLTITREFVSLLOEARRDGVLDLELAADTLAVEQERRIYDITHNVLEGIGLIERKESENSIQWE

o ; -

w
L4

Notice the Links button on the toolbar. When you click the button the menu appears with quick links to online resources with detailed
information about the molecule opened:

* PDB Wiki

®* RSCB PDB
® PDBsum

* NCBI MMDB

Note that if you're online, you can access the Protein Data Bank directly from UGENE and load a required file by its PDB ID (see Fetching
Data from Remote Database for details).
Hint

Don't forget to select the correct database (PDB) while fetching.

Changing 3D Structure Appearance

This chapter describes how you can change a 3D stucture appearance.

Selecting Render Style
Selecting Coloring Scheme
Calculating Molecular Surface
Selecting Background Color
Selecting Detail Level
Enabling Anaglyph View

Selecting Render Style
The following render styles are available:

® Ball-and-Stick
® Space Fill
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® Tubes
® Worms

To change the render style select an appropriate item in the Render Style menu (it can be found either in the 3D Structure Viewer context
menu or in the the Display menu on the toolbar).

Ball-and-Stick

Selecting Coloring Scheme
You can select one of the following coloring schemes:

® Chemical Elements
® Molecular Chains

® Secondary Structure
® Simple colors

To change the coloring scheme open the Coloring Scheme menu (available in the context menu and in the Display menu on the toolbar).
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Chemical elements Molecular chains

Simple colors

Calculating Molecular Surface

To calculate the molecular surface of a molecule select the Molecular Surface item in the 3D Structure Viewer context menu or in the Display

menu on the toolbar and check one of the following items:

® SAS (solvent-accessible surface)
® SES (solvent-excluded surface)
® vdWS (van der Waals surface)

To remove the molecular surface that has already been calculated select the Off item.

You can also select the Molecular Surface Render Style to modify the calculated molecular surface appearance:

® Convex Map
* Dots

93



Unipro UGENE Manual, Version 1.26

SAS (solvent-accessible surface) SES (solvent-excluded surface)

vilWS with dots

vilWS (van der Waals surface)

Selecting Background Color

To change the background color open the Settings dialog (choose the Settings item in the 3D Structure Viewer context menu or in the Displa
y menu on the toolbar), press the Set background color button and select a color in the dialog appeared.

Selecting Detail Level

To select the detail level of a 3D Structure representation open the Settings dialog of the 3D Structure Viewer and drag the Detail level slider.
Enabling Anaglyph View

UGENE allows you to view a molecule in the anaglyph mode. To enable the anaglyph view open the Settings dialog of the 3D Structure
Viewer and check the Anaglyph view check box.

You can modify the color settings: select one of the available Glasses colors or set custom colors, swap the colors.

The offset of the color layers can be adjusted by dragging the Eyes shift slider.

&
Eyes shift

J

Glasses colors Cyan - Red w

Swap colors

Left Right

See the result the anaglyph view is applied to a molecule below:
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Moving, Zooming and Spinning 3D Structure
A 3D structure can be easily spinned, moved and resized:

® To spin the 3D structure drag the mouse on the 3D structure while holding the left mouse button.
® To move the 3D structure hold the Ctrl keyboard button and drag the mouse with the left button pressed.
® To resize the 3D structure either use the mouse wheel or Zoom In and Zoom Out buttons on the toolbar.

At any time you can restore the default view by pressing the Restore Default View button on the toolbar.

+

=
You can also overview the whole structure by spinning it automatically. Select the Spin item either in the 3D Structure Viewer context menu

or in the Display menu on the toolbar to do it.

To stop the spinning uncheck the Spin item.
Selecting Sequence Region

When you are selecting a region of a sequence e.g in the Sequence zoom view the corresponding region on the 3D structure is being
highlighted while the rest regions of the 3D structure are being shaded.

To configure the color of a region selected open the Settings dialog (press the Settings item in the 3D Structure Viewer context menu or in
the Display menu on the toolbar to do it), press the Set selection color button and select a color in the dialog appeared.

To adjust the shading drag the Unselected regions shading slider in the Settings dialog.
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&% 3D Structure Viewer Active view: [1: 2ZML = b = Display .

(%' 2ZML chain 1 sequence [aminag] ":, Lt = * = 8l
. [alpha_helix { alpha_helx >  pefa_sy  peta_sir: Eﬂl
139 150 180 170 180 180 200 210 220 zén\ 240 250 266

14 aal 3234

5

£ *

Selecting Models to Display

When a molecular structure contains multiple models (e.g. NMR ensembles of models), the Models item appears in the 3D Structure Viewer
context menu and in the Display menu on the toolbar. For example, for protein with PDB ID 1ZNF the menu looks as follows:

Render Style

Colering Scheme

Maelecular Surface Render Style
Meolecular Surface

Maodels..

Spin

Settings...
Export Image...
Structural Alignment

Close

The dialog will appear:
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o4 Select Models 2 o]

M1
02
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07
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] 14
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O] 16
O 17
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[[] 19
[ 20
O 21 n
O 22

O 23

] 24

£ 25

[C] 26

O 27

O] 28 il

[ All H Invert ][ QK ][ Cancel H Help

13

m

To show all the models check the All item. To show only one model check the item and click the OK button. To show several models select it
and click OK button. To show the inverted selection click the Invert button and click OK button.

Structural Alignment

To use the structural alignment call the Structural alignment->Align with context menu item. The following dialog will appear:

i B
[M] structural Alignment @lﬂ

Algorithm [PTqus - ]

Reference Muohile

Structure | 1CF7 Structure

Region Region

Model 1 Model 1

IE

[ QK J[ Cancel ][ Help ]

L A

Here you can change reference and mobile settings. After that click on the OK button. To reset structural alignment call the Structural
alignment->Reset context menu item.
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Exporting 3D Structure Image

To export a 3D structure image select the Export Image item in the 3D Structure Viewer context menu or in the Display menu on the toolbar.
The Export Image dialog will appear:

* Exportimage o

Export to File

File name || |
Format |png 2| Quality i—— |80 [2]
width | 1369px |2 Height | 275px |2

Help Cancel Export

Here you can browse for the file name, select the width and height of the image as well as its format: svg, png, ps, jpg, jpeg, tiff, tif, pdf, bmp
or ppm. For jpg, jpeg formats the quality score parameter is available.

Working with Several 3D Structures Views

To add another view to the 3D Structure Viewer you can:

® Drag a required [3d] object from the Project View to the 3D Structure Viewer.

Project *| & 3D Structure Viewer Activeview: (1:1EBE v & #. =

Mame filter

Objects

= E 1crn.pdb
'?f-; [5] 1CRM chain 1 sequence
C\f [a] 1CRM chain 1 annotation

ol [3d] 1CRN

= [ 1FDL.pdb
% [s] 1FDL chain 1 sequence
Al T=1 BRI Ahain 1 ammabadiae

® Press the Add button on the toolbar. The Select Item dialog will appear. Select [3d] objects to add.
Hint

Use the Ctrl keyboard button to select several objects.

i Select Item I. 2 _Zh]
4 [ 1CF7.PDB
W [3d]1CF7
4 [ 1CRN.PDE
o8 [3d]1CRN
oK ] | Cancel

Below you can see the 3D Structure Viewer with two views:
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&% 3D Structure Viewer Active view: |2: 1CRN w| (& '* = e Display Links Add o

To select an active view click on the view area or select an appropriate value in the Active view combo box on the toolbar.

To synchronize the views press the Synchronize 3D Structure Views sticky button on the toolbar (see the image above). When the button
has been pressed the 3D structures are moved, zoomed and spinned synchronously. Press the button again to stop the views

synchronization.

The views that are no more required can be closed by selecting the Close button in the 3D Structure Viewer context menu.

Also you can hide/show views for a while. Use the menu of the green arrow button on the toolbar to do it:

—1
v Show 1CRM
¥ Show 1V&C
v Show 1IMOT
Close 3D Structure Viewer
|

Notice that the 3D Structure Viewer can be closed from this menu.

Chromatogram Viewer

The Chromatogram Viewer plugin brings DNA chromatogram data viewing and editing capabilities into UGENE.

Currently supported chromatogram file formats are ABIF and SCF.

To view a chromatogram, just open an interesting file in UGENE by standard means (e.g. drag&drop the file or press the Ctrl-O shortcut).
The Chromatogram Viewer is automatically embedded into the generic Sequence View if chromatogram data are found, as on the
screenshot below:
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(% Alzberezikov [dna] (@] & % i\ e

@ 1 50 100 150 200 |25I] 300 350 400 450 500 550 600 650 ?I}|J 750 800 850 500 838

"' Chromatogram view (zoom in to see base calls) @]

0TOGOCOA
o
L)

"H‘i"llnlig

E
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To edit a sequence data, right-click on the chromatogram view and select the Edit new sequence item in the appeared context menu. The
following dialog will appear:

[¥] 2dd New Document &lﬂ_ﬁj

Document format [FAST#. - ]

Document location || [I]

[] Compress file

[ Create ][ Cancel H Help ]

L A

Select new document format and location and click on the Create button.
The original DNA sequence is not allowed to be changed; however you can add and modify a new sequence stored in a separate file.

The sequence being edited is displayed right above the original one. Symbols can be changed by clicking on interesting value, modifications
are shown in bold.

Also you can show/hide different signals of chromatogram and quality bars with a help of the Show/hide trace and Show quality bars toolbar
buttons correspondingly:
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lo0 —et— Show quality bars
A T.I.T

L A A CC

Sihw%ﬂhifde itracfe

® Exporting Chromatogram Data
® Viewing Two Chromatograms Simultaneously

Exporting Chromatogram Data

Open, for example, the $3UGENE/data/samples/SCF/90-JRI-07.srf file. In the Project View context menu there is Export chromatogram to

SCF item:

Project X || () 90-IRI-07 sequence
Mamme Filer | [Z) i 1020 =0 40 s e0 70
Objects Chromatogram
=

% [5] o Dpen vigw L4

@ el '

[ Unload selected documents

Lock docurment For ediking
Ll
I 1 |I 1111
[

LHTETL L4

(TEETAECLALTA TECETATEven ey (e aneerm
Export sequences

Remove v Export sequences as alignment

1 10 20 30 40 a0 =11 ?;:I

Marne

After clicking on the item, the Export chromatogram file dialog will appear:

L

i '
[ Export Chromatogram File M

Export to file C: fwork/ugene fdata/samples/SCF20-IRI-07_copy.scf E]
File format to use [SCF - ]
[7] Reverzed [] complemented

Add document to the project

[ Expart ][ Cancel ][ Help ]

A

Check the Reversed and Complemented options if you want to create a reverse and complement chromatogram. Press the Export button.

The exported file will be opened in the Sequence View.
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Viewing Two Chromatograms Simultaneously

To add another sequence to the Sequence View, drag the required sequence object from the Project View and drop it in the Sequence View
area. (Note that the dragged object is the sequence object, not the chromatogram object.)

Praoject X| (9 Q0-IRI-07 _copy sequence
Hame filter | | 1100 20 30 40 50  E
Objects Chromat
= [ 90-IRI-07.scF
R . [=] 90-JRI-07 sequence
) [c] 90-IRI-07 chromatograrn T
= [#8 90-IRI-07_copy.sck r
My [5]90-IRI-07_copy sequence
S @[] 90-IRI-07_copy chroma...
1 10 20 a0 40 an £
The result will ook like this:
& 90-R1-07 sequence || O K’ T, cz T3 | B & = & va
0 50 =0 0 30 1l 00 0 0 0 0 0 50 ‘@
Chromatogram view (zoom in to see base calls)
0ToGoCoA
‘h MI ‘ I “m | | il M\“\ I S
110 20 30 40 S0 60 A0 80 80 100 110 120 130 140 150 160 170 180 190 200 213
(% 90-RI-07_copy sequence |E| QO KR T i |§|E| e e = & 7
110 20 30 40 S0 60 70 80 80 100 110 120 130 140 150 160 170 180 190 200 213‘]@
Chromatogram view (zoom in to see base calls)
0ToGOCOA
| | Il E
11020 a0 &N SN A0 70 AN 80 100 11A_ 120 130140 150 1AN__ 170180140 200 A3 ¥
Name “ value
< >

You can also use the Lock scales and Adjust scales global actions for the chromatograms.

For example if you lock the scales you are able to scroll the sequences simultaneously. Also when you select a sequence region in one
sequence, the same region is selected in the second sequence.
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U New Project® UGENE - [90-JRI-07 _copy 90-JRI-07_copy sequence] E|@[g|
(#] Fila Actions Settings Tools Window Help - | ] 3¢
" ROoOB)A4A® G @ G @ 4% % | [ & ~|f1a - = % w »
@ 90-R1-07 sequence (MO B & [i|ce THTH0 & & & & ¢4
g 1 10 20 30 40 S0 60 70 &0 wl_lm_‘u_ﬂ_l@ 130 140 150 180 170 180 150 200 21
]
-+,
= L)
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'D-L 8 bp *lar,-h
3595 97 98 99 100 101 10 111 12 13 14 115 16 17 118 119 12
AT A G G A T|G A G G C A G G|A A T C A A A G A C A G

< | >

% 90-RI-07_copy sequence (WO B T, (illcz|m3| @ & & & & @

t 1020 ﬁ 40 S0 60 70 &80 90 100 110 120 130 140 150 160 170 180 190 200 213.@
)
-+

EEEDDDDDODDDUUDODDODD DDD

b UA‘MJ.

2 A & R T 8 6 A0 4443 1li 'hl 1818 1.1' iR iﬁﬁﬂ??ﬂ'}l‘)ﬂ‘)ﬁ'}?‘?k)ﬁ__

Name “ value
bl ]
[ Ozmnsks || (Dawe | No active tasks 5’

DNA/RNA Graphs Package

The DNA/RNA Graphs Package draws contextual graphs for sequences. The DNA/RNA Graphs Package is available for the Standard DNA
and Standard RNA alphabets.

Open a sequence in the Sequence View and click the Graphs icon on the toolbar. The popup menu appears:

ey SIS 5 |
jl:l GC Content (%) E
[l AG Content (%)

[ ] GCFrame Plot

[ ] GC Deviation (G-C)/(G+C)
1 [] AT Deviation (A-T)/(A+T)

[ Karlin Signature Difference

| ] Informational Entropy
| [] DNA Flexibility

To see a graph select the corresponding graph item in the popup menu. A new area with the graph appears right above the Sequence zoom
view:
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Each point on a graph is calculated for a window of a specified size. The window is moved along the sequence by a step. See Graph
Settings for instructions on how to modify these parameters.

It is possible to get information about each point of a graph. When a mouse is moved in the Graphs area, a small circle shows on the graph.
A coordinates hint shows above it. When you hold Shift and click on a graph, the circle and the hint locks:

}

[1012::5 0.0813397] | (118893, 0. UUEZSEE]}U

WW TTw Ve

To remove it click on the hint. Also you can delete all labels by Graph->Delete all labels context menu. To select all extremum points use the
Graph->Select all extremum points context menu item.

All graphs are always aligned to the range shown in the Sequence zoom view. It means that if you change the visible range in the overview
(either by zooming or scrolling) the graph will also be updated. The minimum and maximum values of the visible range are shown at the right

lower and upper corners of the graph.

To close a graph, uncheck its item in the popup menu.

® Description of Graphs
® Graph Settings
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® Saving Graph Cuttoffs as Annotations
Description of Graphs

Find below the detailed description of each graph. Note that characters A, C, G and T in the formulas denote the number of corresponding
nucleotide in a window.

* DNA Flexibility — searches for regions of high DNA helix flexibility in a DNA sequence. The average Threshold in a window is
calculated by the following formula:

(sumof flexibility angles in the window) / (the wi ndow size - 1)

For more detailed information see DNA Flexibility paragraph.
® GC Content (%) — shows the percentage of nitrogenous bases (either guanine or cytosine) on a DNA molecule. It is calculated by
the following formula:

(G+Q) | (A+G+C+T) * 100

® AG Content (%) — shows the percentage of nitrogenous bases (either adenine or guanine) on a DNA molecule. It is calculated by
the following formula:

(A+GQ) | (A+G+C+T) * 100

® GC Frame Plot — this graph is similar to the GC content graph but shows the GC content of the first, second and third position
independently. It is most effective in organisms with GC rich genomic sequence but it also works on all microbial sequences.

® GC Deviation (G-C)/(G+C) — shows the difference between the “G” content of the forward strand and the reverse strand. GC
Deviation is calculated by the following formula:

(G Q)1 (G+Q)

® AT Deviation (A-T)/(A+T) — shows the difference between the “A” content of the forward strand and the reverse strand. AT
Deviation is calculated by the following formula:

(A-T)/ (A+T)

® Karlin Signature Difference — dinucleotide absolute relative abundance difference between the whole sequence and a sliding

window. Let:
f(XY) = frequency of the dinucleotide XY
f(X) = frequency of the nucleotide X

P(XY) = F(XY) / f(X) * f(Y)

p_seq(XY)
p_wi n(XY)

p(XY) for the whol e sequence
p(XY) for a w ndow

The Karlin Signature Difference for a window is calculated by the following formula:

sunm(p_seq(XY) - p_win(xy)) / 16

® |nformational Entropy — is calculated from a table of overlapping DNA triplet frequencies. The use of overlapping triplets smooths
the frame effect. Informational Entropy is calculated by the following formula:
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-(triplet frequency)*loglO(triplet frequency)/logl0(2)

Graph Settings

To change settings of a graph, select the Graph->Graph settings item in the graph context menu. The Graph Settings dialog appears:

rlﬁ Graph Settings I. 2 &r

Window: 100 =

Steps per window: 100 (=

Default color: . |

[ cuteff for minimum and maximum values
Minirmurm: 0.00

Maximurm: 0.00

K, H Cancel ][ Help

The following parameters are available:
Window — the number of bases in a window.
Steps per window — the number of steps in window. The Step is calculated as Window / Steps per window.
Default color — the default color of line of graph (or lines of graphs for GC Frame Plot).
Checking of the Cutoff for minimum and maximum values checkbox enables the following settings:
Minimum — the minimum value for cutoff.
Maximum — the maximum value for cutoff.

Select an appropriate minimum and maximum value and click the OK button to show the graph of cutoffs. The graph is divided into 2 parts.
The upper part shows values greater than the specified Maximum value. The lower part of the graph shows values lower than the specified M
inimum value. For example:

DML Flexibility [1, 5833], Window: 100, Step 1

Values greater than
"Maximum™

Values lower than
"Minimum"

Saving Graph Cuttoffs as Annotations

EE——

To save graph cuttoffs as annotations select the Graph->Save cuttoffs as annotations item in the graph contex menu. The following dialog
will appear:
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s ™
%4 Save Graph Cutoffs as Annotations liléj
Maximum cutoff 52.25[%
Minimum cutoff 16.25(%

Area to annotate
() Around cutoff values

@ Between cutoff values

* Save annotation(s) to

@ Existing table | ) NC_D14267 features [NC_014267. 1.b] x| &)

) Create new table

Use auto-annotations table

 Annotation parameters

Group name <autox

Annotation type | Misc. Feature hd

Annotation name  graph_cutoffs

Description

Save ] [ Cancel ] [ Help

The following parameters are available:
Maximum cutoff - maximum cutoff value.
Minimum cutoff - minimum cutoff value.
Around cutoff values - saves the values around cutoffs values.
Between cutoff values - saves the values between cutoffs values.

In the Save annotation(s) to group you can set up a file to store annotations. It could be either an existing annotation table object, a
new annotation table or auto-annotations table (if it is available).

In the Annotation parameters group you can specify the name of the group and the name of the annotation. If the group name is set to
<auto> UGENE will use the group name as the name for the group. You can use the ‘/’ characters in this field as a group name
separator to create subgroups. If the annotation name is set to by type UGENE will use the annotation type from the Annotation type: t
able as the name for the annotation. Also you can add a description in the corresponding text field.

Select the parameters and click on the Save button. The corresponding annotations will be saved.

Dotplot

The Dotplot plugin provides a tool to build dotplots for DNA or RNA sequences. This allows comparing these sequences graphically. Using a
dotplot, you can easily identify such differences between sequences as mutations, inversions, insertions, deletions and low-complexity
regions.

Also the plugin provides advanced features: comparing multiple dotplots, navigation in a dotplot, dotplots synchronization, saving and loading
a dotplot, etc.

An example of a dotplot view:
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1 The Dotplot plugin uses the Repeat Finder plugin to build a dotplot, make sure you have the Repeat Finder plugin installed.

The Dotplot features are described in more details below.

Creating Dotplot

Navigating in Dotplot

Zooming to Selected Region

Selecting Repeat

Interpreting Dotplot: Identifying Matches, Mutations, Invertions, etc.
Editing Parameters

Filtering Results

Saving Dotplot as Image

Saving and Loading Dotplot

Building Dotplot for Currently Opened Sequence
Comparing Several Dotplots

Creating Dotplot

To create a dotplot select the Tools Build dotplot main menu item. The Build dotplot from sequences dialog will appear:
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[7] euild Dotplot from Sequences @lﬂ_hj

File with first sequence | D
[] Join all sequences found in the file Gap size: |0

[] Compare sequence against itself

File with second sequence E]

[7] Jin all sequences found in the file Gap size: |0

Mext ][ Cancel ][ Help ]

L A

Here you should specify the File with first sequence. Also you should either check the Compare sequence against itself option or select the Fi
le with second sequence.

Optionally you can select to Join all sequences found in the file (for the first and/or for the second file). If you select to join the sequences you
can also select the Gap size. The gap of the specified size will be inserted between the joined sequences.

After you press the Next button, the dialog to configure the dotplot parameters will appear:

([0 DotPiot |2 | |

Dotplot parameters
¥ axis sequence [human_Tl (UCSC April 2002 chr7:115577709-117855134) - ]
f axis sequence [human_Tl (UCSC April 2002 chr7: 115977709-117855134) - ]

[ Load Sequence ]

Search for direct repeats - default
[] search for inverted repeats - default

[7] custom algorithm Auto

Minimum repeat length 100bp |+
Repeats identity 100% (=

Ok ][ Cancel ][ Help ]

L A

The following parameters are available:
X axis sequence — the sequence for the X dotplot axis.
Y axis sequence — the sequence for the Y dotplot axis.

If there are several sequences in the specified (the first or the second) file and you haven't selected to join the sequences in the previous
dialog, then you can select a sequence in these fields.

If you have selected to Join all sequences found in the file, then you can'’t select a separate sequence from the file, the joined Sequence can
be selected instead.

Search direct repeats — check this option to search for direct repeats in the specified sequences. You can also select the color with which
the repeats will be displayed in the picture. The default button sets the default color.

Search inverted repeats — check this option to search for inverted repeats in the specified sequences. You can also select the color with
which the repeats will be displayed in the picture. The default button sets the default color.

Custom algorithm — optionally you can select an algorithm to calculate the repeats:
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1 The specified algorithm is provided to the Repeat Finder plugin as an input parameter. In most cases the Auto value is appropriate.

Minimum repeat length — allows to draw only such matches between the sequences that are continuous
and long enough. For example if it equals to 3bp, then only repeats will be found that contain 3 and more

base symbols.

Press the 1k button to automatically adjust the Minimum repeat length value. Such value will be set, that there will be about 1000 repeats

found.

Repeats identity — specifies the percents of the repeats identity.

Press the 100 button to set the 100% identity.

After the parameters are set, press the OK button. The dotplot will appear in the Sequence View:
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It is a two-dimentional plot consisted of dots.

Each dot on the plot corresponds to a matched base symbol at the “x” position of the horizontal sequence and the “y” position of the vertical
sequence.

Visible diagonal lines indicate matches between sequences in the given particular region.
See also:

® Interpreting Dotplot: Identifying Matches, Mutations, Invertions, etc.
® Building Dotplot for Currently Opened Sequence

Navigating in Dotplot
To zoom in / zoom out a dotplot you can:

® Rotate the mouse wheel.
® Press corresponding zoom buttons located on the left:

To move the zoomed region you can:

askf:
S0k T
55k

B0k} - -0

aouanbas LazE10 ON

85k .

7ok} T

o b T Miminap = |
MC_014267 sequence (min length 11, identity 100%)

® Hold the middle mouse button and move the mouse cursor over the zoomed region of the doplot.
® Click on the desired region of the minimap in the right bottom corner.
® Activate the Scroll tool, hold the left mouse button and move the mouse cursor over the zoomed region:

Zooming to Selected Region

To select a dotplot region activate the Select tool:

[

hold down the left mouse button and drag the mouse cursor over the dotplot.

When you select a region on a dotplot the corresponding region is also selected in other Sequence View areas (Sequence details view, Sequ
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ence zoom view, etc.).
The opposite is true as well: if you select a region in a Sequence View area, the corresponding region is also selected in the dotplot view.

To zoom to the region selected click the Zoom in on the left.

12230 16k 18k 20

—_—

—
= Click it to zoom to
v the selected region

LT TN

Selecting Repeat

To select a repeat activate the Select tool:

and click on the repeat:

26855 27k 272k

24 5k ‘w

To deselect the repeat either click on other repeat or hold Ctrl and click somewhere on the dotplot.

Interpreting Dotplot: Identifying Matches, Mutations, Invertions, etc.
Using a dotplot graphic, you can identify such the following differences between the sequences:
1. Matches
A match between sequences looks like a diagonal line on the dotplot graphic, representing the continuous match (or repeat).
2. Frame shifts
a. Mutations

Mutations are distinctions between sequences. On the graphic they are represented by gaps in diagonal lines. They
interrupt matches.

b. Insertions

Insertions are parts of one sequence that are missed in the another, while the surrounding parts match. In other words, an
insertion is a subsequence that was inserted into a sequence.

Graphically, insertions are represented by gaps which lie only on one axis. A little shift towards the other axis indicates a
mutation involved.

c. Deletions
A deletion is a subsequence that was deleted from a sequence.

A deletion from sequence A found in sequence B can be considered as an insertion into sequence B and contained in
sequence A.
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3. Inverted repeats
The Dotplot plugin allows to search for inverted repeats as well. Inverted repeats are shown contrary to the direct repeats.

Use the Search direct repeats and Search inverted repeats options of the Dotplot parameters dialog to select which repeats to draw
(the dialog is described here).
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4. Low-complexity regions

AN

22IN0s

A low-complexity region is a region produced by redundancy in a particular part of the sequence. It is represented on a plot as a
rectangular area filled with the matches.
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Hint

Compare sequence with itself to easily find low-complexity regions in it.

Editing Parameters

It is possible to edit parameters of a built dotplot. Right-click on the dotplot and select the Dotplot Parameters context menu item:

.- T - = o @ .

: PR RS S L
Dotplot r Parameters
Go to position.. Ctrl+G Savefload k -
_;,__ . | select sequence region.. Cirl+4 Remove
e 45| New annotation Ctrl+M

Copy k

The parameters dialog will be re-opened. See description of the available parameters here.

Filtering Results

It is possible to find features intersections and filter dotplot results. Right-click on the dotplot and select the Dotplot Filter results context
menu item. The following dialog will appear:
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Imtersection Parameters

Features Selection
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4 Sequence¥: NC_001363
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Invert Selection
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Clear Selection

QK ][ Cancel ][ Help ]
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Select features and click OK button. The filtered dotplot will appear.

Saving Dotplot as Image

To save a dotplot as image right-click on the dotplot and select the Dotplot Save/Load Save as image context menu item:

: Lo - 2o o oo = S .o - i -~ i - -
- - gy — . - - o o = - - - -

‘ | Dotplot 4 | Parameters - T e
£ | Go to position.. Cirl+G | Save/lload # | Sax;e as image
Select sequence region. . Ctrl+4 Remaove Save
A5 Mew annotation crl+ |- . L. % Load
s T ' - . T N
) Ol . PR S

The following dialog will appear:
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* ExporktImage G

Export settings

[l Include area selection

Export to File

File name || | |_|

Format |.png $| Quality - (] : |

width [1372px |3 Height [_376px [2| oPI 96 [

| Help | | Cancel || Export |

Available formats are *.png, *.jpg, *.bmp, *.jpeg, *.ppm, *.tif, *.tiff, *.xbm and *.xpm.

Saving and Loading Dotplot

To save a dotplot in a native format, right-click on the dotplot and select the Dotplot Save/Load Save context menu item:

- " . i - -

L S e - ) i -
3 3 o - - = &
- T Tow

‘ | Daotplot 4 | Parameters |- T N
£ | Go to position.. Cirl+G | Save/lload # | Sax;e as image 3
Select sequence region. . Ctrl+4 Remaove Save
" | A Mew annotation crl+ |- . L. 5 Load
s T ' - . T N
) Ol . PR S

The Save Dotplot dialog will appear. A dotplot is saved in a file with the *.dpt extension.

Later the dotplot can be loaded using the Dotplot Save/Load Load context menu item.

Building Dotplot for Currently Opened Sequence

To build a dotplot for currently opened sequences, create a multiple view containing these sequences. It can be arranged by dragging the
corresponding sequence objects (the items strated with the “[s]”) into the same Sequence View.

Then right-click on the created view and select the Analyze Build dotplot item in the context menu. Every sequence from the current multiple
sequence view can be used to build a dotplot.

1 Ifyou need to compare a sequence with itself, you can activate the menu from a single Sequence View.

Comparing Several Dotplots

Dotplots created for the same view are shown at the same view.

If the horizontal and vertical sequences of several dotplots are the same correspondingly, it is possible to lock all zooming and navigating
operations for these dotplots. Press the Multiple view synchronization lock button on the left.
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Alignment Editor

® Overview
® Alignment Editor Features
Alignment Editor Components
Navigation
Coloring Schemes
® Creating Custom Color Scheme
Highlighting Alignment
Zooming and Fonts
Searching for Pattern
Consensus
® Export Consensus
® Alignment Overview
® Working with Alignment
® Undo/Redo Framework
Selecting Subalignment
Moving Subalignment
Copying/Pasting Subalignment
Editing Alignment
® Removing Selection
Filling Selection with Gaps
Replacing Selected Character
Replacing with Reverse-Complement
Replacing with Reverse
Replacing with Complement
Removing Columns of Gaps
Removing Sequence(s)
® Removing All Gaps
Saving Alignment
Aligning Sequences
Aligning Sequence to this Alignment
Pairwise Alignment
Working with Sequences List
® Adding New Sequences
Renaming Sequences
Sorting Sequences
Shifting Sequences
Collapsing Rows
® Copying Sequences
® Exporting in Alignment
® Extracting Selected as MSA
® Exporting Sequence from Alignment
® Exporting Alignment as Image

® Statistics
® Distance Matrix
® Grid Profile
® Advanced Functions
® Building HMM Profile
® Building Phylogenetic Tree
® PHYLIP Neighbor-Joining
®* MrBayes
® PhyML Maximum Likelihood

Overview

This chapter gives an overview of the Alignment Editor components and explains basic concepts of browsing an alignment.

Alignment Editor Features
Alignment Editor Components
Navigation
Coloring Schemes

® Creating Custom Color Scheme
Highlighting Alignment
Zooming and Fonts
Searching for Pattern
Consensus

® Export Consensus
® Alignment Overview

Alignment Editor Features

The Alignment Editor is a powerful tool for visualization and editing DNA, RNA or protein multiple sequence alignments. The editor supports
different multiple sequence alignment (MSA) formats, such as ClustalW, MSF and Stockholm. The full list of file formats supported in UGENE
is here.
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The editor provides interactive visual representation which includes:

* Navigation through an alignment;

® Optional coloring schemes (for example Clustal, Jalview like, etc.);
® Flexible zooming for large alignments;

® Export publication-ready images of alignment;

® Several consensus calculation algorithms.

Using the Alignment Editor you can:

® Perform multiple sequence alignment using integrated MUSCLE and KAlign algorithms;
® Edit an alignment: delete/copy/paste symbols, sequences and subalignments;

® Build phylogenetic trees;

® Generate grid profiles;

® Build Hidden Markov Model profiles to use with HMM2/HMM3 tools.

Alignment Editor Components

Here is the default layout of the editor:
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The Alignment Editor components:

For example, let's assume that the coordinate of the first visible base of the row is N, but the row contains K gaps before the position N. The
starting offset value will be N-K. The same rule is true for the ending offset.

You can turn off the Sequence offsets by unchecking the Actions View Show offsets main menu item or View Show offsets context menu
item.

Navigation

The Sequence area provides several flexible ways to navigate through an alignment. The simplest way is to use the mouse and the
scrollbars.

Alternatively you can use arrow keys on the keyboard to navigate.
The list of hot keys for quick navigation:

® PageUp — to move one screen left.
® PageDown — to move one screen right.
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®* Home — to center the starting columns of the alignment.
* End — to move to the trailing columns of the alignment
Hint

if you use Shift key with the hot keys above you will navigate through the rows. For example, Shift-PageDown will move one screen
down.

Finally you can use the Go to position dialog from the Actions menu, the context menu or the editor toolbar.

Position

T A
T A
T A

T A
TEA
Ta ATTC

Enter the column number (base coordinate) and the view will be centered to the corresponding base.
Coloring Schemes

There are various coloring schemes for DNA and amino alphabets available.

To change the scheme, activate the Colors context menu:

u- Y Tl T r n - I\ I % ot n " T I % .
C g Goto position.. Ctrl+G T CcCC ]
Add b
d .., 1A TCA
c ';Q Colors 4 Mo colors :
C Highlighting PV Jalview .
Edit - Percentage Identity ‘
C =0 Align / Percentage Identity (gray) .
C Tree ¥ UGENE ‘
il Statistics 4 Customn schemes |
C View 3 .
C Export » ’

or use the Highlighting tab of the Options Panel:

 Color

Mo colors

Jalview

Percentage Identity
Percentage Identity {gray)
UGENE

® Creating Custom Color Scheme

Creating Custom Color Scheme

To create custom color scheme use the Colors->Custom schemes->Create new color scheme context menu item. The Application Settings di
alog will appear. Click on the Create color scheme button:
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Alignment Color Scheme

Create and modify custom color schemes

Directory to save color scheme:

(]

L

The following dilaog will appear:
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Select the new scheme name, alphabet and click on the Create button. The next dialog will appear for nucleotide extended mode:
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Here you can select a color for each element. Click on the element for it. The new scheme will be created after clicking the OK button. The
new custom scheme will be available in the Colors->Custom schemes context menu.

Highlighting Alignment
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To apply an alignment highlighting mode, select it in the Highlighting context menu:

TAATTC.A.CC.AATTA TCAACCA ATA
T A 5 Gote position.. Ctrl+G TCAACCT TTA
T A Add b TCAACCA CiT A
T A c TCAACCA TTA
opy *
T 4 - ClCAACCA TTA
¥ Colors
T A . . . T A AT T T A T A
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T A Edit " Agreements CTA
T Al 25 Align » Disagreements CT A
T A Tree r Gaps GTA
T Ay Statistics ¥ | v Conservation level GTA
T A  View g Transitions G A
T A Export » Transversions G A
T A Advanced L4 TR A
T A Uze dots TIT A
T A Set this sequence as reference TIT A
TT ATC
Consensus mode...
T A CiTG

_ﬁ - T

or on the Highlighting tab of the Options Panel:

| Highlighting |

 Reference sequence

Select and add E]

gt
=
- Culur ERE
&L
|UGENE v | p—
—3
==
 Highlighting —
[Conseruaﬁon level v] i
Threshold: 50% ﬁL]
! =
1 1 1 1 1 V 1 1 1 1 1 Eiﬂ
Highlight characters with
conservation level:
(™) = threshold
@ = threshold
[ Use dots
Export

The following modes are available:

* Agreements — highlights symbols that coincide with the reference sequence.

* Disagreements — highlights nucleotides that differ from the reference sequence.

® Gaps - highlights gaps.

® Conservation level - highlights conservation level of symbols in a multiple alignment >= or <= treshhold. To select the conservation
parameters use the Highlighting Options Panel tab.
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® Transitions - highlights transitions.
® Transversions - highlights transversions.

To use dots instead of symbols which are not highlighted check the Use dots checkbox in the Options Panel or use the Highlighting->Use
dots context menu item.

To select a reference sequence use the Set this sequence as reference context menu or Reference sequence field in the Highlighting tab of
the Options Panel.

Also you can export highlighting with a help of the Export button in the Options Panel or by the Export->Export highlighted context menu
item. The following dialog will appear:

‘d '
Export Highlighted to File L2 S|
Export to file | [I]

Exported area: from 15 to 604 =
Indexing
@ 1-based (7 D-based

Keep gaps
Dots instead not highlighted

[ Export ][ Cancel H Help

LS A

Select file to export, exported area and click on the Export button. The task report will appear in the Notifications.

Zooming and Fonts

To perform zoom operations use the corresponding buttons on the editor toolbar.

R W

(&2 =2 @& & R)¥ B » K & G
ct QO 8Nn WHIv-1

By default, the base characters are visible when zooming. But for rather long sequences there is another zoom mode available. In this mode
the bases are not shown. This allows viewing very large sequence regions (up to 500 bp).
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You can zoom to the selected region by clicking the Zoom to selection button. It is very convenient operation, when the alignment size is
rather large. For example, you can zoom out to some percentage, select an interesting region and then zoom to the selection.

123



Unipro UGENE Manual, Version 1.26

You can change font by clicking the Change font button.

To reset zoom and font click the Reset zoom button.

Searching for Pattern
You can search for a pattern inside an alignment.

Enter a query string in the edit box under the Sequence area.

1'N Y F E
18 EF
1H FRK
1H FRK
. -
1€ - —
Find: = o

A~ A X -

Press the right arrow to search in the direction “From left to right, from top to bottom”. Press the left arrow to search in the direction “From
right to left, from bottom to top”. If the pattern is found, the result will be focused and highlighted in the Sequence area. You can continue the
search in any direction from this position.

Consensus

Each base of a consensus sequence is calculated as a function of the corresponding column bases. There are different methods to calculate
the consensus. Each method reveals unique biological properties of the aligned sequences. The Alignment Editor allows switching between
different consensus modes. To switch the consensus mode go to the General tab of the Options Panel or activate the context menu (using
the right mouse button) or the Actions menu and select the Consensus mode item and General tab will be opened automatically:

| General

 Reference seguence

Select and add

* Alignment info

Length:

Sequence number;

 Consensus mode

Consensus type:
Default

Threshold:

There are several consensus modes:

® JalView (Default) — it is based on the JalView algorithm. Returns ‘+' if there are 2 characters with high frequency. Returns symbol
in lower case if the symbol content in a row is lower than the specified threshold.

® ClustalW — emulates the ClustalW program and file format behavior.

® Levitsky — this algorithm is proposed by Victor Levitsky to calculate consensus of DNA alignments. At first, it collects global
alignment frequencies for every symbol using extended (15 symbols) DNA alphabet. Then, for every column it selects the rarest
symbol in the whole alignment with percentage in the column greater or equals to the threshold value.

® Strict — the algorithm returns gap character (‘—') if symbol frequency in a column is lower than the threshold specified.
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Also the General tab shows the general information about an alignment and allows to select a reference sequence. The following chapter
describes how to export a consensus sequence:

® Export Consensus

Export Consensus

To export consensus sequence use the Exprot consensus tab of the Options Panel:

| Export Consensus

Expart to file

File format E
|Plain text - |

Info: alphabet of the consensus is
undefined, the sequence can only
be saved into a plain text
document.

The following parameters are available:

Export to file - here you need to select path for the output file.

File format - format for the output file.

When you click on the Export button the consensus sequence will be exported into selected output file.
Alignment Overview

The alignment overview is shown automatically in the Alignment Editor. To close the overview click on the Overview toolbar button. To show
the simple alignment overview use the Show simple overview context menu item of the overview.

I Bl

Calculation method...

T T Y 1" m l’ 7y

The following settings of the alignment overview are available:

Export as image - you can export multiple alignment overview and simple alignment overview as image. Use this context menu item to
do it. In the following dialog select the required parameters and click on the Export button:
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[ Export Image

? -t |

Alignment overview export settings

Expart simple overview
Export graph overview

Export to file |
File name E]
Format png -
|
Export ][ Cancel ][ Help ] |
. — S — — — —
Dispaly settings:

Graph type - sets the graph type: histogram, line graph or area graph.
Orientation - sets the orientation: top to buttom or buttom to top.
Set color - sets the gpaph color.

Calculation method - sets the calculation method: strict, gaps, clustal or highlighting.

To use these settings go to the corresponding context menu items of the alignment overview.

Working with Alignment

This chapter explains how to work efficiently with the Alignment Editor. You will learn how to modify an alignment, remove gaps, align

sequences, copy and paste regions, add new sequences and extract subalignments as new alignments.

® Undo/Redo Framework
® Selecting Subalignment
® Moving Subalignment
® Copying/Pasting Subalignment
¢ Editing Alignment
® Removing Selection
® Filling Selection with Gaps
® Replacing Selected Character
® Replacing with Reverse-Complement
® Replacing with Reverse
® Replacing with Complement
® Removing Columns of Gaps
® Removing Sequence(s)
® Removing All Gaps
® Saving Alignment
® Aligning Sequences
® Aligning Sequence to this Alignment
® Pairwise Alignment
[ ]

Working with Sequences List
® Adding New Sequences

Renaming Sequences
Sorting Sequences
Shifting Sequences
Collapsing Rows

® Copying Sequences
® Exporting in Alignment
® Extracting Selected as MSA
® Exporting Sequence from Alignment
® Exporting Alignment as Image

Undo/Redo Framework
The editor tracks all modifications of the aligned sequences.
When a modification happens the current state of the multiple sequence alignments object is being recorded.

You can apply any previous state and redo the modifications using the corresponding buttons on the toolbar:
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Selecting Subalignment

While in the Sequence area, if you hold the left mouse button and move the cursor, you will activate the selection mode. By moving the
cursor you can adjust the size of the selection. Also you can use the Shift modifier for selecting. Select a first row, hold Shift and select a las
row. All the rows between the first and the last row will be selected.

Releasing the mouse button will result in exiting the selection mode.

The selection mode is available in the Sequence list and the Consensus area too. The difference between these areas and the Sequence
area is that here you can add to selection the whole rows or columns respectively.

To cancel the selection, press the Esc key.

Moving Subalignment
To move subalignment there are different ways:

1. Select a subalignment and drag and drop it. The subalignment will be moved.

2. With a help of the Spase the subalignment will be moved to the right by size of the selection. With a help of the Backspase the
subalignment will be returned to the first state.

3. With a help of the Ctrl+Spase the subalignment will be moved to the right by one column. With a help of the Ctrl + Backspase the
subalignment will be returned to the first state.

Copying/Pasting Subalignment

To copy current selection click the Copy/Paste Copy selection item in the Actions main menu or the context menu. The hotkey for this action
is Ctrl-C.

Also you can copy selection in different formats, for example FASTA, CLUSTALW, RICH TEXT(HTML), NEXUS, MSF.
To copy subalignment in selected format do the following:

® Select the subalignment;
® Select the Copy/Paste->Copy formatted context menu item in the context menu or use hotkey Ctrl+Shift+C.
® The global Options Panel tab will open:
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| General |

 Reference sequence

Select and add E]

* Alignment info

Length: 615
Sequence number: 45

* Consensus mode

Consensus type:
Default ~ ]
Threshold:
[] 100% 2
* Copy to dipboard
Farmat:
|Rich text (HTML) -

® Select format and press the Copy button.

To paste any of copied selection use the Copy/Paste->Paste context menu item or Ctrl+V shortcut.

Editing Alignment

Select the Edit submenu in the Alignment Editor context menu:

?;'Lr_r_T_Ln_r_r_cmr_.:-_uTTA TCAACCA ATAC——-CTAE
? =% (o to position.. Ctrl+G TTA TCAACCT TTAT---CTA:
78 Add » IET A TCAACCA CTAT---TTA:
78 Copv/Past , {CTT TCAACCA TTAT---CTA:
7§ | ORTEE cCTT CCAACCA TTAT---TTA
7.1} Colors * T A TCAACCT ATAT - - - TTA;:
78 Highlighting |2 TR TCA.CCA ATAT---TTA:
78 i A
? - Edit v Remove selection n
78 = Align D Fill selection with gaps TUk
B Tree b Replace selected character Shift+R LUk
74 . TUH
. i il statistics 4 Replace selected rows with reverse-complement 1 :
7 1 View b Replace selected rows with reverse i A
7 1 Export D Replace selected rows with complement [ A
: Advanced * | eE:  Remove columns of gaps... Shift+Del [ i
? Set this sequence as reference Remove sequence T

: £% Removeall gaps 5

Consensus mode... T

The actions available from this menu are described below.

Removing Selection

Filling Selection with Gaps

Replacing Selected Character
Replacing with Reverse-Complement
Replacing with Reverse

128



Unipro UGENE Manual, Version 1.26

Replacing with Complement
Removing Columns of Gaps
Removing Sequence(s)
Removing All Gaps
Removing Selection

To remove a subalignment select it and choose the Edit Remove selection item in the context menu or press the Delete key. For Mac OS
use the Fn+Delete key instead of the Delete key.

Filling Selection with Gaps

Select a region in the alignment and choose the Edit Fill selection with gaps item in the context menu or press the Spacebar. The region is
filled with gaps shifting the subalignment from the region to the right.

Replacing Selected Character

To replace a symbol in the alignment select the nucleotide and press Shift+R for switching the edit mode on.
While the selection is blinking, press a keyboard character that you want to replace the nucleotide with.
After that the edit mode is switched off. For replacing another nucleotide press Shift+R again.

You always can cancel the changes pressing Ctrl+Z.

Replacing with Reverse-Complement

To replace sequence(s) in the alignment with reverse-complement select it and use the Edit->Replace with reverse-complement item in the
context menu.

Replacing with Reverse

To replace sequence(s) in the alignment with reverse select it and use the Edit->Replace with reverse item in the context menu.
Replacing with Complement

To replace sequence(s) in the alignment with complement select it and use the Edit->Replace with complement item in the context menu.
Removing Columns of Gaps

To remove colums containg certain number of gaps select the Edit Remove columns of gaps item in the context menu. The dialog appears:

.2 Remove Columns of Gaps @Iﬂ—hJ

(7) Remove columns with number of gaps 1

(7} Remove columns with percentage of gaps | 105

@ Remove all gap-only columns I
[ Remove ] [ Cancel ] [ Help ]
N I 2

There are the following options:
Remove columns with number of gaps — removes columns with number of gaps greater than or equal to the specified value.
Remove columns with percentage of gaps — removes columns with percentage of gaps greater than or equal to the specified value.

Remove all columns of gaps — this option is selected by default. It specifies to remove columns from the alignment if they entirely
consist of gaps.

Select the option required and press the Remove button.
Removing Sequence(s)

Select a sequence and call the Edit Remove sequence(s) item in the Actions main menu or in the context menu to remove sequence from
the alignment.

Removing All Gaps

Use the Edit Remove all gaps item in the Actions main menu or in the context menu to remove all gaps from the alignment.
Saving Alignment
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To save current alignment click the Save alignment button, to the the alignment into another file click the Save alignment as button.
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Aligning Sequences

The Alignment Editor integrates several popular multiple sequence alignment algorithms. Below is the list of available algorithms and links to

the documentation:

® Port of the popular MUSCLE3 algorithm.
® KAlign plugin: effective work with huge alignments.

® ClustalW and MAFFT: these algorithms appeared in the version 1.7.2 of UGENE with the External Tools plugin.
® T-Coffee: this alignment algorithm is available since version 1.8.1 of UGENE with the External Tools plugin.

To align sequences choose a preferred alignment method in the Actions main menu, in the context menu or by Align main toolbar button .

Also you may find useful the following video tutorials devoted to the multiple sequence alignment:

® Making a multiple sequence alignment from FASTA file

® Working with large alignments in UGENE

® Performing profile-to-profile and profile-to-sequence MUSCLE alignments
® Running remote MUSCLE task

Aligning Sequence to this Alignment

To align a sequence to an opened alignment, click the Align sequence to this alignment toolbar button:

Els ¢v®z=o .

Choose a file with the sequence from the files system, and click Open.

=
=y

i

bl

Also, you can add an already opened sequence or sequences to the alignment. To do it, select the sequence object(s) in the Project View an
d click the Align sequence to this alignment toolbar button. The sequence(s) will be aligned to the alignment automatically.

Pairwise Alignment

To align two sequences go to the Pairwise Alignment tab of the Options Panel:
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| Pairwise Alignment

 Sequences

Select and add E]
Select and add E]

Algorithm:
| Hirschberg (KAlign) -

 Algorithm settings
Gap open penalty
21700

4| e

Gap extension penalty
39.00

4| »

Terminate gap penalty
39.00

L3

Bonus score

283.00 -

* Output settings
In new window
Cutput file:
3\PairwiseAlignmentResult. aln| E]

Align

Select two sequence from the original alignment, select the parameters and click on the Align button. The following parameters are available:
Algorithm - algorithm of the pairwise alignment. There are two algorithms:
Hirschberg (KAlign) - algorithm has the following parameters:
Gap open penalty - indicates the penalty applied for opening a gap. The penalty must be negative.
Gap extension penalty - indicates the penalty applied for extending a gap.

Terminate gap penalty - the penalty to extend gaps from the N/C terminal of protein or 5'/3' terminal of nucleotide
sequences.

Bonus score - a bonus score that is added to each pair of aligned residues.
Smith-Waterman - the following parameters are available:

Algorithm version - version of the algorithm implementation. Non-classic versions produce the same results as classic but
much faster. To use these optimizations our system must support these capabilities: OPENCL, SSE2 or SW_classic.

Scoring matrix - scoring matrix.
Gap open penalty - penalty for opening a gap.
Gap extension penalty — penalty for extending a gap.

Output settings - settings of the otput file.

Working with Sequences List

® Adding New Sequences
® Renaming Sequences
® Sorting Sequences
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® Shifting Sequences
® Collapsing Rows
® Copying Sequences
Adding New Sequences
You can add new sequences to an alignment using the Add submenu in the Actions main menu or the context menu.

There are two ways to add a new sequence to the current alignment:

® From a file in the compatible format (FASTA, GenBank etc.). The list of the supported data formats can be found here.
® From the current project.

If you activate this item, the following dialog will appear:

I — B
o= Select Item [:E'] ﬁ,l

4+ [ 1CF7.PDB
% [s] 1CFT chain 3 sequence

Y [] 1CF7 chain 4 sequence

[ oK J [ Cancel

L A

You will see the Project View tree filtered to show only appropriate sequences. Select the items to add and press the Ok button.
Renaming Sequences

To rename a sequence double click on the name of this sequence and enter a new sequence name in the dialog.
Sorting Sequences

To sort sequences by name in the alphabetical order choose the View Sort sequences by name item from the Actions main menu or the
context menu.

Shifting Sequences
To change an order of sequences in a multiple sequence alignment do the following:

® select sequence or sequences in the sequences names list by click or by click and drag correspondingly.
® click and drag on selected region to shift it.

Collapsing Rows

It is able to coolaps the sequential rows. To collapse rows click on the Switch on/off collapsing main toolbar button:

el

5 DG » §

il
Bl

The triangle will appear near collapsed sequences. Click on the triangle to show the whole tree of the collapsed rows.
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Consensus

a

o -

5 10 12 14 1
AT AATTC
AFTAATTC cT
AFTAATTC cc
AFTAATTC cT
ATTECcTAATTC cc
ATTATTAATTC cT
TTTAATTCETTC A
ACT AATCC

Bicolorana_bicolor_EF540830
Conocephalus_discolor
Conocephalus_percaudata
Conocephalus_sp.
Deracantha_deracantoides_ EF540 T T A
Gampsocleis_sedakovii_EF540828 TCA
Hetrodes pupus_ EF540832 T A A
Isophys_altaica_EF540820 T A A

4 Mecopoda elongata_ Ishigari ] T AA
Mecopoda elongata  Sumatrs T AA
Mecopoda_sp._ Malaysia_ T A A
Metrioptera_japonica EF540831 TTA
Montana_montana T e A
Phaneroptera_falcata T A A
Podisma_sapporensis T A A

Roessliana_rosseli TLCA
Tettigonia_viridissima T A A
i Zychia_baranovi | . A

To update the collapsed groups click on the corresponding main toolbar button .

Copying Sequences
To copy one or several sequences do the following:

® Select the sequences in the Sequence list area;
® Select the Copy/Paste Copy selection context menu item in the Sequence area or use hot key combination. Note, that if you
activate context menu in the Sequence list area you will lose your current selection.

'TAATTC.A.CT.AACTA TCAACCA

CTAT - - -

TI$ Got " Chrle G TCAACCA TTAT - - -

oo ot
T o to position r ABcTBAAcCTT EcaAl
i Add ' BAGCTGAATTA TCAAC
T Copy/Paste - Paste Ctrl+V
| -
T ) Colors . Copy selection Ctrl+C
T Highlighting * |58 Copyformatted Ctrl+Shift+C
T Edit 4 Copy consensus
| I E Align ’ Copy consensus with gaps

3 i I a

W, - ABICITIBIA ATTAGIEACAIAC
T | il Statistics 4 ANSC TS A AT T A ACAALC

To copy consensus sequence use the Copy/Paste Copy consensus item. To copy consensus with gaps use the corresponding menu item.

Exporting in Alignment

® Extracting Selected as MSA
® Exporting Sequence from Alignment
® Exporting Alignment as Image
Extracting Selected as MSA
It is possible to extract a subalignment and save it as new multiple sequence alignment (MSA).

Select a subalignment and choose the Export Save subalignment item in the Actions main menu or in the context menu. The following dialog
appears:
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i ™
.= Extract Selected as MSA &lﬂ

From 3= to 315

Selected sequences

Phaneroptera_falcata -
Isophya_altaica_EF540820
Bicolorana_bicolor EF540830
Roezeliana_roezel
Montana_montana
Metrioptera_japonica_EF540831
Gampsodeis_sedakovii_EF540828
Deracantha_deracantoides_EF540
Zychia_baranovi
Tettigonia_viridissima
Conocephalus_discolor
Conocephalus_sp,

7] ronnrenhalie nercandata et

[Inuertselecﬁon] [ Select all J [Clear selection]

m

File name itafsamples/CLUSTALW fCOI_subalign1.aln E]

File format to use | CLUSTALW - |

Add to project

[ Extract ][ Cancel ][ Help ]

Specify the name and format of the new MSA file in the File name and File format to use fields. The currently selected region is extracted by
default when you press the Extract button.

You can change the columns to be extracted using the From and to fields. And change the rows to be extracted by checking/unchecking
required sequences in the Selected sequences list.

Use buttons:

® Invert selection — to invert the selection of the sequences.
® Select all — to select all sequences.
® Clear selection — to clear the selection of all sequences.

The Add to project check box specifies to add the MSA file created from the subalignment to the active project.
Exporting Sequence from Alignment

To export one sequence from an alignment select the sequence in the sequence list or in the sequence area and use the Export->Save
sequence context menu item. The following dialog will appear:

i B’
Export Selected Sequence from Alignment M
[ Expo eq g
Export to file | E]

File format to use |FASTA - |

Add document to the project
Gap characters (-

@ Keep (=) Trim

[ Expart ][ Cancel H Help

e A

Here it is possible to specify the result file location, to select a sequence file format, to define whether to keep or remove gaps (‘—' chars) in
the sequence and optionally add the created document to the current project.
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Exporting Alignment as Image

To export an alignment as image click the Export as image button on the editor toolbar or call the Export->Export as image context menu

item.
Ga il W 8 W e o &

The Export Image dialog will appear where you should set name, location, export settings and format of the picture:

s Exportimage

Export settings

Region [whole alignment G] [ Select ]

¥ Include sequences' names
v Include consensus

¥ Include ruler

Export to File

File name [| l

Format Quality {1} |80 |=
Cancel H Export |

UGENE supports export to the BMP, CUR, DDS, ICNS, JP2, JPEG, JPG, PBM, PGM, PNG, PPM, TIF, TIFF, WBMP, WEBP, XBM, XPM
and SVG image formats. You can export whole alignment or custom region. To select the custom region click on the Select button.

Statistics

To show statistics use the Statistic tab of the Options Panel:

| Statistics |

w Reference sequence

Select and add E]

 Distances column

=

Show diztances column

Distance algorithm:

[Hamming dissimilarity - ]

=171

Profile mode

(71 Counts

D

@ Percents

[] Exdude gaps

Automatic updating
Press button to update %

Hint: select a reference above

Here you need to select a reference sequence. Also you can change the distance algorithm, select the profile mode and exclude gaps. To
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generate distance matrix and grid profile see the documentation below:

® Distance Matrix
® Grid Profile

Distance Matrix
Using the Alignment Editor you can also create a distance matrix of a multiple sequence alignment.
To create a distance matrix, use the Statistics Generate distance matrix item in the Actions main menu or in the context menu.

The dialog will appear:

i '
.= Generate Distance Matnx @lﬂj

Distance algorithm | Hamming dissimilarity - ]

Profile mode

@ Counts

(71 Percents
Exdude gaps

I Show group statistics of multiple alignment

[] save profie to fie
File
(@ Hypertext (HTML)

Comma separated ( .CSV)

[ Generate J[ Cancel ][ Help

L

The following parameters are available:

_ W I _— I - >y

Distance algorithm - there are two distance algorithms: "Hamming distance" for dissimilarity and "Simple similarity" for similarity.
Profile mode: Counts/Percents — select the Percents to have scores shown as percents in the report. Also you can Exclude gaps.
Show group statistics of multiple alignment - shows group statistics when the collapsing is switched on.

Save profile to file — allows to save profile to a file in the HTML or CSV format. The CSV format is convenient for further processing in
worksheets editors like Excel.

The result profile in the HTML mode:
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|1 Dhstanc triz for CO

Table content: Hamming dissimilarity

[Phaneroptera_fa
Phaneroptera_falcata 0
Isophya_altaica EF540820
Bicolorana_bicolor_ EF 540830
Roeseliana_roeseli
Montana montana
Metrioptera_japonica EF540831
\Gampsocleis_sedakovii EF540828
Deracantha_deracantoides EF540
Zychia_baranovi
Tettigonia_viridissima
Conocephalus_discolor
Conocephalus_sp.
Conocephalus_percandata
Mecopoda elongata  Ishigald  J
Mecopoda elongata  Sumatra
Mecopoda sp. Malaysia
Podisma_sapporensis
Hetrodes_pupus EF540832

Legend: [1098 25% 50% 70% 90%

€ 1 | 3

Grid Profile

Using the Alignment Editor you can create a statistic profile of a multiple sequence alignment.

The alignment grid profile shows positional amino acid or nucleotide counts highlighted according to the frequency of symbols in a row.
To create a grid profile, use the Statistics Generate grid profile item in the Actions main menu or in the context menu.

To learn more about this feature, refer to the DNA Statistics plugin documentation.

Advanced Functions

This chapter is devoted to the advanced functions of the Alignment Editor. You will learn how to build a grid profile, export a picture of an
alignment and build HMM profiles.

® Building HMM Profile

Building HMM Profile
The editor has capabilities to build a Hidden Markov Model profile based on the multiple sequence alignment.
This functionality is based on the Sean Eddy’s HMMER package.

To build a HMM profile select the Advanced Build HMMER2 profile or the Advanced Build HMMERS3 profile item in the Actions main menu
or in the context menu.

Learn more about the HMM tool in the documentation pages of the HMM2 and the HMM3 plugins.

Building Phylogenetic Tree

To build a tree from an alignment either press the Build Tree button on the toolbar, select the Tree Build Tree item in the alignment context
menu or the Actions Tree Build Tree item in the main menu.

N

Also you can use Tree Settings tab of the Options Panel:
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| Tree Settings

There are no displayed trees so settings
are hidden,

[ |- Open tree ] [ quJ Build tree ]

Three methods for building phylogenetic trees are supported:
1. The PHYLIP Neighbour-Joining method. The PHYLIP package implementation of the method is used under the hood.
2. The MrBayes external tool. Check MrBayes Web Site for more details.
3. PhyML Maximum Likelihood method. Check PhyML Maximum Likelihood Web Site for more details.

® PHYLIP Neighbor-Joining
®* MrBayes
® PhyML Maximum Likelihood

PHYLIP Neighbor-Joining

The Building Phylogenetic Tree dialog for the PHYLIP Neighbour-Joining method has the following view:

.
.z Build Phylogenetic Tree m

Tree building method |PHYLIP Neighbar Joining - |

-~

Distance Matrix Bootstrapping and Consensus Tree I Display Options

Distance matrix model [FM

[] Gamma distributed rates across sites
Coefficent of variation of substitution rate among sites |0.50 =

Transitionftransversion ratio 2,00

L3

Save tree to | E]

Remember Settings | [Restore Default
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The following parameters are available:

Distance matrix model — model to compute a distance matrix. The following values are available for a nucleotide multiple sequence
alignment:

* F84

® Kimura

® Jukes-Cantor
® LogDet

The following models are available for a protein alignment:

® Jones-Taylor-Thornton
® Henikoff/Tillier PMB

® Dayhoff PAM

® Kimura

Gamma distributed rates across sites — specifies to take into account unequal rates of change at different sites. It is assumed that the
distribution of the rates follows the Gamma distribution.

Coefficient of variation of substitution rate among sites — becomes available if the Gamma distributed rates across sites parameter is
checked. Specifies the coefficient of the distribution of the rates.

Transition/transversion ratio — expected ratio of transitions to transversions.
To enable bootstrapping check the Bootstrapping and Consensus Trees group check box. The following parameters are available:
Number of replicates — number of replicate date sets.

Seed — random number seed. By default, it is generated automatically. You can manually change this value in order to make results
of different runs (of a tree building) reproducible. The should must be an integer greater than zero and less than 32767 and which is of
the form 4n+1, that is, it leaves a remainder of 1 when divided by 4. Any odd number can also be used, but may result in a random
number sequence that repeats itself after less than the full one billion numbers. Usually this is not a problem.

Consensus type — specifies the method to build the consensus tree. Select one of the following:

® Strict — specifies that a set of species must appear in all input trees to be included in the strict consensus tree.

® Majority Rule (extended) — specifies that any set of species that appears in more than 50% of the trees is included. The
program then considers the other sets of species in order of the frequency with which they have appeared, adding to the
consensus tree any which are compatible with it until the tree is fully resolved. This is the default setting.

® M1 —includes in the consensus tree any sets of species that occur among the input trees more than a specified fraction of
the time (see the Fraction parameter below). The Strict consensus and the Majority Rule consensus are extreme cases of
the MI consensus, being for fractions of 1 and 0.5 respectively.

® Majority Rule — specifies that a set of species is included in the consensus tree if it is present in more than half of the input
trees.

Fraction — becomes available when the Consensus type parameter is set to M1. Specifies the fraction.
Display tree in new window - displays tree in new window.

Display tree with alignment editor - displays tree with alignment editor.

Synchronize alignment with tree - synchronize alignment and tree.

Save tree to — file to save the tree built.

Press the Build button to build a tree with the parameters selected.

MrBayes

The Building Phylogenetic Tree dialog for the MrBayes method has the following view:
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«: Build Phylogenetic Tree &lﬂ_hJ

Tree building method MrBayes - ]

| Model | MCMC | Display Options

Chain length 10000 =
Subsampling frequence 1000 =
Burn-in length 10 =
Heated chains 4 =
Heated chain temp 0.40 =
Random seed 5789 =

Save tree to | [I]

Remember Setﬁngs] [F‘.estcre Default

Build ][ Cancel ][ Help ]

L -y

There are two steps to a phylogenetic analysis using MrBayes:

1. Set the evolutionary model.
2. Run the Markov chain Monte Carlo (MCMC) analisys.

The evolutionary model is defined by the following parameters:

Substitution model — specifies the general structure of a DNA substitution model. This parameter is available for the nucleotide
sequences. It corresponds to the Nst setting of MrBayes. You may select one of the following:

* JC69 (Nst=1)
* HKY85 (Nst=2)
* GTR (Nst=6)

Rate matrix (fixed) — specifies the fixed-rate amino-acid model. This parameter is available for amino-acid sequences. The following
models are available:

® poisson
® jones
® dayhoff
® mtrev
® mtmam
® wag

® rtrev

® cprev
® vt

® blosum
® equaline

The following parameters are common for nucleotide and amino-acid sequences:
Rate — sets the model for among-site rate variation. Select one of the following:

® equal — no rate variation across sites.

® gamma — gamma-distributed rates across sites. The rate at a site is drawn from a gamma distribution. The gamma
distribution has a single parameter that describes how much rates vary.

® propinv — a proportion of the sites are invariable.
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® invgamma — a proportion of the sites are invariable while the rate for the remaining sites are drawn from a gamma
distribution.

Gamma — sets the number of rate categories for the gamma distribution.
You can select the following parameters for the MCMC analisys:

Chain length — sets the number of cycles for the MCMC algorithm. This should be a big number as you want the chain to first reach
stationarity, and then remain there for enough time to take lots of samples.

Subsampling frequency — specifies how often the Markov chain is sampled. You can sample the chain every cycle, but this results in
very large output files.

Burn-in length — determines the number of samples that will be discarded when convergence diagnostics are calculated.
Heated chains — number of chains will be used in Metropolis coupling. Set 1 to use usual MCMC analysis.

Heated chain temp — the temperature parameter for heating the chains. The higher the temperature, the more likely the heated chains
are to move between isolated peaks in the posterior distribution.

Random seed — a seed for the random number generator.

Display tree in new window - displays tree in new window.

Display tree with alignment editor - displays tree with alignment editor.
Synchronize alignment with tree - synchronize alignment and tree.
Save tree to — file to save the built tree.

Press the Build button to run the analysis with the parameters selected and build a consensus tree.

PhyML Maximum Likelihood

The Building Phylogenetic Tree dialog for the PhyML Maximum Likelihood method has the following view:

=22 Build Phylogenetic Tree @léj

Tree building method [PhyML Maximum Likelihood - ]

Substitution Model Branch Suppart I Tree Searching I Display Options

Substitution model HKYgs -

Equilibrium frequencies ) optimized @ empirical

|:| Transition [ transversion ratio 1]

[ Proportion of invariable sites 0,00

4|

Mumber of substitution rate categories 4
|:| Gamma shape parameter 1]

Save tree to | E]

[F‘.emember Setﬁngs] [F‘.estore Default

Build ][ Cancel ][ Help ]

b o

There following parameters are available:
Substitution model parameters - selection of the Markov model of substitution:
Substitution model - model of substitution.
Equilibrium frequencies - equilibrium frequencies.
Transition/transversion ratio - fix or estimate the transition/transversion ratio in the maximum likelihood framework.

Proportion of invariable sites - the proportion of invariable sites, i.e., the expected frequency of sites that do not evolve, can be

141



Unipro UGENE Manual, Version 1.26

fixed or estimated.

Number of substitution rate categories - number of substitution rate categories.

Gamma shape parameter - the shape of the gamma distribution determines the range of rate variation across sites.
Branch support parameters - selection of the method that is used to measure branch support:

Use fast likelihood method - use fast likelihood method.

Perform bootstrap - the support of the data for each internal branch of the phylogeny can be estimated using non-parametric
bootstrap.

Tree searching parameters - selection of the tree topology searching algorithm:
Make initial tree automatically - initial tree automatically.
Type of tree improvement - type of tree improvement.
Set number of random starting tree - number of random starting tree.
Optimize topology - the tree topology is optimised in order to maximise the likelihood.
Optimize branch lengths - optimize branch lengths.
Display tree in new window - displays tree in new window.
Display tree with alignment editor - displays tree with alignment editor.
Synchronize alignment with tree - synchronize alignment and tree.
Save tree to - file to save the built tree.

Press the Build button to run the analysis with the parameters selected and build a consensus tree.
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Assembly Browser

The UGENE Assembly Browser project started in 2010 was inspired by lllumina iDEA Challenge 2011 and multiple requests from UGENE
users.The main goal of the Assembly Browser is to let a user visualize and efficiently browse large next generation sequence assemblies.

Currently supported formats are SAM (Sequence Alignment/Map) and BAM, which is a binary version of the SAM format. Both formats are
produced by SAMtools and described in the following specification: SAMtools. Support of other formats is also planned, so please send us a
request if you're interested in a certain format.

To browse an assembly data in UGENE, a BAM or SAM file should be imported to a UGENE database file. After that you can convert the
UGENE database file into a SAM file. The import to a UGENE database file has both advantages and disadvantages. The disadvantages are
that the import may take time for a large file and there should be enough disk space to store the database file.

On the other hand, this allows one to overview the whole assembly and navigate in it rather rapidly. In addition, during the import you can
select contigs to be imported from the BAM/SAM file. So, there is no need to import the whole file if you're going to work only with some
contigs. Note that in the future there are plans to support the other approach as well, namely, when a BAM/SAM file is opened directly.

The Assembly Browser has been tested on different BAM/SAM files from the 1000 Genomes Project and other sources.

Read the documentation below to learn more about the Assembly Browser features.

® |Import BAM/SAM File
® Import ACE File
® Browsing and Zooming Assembly
® Opening Assembler Browser Window
Assembly Browser Window
Assembly Browser Window Components
Reads Area Description
Assembly Overview Description
Ruler and Coverage Graph Description
Go to Position in Assembly
® Using Bookmarks for Navigation in Assembly Data
® Getting Information About Read
® Short Reads Vizualization
® Reads Highlighting
® Reads Shadowing
Associating Reference Sequence
Associating Variations
Consensus Sequence
Exporting
® Exporting Reads
Exporting Visible Reads
Exporting Coverage
Exporting Consensus
Exporting Consensus Variations
Exporting Assembly as Image
® Exporting Assembly Region
® Options Panel in Assembly Browser
® Navigation in Assembly Browser
® Assembly Statistics
® Assembly Browser Settings
® Assembly Browser Hotkeys
® Assembly Overview Hotkeys
® Reads Area Hotkeys

Import BAM/SAM File

To start working with an assembly import it to the UGENE database file. To do this, open the assembly file.

For assembly file without header you need to choose a referenece sequence:
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[7] Import SAM File P ||

Source URL:  C:fwarkfugene/datasamples/AssemblychrM, sam Info

The SAM file does not contain the header. Please, choose the reference sequence.

[] Import unmapped reads

Destination URL:  C:fworkjugene/data/samples/Assembly/chrM.sam.ugenedb E]

[ Import H Cancel ][ Help ]

L A

Select the referense sequence and click Import button.

For other assembly files the following dialog appears:

™y
[7] Import BAM File P ||

Source URL:  C:fwarkfugene/fdatasamples/AssemblychrM, sorted.bam Info
Assembly name Length URI
1 chrid 16571

[Select All | [Deselect All | | Invert Selection |

[] Import unmapped reads

Destination URL: | E]

[ Import ][ Cancel H Help ]

L A

The Source URL field in the dialog specifies the file to import. The Info button nearby can be used to obtain additional information about the
file.

There is a list of contigs below the Source URL. Check the contigs that you want to import to the database. You can use the Select All, Desel
ect All and Invert Selection buttons to manage the selection.

The Destination URL field specifies the output database file.

If you check the Import unmapped reads, then all unmapped reads in the assembly (i.e. read with the unmapped flag or without CIGAR) are
imported. Note, however, that they are not vizualized in the current UGENE version.

To start the import, click the Import button in the dialog. You can see the progress of the import in the Task View. To export a UGENE
database file into the SAM format, select the Actions Export assembly to SAM format item in the main menu.

Import ACE File

To start working with ACE file you can open it in the Alignment Editor or import it to the UGENE database file.

To do this, open the *.ace file. The following dialog will appear:
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” m Select Document Format { [ \ﬁj |

Open 'K26.ace' as
@ Multiple sequence alignment in the Alignment Editor

() Short reads assembly in the Assembly Browser

OK H Cancel H Help ‘

L o

If you choose the first option the file will be opened in the Alignment Editor as multiple sequence alignment. If you choose the second option
the following dialog will appear:

[¥] Import ACE File =
Source URL: C: fworkfugene/data/samples/ACE K 26.ace
Destination URL: 1 /datasamples (ACE K 26.ace.ugenedb E]

Ok ] [ Cancel ] [ Help ]

Select the Source URL and Destination URL and click OK button.
The Source URL field in the dialog specifies the file to import.

The Destination URL field specifies the output database file.

Browsing and Zooming Assembly

® Opening Assembler Browser Window

® Assembly Browser Window

® Assembly Browser Window Components

® Reads Area Description

® Assembly Overview Description

® Ruler and Coverage Graph Description

® Go to Position in Assembly

® Using Bookmarks for Navigation in Assembly Data

Opening Assembler Browser Window

An imported assembly added to the project is shown in the Project View as follows:

Project *
Mame filter
Objects
4 [ Klebsisllasort.bam.ugenedb
¢ [as] pkF70
@ [as] pkf140

Each [as] object corresponds to an imported contig. When you double-click on an [as] object a new Assembly Browser window with the
assembly data is opened. A window for the first assembly object in the list is opened automatically after the import.

Assembly Browser Window
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The opened window contains the list of well-covered regions of the assembly:

0 to 16 571 {16 571 bp) 1to 16 571 (16 571 bp)
[+ |
[ 1 1 ] :I
T T T T T T T T T | T T T T T T | bn,
Qs
10k 15 385C 239

Zoom in to see the reads or choose one of the well-covered regions:

Position Coverage
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F: Page up/Page down — Move one page up/down in the Reads Area

Note that for large assemblies it may take some time to calculate the overview and the well-covered regions.

To see the reads, either select a region from the list or zoom in, for example, by clicking the link above the well-covered regions or by rotating
the mouse wheel.

You can also use the hotkeys. Tips about hotkeys are shown under the list of well-covered regions. To learn about available hotkeys refer to
Assembly Browser Hotkeys.

Assembly Browser Window Components

An Assembly Browser window consists of:
Assembly Overview

By default, shows the whole assembly overview. Can be resized to provide an overview of an
assembly part.

Reference Area

Shows the reference sequence.
Consensus Area

Shows the consensus sequence.
Ruler

Shows the coordinates in the Reads Area.
Reads Area

Displays the reads.

Coverage Graph
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Shows the coverage of the Reads Area.

See the example below:

Assembly Overview
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Reads Area Description

The Reads Area provides a visualization of reads of an assembly part. To zoom in or zoom out, rotate the mouse wheel.

To perform zooming you can also use the Zoom In and Zoom Out buttons on the toolbar or the Actions Zoom In and Actions Zoom Out item
s in the main menu.

Also, when you double-click on a read it is zoomed in and moved to the center of the window.
By dragging the mouse while holding the left mouse button you can navigate in the Reads Area.
To navigate long distances in the Reads Area use the Assembly Overview described below.
Other ways to navigate in the assembly are:

® Use the horizontal and vertical scroll bars of the Reads Area
® Go to a specified position in an assembly

To learn about available hotkeys refer to Assembly Browser Hotkeys.

By default, assembly rendering is optimized while scrolling. While you are moving across an assembly, it shows the assembly in gray color,
but when you stop it shows the assembly in different colors. To disable this option uncheck the Optimize the rendering while scrolling item in
the context menu of the Reads Area or Optimize scrolling item on the Assembly Browser Settings tab of the Options Panel.

Assembly Overview Description

The Assembly Overview shows a coverage overview of the assembly. The longer the depth of a line in the overview and the deeper the
color, the more reads are located in this region.

To open a region of the assembly in the Reads Area click on it in the Assembly Overview. On the overview, the selected region is displayed
either as a gray rectangle, a red cross or a red rectangle. For example:
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If you hold Shift and select a region on the overview, the overview is zoomed to the selection.

Note that when the Assembly Overview is in focus and you use either the zoom buttons on the toolbar, the zoom items in the Actions main
menu, or a mouse wheel, the Reads Area is resized appropriately.

The Assembly Overview can also be resized. To zoom in the overview, select either the Zoom in or the Zoom in 100x item in the Assembly
Overview context menu. You can scroll the resized overview by dragging the mouse while pressing down the mouse wheel. To zoom out the
overview, select the Zoom out item in the context menu. The Restore global overview item in the context menu restores the default overview
size when the whole contig overview is shown.

Notice that the Assembly Overview shows the coordinates of the assembly areas visible in the Reads Area and in the Assembly Overview:

Reads Area
coordinates

25 382 to 26 031 (650 bp)

Assembly Overview
coordinates
23 738 to 27 954 (4 216 bp)

To scroll the resized overview, drag the mouse while pressing down the mouse wheel.

To learn about available hotkeys refer to Assembly Browser Hotkeys.
Ruler and Coverage Graph Description
The Ruler shows the coordinates in the Reads Area. When you move the mouse cursor in the Reads Area the coordinate of the selected

location with the coverage of reads is shown on the ruler in dark red. The Coverage Graph shows the exact coverage of the sequence at
each position. For example on the image below the coordinate is 9168 and the coverage of reads is 251.

8.9k ok 9.1k 9 168 C251 9.3k

il e ol

To show/hide the coordinates on the ruler you can click the following button on the toolbar:

o

K

To show/hide the coverage on the ruler you can click the following button on the toolbar:

100

Alternatively, you can use the Show coordinates and Show coverage under cursor check boxes located on the Assembly Browser Settings ta
b of the Options Panel.

Go to Position in Assembly

To go to the required position in an assembly use the following field located on the Assembly Browser toolbar.

Input the location and click the Go! button. A similar Go! field is also available on the Navigation tab of the Options Panel.
Using Bookmarks for Navigation in Assembly Data

Use bookmarks to save and restore visual state of an assembly, for example, position in the assembly, zoom scale, etc.

Getting Information About Read

A read displayed in the Reads Area consists of the bases (A, C, G, T). It may also contain the N character that stays for an ambigous base.
Depending on the value of the Cigar parameter, the read can be shown partially or gaps can be inserted inside the read (see below).

By default when a read is hovered over in the Reads Area a hint appears:
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|

|From 26925 to 26952 Row: 12
|Length: 35

| Strand: complement
| Read sequence: CAGGTGTACCCTGTATGCCGGT GGETGATGCCCGCC

R B B R EE E
bR EEEEE

&
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A
A
A
A
A
A
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A
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To disable this behaviour click the following button on the toolbar:

Or uncheck the Show pop-up hint check box on the Assembly Browser Settings tab of the Options Panel.
The hint shows the following information about the read:

® Read name

® Location

® Length

® Cigar

® Strand

® Read sequence

The operations in the Cigar parameter are described as follows:

* M — Alignment match (can be a sequence match or mismatch).

® | — Insertion to the reference. Skipped when the read is aligned to the reference, i.e. it is not shown in the Reads Area, but is
present in the read sequence.

* D — Deletion from the reference. Gaps are inserted to the read when the read is aligned to the reference. For example:

L L - -

923 Example sequence FU
From 5335 to 5336 Row: 13
Length: 52
Cigar: 18M 3D 31M
Strand: direct
Read sequence: CAAGGGAAGAGACCG
e AN L L N R

Deletion is shown as gaps

=k PFPFEFFFEFP
= P PFPRFPFEPEPR
=B b BB

ATATACCCGCGCTETCGAACTGCGATAAGA
— = : =1

[ n

® N — Skipped region from the reference. Behaves as D, but has a different biological meaning: for mRNA-to-genome alignment it
represents an intron.

® S — Soft clipping (clipped sequences are present in the read sequence, i.e. behaves as I).

®* H— Hard clipping (clipped sequences are not present in the read sequence).

® P — Padding (silent deletion from padded reference).

® = — Exact match to the reference.

® x — Reference sequence mismatch.

To copy the information about the read to the clipboard, select the Copy read information to clipboard item in the Reads Area context menu.
Now you can paste it in any text editor.

To copy the current position of the read select the Copy current position to clipboard item in the Reads Area context menu.

Short Reads Vizualization

There are various modes of reads highlighting and shadowing.
® Reads Highlighting
® Reads Shadowing

Reads Highlighting

To apply a reads highlighting mode, select it in the Reads highlighting menu of the Reads Area context menu or on the Assembly Browser
Settings tab of the Options Panel. The following modes are available:

* Nucleotide — shows all nucleotides in different colors. It is used by default.
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* Difference — highlights gaps and nucleotides that differ from the reference sequence. You should add a reference first for correct
displaying of this highlighting.

& L A &K B A A &K B A & & &

2012 C2407

® Strand direction — highlights reads located on the direct strand in blue and reads on the complement strand in green.

® Paired reads — highlights all paired reads in green. Note that the information about the pair is shown in the hint.

SRR014820.1098584

From 152332365 to 152382900 Row: 54

Length: 35

Cigar: 30M

Strand: direct

Read sequence: TACAGATCCAGTCACAGTCTCACCTGTCTGGETGEGET

Read sequence: CTTGCCTETCATAGCTGCTGACACACGCAGAGCCAG

Reads Shadowing

Various modes of column highlighting are available from the Reads shadowing item in the context menu of the Reads Area:

* Disabled — highlights all columns of nucleotides.

® Free — highlights all reads that intersect a given column. In this mode you can lock a position. Click the Lock here item in the
context menu to do it. To return to a locked position, select the Jump to locked base item in the context menu.

® Centered — highlights all reads that intersect the column in the center of the screen.
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ke

58

Associating Reference Sequence

To associate a reference sequence with the assembly use one of the following ways:

1. Open the sequence (the sequence must be loaded) and drag it to the Assembly Reference Area:

Project bl
'-E{) Search...
Objects 0 to 16 570 {16 570 bp)

4 [ chrM.sam.ugenedb

i [as] chrM
L |E| chril.fa

% [s] chrv

[=]= =

bl

1

1

R EFE B

bl

2. Use the corresponding toolbar button:

3. Use the corresponding context menu item:

? Set reference

UUnassociate

The reference sequence will appear in the Reference Area:
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Objects |n to 16 570 (16 570 bp)
4 [{f) chrM.sam.ugenedb P

@ [as] chrM
4 @ chrM.fa /

% [s] chrM

To remove the association, select the Unassociate item in the Reference Area context menu.

Associating Variations

To associate variations with the assembly, open the sequence (the sequence must be loaded) and drag it to the Assembly Reference Area:

Project

Mame filter
Objects
4 |E| chri.fa
% [s] cheM
4 [y chrM.sam.ugenedb
¢ [as] chrM
4 |E| exported To5MP.sn

The variations will appear under the Consensus Sequence:

—
.A A'Hfariimtstartpnsiﬁnn:lﬁﬁﬂu
Source nucleotides: t
l Variant nucleotides: 1T
]

15380 C 251 15 390

To remove the association, select the Remove track from the view item in the Variations Area context menu.

Consensus Sequence

A consensus sequence can be found in the Consensus Area under a reference sequence. It refers to the most common nucleotide at a
particular position.
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To choose a consensus algorithm select the Consensus algorihtm item either in the context menu of the Consensus Area, in the context
menu of the Reads Area or on the Assembly Browser Settings tab of the Options Panel. .

The following algorithms are currently available:

® Default — shows the most common nucleotide at each position. When there is equal numbers of different nucleotides in a position,
the consensus sequence resulting nucleotide is selected randomly from these nucleotides.

® SAMtools — uses an algorithm from the SAMtools Text Alignment Viewer to build the consensus sequence. The algorithm takes into
account quality values of reads and nucleotides and works with the extended nucleotide alphabet.

To leave only differences between the reference and the consensus sequences highlighted on the consensus sequence, select the Show
difference from reference item in the context menu of the Consensus Area or the Difference from reference item on the Assembly Browser
Settingstab of the Options Panel:

To export a Consensus Sequence, right-click on it in the Consensus Area and select the Export Export consensus item in the context menu.
For more information about consensus exporting see Exporting Consensus.

Exporting

Exporting Reads

Exporting Visible Reads
Exporting Coverage

Exporting Consensus

Exporting Consensus Variations
Exporting Assembly as Image
Exporting Assembly Region

Exporting Reads

To export a read, right-click on it in the Reads Area and select the Export Current read item in the context menu.

The Export Reads dialog appears:

.
Export Reads L? S|
Export to file E]

File format | fasta - ]

Add to project
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Select a file to export the read to and the file format. The read can be exported either to a FASTA or FASTQ file.
When the parameters are set click the Export button.

The read is exported to the file and if the Add to project check box has been checked it is added to the current project from where you can op
enit.

Exporting Visible Reads
To export all reads visible in the Reads Area select the Export Visible reads item in the Reads Area context menu.

The Export Reads dialog appears. The dialog is described in the Exporting Read section.

Exporting Coverage
To export a coverage of the assembly, select either the Export coverage item in the Consensus Area context menu.

The Export Coverage dialog appears:

[¥] Export the Assembly Coverage @I&J

Export to: || E]
Format: [7] compress the file
Threshaold: 1 -
Additional options
Export coverage value
[] Export bases quantity
Export ] [ Cancel ] [ Help
L A

Select a file, threshold and format: Histogram, Per base or Bedgraph. Where threshold is the minimum coverage value to export. For Per
base format the additional options are available: Export coverage value or Export bases quantity or both of them.

When all the parameters are set click the Export button.

Exporting Consensus

To export a consensus sequence of the assembly, select either the Export consensus item in the Consensus Area context menu or the Expor
t Consensus item in the Reads Area context menu.

The Export Consensus dialog appears:

[7] Export Consensus l 2 ﬁ,l
Export to file E]

File format FasTA -
SeqUENCE name chri_consensus

Consensus algorithm [Default "]
Region [Whule seguence ] 1| = 15571

Keep gaps
Add to project

[ Export ][ Cancel H Help

L A

Select a file and the file format. The consensus can be exported to a FASTA, FASTQ, GFF or GenBank file.
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Modify, if required, the exported sequence name and choose the consensus algorithm.

The consensus is exported with gaps if the Keep gaps check box has been checked.

Also you can select the exporting region. It can be either a Whole sequence, a Visible region, or a Custom region.
When all the parameters are set click the Export button.

The consensus sequence is exported to the file and if the Add to project check box has been checked it is added to the current project and
opened.

Exporting Consensus Variations

To export a consensus sequence variations of the assembly, select the Export consensus variations item in the Consensus Area context
menu.

The following dialog will appear:

[ Export Consensus Variations @léj
Export to file E]

Mode [h‘ariaﬁuns - ]
File format | SimpleSNP - |
Consensus algorithm [Default v]
Region [Whole seguence ] i - 16571

Keep gaps
Add to project

Export ][ Cancel H Help

e A

Select a file, mode and the file format. The following modes are available: Variations, Similar and All. Variations can be exported as to a
SimpleSNP or VCFvA4 file.

Modify, if required, the consensus algorithm.

The consensus is exported with gaps if the Keep gaps check box has been checked.

Also you can select the exporting region. It can be either a Whole sequence, a Visible region, or a Custom region.

When all the parameters are set click the Export button.

The consensus sequence is exported to the file and if the Add to project check box has been checked it is added to the current project and

opened.

1 The Export consensus variations feature is available when the reference sequence is associated with assembly.

Exporting Assembly as Image

To export the visible part of the assembly as an image, select either the Actions Export as image item in the main menu or the following
button on the toolbar:

The Export Image dialog appears:
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e Exportimage

Export to File

File name [| l
Quality - Gi——= (80 [

Cancel H Export ]

Format

In the dialog you can select the image file name and its format (bmp, jpeg, png, etc.). For some file formats the Quality parameter also
becomes available.

When the parameters are set click the OK button.

Exporting Assembly Region
To export an assembly region use one of the following ways:

1. Use the Actions->Export assembly region main menu item:

File Settings Tools Window Help
2 '~'!&> Zoom in
- =, foom out
o b= Export as image
% sa¥ Export assembly to SAM format
G-||0to "1 Export assembly region -
@ * Setreference u
— Close active view Ctrl+w

2. Use the corresponding toolbar button:

3. Use the corresponding context menu item:

Copy read information to clipboard
Copy current position to clipboard

Coverage

Reads highlighting Consensus

Reads shadowing
Consensus algorithm

Optimize rendering when scrolling

The following dialog will appear:

Current read
Visible reads as sequences
Assembly region
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* Export Assembly Region

Export to file [|

File format [UGENE Database

)

Region [Uisihle

Add to project

Select a file, region and the file format.

Options Panel in Assembly Browser

® Navigation in Assembly Browser
® Assembly Statistics
® Assembly Browser Settings

Navigation in Assembly Browser

The Navigation tab of the Options Panel in the Assembly Browser includes the list of well-covered regions of the assembly and the field for

searching required position.

* Most Covered Regions

—'I'-'-:*‘**I:[' —'-:“-:**-'—'-

§090 8.1k g 110 G120 8130 8142C 176

5 wma oo b e
(]
s
5
S

-| O 2 Tasks || [ 3log |

f ™
—* UGENE - [chrM.sam.bam.sam [as] chrM] (=] O [
— — - — e — — s —
[@ File Actions Settings Tools Window Help [=[=][x]
=0 = NN i (]
‘ Mavigation |

*
'g‘ Enter position in assembly:
E, 0 to 16 571 (16 571 bp) 079 to 8 143 (85 bp)
g

No active tasks ‘&' [=]

L

J

To learn more about well-covered regions refer to the Assembly Browser Window chapter.

To learn more about searching required position refer to the Go to Position in Assembly chapter.

Assembly Statistics
The Assembly Statistics tab includes the following Assembly Information:

® Name — the name of the opened assembly.
® Length — the length of the assembly.
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® Reads — the number of reads in the assembly.

Also the tab can include the Reference Information if it is available in the assembly file. For example:

*M

D5

® Species

*u

RI

-

-* UGENE - [chrM.sam.bam.sam [as] chrivi]

m File Actions Settings Tools Window Help

‘ Assembly Statistics

=l

'% * Assembly Information

El 0 to 16 571 (16 571 bp) 079 to & 143 (65 bp) Mame:  chrM

i Length: 16 571
Reads: 33451

K
8142C 176

Mo active tasks g’ F__'I

"

Assembly Browser Settings

The Assembly Browser Settings tab includes Reads Area, Consensus Area and Ruler settings.
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File Actions Settings Tools Window Help

S e HE & e

,
et e e

[-]=]x]

‘ Assembly Browser Settings |

0 to 16 571 (16 571 bp) 079 to 8 143 (65 bp)

= L Project

§090 g1k g 110 G120 8133C163 5140

4

| ) 2: Tasks ||

¥ Reads Area

Reads highlighting:

[DiFFerenoe - d ] B
You should add reference first for
correct displaying of this

highlighting

Scrolling can be optimized by drawing \‘é}
only reads’ positions without content

while scrolling:
Optimize scrolling

Shaw pop-up hint

* Consensus Area

Consensus algorithm:
[pefaut =

Difference from reference

* Ruler

Show coordinates

Show coverage under cursor

Mo active tasks ' |—__]

J

To learn more about Reads Area settings refer to the Reads Area Settings chapter.
To learn more about Consensus see the Consensus Sequence chapter.

To learn more about Ruler see the Browsing and Zooming Assembly chapter.

Assembly Browser Hotkeys

® Assembly Overview Hotkeys
® Reads Area Hotkeys

Assembly Overview Hotkeys

The following hotkeys are available for the Assembly Overview:

Hotkey Action
Shift + move mouse
Ctrl + wheel

Alt + click

wheel + move mouse

Reads Area Hotkeys

The following hotkeys are available for the Reads Area:

Zoom the Assembly Overview to selection
Zoom the Assembly Overview
Zoom the Assembly Overview in 100x

Move the Assembly Overview

Hotkey Action

wheel Zoom the Reads Area

double-click Zoom in the Reads Area

+/- Zoom in / zoom out the Reads Area

click + move mouse Move the Reads Area

arrow

Move one base in the corresponding direction in the Reads Area
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Page Up / Page Down
Home / End

Ctrl+G
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Move one page in the corresponding direction in the Reads Area
Move one page up / down in the Reads Area
Move to the beginning / end of the assembly in the Reads Area

Focus to the Go to position field on the toolbar
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Phylogenetic Tree Viewer

The Phylogenetic Tree Viewer is intended to display a phylogenetic tree built from an alignment or loaded from a file (e.g. a Newick file).

p - Ny
~* UGENE - [COI [m] €OT] ==
i File Actions Settings Tools Window Help BEE
o8B w=eaaald G =+
5 Tree view | Tree Settings |
Bl commix | 3 = - e
B e TaAGttTatTaATtCGag
~ . ~ — N Tree layout [Rectangular - @
W ¢ H @ < <4 & % 31 & 8 % 2 12 4 & 8 10 12 14 16 1 e view
GRGE cophya_stmcagrs * | L S 43
e Feclerana bokor & { 2 1: .
0.023 53— Roeseliana_roesel Sh =
5,004 ] [ Al s ow names
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—= Konocephalus_percat | [ CTTATTAATTCEAl 18
— Mecopoda_elongata_ | [ TCTTTTAATTCGANl 18 i
o Mecopoda_clongata_ | [ TCTIITAATTCEAL 18 tinewidh
T Mecopoda_sp._Male | [ TCTTTTAATTCEA|l 18
Podisma_sapporensis | [ AATAATTATTCEA, 18 -~ Branches
55— Hetrodes_pupus EF5 | [ CCTTTTAATTCET 18  wh [}
SIS h faate | [ acmTcmaaTTclal 18 pege
Show pen settings
< [ i | 3 = »
Find: 4= = In1/18 Coll/604  Pos1/601 [
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|
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e = —— = —— = = == = )

To load a tree from a file follow the instruction described in the Opening Document paragraph or use the Tree settings tab of the Options
Panel. For example, you may open the $UGENE\data\samples\Newick\COl.nwk sample file provided within UGENE package.

To build a tree from a multiple sequence alignment see the Building Phylogenetic Tree paragraph.

To learn what you can do with a tree using UGENE Phylogenetic Tree Viewer read the documentation below.

® Tree Settings
® Selecting Tree Layout and View
® Modifying Labels Appearance
® Showing/Hiding Labels
® Aligning Labels
® Changing Labels Formatting
® Adjusting Branch Settings
® Zooming Tree
Working with Clade
® Selecting Clade
Collapsing/Expanding Branches
Swapping Siblings
Zooming Clade
Adjusting Clade Settings
® Changing Root
® Exporting Tree Image
Printing Tree

Tree Settings

To adjust a tree settings select either the Tree Settings toolbar button or the Tree settings tab of the Options Panel. The Tree settings tab:
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Tree Settings |
* General
Tree layout [R.eclangdar - ] {é}
Tree view [Deﬁult - ] T
]
¥ Labels =
Show names ¥
Show distances
Align labels Eﬁ-}
Hide font settings |y

Font  Helvetica -
Size 12 =
Attributes

 Branches
width | |
Height | |

Hide pen settings

Line weight 1 El

Detailed information about tree setting see below:

® Selecting Tree Layout and View
® Modifying Labels Appearance

® Showing/Hiding Labels

® Aligning Labels

® Changing Labels Formatting
® Adjusting Branch Settings

Selecting Tree Layout and View
You can select one of the following tree layouts:

® Rectangular
® Circular
® Unrooted

To do it press the Layout toolbar button and check the required item in the appeared menu or select it in the Tree settings Options Panel tab:

 General
Tree layout [Redarg.ﬂar - ]
Tree view [Deﬁsult v]

See the example of the Circular layout:
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Also you can select one of the following tree view
® Default

® Phylogram
® Cladogram

Modifying Labels Appearance

® Showing/Hiding Labels

® Changing Labels Formatting

Unipro UGENE Manual, Version 1.26

From this paragraph you can learn how to show/hide taxon and distance labels, align them and change their formatting (font, color, etc.).
® Aligning Labels

Showing/Hiding Labels

When you open a tree all the labels are shown by default.

Names item.

To hide the distance labels uncheck the Show Distances item.

To show the labels again check an appropriate item.

Labels settings in the Options Panel:

 Labels

Show names

[] Show distances

Align labels
Aligning Labels

See the example of aligning labels below:

To hide the taxon (sequence name) labels select the Show Labels toolbar button or in the Tree settings Options Panel tab uncheck the Show

To align a tree labels press the Align labels toolbar button or in the Tree settings Options Panel tab check the Align label item.

163



Unipro UGENE Manual, Version 1.26

Changing Labels Formatting

To change formatting of a tree labels select the Labels Formatting toolbar button or the Tree settings Options Panel tab:

Font  Helvetica -
Size 12 =
Attributes

Here you can select color, font, size and attributes (bold, italic, etc.) of the labels.

Note that when a clade has been selected the labels formatting settings are applied to the clade only.

Adjusting Branch Settings

To adjust branch settings select the Branch Settings toolbar button, the Branch Settings context menu item or the Tree settings Options
Panel tab.

The following settings are available:

* Branches

width [ |

Height [ |
Hide pen settings

Line weight 1 El

Here you can select the color and the line width of the tree branches.
Note that when a clade has been selected the branch settings are applied to the clade only.

Zooming Tree

To change the size of a tree use the Zoom In and Zoom Out toolbar button. You can use the Restore Zooming toolbar button to set the
default size.

Or use the corresponding items in the Actions main menu.

See also: Zooming Clade.
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Working with Clade

This paragraph describes how to select a clade and modify it's appearance.

Selecting Clade
Collapsing/Expanding Branches
Swapping Siblings

Zooming Clade

Adjusting Clade Settings
Changing Root

Selecting Clade

To select a clade click on it's root node:

You can see that the corresponding branches are highlighted.

To select several clades at the same time hold the Shift key and click on the root nodes of the clades.

Collapsing/Expanding Branches

You can hide branches of a clade by selecting the Collapse item in the context menu of the clade’s root node or use the Collapse button on
the tree toolbar:
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To show the collapsed clade select the Expand item in the node’s context menu.

Swapping Siblings

To rearrange two branches of an internal node, select the Swap Siblings item in the node context menu or click the Swap Siblings button on
the tree toolbar, while the node is selected:
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Zooming Clade

Additionally to other zooming options you can use the Zoom In item in the context menu of the root node of a clade.

Adjusting Clade Settings
When a clade is selected the branch and the labels formatting settigns are applied to the clade only.
Note that the settings are not applied to the collapsed branches (if any).

See an example of changing branch settings for a clade:

o

Changing Root

To change root of a tree select the root and call the Reroot tree context menu item or use the Reroot tree button on the tree toolbar:
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¢ O <0 = % & @ % 2
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Gampsodeis_sedakovii_EF540823

Swap Siblings

—-—1Zychia_baranovi

Reroot tree
=— Deracantha_deracantoides_EF540

Tettigonia_viridissima

Branch Settings...

{3
=
> Collapse o
-
L]

Export Tree Image b Podisma_sapporensis
0,003 T

Hetrodes_pupus_FF540832

Mecopoda_elongata__Ishigaki__ ]

_____

1,008

Mecopoda_elongata__Sumatra_

......

1

1

i 0008 Mecopoda_sp. _ Malaysia_
1

i ________________________________________ 0103 |1sophya_altaica_EF540820

0,106 |Phaneroptera_falcata

Exporting Tree Image

A tree image can be exported to a raster format (.png, .jpg, .bmp, etc.) or to a vector format (.svg).
Select either the Export Tree Image toolbar button or the Actions Export Tree Image item in the main menu.

In the submenu appeared select the Screen Capture item to save the tree image to a raster format. The standard Save As dialog will appear
where you can select the file name and format.

To export a tree image to a vector format select the As SVG item in the Export Tree Image submenu.

Printing Tree

To print a tree select either the Print Tree toolbar button or the Actions Print Tree item in the main menu.
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The standard print dialog will appear where you can select a printer to use and specify other settings.
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Extensions

® Workflow Designer
¢ DNA Annotator
® DNA Flexibility
® Configuring Dialog Settings
® Result Annotations
DNA Statistics
DNA Generator
ORF Marker
Remote BLAST
® Exporting BLAST Results to Alignment
® Fetching Sequences from Remote Database
® BLAST/BLAST+
® Creating Database
® Making Request to Database
® Fetching Sequences from Local BLAST Database
® Repeat Finder
® Repeats Finding
® Tandem Repeats Finding
® Tandem Repeats Search Result
® Restriction Analysis
® Selecting Restriction Enzymes
Using Custom File with Enzymes
Filtering by Number of Hits
Excluding Region
Circular Molecule
® Results
® Molecular Cloning in silico
® Digesting into Fragments
® Creating Fragment
® Constructing Molecule
® Available Fragments
Fragments of the New Molecule
Changing Fragments Order in the New Molecule
Removing Fragment from the New Molecule
Editing Fragment Overhangs
Reverse Complement a Fragment
Other Constuction Options
® OQutput
® Creating PCR Product
¢ In Silico PCR
® Primers Details
® Primer Library
® Secondary Structure Prediction
¢ SITECON
® SITECON Searching Transcription Factors Binding Sites
® Types of SITECON Models
® Eukaryotic
® Prokaryotic
® Building SITECON Model
® Smith-Waterman Search
* HMM2
® Building HMM Model (HMM Build)
® Calibrating HMM Model (HMM Calibrate)
® Searching Sequence Using HMM Profile (HMM Search)

® Building HMM Model (HMMS3 Build)
® Searching Sequence Using HMM Profile (HMM3 Search)
® Searching Sequence Against Sequence Database (Phmmer Search)
® uMUSCLE
® MUSCLE Aligning
® Aligning Profile to Profile with MUSCLE
® Aligning Sequences to Profile with MUSCLE
Clustalw
MAFFT
T-Coffee
Bowtie
® Bowtie Aligning Short Reads
® Building Index for Bowtie
® Bowtie 2
® Bowtie 2 Aligning Short Reads
® Building Index for Bowtie 2
* BWA
® Aligning Short Reads with BWA
¢ Building Index for BWA
* BWA-SW
® Aligning Short Reads with BWA-SW
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® Building Index for BWA-SW
* BWA-MEM
® Aligning Short Reads with BWA-MEM
¢ Building Index for BWA-MEM
® UGENE Genome Aligner
® Aligning Short Reads with UGENE Genome Aligner
¢ Building Index for UGENE Genome Aligner
® Converting UGENE Assembly Database to SAM Format
CAP3
SPAdes
® Weight Matrix
® Searching JASPAR Database
® Building New Matrix
® Primer3
® RTPCR Primer Design
® Spliced Alignment (MRNA to genomic)
External Tools
® Configuring External Tool
Query Designer
Plasmid Auto Annotation
ClustalO
Kalign Aligning

Workflow Designer

The Workflow Designer allows a molecular biologist to create and run complex computational workflow schemas even if he or she is not
familiar with any programming language.

The workflow schemas comprise reproducible, reusable and self-documented research routines, with a simple and unambiguous visual
representation suitable for publications.

The workflow schemas can be run both locally and remotely, either using graphical interface or launched from the command line.

The elements that a schema consists of corresponds to the bulk of algorithms integrated into UGENE. Additionally you can create custom
workflow elements.

U -* UGENE - [Workflow Designer - Build HMM from alignment and test it]

[¥] File Actions Settings Tools Window Help I
= B ) E LR A BN R i & ® Item style, Runmode. Scripting mode,
Elements | Samples | A - Property Editor

[ Data sources ]l Element name: |y search
J
J

é D?m s\r;h. HMM search : Searches each input
Basic analysis sequence for significantly similar

k=)
i
o
&
Al
o

= Collocation search Multiple sequence matches to all specified
. sequence HMM profiles. In case several profiles
Read alignment alignment HMM build were supplied, searches with all
. Extract annotated regions — T profiles one by one and outputs
Reads MSA(s) from build and calibrate united set of annotations for each
<= Find repeats HIV-1.aln. HMM profile using sequence
default settings.
To configure the parameters of the
ncs. Find substrings element go to "Parameters” area
below.
. Import PHRED qualities .
\\i'"‘" fruic [#] Tterations
-
(-_': Local BLAST search | ~ |=] Parameters
- r ™~ Name Yalue
= Local BLAST + search . | * -
{ ] i
i “
¥ ORE marker i HMHM search i ‘Write HMM profile Result annotation
4 Read sequence Sequence i 1 .
,_.JJI search HMM signals . Use I result.hmm Filter by low score
Reads sequence(s) | default settings. 1 Number of seqs
“| Reguest to remote database Forbmah TG I Qutput the list of found I
I regions annotated as |
W smith-Waterman search | hmm_signal. |
i
- ]
(I3 DINA assembly J L ]
I HMMER? toals
= Multiple sequence alignment
[#] Input data
E& nian with Clustalw [ Output data
Align with Kali ~ Filter by high E-value : E-value
< g wi an Write Genbank filtering can be used to exdude low-
probability hits from result
B Align with MAFFT Write sequence(s) from For
each sequence from Read W
S sequence and set of
m Align with MUSCLE annotations from HMM
search, Read sequence in
| Align with TCaffes Genbank format, to
signals.gb.
= Transcription factor J
b
I Build frequency matrix =
quency ~| < >
‘ i 2: Tasks | | L 3:lag ‘ No active tasks ‘&' [gl|

To learn more about the Workflow Designer read the Workflow Designer Manual (follow the link on the UGENE documentation page).

DNA Annotator

The DNA Annotator plugin provides an algorithm to search for sequence regions that contain a predefined set of annotations.
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Usage example:

Open the Sequence View for a sequence that has annotations. A good candidate here could be any file in Genbank format with a rich set of
annotations.

Select the Analyze Find annotated regions item in the context menu. The dialog will appear:

[¥] Find Groups of Annotated Regions [ 2 &J

O cos [ -] |144,1443]
O misc_feature C] (4305, 5504]

<<chck '+' button to add new annotation> =

Annotations to search Results

Region size: 1000 |+ Save regions as annotations.. ] lCIear results ...

Result strand

() Direct () Complement @ Both
D Annotation must fit into region
Found 2 regions

Search ] [ Cancel l [ Help

Using this dialog you can search for DNA sequence regions that contain every annotation from the list on the left side. The found regions are
displayed on the right side of the dialog.

Use the Save regions as annotations button to store the regions as new annotations to the sequence.

DNA Flexibility

To search for regions of high DNA helix flexibility in a DNA sequence, open the sequence in the Sequence View and select the Analyze Find
high DNA flexibility regions item in the context menu. Note that only standard DNA alphabet is supported, i.e. the sequence should consist of
characters A, C, G, T and N.

The following dialog appears:
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( [¥) DNA Flexibility |0 e |

Search Settings | Cutput |

High DMA Flexibility Regions Settings
Window size oo - [ Remember Settings ]
Window stey 1 =

P [ Restore Defaults ]
Threshald 13.7 =

[ Search J [ Cancel ] [ Help
L -

The calculation is made for overlapping windows along a given sequence. If there are two or more consecutive windows with an average
flexibility threshold (in each window) greater than the specified Threshold parameter, such area is marked by an annotation.

The average threshold in a window is calculated by the following formula:

(average wi ndow threshold) = (sumof flexibility angles in the window) / (the
wi ndow si ze - 1)

The following flexibility angles are used during the calculation:

Dinucleotide Angle Dinucleotide Angle
AA 7.6 CA 14.6
AC 10.9 CcC 7.2
AG 8.8 CG 111
AT 12.5 CT 8.8
GA 8.2 TA 25
GC 8.9 TC 8.2
GG 7.2 TG 14.6
GT 10.9 T 7.6

A minimum value is used when N characters is present in a dinucleotide:

® CN, NC, GN, NG, NN: 7.2
® AN, NA, TN,NT:7.6

® Configuring Dialog Settings
® Result Annotations

Configuring Dialog Settings
In the dialog you can setup the corresponding parameters:
Window size — the number of bases in a window. The window size should be greater than 2. The default value is 100 bp.

Window step — the number of bases used to shift a window. The Window step should be a positive integer. The default value is 1 bp.
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Threshold — the threshold value of the twist angle (see above). The default value is 13.7.
You can remember the input values or restore the default values using the Remember Setting and the Restore Defaults buttons.

The annotations names and other parameters can be changed on the Output tab of the dialog:
I It
[¥] DNA Flexibility LT e

| Search Settings | Cutput

* Save annotation(s) to

@ Existing table ’ {9 MC_001363 features [murine.gh] - ] @

() Create new table

|Use auto-annotations table

* Annotation parameters
Group name <auto= %:E'

Annotation name  dna_flex

Description

Search ][ Cancel ][ Help

L A

Once the Search button has been pressed, the annotations for the regions of the high DNA flexibility are created.

Result Annotations
Each annotation has the following qualifiers:

® area_average_threshold — average window threshold in the area (i.e. total_threshold / windows_number)
® total_threshold — sum of all window thresholds in the area
® windows_number — number of windows in the area

= M dna_flex 144,,156
are-a_average_mreshnld 14.672
total_threshold 558,689
windows_number 4

1 Using the DNA Graphs Package you can see the flexibility graph of a DNA sequence.

DNA Statistics

The DNA Statistics plugin provides exportable statistic reports.

In the current UGENE version the DNA Statistics plugin provides only Alignment Grid Profile report. The Alignment Grid Profile shows
positional amino acid or nucleotide counts highlighted according to the frequency of symbols in a row.

The original idea of the MSA Grid Profile is described in the following paper:

“Alberto Roca, Albert Aimada and Aaron C Abajian: ProfileGrids as a new visual representation of large multiple sequence alignments: a
case study of the RecA protein family, BMC Bioinformatics 2008, 9:554"

Usage example:
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Open a sequence alignment in the Alignment Editor and use the Statistics Generate grid profile context menu item.

13§ N 5 | Go ko position, Chri4+3
i [
13- MRD Y oRY
] i 3
14-rRsasfl
14:-[@ o T TS A
13- T g T8 il Statistics
13:- TR TS iz
178 - = Advanced
‘I':';_ = Mhoe

The dialog will appear:

r ™
.z Generate Alignment Profile m

Profile mode

@ Counts

(71 Percents

Custom oplions

[] show scores for gaps
| [] Show scores for symbols not used in alignment

|:| Skip gaps in consensus position increments

[7] save profile to file
File
i@ Hypertext ((HTML)

Comma separated ([ .CSV)

QK ][ Cancel ][ Help ]

h - T e ¥y,

Here is a brief description of the options that can be set in the dialog:
Profile mode: Counts/Percents — select the Percents to have scores shown as percents in the report.
Show scores for gaps — check this item if you want gap characters (‘—') statistics to be shown in the report.

Show scores for symbols not used in alignment — if a symbol is not used in the alignment at all it won't be shown in the report. Check this
item to make all symbols of alignment alphabet reported.

Skip gaps in consensus position increments — consensus ruler configuration. If checked the gaps in consensus will not lead to ruler
increments.

Save profile to file — allows to save profile to a file in the HTML or CSV format. The CSV format is convenient for further processing in
worksheets editors like Excel.

The result profile in the HTML mode:
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Ul -* UGENE
File  Actions Settings Tools ‘Window Help
Irr=N=If

U Col col

U] Alignment profile for COI
Consensus

E 1: Project

Multiple Sequence Alignment Grid Profile

Phaneropte [

Isaphya_al [ Alignment file: C:/Program Files/Unipro UGENE/data/samples/CLUSTALMWC Ol ain@C ol

. Table content: symbol counts
Bicolorana_ [

Roeselilana. [

Montana n [
ijﬂ] g Consensus|

Find: 4= A

224 1]22]23]24
AlG ]

0
0o
0

1
T
0
0
0
B 7 oo

C
G
T

Legend: 10% 25% 50% 70% B0

Q 2: Tasks L 3: Log Mo active tasks \()
DNA Generator

DNA sequence generator is a tool that generates a random DNA sequence with specified nucleotide content. To generate a random DNA
sequence select the Tools->Generate sequence item in the main menu. The dialog will appear:

r.ﬁ: Generate Sequence @u1
Parameters
Length hooo bp E
Window size 1000 bp El
Mumber of sequences 1 E
Initialize random generator manually
Content
@ Reference E]
© v
Output
Qutput File [oes ]
Format  |FASTA - |
Add to project
| Generate || cancel || Hep |

L _y

The following parameters are available:
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Length - length of the resulted sequence(s) (using '1000' bp by default).

Window size - size of window where set content (using '1000' by default).

Number of sequences - number of sequences to generate (using '1' by default).

Initialize random generator manually - value to initialize the random generator.

Reference - path to the reference file (could be a sequence or an alignment).

Manual - set the base content persents. To configure base content click on the Configure button and set base content manually.
Output file - output file.

Format - output file format (using ‘fasta’ by default).

Add to project - adds the generated sequence(s) to project.

Once the Search button has been pressed, the sequence(s) are created.

ORF Marker

From this chapter you can learn how to search for Open Reading Frames (ORF) in a DNA sequence. The ORFs found are stored as
automatic annotations. This means that if the automatic annotations highlighting has been enabled then ORFs are searched and highlighted
for each sequence opened. Refer Automatic Annotations Highlighting to learn more.

To open the ORF Marker dialog, select the Analyze Find ORFs item in the context menu.
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e ORF Marker -
Settings/ | Output

Strand Search Settings . Preview |
) Min length, bp: | | Clear results |
@ Both [] Must terminate within region
v Must start with init codon
) Direct L] allow overlaps
L] Allow alternative init codons
O Complement L Include stop codon
¥ Maxresult | 200000 B
|1 The Standard Genetic Code cl
Start codons ATG
Alternative start codons TTGCTG
Stop codons TAATAG TGA
Region [whole sequence ¢ | [ 1] - [ 199950
Region A Strand Length
0 results found. | Help | Cancel | | OK

The following search settings are available:
Min length — ORFs with length lower than Min length value will not be found.
Must terminate within region — this option ignores boundary ORFs located beyond the search region.

Must start with init codon — item switches the ORF Marker algorithm to the mode when any non-stop amino acid code is interpreted as
region start position.

Allow overlaps — alternative (downstream) initiators, when another start codon is located within a longer ORF, i.e. all possible ORFs will be
found, not only the longest ones.

Allow alternative init codon — option includes ORFs starting with alternative initiation codons, accordingly to the current translation table.
Include stop codon — includes stop codons into resulting annotations.

The other available parameters are:

DNA-to-Amino translation table defines the way start, alternative start and stop codons are encoded.

Strand — where to search the ORFs: in the direct strand, in the complement strand or in both strands.

Preview — allow to preview the regions, strands and lengths of the found ORFs.
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Clear results — becomes available when some results have been found, clears these results.

To set the saving parameters go to the Output tab of the dialog.

Here you can modify the annotations saving parameters (Group hame, Description and a file to save the annotation to).
Results:

When the search parameters has been selected and the OK button has been pressed in the dialog, the auto-annotating becomes enabled. In
the Annotations editor the ORFs annotations can be found in the Auto-annotations\orf group.

After the search has been finished you can browse the results, sort them by length, strand or start position and save as annotations to the
original sequence in the Genbank format.

For more information about codons use the codon table. To show or hide the table use Ctrl+T shortcut or click the Show codon table toolbar

e -* UGENE - [human_T1 [s] human_T1 (UCSC April 2002 chr7:115977709-117855134)]

button menu:

The codon table will appear:

% File Actions Settings Tools Window Help

0 5 H: & Sa Ea Gn En Ga Za D :][Goll &, 11 5 OSW ey S

-;-'d 1st base v < 2nd base -
o
é__._ y 3ﬂg Phenylalanine (Phe, F) 322 cerne ser 9 3iz Tyrosine (Tyr, Y)
I UuUA UcA ===l UAA Stop codon
- uuG ucac UAG
cuy Leucine (Leu, L ceu AU Histidine (His, H
. cuc eucine (Leu, L) ccc eroline (bro. ) cAC istidine (His, H)
CuA CCA —_— CAA .
cuG [ddd CAG Glutamine (Gln, Q)
AUU ACU AAU X
A AUC Isoleucine (lle, 1) ACC Threonine (Thr, T) AAC Asparagine (Asn, N)
AUA ACA —_—— AAA .
AUG Methionine (Met, M) ACG AAG Lysine (Lys, K)
cue — GAY Aspartic acid (Asp, D)
G oue Valine (Val, V) ace Alanine (Ala, A) CAC . =
GUA e GCA —_— GCAA . .
GUG GCG GAG Glutamic acid (Gly, E)

Clicking on a codon name redirects you to Wikipedia to give you a brief description of the corresponding amino acid. Cells of the table are
colored according to classes of amino acids.

Remote BLAST

The Remote BLAST plugin provides a capability to annotate sequences with information stored in the NCBI BLAST remote database.

To perform a remote database search open a Sequence View, select a sequence region to analyze and click the Analyze Query NCBI
BLAST database context menu item. If a region is not selected the whole sequence will be analyzed.
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Find qualifier... B Find pattern... Ctrl+F
Invert annotation selection W Find pattern [Smith-Waterman]... Ctrl+Shift+F
Rename item F2 ¥ Find ORFs...
- == Find annotated regicns...
5 Goto position... Ctrl+G -
. _ =31  Annctate plasmid...
Select sequence region... Ctri+A |
. i Build dotplot...
45 Mew annotation... Ctrl+N |
= Find repeats...
Copy/Paste b E‘C Find tandems...
Select ¥ | w¥  Analyze with query schema...
Add » % Find restriction sites...
Analyze y | Query NCBIBLAST database... b
Align , | H8  Find HMM signals with HMMERZ... E
Cloning , | HEy  Find HMM signals with HMMERS...

The following dialog will appear where you can choose the search options:

¢ Search Through a Remote Database

General options | Advanced options |

Select the search type: | blastn j W Search For short, nearly exact matches
Expectation value: | 10.000000 = [~ Megablast

Results limit: | 20 =

The database:

|Nucleotide collection - nr ~|

The database description:

Basic Local Alignment Search Tool, or BLAST, is an algorithm for comparing primary
biological sequence information, such as the amino-acid sequences of different
proteins or the nucleotides of DNA sequences. A BLAST search enables a researcher to
compare a query sequence with a library or database of sequences, and identify
library sequences that resemble the query sequence above a certain threshold.

¥ Save annotation(s) to

it
+ New document I _I
~ Annotation parameters
Group name |<auto> 3*|

Description |
Search timeout | 20 min 3:
Help | Cancel | Search

General options are:

Select the search type — in the remote databases the blastn search is used for nucleotide sequences, blastp and cdd searches are
used for amino sequences.

UGENE also provides a way to use blastp and cdd searches for nucleotide sequences. This is achieved by translating the nucleotide
sequence into the amino sequences.
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When a sequence is translated the translation table from the active Sequence View is used. Finally, all 6 translations are used to query
the remote database with the selected blastp or cdd search.

Expectation value — this option specifies the statistical significance threshold for reporting matches against database sequences.
Lower expect thresholds are more stringent, leading to fewer chance matches being reported.

Max hits — the maximum number of hits that will be shown (not equal to number of annotations). The maximum availablle number is
5000.

Database — the target database.

Search for short, nearly exact matches — automatically adjusts the word size and other parameters to improve results for short
queries.

Megablast — select this option to compare query with closely related sequences. It works best if the target percent identity is 95% or
more, but it is very fast.

You can see the description of the annotation saving parameters here.

Search timeout — the remote task terminated if the timeout is reached.

@ There is a little difference in default values of parameters between NCBI Nucleotide BLAST web interface and UGENE:

®* The web interface uses the megablast option by default: the search is fast, but only highly similar sequences are found.
® UGENE ignores the option by default: the search may take more time, but all somewhat similar sequences are found.

Check the Megablast option, if you want exactly the same results to be found in UGENE as you had in the NCBI web interface.

Also there is Advanced options tab:

e Search Through a Remote Database

General options  Advanced options ]

word size | 11 ~ Gap costs | 52 -
Match scores | 2-3 v
Entrez query |

Filters Masks

¥ Low complexity Filter [1 Mask for lookup table only

[ Human repeats filter [ 1 Mask lower case letters

Filter results

Filter by Select result by
[ accession * EValue

[ def (Filter by definition of annotations) © Score

Cid

Help Cancel Search
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The view of the Advanced options tab depends on the selected search. For the blastn search it looks like on the picture above.
Word size — the size of the subsequence parameter for the initiated search.

Gap costs — costs to create and extend a gap in an alignment. Increasing the Gap costs will result in alignments which decrease the
number of Gaps introduced.

Match scores — reward and penalty for matching and mismatching bases.

Entrez query — a BLAST search can be limited to the result of an Entrez query against the database chosen. This restricts the search
to a subset of entries from that database fitting the requirement of the Entrez query. Examples are given below:

protease NOT hivl[organism] — this will limit a BLAST search to all proteases, except those in HIV 1.

1000:2000[slen] — this limits the search to entries with lengths between 1000 to 2000 bases for nucleotide entries, or 1000 to
2000 residues for protein entries.

Mus musculus[organism] AND biomol_mrna[properties] — this limits the search to mouse mRNA entries in the database. For
common organisms, one can also select from the pulldown menu.

10000:100000[mIwt] — this is yet another example usage, which limits the search to protein sequences with calculated
molecular weight between 10 kD to 100 kD.

src specimen voucher[properties] — this limits the search to entries that are annotated with a /specimen_voucher qualifier on the
source feature.

all[filter] NOT enviromnental sample[filter] NOT metagenomes[orgn] — this excludes sequences from metagenome studies and
uncultured sequences from anonymous environmental sample studies.

For help in constructing Entrez queries see the Entrez Help document.
Filters — filters for regions of low compositional complexity and repeat elements of the human’s genome.

Masks for lookup table only — this option masks only for purposes of constructing the lookup table used by BLAST so that no hits are
found based upon low-complexity sequence or repeats (if repeat filter is checked).

Mask lower case letters — with this option selected you can cut and paste a FASTA sequence in upper case characters and denote
areas you would like filtered with lower case.

Filter by — filters results by accession, by definition of annotations or by id.
Select result by — selects results by EValue or by score.

When the blastp search is selected in the general options, the view of the Advanced options tab is the following:
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e Search Through a Remote Database x

General options  Advanced options |

Word size | 6 v Gap costs | 111 -
Entrez query |
Matrix | BLOSUM62 ~| Service | plain ~|
—Filters Masks

¥ Low complexity Filter [ Mask For lookup table only

" Human repeats filter " Mask lower case letters

—Filter results
Filcer by Select result by
I accession ~ EValue

I def (Filter by definition of annotations)  Score

™ id

Help | Cancel Search

As you can see there is no Match scores option, but there are Matrix and Service options.

Matrix — key element in evaluating the quality of a pair-wise sequence alignment is the “substitution matrix”, which assigns a score for
aligning any possible pair of residues.

Service — blastp service which needs to be performed: plain, psi or phi.

The Advanced options tab is not available when the cdd search is selected.

® Exporting BLAST Results to Alignment
® Fetching Sequences from Remote Database

Exporting BLAST Results to Alignment

To export BLASt results as alignment select the results in the Annotations Editor and call the Export->Export BLAST result to alignment cont
ext menu item. The following dialog will appear:
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s Exporkt BLAST Result to Multiple Alignment

Export to file | J
=

File Format to use |CLUSTALW

Qualifier to use as name |a+:+:E55iun j
| Add reference to alignment

¥ Add document to the project

Help Cancel | Export

The following parameters are available:

Export to file - name of the new file.

File format to use - format of the new file. The following formats are available: CLUSTALW, FASTA, MSF, MEGA, NEXUS, PHYLIP
Interleaved, PHYLIP Sequential, Stockholm.

Qualifier to use as name - name of the qualifier. The following qualifiers are available: accession, def, id.
Add reference to alignment - adds a reference to alignment.
Add document to the project - adds the new document to the project.

Select the options and click on the Export button.

Fetching Sequences from Remote Database

Each result annotation found with the remote BLAST in UGENE has "accession" and "id" qualifiers that can be used to fetch the
corresponding sequences from the NCBI. The prompt way to fetch the sequences of several annotations is the following:

® Select the annotations in the Annotations Editor.

® Open the context menu.

® Choose the Fetch sequences from remote database->Fetch sequences by 'id' from 'blast result' item or Fetch sequences from
remote database->Fetch sequences by ‘accession' from 'blast result' item.

The following dialog will appear:

® GetSequences by ID o

The sequences from selected BLAST results will be downloaded from
NCBI Genbank by their Gl identifier

save to directory: || J
v Add to project

Help Cancel | oK

Select an output path in the dialog and click the OK button.

BLAST/BLAST+

The Basic Local Alignment Search Tool (BLAST) finds regions of local similarity between sequences. The program compares nucleotide or
protein sequences to sequence databases and calculates the statistical significance of matches. BLAST can be used to infer functional and
evolutionary relationships between sequences as well as help identify members of gene families.

BLAST+ is a new version of the BLAST package from the NCBI.

From UGENE you can use the following tools of the old BLAST package:
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® blastall — the old program developed and distributed by the NCBI for running BLAST searches.
* formatdb — formats protein or nucleotide source databases before these databases can be searched by blastall.

And the following tools of the new BLAST+ package:

® blastn — searches a nucleotide database using a nucleotide query.

® blastp — searches a protein database using a protein query.

® blastx — searches a protein database using a translated nucleotide query.

® tblastn — compares a protein query against a translated nucleotide database (the all six reading frames).

® tblastx — translates the query nucleotide sequence in all six possible frames and compares it against the six-frame translations of a
nucleotide sequence database.

®* makeblastdb — — formats protein or nucleotide source databases before these databases can be searched by other BLAST+ tools

BLAST home page: http://blast.ncbi.nlm.nih.gov/Blast.cgi?CMD=Web&PAGE_TYPE=BlastHome
To make BLAST (or BLAST+) tools available from UGENE:

1. Install the required verion of BLAST (or BLAST+) on your system.
2. Set the paths to the executables, you are going to use, on the External tools tab of UGENE Application Settings dialog.

After you've finished this configuration you can access the tools from the Tools BLAST submenu of the main menu.

® Creating Database

® Making Request to Database

® Fetching Sequences from Local BLAST Database
Creating Database
To format a BLAST database do the following:

® |f you're using BLAST open Tools BLAST FormatDB.
® |f you're using BLAST+ open Tools BLAST BLAST+ make DB.

The Format database dialog appears:
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# Format Database -

Input data

@ select input File(s) For Formatting database::

| ]

" Or select directory with input files:

Type of file(s)

& protein T nucleotide

Output settings
select the path to save the database into:

| ]

Base name for BLAST files: |

Title for database file: |

Help Cancel |

Here you must select the input files. If all the files you want to use are located in one directory, you can simply select the directory with the

files. By default only the files are taken into account with *.fa and *.fasta extensions. You can change this by specifying either Include files
filter orExclude files filter.

You can choose either protein or nucleotide type of the files.

Then you must select the path to save the database file and specify a Base name for BLAST files and a Title for database file.
Making Request to Database

To make a request to a local BLAST database do the following:

® |f you're using BLAST open Tools BLAST BLAST Search.
® If you're using BLAST+ open Open Tools BLAST BLAST+ Search.

If there is a sequence opened you can also initiate the request to a local BLAST database from the Sequence View:

® |f you're using BLAST select the Analyze Query with BLAST item in the context menu or in the Actions main menu.
® |f you're using BLAST+ select the Analyze Query with BLAST+ item in the context menu or in the Actions main menu.

The Request to local BLAST database dialog will appear:
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* Regquest to Local BLAST Database %

. General options l Advanced options ] Extension options ]

Select search: blastn ~| I” search for short, nearly exact matches

Expectation value |10.000000 - I Megablast

Best hits limit: | 100 = & Both strands ¢ Direct ¢ Complement

Database path | Database file

Base name for BLAST DB files |
~* Save annotation(s) to
& Existing document | & MyDocument.gb [Annotations] - E

" Mew document

* Annotation parameters

Group name |<auto> 3%

Description |

Number of CPUs being used IE

Help Cancel Restore to default

The following general options are available:

Select search - here you should select the tool you would like to use. If the query sequence is a nucleotide sequence then blastn, blast
x and tblastx items are available. For a protein sequence the items are blastp and tblastn.

Expectation value - this option specifies the statistical significance threshold for reporting matches against database sequences. Lower
expect thresholds are more stringent, leading to fewer chance matches being reported.

Culling limit - the maximum number of hits that will be shown (not equal to number of annotations). The maximum availablle number is
5000.

Search for short, nearly exact matches - automatically adjusts the word size and other parameters to improve results for short queries.

Megablast - select this option to compare query with closely related sequences. It works best if the target percent identity is 95% or
more, but it is very fast.

Database path - path to the database files.
Base name for BLAST DB files - base name for the BLAST database files.
You can see the description of the annotation saving parameters here.

The following advanced parameters are available:
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* Regquest to Local BLAST Database %

General options | Advanced options ] Extension options ]

word size [11 = Gapcosts (22 |

Match scores |1-3 |
Filters Masks
[ Low complexity filter [ Mask For lookup table only

[ Human repeats Filter

Help Cancel Restore to default

Word size - the size of the subsequence parameter for the initiated search.

Gap costs - costs to create and extend a gap in an alignment. Increasing the Gap costs will result in alignments which decrease the
number of Gaps introduced.

Match scores - reward and penalty for matching and mismatching bases.
Filters - filters for regions of low compositional complexity and repeat elements of the human’s genome.

Masks for lookup table only — this option masks only for purposes of constructing the lookup table used by BLAST so that no hits are
found based upon low-complexity sequence or repeats (if repeat filter is checked).

Mask lower case letters — with this option selected you can cut and paste a FASTA sequence in upper case characters and denote
areas you would like filtered with lower case.

The view of the Advanced options tab depends on the selected search. For the blastn search it looks like on the picture above. When the bla
stx search is selected in the general options, the view of the Advanced options tab is the following:
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* Regquest to Local BLAST Database x

General options  Advanced options | Extension options|

word size |3 = Gap costs |11 1 j
Threshold |12.00 =
Matrix ~ [BLOSUM62 ~| Service -
Filters Masks
I Low complexity Filter I Mask for lookup table only

" Human repeats Ffilter

Help | Cancel | Restore to default

As you can see there is no Match scores option, but there are Threshold, Matrix, Composition-based statistics and Service options.

Threshold - threshold for extending hits.

Matrix — key element in evaluating the quality of a pair-wise sequence alignment is the “substitution matrix”, which assigns a score for
aligning any possible pair of residues.

Service — blastp service which needs to be performed: plain, psi or phi.
Composition-based statistics - composition-based statistics.

When the tblastx search is selected in the general options, the view of the Advanced options tab is the following:
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* Regquest to Local BLAST Database x

General options

word size |3 =

Threshold |13.00 =

Matrix ~ [BLOSUM62 ~|
Filters

Advanced options | Extension options |

Service [[sE -

Masks

I Low complexity Filter

" Human repeats Ffilter

I Mask for lookup table only

Help |

Restore to default

Cancel |

The following extension options are available:

* Request to Local BLAST Database x

General options | Advanced options

Extension options |

—X dropoff value (in bits)
For gapped alignment
For ungapped extensions

For final gapped alignment

.00 —

Multiple Hits window Size

|40 =

Help |

Restore to default

Cancel |
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For gapped alignment - X dropoff value (in bits) for gapped alignment.

For ungapped alignment - X dropoff value (in bits) for ungapped alignment.

For final gapped alignment - X dropoff value (in bits) for final gapped alignment.
Multiple hits window size - multiple hits window size.

Perform gapped alignment - performs gapped alignment.

Fetching Sequences from Local BLAST Database

To fetch sequences from local BLAST database use the Fetch sequences from local BLAST database->Fetch sequences by 'id' from 'blast
result' context menu item of the blast result. The following dialog will appear:

e Fetch Sequences from BLAST Database

Query ID-

|gi|538117317|gb|CY148232.1]

Select database

Database path |

Database File
Base name For BLAST DB Files |

- Qutput path
| JUGENE_Data/gi 538117317 gb _CY148232 1 .fa _J

¥ Add to project

Help Cancel

Here you need select a query ID, database, type of file(s) and output path. After that click on the Fetch button. To fetch sequences for
several annotations at the same time select the blast results with Ctrl key and call the Fetch sequences from local BLAST database->Fetch
sequences by 'id' from 'blast result' context menu item.

Repeat Finder

The Repeat Finder plugin provides a tool to search for direct and invert repeats in a DNA sequence. Also it allows to search for tandem
repeats.

® Repeats Finding
® Tandem Repeats Finding
® Tandem Repeats Search Result

Repeats Finding
Usage example:

Open a DNA sequence in the Sequence View and select the Analyze Find repeats... context menu item:
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e

Analyze r RCE Find pattern... Ctrl+F
Align ¥ | SW  Find pattern [Smith-Waterman]... Ctrl+Shift+F
Clening ¥ | ¥ Find ORFs...

Export b Find annotated regions...

Edit sequence * | =1 Annotate plasmid and custom features...
Remowve * B Build dotplot...
A Rulers.. 5 [= " Find repeats... ]l
| I:,  Find tandems...
il Statistics w4 Analyze with query schema...

The dialog will appear that allows specifying repeat parameters and the annotations table document to save the results into:

® Find Repeats x

—

Base ‘ Advanced |

Repeat finder parameters
window size 100bp |2 [ 1k |
Minimum indentity per window 100% || [100

¥ Minimum distance between repeats [ obp |i]

¥ Maximum distance between repeats [ 5000bp |2

Region to process

Region [Whole sequence C] l 1] - [ 199950]

~ Save annotation(s) to

® Create new table l/homefyalgaer,"MyDocument.gb ] D

~ Annotation parameters

Group name [<auto:= ] @

Annotation name lrepeat_unit ]

Description [ ]

Estimated repeats count: 0

Help | Cancel H Start

The dialogues status line displays approximate repeats number that will be found with the current settings.

The Advanced tab provides additional repeats finding options:
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* Find Repeats £a
Base  Advanced

Advanced parameters

[J Custom algorithm

Nested repeats filter algorithm | Disjoint repeats ¢

[ search For inverted repeats

[l Exclude tandems areas

Estimated repeats count: 0

| Help | Cancel | | Stark

The found repeats are saved and displayed as annotations to the DNA sequence:
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€/ human_T1(UCSC April 2002 chr7:115977709-1 ) [&, 5, 0 [czlT2| T Bm #* = "
-l
1 2k 40k 50k B0k 100k 120k 140k 160k 180k 199 950 &)
repeat unit repeat unit ) -
19852 19880 19.9k 19820 19940 {3980 19880 20k 20020 20 047
19912 [45 bp] 19956 19990 [45 bp] 20034

-~

4 I

Tandem Repeats Finding

To find tandem repeats, select the Analyze Find tandems... context menu item in the Sequence View window.

In the opened dialog you can specify the tandem search parameters, the region to search in and the result parameters:

4 [
Mame - Yalue =
4 {}.J' Annotations [MyDocument_1.gb] *
4 @ repeat_unit (0, 4) -
» O repeat_unit join(19912..19956,19990..20034) [
» O repeat_unit Join(G3727..63804 65754..65831)
» O repeat_unit Jjoin(185499, 185538, 189058,.189097) B
» O repeat_unit Join(190533,.190577,190640..190684) 7
k
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-
(1] Find Tandems

A=)

Base Advanced

Tandem finder parameters
Tandem preset
Min period

Max period

Region to process

Region |Whole sequence -

* Save annotation(s) to
@ Existing table
) Create new table

Use auto-annotations table

* Annotation parameters
Group name <auto=
Annotation name  repeat_unit

Description

all -
in =
1000000 n =
1 - 140426

[ () NC_014267 features [NC_014267. 1.gb]

[ Start ] [ Cancel

J

Help ]

The dialog parameters:

Tandem preset — specify the tandem repeats parameters with predefined values by selecting the available preset:

[V} Find Tandems

Base Advanced

Tandem finder parameters
Tandem preset
Min period

Max period

Region to process

Region |Whole sequence +

Micro-satelites
Mini-satellites
Big-period tandems

199950

Min period, Max period — the minimum and maximum acceptable repeat length measured in base symbols.

Region to process — specify the region to search in the whole sequence, a custom region or the region of the current selection (if

any).

In the Save annotation(s) to group you can set up a file to store annotations. It could be either an existing annotation table object, a
new annotation table or auto-annotations table (if it is available).

In the Annotation parameters group you can specify the name of the group and the name of the annotation. If the group name is set to
<auto> UGENE will use the group name as the name for the group. You can use the ‘/' characters in this field as a group name
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separator to create subgroups. If the annotation name is set to by type UGENE will use the annotation type from the Annotation type: t
able as the name for the annotation. Also you can add a description in the corresponding text field.

Advanced

Advanced parameters

Algarithm Suffix array (optimized) - ]
Minimum tandem size 9 =
Minimum repeat count %3 =

[7] Show overlapped tandems

Additional search options can be found in the Advanced tab:

Algorithm — the algorithm parameter allows to select the search algorithm. The default and a fast one is optimized suffix array
algorithm.

Minimum tandem size — the minimum tandem size sets the limit on minimum acceptable length of the tandem, i.e. the minimum total
repeats length of the searched tandem.

Minimum repeat count — the minimum number of repeats of a searched tandem.
Show overlapped tandems — check if the plugin should search for the overlapped tandems, otherwise keep unchecked.
® Tandem Repeats Search Result

Tandem Repeats Search Result

An example of the search results for the micro-satellite preset:

() CPO01037 sequence QK & I egrE & ® - <
1 im 2m Fiy 3m 4m Sm 8m im 323432‘2| L
~
I
1 |
1 1 1 1
L A A A L VYA T Mb L T N S Y ) L T S AR R AL MR )
L) [
1 m Zm am 4am Sm sm m o234 322
v

* Y ¢ K ¢ N R & H Q R E R E N H ¢ H R H Q R
D r v 8§ VvV I E A T R E R E K I I A I Vv T R E
TGATATTGTAAGTGTAATCGAAGCCACdadrdadadrdadrAn A TCATTGCCATCGTCACCAGAGA

451 641 451850 451850 451870 451830 451890 4317

H ¥ Q L H L E L W W I 5 L S F * Q W R * W L
I N ¥ T ¥ D F &6 G § L 5§ L F D N &G D D G 5 E‘I
s I T L T I 8§ A VvV L 8 L s F I M A M T v L S

< | >

Value ™

O repeat_unit JoIn{FF0472T. FF04727, 7704728, . FF04728, 7704729, 7704729, 7704730, . 7704730, 7704731, . 7704731, 7704732, . 7704732, 77

O repeat_unit join{1203537., 1209538, 1209589, . 12095590, 1209591, , 1209592, 1209593, 12095594, 1209595, , 1209596, 1209597, . 1209598)

B repeat_unit join(2451669., 2451670, 2451671, . 2451672, 2451673, 2451674,2451675.. 2451676, 2451677, . 2451678, 2451679, . 2451680)

O repeat_unit join{6149025..6149029,6145030,.6145031,6149032. .6149033,6 149034..6149035,6143036..6 149037,6 149038, .6143039)

O repeat_unit join{4607596, . 4607593, 4607599, . 460750 1, 4607602, . 4607604, 4607605, . 460 7607,4607608, . 4507510,4607511,,.4607613)  —

==l

M repeat unit ioinf8049749.,8049752,8049753..8049756.8043757,.8045760,804976 1.,8049754,8049755, . 8049768.8049769. 804977280 ¥
| 3

The tandem repeats annotations are located side by side.

Restriction Analysis

195



Unipro UGENE Manual, Version 1.26

From this chapter you can learn how to search for restriction sites on a DNA sequence.

The restriction sites found are stored as automatic annotations. This means that if the automatic annotations highlighting is enabled then the
restiction sites are searched and highlighted for each nucleotide sequence opened. Refer Automatic Annotations Highlighting to learn more.

Open a DNA sequence in and click the following button on the Sequence View toolbar:

%

Alternatively, select either the Actions Analyze Find restriction sites item in the main menu or the Analyze Find restriction sites item in the
context menu.

The Find restriction sites dialog appears:

®* Find Reskriction Sites e

Filter by name: [ ] | Open enzymes |
MName v | Accession Type Sequence Organizm / Details | Export enzymes |
B Ao, 264) Aaal .. Axyl . _
b B (2, 917) Bacl .. BVUBI | selectall |
B C(1,193) Cacl .. Cvnl ﬁ Z
b D(1,31) Daql .. Dsp1l | Select None |
B E(2,325) Eacl .. EspHK30l - ]
b F (0, 63) F-Cphl .. F-TevIV | Select by length |
b G (0, 23) Gall .. Gsul | Invert selection |
P H(1,312) H-Drel .. Hsul j :
b 1(0,61) I-AchMI .. I-Vdi141] | Load selection |

Selected enzymes: - - Y
|. Save selection |

BamHI,Bglil,Clal,Dral,EcoRl,EcoRV,Hindlll,Pstl,Sall,Smal, Xmal

| REBASEInfo |
[] Filter by number of results:
Minimum hits: 1 Maximum hits: 2
Search in:
Region |:whole sequence s | [ 1 H 199950
[ Exclude 1 |- 199950
Total number of enzymes: 4862, selected 11
|_ Help | Cancel | | OK |

You can see the list of restriction enzymes that can be used to search for restriction sites. Also you can set a region to search for. The
information about enzymes was obtained from the REBASE database. For each enzyme in the list a brief description is available (the
accession ID in the database, the recognition sequence, etc.). If you're online you can get more detailed information about an enzyme
selected by clicking the REBASE Info button.

Selecting Restriction Enzymes
Using Custom File with Enzymes
Filtering by Number of Hits
Excluding Region

Circular Molecule

Results

Selecting Restriction Enzymes
To select an enzyme check it in the list. Notice that the enzyme appears in the Selected enzymes area of the dialog.

You can also use the Select All button to select all the enzymes available, the Select None button to deselect all the enzymes.
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To select all enzymes with recognition sequence length shorter than the specified value click the Select by length button and input the
minimum length in the dialog appeared.

To invert selection click the Invert selection button.

As soon as enzymes are selected you can click the OK button to search for corresponding restriction sites in the sequence.

Using Custom File with Enzymes

To load a custom file with enzymes click the Enzymes file button and browse for the file. The file must be of the Bairoch format.
For details about the format refer http:/rebase.neb.com/rebase/rebase.f19.html.

To export enzymes use the Export enzymes button. You can also save the currently selected enzymes to a file and load saved selection.
Click the Save selection and Load selection buttons correspondingly to do it.

Filtering by Number of Hits

To filter the results by the number of restriction sites found for an enzyme check the Filter by number of results check box and input the
minimum value and the maximum value of hits.

Excluding Region

To exclude a sequence region from the search check the Exclude region check box and input the start and the end positions of the region. If

a subsequence has been selected before opening the dialog you can click the Selected button to automatically fill the values with the
selected subsequence’s start and end positions.

Circular Molecule

To consider the sequence as circular and be able to search for restriction sites between the end and the beginning of the sequence check
the Circular molecule option.

Example: Let's consider:

® The sequence is “CTGC ... CAC".
® Aarl restriction enzyme (with recognition sequence “CACCTGC") has been checked.

In this case if the Circular molecule option has been checked, the restriction site will be found. If it hasn’t been checked, the restriction site
won't be found (in this position).

Results

When at least one enzyme has been selected and the OK button has been pressed in the dialog, the auto-annotating becomes enabled. In
the Annotations editor the Restriction Sites annotations can be found in the Auto-annotations\enzyme group.

The direct and complement cut site positions are visualized as triangles on an annotation in the Sequence details view:

Ia 0
- -

TGGGGCCTGCEQTTTTETC

9340 9345 9350 9355
ACCCCGGACGTCAARATAG
*

Molecular Cloning in silico

This chapter describes a set of tools in UGENE to perform molecular cloning experiments in silico.

This allows you to digest a molecule into fragments, create a fragment from a sequence region and ligate fragments into a new molecule.

® Digesting into Fragments
® Creating Fragment
® Constructing Molecule
® Available Fragments
Fragments of the New Molecule
Changing Fragments Order in the New Molecule
Removing Fragment from the New Molecule
Editing Fragment Overhangs
Reverse Complement a Fragment
Other Constuction Options
® Output
® Creating PCR Product

Digesting into Fragments
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Open a DNA molecule you want to cut into fragments.

Digestion into fragments is performed using restriction enzymes. So before continuing make sure that the restriction analysis has been
performed. Refer chapter Restriction Analysis for details.

Select either the Tools Cloning Digest into Fragments item or the Actions Cloning Digest into Fragments item in the main menu or the Clon
ing Digest into Fragments item in the context menu.

The Digest Sequence into Fragments dialog appears:

m Digest Sequence into Fragments &Iﬂ—hj

Restriction Sites Conserved Annotations | Output |

Target Sequence: human_T1 (UCSC April 2002 chr7: 115977709-117855134)

Available enzymes: Selected enzymes:

Add —>

Add All —=

Remove

Clear
Selection

[ circular molecule

Hint: there are no available enzymes, Use “Analyze-:»Find Restrictions Sites”™ feature to find them.

oK Cancel ] [ Help

L — A

On the Restriction Sites tab of the dialog you can see the name of the molecule, the list of restriction enzymes found during the restriction
analysis that can cut the molecule and the list of enzymes selected to perform the digestion.

To digest the sequence into fragments you should select at least one enzyme.

To move an enzyme to the Selected enzymes list click on it in the Available enzymes list and press the Add button. Note that you can select
several items in a list by holding the Ctrl key while clicking on the items.

To select all available enzymes press the Add All button.

To remove enzymes from the Selected enzymes list select them in the list and press the Remove button.

To remove all items from the Selected enzymes list press the Clear Selection button.

On the Conserved Annotations tab of the dialog you can select the annotations that must not be disrupted during cloning.
On the Output tab of the dialog you can select the file to save the new molecule to.

As soon as the required parameters are selected press the OK button. The fragments will be saved as annotations.

Also all the generated fragments are available in the task report:
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P

[ Task report [DigestSeque... | = | & |[s5w|

Task report
[DigestSequenceTask]

status Finished
time 0.00,00.023

Digest into fragments CWVU55762.gb (circular)

Generated 3 fragments.
1:  From Dral {1460) To Dral {3901) - 2442 bp
2 From Dral {3902) To Dral (3520) - 19 bp

31 From Dral (3921) To Dral (1459) - 2272 bp

Refer to Notifications to learn more about task reports.

Creating Fragment

To create a DNA fragment from a sequence region activate the Sequence View window and select either the Actions Cloning Create
Fragment item in the main menu or the Cloning Create Fragment item in the context menu.

The Create DNA Fragment dialog appears:

s it
[l Create DNA Fragment @lﬂ—hj
Fragment Options | Qutput |
Reqion [Whale sequence '] 1| - 199950
[7] tnclude Left Overhang [7] Indude Right Overhang
) Direct Reverse-complement @ Direct Reverse-complement
0K ] [ Cancel ] [ Help
' = = v

If a region has been selected you can choose to create the fragment from this region. Otherwise you can either choose to create the
fragment from the whole sequence or choose the Custom item and input the custom region.

To add a 5’ overhang to the direct strand check the Include Left Overhang check box and input the required nucleotides. To add a 5’
overhang to the reverse strand in addition to the described steps select the Reverse-complement item in the same group box.

Similarly, to add a 3’ overhang check the Include Right Overhang check box, input the required overhang and select either the direct or the
reverse-complement strand.

On the Output tab of the dialog you can optionally modify the annotations output settings.

Finally, press the OK button to create the fragment. The fragment will be saved as an annotation.
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Constructing Molecule
To construct a new molecule from fragments select the Tools Cloning Construct Molecule item in the main menu.

If a Sequence View window is active you can also select either the Actions Cloning Construct Molecule item in the main menu or the Clonin
g Construct Molecule item in the context menu.

The Construct Molecule dialog appears:

-
[ construct Malecule

Construction Output

Available fragments:

A=)
Add

Mew molecule contents:

5 Fragment 3 Inverted

4 n | »

Annotate fragments in new molecule

[] Foree "blunt™ and omit all overhangs

[ Make circular

OK ][ Cancel ][ Help J

Available Fragments

Fragments of the New Molecule

Changing Fragments Order in the New Molecule
Removing Fragment from the New Molecule
Editing Fragment Overhangs

Reverse Complement a Fragment

Other Constuction Options

Output

[ ]
L[]
[ ]
L]
[ ]
L]
[ ]
[ ]
Available Fragments

All the fragments available in the current project are shown in the Available fragments list.

You can automatically create a fragment from a DNA molecule from the current UGENE project. Click the From Project button to do so. The
Select Item dialog appears with the sequence objects available. Select a sequence and press the OK button. After that create a fragment in
the appeared Create DNA Fragment dialog as described in the Creating Fragment paragraph. The fragment created from the sequence
appears in the list of available fragments.

Fragments of the New Molecule
The next step is to add required fragments to the new molecule contents.
To add fragments select them in the list of available fragments and click the Add button or by double-click on a fragment.

To add all the fragments click the Add All button.
Changing Fragments Order in the New Molecule

To change the order of fragments in the new molecule select a fragment in the new molecule contents list and click either the Up or the Down
button to move the fragment in the corresponding direction.

Removing Fragment from the New Molecule
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To remove a fragment from the new molecule select it in the new molecule contents list and click the Remove button.

To remove all the fragments click the Clear All button.
Editing Fragment Overhangs

To edit a fragment’s overhangs select the fragment in the new molecule contents list and click the Edit button.

The Edit Molecule Fragment dialog appears:

m Edit Molecule Fragment

? -t |

Left End Right End
Type Type
() Overhang i) Overhang
@ Blunt @ Blunt
Custom owverhang Custom overhang
) 5-3 ) 5-3
3-5 3-5
|
Reset Reset
Prewview:
Fragment of human T1.fa
5! 3!
TTGTCAGATT TTTTRARLTCGE
LACLGTCTAR LARATTTAGCC
3! 5!
| | | |
] [ Cancel ] [ Help

L

Here you can select the type of each DNA end and even input a custom overhang.

The changes you've made are shown in the Preview area of the dialog.

To confirm the changes and close the dialog click the OK button.
Reverse Complement a Fragment

To reverse complement a fragment check the Inverted check box for the fragment in the new molecule contents list.

Other Constuction Options

To save the fragments of the new molecule as annotations check the Annotate fragments in new molecule check box.

To make all DNA ends blunt check the Force “blunt” and omit all overhangs check box. All overhangs would be cut in this case.

Check the Make circular check box to make the new molecule circular.

Output

201



Unipro UGENE Manual, Version 1.26

On the Output tab of the dialog you can select the file to save the new molecule to.

The molecule is opened by default as soon as it is created. To modify this behavior uncheck the Open view for new molecule check box on
the same tab.

To save the molecule file to the hard disk immediately after it is created check the Save immediately check box. Otherwise it would be stored
in memory until you save or remove it.

Creating PCR Product

To create a PCR product from a primer use the Cloning->Create PCR product context menu of primer annotation.

The Create PCR Product dialog appears:

' N
“.::M. Create PCR product I. 2 ﬁ]
Fragment Options | Cutput |
Region [Custom region "] 185965 - 1836141
[7] tnclude Left Overhang [7] Indude Right Overhang
i@ Direct Reverse-complement i@ Direct Reverse-complement
oK ] [ Cancel ] [ Help
L "

If a primer has been selected you can choose to create the PCR product from this primer. Otherwise you can either choose to create the
PCR from the whole sequence or choose the Custom item and input the custom region.

To add a 5’ overhang to the direct strand check the Include Left Overhang check box and input the required nucleotides. To add a 5’
overhang to the reverse strand in addition to the described steps select the Reverse-complement item in the same group box.

Similarly, to add a 3’ overhang check the Include Right Overhang check box, input the required overhang and select either the direct or the
reverse-complement strand.

On the Output tab of the dialog you can optionally modify the annotations output settings.

Finally, press the OK button to create the PCR product. The PCR product will be saved as an annotation.

In Silico PCR

In Silico PCR Overview

In silico PCR is used to calculate theoretical polymerase chain reaction (PCR) results using a given set of primers (probes) to amplify DNA se
guences.

UGENE provides the In silico PCR feature only for nucleic sequences with Standard DNA and Extended DNA alphabets. To use it in UGENE
open a DNA sequence and go to the In silico PCR tab of the Options Panel:
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In Silico PCR |

 Forward primer

ACGTTACGTACGTACTACGTACGTGC|

A
Tm = 53.54°C, 26-mer ce @ bo
=
Mismatches 0 bp = =

w Heverse primer

> | B

AAAAAACGTACGTCGET
Tm = 38.25°C, 16-mer C2 2 '®)
Mismatches 0 bp =
w Settings
3 perfect match 15bp =
Maximum product 5000 bp =

Extract annotations

Show primers details

Warning:

Self-dimer can be formed:
Delta G: -15.4 kcal/mole
Base Pairs: 11

Find product{s) anyway

There are the following parameters:
Forward primer - forward primer.
Reverse primer - on the opposite strand from the forward primer.
Mismatches - mismatches limit.
3' perfect match - specify the number of nucleotides at the 3' end that must not have mismatches.
Maximum product - maximum size of the amplified sequence.
Extract annotations - specify the type of extracted annotations: Inner, All intersected or None.

® Value Inner is selected by default. When this value is selected, the extracted PCR product contains annotations from the
original sequence, located within the extracted region.

® Value All intersected specifies that all annotations of the original sequence that intersect the extracted region must be
extracted as well.

® Value None specifies that annotations from the original sequence must not be extracted.

Choosing primers

Type two primers for running In Silico PCR. If the primers pair is invalid for running the PCR process then the warning is shown. Also, primer
s for the running In silico PCR can be chosen from a primer library. Click the following button to choose a primer from the primers library:
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 Forward primer

ACACACGTACTGACAGTCAGCATACG

Tm = 61.39°C, 28-mer C2 &

Mismatches  7bp N
The following dialog will appear:
[ choose Primer M
Mame GC-content (%) Tm (*C) Length (bp) Sequence
Primer 2.22 22 g AALMLAACGT
|
Choose Cancel ] [ Help

L

The table consists of the following columns: name, GC-content (%), Tm, Length (bp) and sequence. Select primer in the table and click the C
hoose button.

Click the Reverse-complement button for making a primer sequence reverse-complement:
In Silico PCR

 Forward primer

ACACACGTACTGACAGTCAGCATACG

Tm = 61.39°C, %z g

Click Show primers details for seeing statistic details about primers.

When you run the process, the predicted PCR products appear in the products table.

Products table

There are three columns in the table:

® region of product in the sequence
® product length
® preferred annealing temperature

Click the product for navigating to its region in the sequence.

Click the Extract product(s) button for exporting a product(s) in a file or use double click for that.
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Region Llength Ta

0522 -63999 3178 55,56

< i |/ b

Extract product(s)

® Primers Details
® Primer Library

Primers Details

Click Show primers details for seeing statistic details about primers.

4K

Mismatches 10 bp

* Settings

Maximum product 5000 bp :

Show primers details /

The following dialog will appear:
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-
% Primers Details

EE=)

Criteria
B GC

Tm (°C)
GC Clamp
Runs

Self-dimers:

Hetero-dimers:

Delta G: -16 kcal/mole Base Pairs: 13

Valid Values

50-60

55-80

»>=1Gor Cat3 end
<=4 base runs

Delta G: -9.3 kcal/mole Base Pairs: 7

AGGICAGETTACCCAC
| |
ACTACCCGARGGGRR

A

Delta G: -6.2 keal fmole Base Pairs: 3

ARRTGRAGGRARARRRTGCTARGGGC

I11&
GACCG

AGEICAGEITACCCACAARGGEARGCCCATCA
[ L A 111
GACCGRACGCECARTCCTARRAAACGCARCTARR

e

Forward Reverse
53.12 41.94
65.67 &0.4

2 4
3 &
ok [ e |

]

This is a dialog with statistic details about primers: melting temperature, GC content, dimers, self-dimers, etc. If a value is not correct for its

criteria then it is colored in red.

Primer Library

The primer library is a storage for keeping user primers. The added primers are stored between UGENE sessions.

Go to the Tools->Primer->Primer library context menu to configure the primer library. The following window will appear:
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]
(g

-
-* UGEME - [Primer Library]

m File Actions Settings Tools  Window Help |;||i||i|
8o H
Mame GC-content (%) Tmi (°C) Length (bp) Sequence Mew primer
CE R T [T =
Prirmer 1 5263 51.09 19 GTCCCACTGTACGTTTACG Remove primer(s)
Test Primer 375 59.26 32 ACGTTTACGTACGATTCGATACACATAGACAT Import primer(s)
Expart primer (s)

Close

Help

| @ 2: Tasks || L] 3:Log | No active tasks ‘&' [

o —— = —— 4

Click the New primer button to add a new primer. The following dialog will appear:

i B
(] Create New Primer m

E 3

Mame Mew Primer

K Cancel ] [ Help

L A

Input the primer sequence and primer name and click on the OK button.
Select the primer and click the Edit primer button to edit primer.
Select the primer in the table (you can use Ctrl and Shift) and click Remove primer(s) button to remove primer(s).

To export primer(s) select it and click the Export primer(s) button. The following dialog will appear:

i T
Export Primers M

Export to: [LOE| file - ]

Format: [genbank - ]

File path: || E]

[ K ] [ Cancel ] [ Help ]

L A

Select file and file format and click on the OK button.

To import primer(s) click the Import primer(s) button. The following dialog will appear:
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~

[} Import Primers I. 2 |ﬁ]
Import from: [Lucal file(s) T]
Files: Add file(s)
Remove
Import Cancel ] [ Help

L

Add one or several files with primer sequences. Note that all sequence formats, supported by UGENE, can be imported, for example,
FASTA, GenBank, etc. But the sequences must consist of ACGT characters only.

Click the Import button to import the added files into the primers library.

Secondary Structure Prediction

The Secondary Structure Prediction plugin provides a set of algorithms for the protein secondary structure (alpha-helix, beta-sheet)
prediction from a raw sequence.

Currently available algorithms are:

® GORIV Jean Garnier, Jean-Francois Gibrat, and Barry Robson,”"GOR Method for Predicting Protein Secondary Structure from Amino
Acid Sequence”, in Methods in Enzymology, vol.266, pp. 540 - 553, (1996).

Improved version of the GOR method in J. Garnier, D. Osguthorpe, and B. Robson, J. Mol. Biol., vol. 120, p. 97 (1978).
® PsiPred Bryson K, McGuffin LJ, Marsden RL, Ward JJ, Sodhi JS. & Jones DT. (2005) Protein structure prediction servers at
University College London. Nucl. Acids Res. 33(Web Server issue):W36-38.

Jones DT. (1999) Protein secondary structure prediction based on position-specific scoring matrices. J. Mol. Biol. 292: 195-202.

You can access these analysis capabilities for a protein sequence using the Analyze Predict secondary structure... context menu item. The
dialog will appear:
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* Secondary Structure Prediction

Algorithm |GORIV -
Range Start: IG Range End: IE
Results:

Reqgion Structure Type

Total predicted: 0

Help | Cancel Predict

It supports the following options:

Algorithm — you can choose the preferred algorithm. Currently, “GORIV” and “PsiPred” algorithms are available.
Range start / Range end — select the sequence range for prediction.

Results — visual representation of the prediction results, for example:
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* Secondary Structure Prediction >

Algorithm 'GORIV |
Range Start: IG Range End: IE
Results:
Region Structure Type
1¢[5..7] beta strand
2|[9..15] beta strand
; [24.32] alpha_helix
: [39..75] alpha_helix
? [75..81] beta strand

Total predicted: 5

Help Save Cancel Predict

Save as annotation — select this button to save the results as annotations of the current protein sequence.

SITECON

SITECON — is a program package for recognition of potential transcription factor binding sites basing on the data about conservative
conformational and physicochemical properties revealed on the basis of the binding sites sets analysis.

To cite SITECON use the following article:

“Oshchepkov D.Y., Vityaev E.E., Grigorovich D.A., Ignatieva E.V., Khlebodarova T.M.SITECON: a tool for detecting conservative
conformational and physicochemical properties in transcription factor binding site alignments and for siterecognition. //Nucleic Acids Res.
2004 Jul 1;32(Web Server issue):W208-12."

UGENE version of SITECON provides a tool for recognition of potential binding sites for over 90 types of transcription factors. Also UGENE
version of SITECON provides a tool for recognition of potential binding sites basing site alignment proposed by user. For the detailed method
description see the original SITECON site.

Data about used context-dependent conformational and physicochemical properties are available in the PROPERTY Database.

® SITECON Searching Transcription Factors Binding Sites
® Types of SITECON Models

® Eukaryotic

® Prokaryotic
® Building SITECON Model

SITECON Searching Transcription Factors Binding Sites
To search transcription factor binding sites in a DNA sequence select the Analyze Search TFBS with SITECON... context menu item.

In the appeared search dialog you must select a file with TFBS profile. The profiles supplied with UGENE are placed in the $UGENE/data/sit
econ_models folder.

After the profile is loaded the threshold-filter is populated with values read from profile. You can use the filter to remove low-scoring regions
from the resuilt.
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' !
%, SITECON Search L2 [

File with model E]

Threshold - ]
"
Strands Region
@ Both strands Whole sequence -
(") Direct strand 1 - 199950

i) Complement strand

Range Strand PSUM First type error Second type error

Clear results | |5ave as annotations

0 results found

Search ] [ Close ] [ Help ]

L -

The regions found by SITECON algorithm can be saved as annotations to the DNA sequence in the Genbank format.

Every SITECON profile supplied with UGENE contains complete information about calibration settings provided to UGENE team by the
author of SITECON.

The original TFBS alignments used to calculate profiles can be requested directly from the author of SITECON.

Types of SITECON Models

® Eukaryotic
® Prokaryotic

Eukaryotic

Name Description

CEBP_a CCAAT-enhancer-binding protein_alpha

CEBP_all CCAAT-enhancer-binding proteins

CLOCK Circadian Locomotor Output Cycles Kaput

cMyc_can Myc (c-Myc) is a regulator gene that codes for a transcription
factor. A mutated version of Myc is found in many cancers.

CRE Cyclic AMP response element

E2F1 Transcription factor E2F1 is a protein that in humans is encoded by
the E2F1 gene.

E2F1/DP1sell E2F factors bind to DNA as homodimers or heterodimers in

association with dimerization partner DP1.
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EGR1
EKLf
ER2

GATA _all

GATA-1
GATA-2
GATA-3
HMG-1
HNF-1
HNF-3
HNF-4
IRF
isre

MyoD

MyOGsel3
NF-1

NF-E2

NFATp

NFkB_all

NFkB_hetero

NFkB_ homo

Nfy

Nrf2
Oct-1
Oct_all
p53
PPRF
Pul
setCREB
setCREBzag
SRE_san
SRF
STAT1

STAT
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Early growth response protein 1
Erythroid Kruppel-like Factor
Estrogen receptor beta

GATA transcription factors are a family of transcription factors
characterized by their ability to bind to the DNA sequence “GATA”

GATA-binding factor 1

GATA-binding protein 2

Trans-acting T-cell-specific transcription factor GATA-3
High-mobility group protein 1

Hepatocyte nuclear factor 1

Hepatocyte nuclear factor 3

Hepatocyte nuclear factor 4

Interferon regulatory factors

Interferon stimulation response element

MyoD belongs to a family of proteins known as myogenic
regulatory factors (MRFs)

Myogenin
Neurofibromin 1

Transcription factor NF-E2 45 kDa subunit is a protein that in
humans is encoded by the NFE2 gene.

Pre-existing component of the NFAT(Nuclear factor of activated
T-cells) transcription complex.

Nuclear factor kappa-light-chain-enhancer of activated B cells

The p50 (NFKB1)/p65 (RELA) heterodimer is the most abundant
form of NF-kB

The c-Rel protein is a member of the NF-kB family of transcription
factors and contains a Rel homology domain

Nuclear transcription factor Y

Nuclear factor (erythroid-derived 2)-like 2
Octamer transcription factor 1

Octamer transcription factors

Protein 53

Paramedian pontine reticular formation

Is a protein that in humans is encoded by the SPI1 gene
CAMP response element-binding

cAMP response element-binding

Serum response element

Serum response factor

Signal Transducer and Activator of Transcription 1

Signal Transducer and Activator of Transcription
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TTF1

USF

yyl
Prokaryotic

Name

AgaR

AgaC

ArcA

ArgR

CpxR

Crp
CysB
CytR
DeoR

DnaA

FadR
fis
FIhDC

Fnr

Frur
FUR
GALR
GALS
GLPR
GNTP
HNS
ICLR
IHF
ISCR1
ISCR3

LEXA
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Thyroid transcription factor 1
Upstream stimulatory factors

Is a protein that in humans is encoded by the YY1 gene

Description

N-acetylgalactosamine repressor, AgaR, negatively controls the
expression of the aga gene cluster

AgacC is the Enzyme IIC domain of a predicted
N-acetylgalactosamine-transporting PEP-dependent
phosphotransferase system

ArcA transcriptional dual regulator

ArgR complexed with L-arginine represses the transcription of
several genes involved in biosynthesis and transport of arginine,
transport of histidine, and its own synthesis and activates genes for
arginine catabolism.

DNA-binding response regulator in two-component regulatory
system with CpxA

cAMP receptor protein
Cysteine B

Cytidine Regulator
Deoxyribose Regulator

DnaA is the linchpin element in the initiation of DNA replication in
E. coli.

Fatty acid degradation Regulon
Factor for inversion stimulation
Operon that encodes two transcriptional regulators

FNR is the primary transcriptional regulator that mediates the
transition from aerobic to anaerobic growth through the regulation
of hundreds of genes.

Fructose repressor

Ferric Uptake Regulation

Galactose repressor

Galactose isorepressor
sn-Glycerol-3-phosphate repressor

Is a member of the GntP family transporters
Histone-like nucleoid structuring protein
Isocitrate lyase Regulator

Integration host factor

Iron-sulfur cluster Regulator 1
Iron-sulfur cluster Regulator 3

LexA represses the transcription of several genes involved in the
cellular response to DNA damage or inhibition of DNA replication
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Lrp

MALT
MARA
MELR

MEtJ

MetR1

MLC

MODE

NAC
NAGC_new?2
NANR
NARL2
NARL

NARP

NIRC

OmpC
OxyR

PHOB

PHOP

PurR

RcsB_1
RcsB_2
Rob2
ROB

SOXS

TORR
TRPR

TyrR

Building SITECON Model
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Leucine-responsive regulatory protein
Maltose regulator

Multiple antibiotic resistance
Melibiose regulator

MetJ represses the expression of genes involved in biosynthesis
and transport of methionine

MetR participates in controlling several genes involved in
methionine biosynthesis [ Weissbach91 ] and a gene involved in
protection against nitric oxide

DgsA, better known as Mic, “makes large colonies,” is a
transcriptional dual regulator that controls the expression of a
number of genes encoding enzymes of the Escherichia coli
phosphotransferase (PTS) and phosphoenolpyruvate (PEP)
systems

Molybdate-responsive transcription factor
Nitrogen assimilation control
N-acetylglucosamine
N-acetyl-neuraminic acid regulator
Nitrate/nitrite response regulator NarL
Nitrate/nitrite response regulator NarL
Nitrate/nitrite response regulator NarP

NirC is a nitrite transporter which is a member of the FNT family of
formate and nitrite transporters

OmpC is a member of the GMP family
Oxidative stress regulator

PhoB is a dual transcription regulator that activates expression of
the Pho regulon in response to environmental Pi

Member of the two-component regulatory system phoQ/phoP
involved in adaptation to low Mg2+ environments and the control of
acid resistance genes

PurR dimer controls several genes involved in purine nucleotide
biosynthesis and its own synthesis

Regulator capsule synthesis B
Regulator capsule synthesis B
Right origin-binding protein
Right origin-binding protein

SoxS is a dual transcriptional activator and participates in the
removal of superoxide and nitric oxide and protection from organic
solvents and antibiotics

TorR response regulator
Tryptophan (trp) transcriptional repressor

Tyrosine repressor
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http://biocyc.org/ECOLI/substring-search?type=NIL&object=NARL&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=NARP&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=NIRC&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=OmpC&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=OxyR&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=PHOB&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=PHOP&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=PurR&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=RcsB&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=RcsB&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=ROB&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=ROB&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=soxS&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=TORR&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=TRPR&quickSearch=Quick+Search
http://biocyc.org/ECOLI/substring-search?type=NIL&object=TyrR&quickSearch=Quick+Search
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To build a new SITECON model call the Tools->SITECON->Build new SITECON model from alignment main menu item. The following dialog
will appear:

[¥] seEcon suild R
Input alignment {nudeic) E]
Qutput model E]

Options
Window size 40bp =

Calibration random seed
Calibration sequence length

Weight algorithm

Default status

J [ Cancel

Here you need to select a nucleotide alignment and an output model. Optionally, you can change other parameters. After that click on the Bu
ild button.

Smith-Waterman Search

The Smith-Waterman Search plugin adds a complete implementation of the Smith-Waterman algorithm to UGENE.

To use the plugin open a nucleotide or protein sequence in the Sequence View and select the Analyze Find pattern [Smith-Waterman] item
in the context menu. The Smith-Waterman Search dialog appears:

& Smith-waterman Search -

[ Smith-waterman parameters l Input and output

Enter pattern here

search in strand Region
® Sequence © Both - 1
. | whole sequence gl
O Translation @ Direct [ l [ ]
- 1] - 199950
' Complement
Smith-waterman algorithm parameters
Algorithm version  Scoring matrix Gap scores Results Filtering strategy

| Classic 2 ol | |jdna < | Gap open | Report results | filter-int < |

[ view.. | Gap extension ED Minimal score |

| Help | | Cancel | | Search |

First of all you need to specify the pattern to search for. The rest parameters are optional:
Search in — select either to search in the sequence or in its translation.
Strand — select the strand to search in: direct, complementary or both strands.

Region — specifies the region of the sequence that will be used to search for the pattern. By default, if a subsequence has been
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selected when the dialog has been opened, then the selected subsequence is searched for the pattern. Otherwise, the whole
sequence is used. You can also input a custom range.

Algorithm version — version of the algorithm implementation. Non-classic versions produce the same results as classic but much
faster. To use these optimizations our system must support these capabilities.

® Classic 2
® SSE2
* CUDA
®* OPENCL

Scoring matrix — can be chosen from a bunch of matrices supplied with UGENE. To view a matrix selected click the View button.
Gap open — penalty for opening a gap.
Gap extension — penalty for extending a gap

Report results — simple heuristic which allows to filter intersected hits. If it is set to none, the algorithm may report large set of almost
identical results in the same region.

Minimal score — another simple heuristic which measures sequences similarity. It is more convenient than using some abstract
scores. If set to 100%, the algorithm will search for exact substring match.

The results of the search are saved as annotations or as multiple alignment. To set the saving parameters go to the Input and output tab of
the dialog.

If you want to save the results as annotations input the annotations saving parameters (Annotation name, Group name, Annotation type,
Description and a file to save the annotation to). Also you can add qualifier with corresponding pattern subsequences to result annotations.
Check the corresponding checkbox for it.

If you want to save the results as multiple alignment select the following parameters:

* Smith-Waterman Search 5

Smith-Waterman parameters In put and output |

<

Save results as |'An notations

~ Save annotation(s) to

@ Create new table [,fhomefyalgaerjMyDocument.gb l |:|

~ Annotation parameters

Group name [<aut0>

Annotation type |iMi5c. Feature e

Annotation name [

Description [

[ Add qualifier with corresponding pattern subsequences to result annotations

Help Cancel | | Search |

Here you can select a file to save the alignment to (Alignment files directory path parameter).
Using the Set advanced options checkbox you can select the saving options.

You can set the different templates for files names: create your own or create by using the following: [E] — adds a subsequence end
position, [hms] — adds a time, [MDY] — adds a date, [S] — adds a subsequence start position, [L] — adds a subsequence length, [SN] —
adds a reference sequence name prefix, [PN] — adds a pattern sequence name prefix, [C] — adds a counter.

You can create templates for alignment files names, reference subsequence names, pattern subsequence names and for pattern sequence
name:
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.z File Actions Settings Tools Window Help =&
R H & & & s F B E PG 9
Project x
MName filter T
i . Consensus —
Objects Reference subsequence ACGTACG -
4 [[] human_T1 fa -"_"—-——_.____.‘ 1 2 3 4 565 7 ¢
‘;\ -
P.:; Ls]humaTrl_Tll (IUCSC Aptl 2002 \Chuman T1 57274 57281 [1 A CFA C 8]
uman, =11
l (Zs == TAC ATC 7
i [m] P1_human_T1_1 ](Pl L7 L ) ]
\ Pattern subsequence
4 4 ¥
Find: <= Alignment = Ln1/2 Col1/8 Pos1/8 |

HMM2

The HMM2 plugin is a toolkit based on the Sean Eddy’'s HMMER2 package.
While working on this plugin we were guided by the following principles:

* Make the HMMER?2 tools accessible to a wider user audience by providing graphical interface for all supported utilities for most of
the platforms.

® Be compatible with the original HMMER2 package.

® Create the high-performance solution utilizing modern multi-core processors and SIMD instructions.

The current version of UGENE provides user interface for three HMM2 tools: HMM build, HMM calibrate and HMM search.
In the original program the corresponding commands are: “hmmbuild”, “hmmcalibrate” and “hmmsearch”.
To access these tools select the Tools HMMER?2 tools submenu of the program main menu:

e ——
Tools | window  Help

|} Create index file | | [G-:u! ] & 4
izt DNA Assembly T 001363 sequence
| ] i i b + + +
[Zas ‘Weight matrix . B o
—|ie" HMERZools b | HM build NP 0
7] S50 SITECON ¢ HMM calibrate
n| ey HYMERS tools b HMM search

1.5k
Workflow Designer s o

We highly recommend reading the original HMMER2 documentation to learn how to use utilities provided by the plugin.

1 SSE2 algorithm is implemented by Leonid Konyaev, Novosibirsk State University. Use of the SSE2 optimized version of the HMM
search algorithm with quad-core CPU gives >30x performance boost when compared with the original single-threaded algorithm
(single sequence mode).

® Building HMM Model (HMM Build)
® Calibrating HMM Model (HMM Calibrate)
® Searching Sequence Using HMM Profile (HMM Search)

Building HMM Model (HMM Build)

HMM build tool is used to build a new HMM profile from a multiple alignment.

You can use any alignment file formats supported by UGENE. The output HMM profile format is compatible with the HMMER2 package.
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g
[ HMM Build

)

Multiple alignment file:

File to sawve HMM profie:
[] Expert options
Mame this HMM:
Default (hmmls) behaviour:
Emulate hmmfs behaviour:
Emulate hmms behaviour:

Emulate hmmsw behaviour:

L]
L]

[ Build ] [ Close ] [ Help

1 The HMM build tool does not automatically calibrate a profile. Use the HMM calibrate tool to calibrate the profile.

Calibrating HMM Model (HMM Calibrate)

The HMM calibrate tool reads a HMM profile file, scores a large number of synthesized random sequences with it, fits an extreme value
distribution (EVD) to the histogram of those scores, and re-saves the hmm file including the EVD parameters.

To avoid modification of the original HMM file you can select a new location for the calibrated profile.

g
[ HMM Calibrate

HMM file:
|:| Expert options

Mean length of the synthetic sequences:

Mumber of synthetic sequences:
Standard deviation:

Random seed:

[ save calibrated profile to file:

Fix the length of the random seguences to:

5000

200.00

[ Calibrate H Close ][

Searching Sequence Using HMM Profile (HMM Search)

The HMM search tool reads a HMM profile from a file and searches the sequence for significantly similar sequence matches.

The sequence must be selected in the Project View or there must be an active Sequence View window opened.

If the selected sequence is nucleic and the HMM profile is built for amino alignment, the sequence is automatically translated and all 6

translations are used to search in.

If a HMM profile is built for nucleic alignment, the search is performed for both strands (direct and complement).
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i - A
9, HMM Search L2 |

File with HMM profile: E]

* Sgve annotation(s) to

@ Existing table ’ (9 MNC_001363 features [murine.gb] hd l @

() Create new table

Use auto-annotations table

|| ¥ Annotation parameters

Group name <auto > |

Annotation type | Misc. Signal v]

Annotation name  hmm_signal

Description

Expert options

Filter results with E-value greater then: le-1 %
Filter results with Score lower than: 0.0 =
Mumber of sequences in dababase: 1%

Algorithm SSE optimized -

[ Search ][ Close ][ Help ]

"

The search results are stored as sequence annotations in the Genbank file format.

) NC_000964 sequence

B T O ce[E8] @ & & &

2342436 23426k 23427k | 23428k 23429k 2343k 23431k 23432k 23433k 2343 464

Mame Value

= (_‘9 Annotations [MyDocument.gb] *
=% hmm_signal (0, 2)

=+ [ hmm_signal
E-value
HMM-model
Score

B hmm_signal

2342756..2342992
L.4e-007

fn3

22.8
2257566,.2257944

¢ NC_000%64 features [bsub.gbk]

{D All HMM2 UGENE tools work only with files that contain a single HMM model.

HMM3
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The HMM3 plugin is a toolkit based on the Sean Eddy’'s HMMERS3 package.
While working on this plugin we were guided by the following principles:

* Make the HMMERS3 tools accessible to a wider user audience by providing graphical interface for all supported utilities for most of
the platforms.

® Be compatible with the original HMMER3 package.

® Create the high-performance solution utilizing modern multi-core processors.

The current version of UGENE provides user interface for three HMM3 tools: HMM3 build, HMM3 search and Phmmer search.
In the original program the corresponding commands are: “hmmbuild”, “hmmsearch” and “phmmer”.

To access these tools select the Tools HMMERS3 tools submenu of the program main menu:

fafs = Window  Help

::l, Create index file b Ca Ea
= izt DA Assembly
h
E_.;.l Weight matriz ~ » Elen) O ¢t
e’ HMMERZtocls b | aok 100k
49 SITECOM ’
[ HMMERS tonls  » TR
workflow Designer Search HMM signals

............................................. F'|‘|IT|IT|EI’ Search

TT I [al e T ™ el T T

We highly recommend reading the original HMMER3 documentation to learn how to use utilities provided by the plugin.

® Building HMM Model (HMM3 Build)
® Searching Sequence Using HMM Profile (HMM3 Search)
® Searching Sequence Against Sequence Database (Phmmer Search)

Building HMM Model (HMM3 Build)

The HMM3 build tool is used to build a new HMM profile from a multiple alignment. You can use any alignment file formats supported by
UGENE.

The output HMM profile format is compatible with the HMMER3 package, but it is not compatible with the HMMER?2.

The HMM3 build automatically calibrates the target model.

[0 Hmm3 Build [ 2 [

Input and output | Construction strategies I Relative weighting Effective weighting E-value calibration I Other |

Input alignment file E]

Build to profile [:]

Build ][ Cancel ][ Help

The HMM3 configuration dialog provides an easy way to set appropriate search parameters.

Here you can see effective weighting strategies options:
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[0 Hmm3 Build -2 S

| Input and output I Construction strategies I Relative weighting Effective weighting E-value calibration I Other |

@ Adjust effective sequence number to achieve relative entropy target
Minimum relative entropy/fposition 0.00
Sigma parameter 45,00
") Use number of single linkage dusters as effective Fractional identity cutoff (0,62
*) Use number of sequences as effective

" Effective sequence number for all models to

Searching Sequence Using HMM Profile (HMM3 Search)

The HMM3 search tool reads a HMM profile from a file and searches a sequence for significantly similar sequence matches.
The sequence must be selected in the Project View or there must be an active Sequence View window opened.

If the selected sequence is nucleic and profile HMM is built from amino alignment, the sequence will be automatically translated and
searched in all possible frames (6 totally).

If a profile HMM is built for nucleic alignment, the search is performed for both strands (direct and complement).

The HMM3 search accepts the HMMER2 HMM profiles (amino only) as a backward compatibility feature. An interesting post about using the
HMMER2 models with the HMMERS is available on the Sean Eddy’s blog.

i ™y
[ HMMS Search [

Input and output | Reporting thresholds Acceleration heuristics | Cither |

Query profile HMM file: E]
 Save annotation(s) to
@ Existing table | (5 NC_014267 features [NC_014267.1.gb] ~| &)
) Create new table
Lse auto-annotations table '
| * Annotation parameters 1
Group name <auto >
Annotation type | Misc. Signal v]
Annotation name  hmm_signal
Description
[ Run ] l Cancel ] [ Help
L A

For example, reporting thresholds options can be configured using the dialog:
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i B’
[¥] HMM3 Search L2 ||

| Input and output | Reporting thresholds Acceleration heuristics I Other |

Ak

@ Report domains with E-value less than 1E+1
(") Report domains with score greater than

i@ Score threshold: 0.01
IUse profile's GA gathering cutoffs
|Use profile's NC noise cutoffs
Use profile's TC trusted cutoffs

[7] Mumber of significant sequences for domain E-value calculation 0.00

Fun ][ Cancel ][ Help J

L A

The search results are stored as sequence annotations in the Genbank file format.

(9 qi|2136280|pir| |I38344 kitin - hurman

1 200k 400k GO0k GO0k im 1.2m 1.4m 1.6m 1.8m 2m 2.2m 2.4m 2.6m 2.8m

j';'.E.‘E.‘ ............. 095 Tk L= mo o s nz0 23 30 3 a0 A4S 0
4
Mame 4| value

- @ annotations [MyDocument_3.gb] *
=@ hmm_signal (0, 24024

[+ @ hmm_signal 6594, 667
[+ @ hmm_signal 6695, 6751
[+ @ hmm_signal 6796, 6EEZ
[+ @ hmm_signal 6992, 7076
=@ hmm_signal 092, 7177
> Accuracy per residue 9.76351e-01
- Bias 3.53754e-02

Zonditional e-value 5.96204e-17
Envelope of domain lacation 7091,..7177
HMM model fr3 Accession number in PRAM database: PFOOO41

- HMM redgion 1..87

Independent e-value 1.89874e-17

e SCOME 49,864132
[+ @ hmm_signal T266,.7372
[+ @ hmm_signal T3E7..7473

(D The HMM3 search works only with files that contain a single HMM model.

Searching Sequence Against Sequence Database (Phmmer Search)

The Phmmer search tool searches for query sequence matches in sequence database, much as BLASTP or FASTA would do.

The Phmmer search works essentially like the HMM3 search does, except you provide a query sequence instead of a query profile HMM.

The database sequence must be selected in the Project View or there must be an active Sequence View window opened.

Select the query sequence in the Phmmer search dialog:
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L

i @ ™
[T ehmmer Search uﬂ
Input and output | Reparting tresholds Scoring system Acceleration E-value calibration I Other |
Query sequence file: E]
» Save annotation(s) to
Existing table - | [
@ Create new table  C:/Users/yalgaerMyDocument.gb E]
 Annotation parameters
Group name <auto=
Annotation name  signal T‘
[ Search ] [ Cancel ] [ Help
S -

You can set options of the Phmmer search by choosing the needed dialog tab. Here you can see the e-value calibration options:

rm Phmmer Search uﬂ@ A
| Input and output | Reporting tresholds Scoring system Acceleration E-value calibration Other
Length of sequences for MSY Gumbel mu fit 200 =
Mumber of sequences for M5V Gumbel mu fit 200 =
Length of sequences for Viterbi Gumbel mu fit 200 =
Mumber of sequences for Viterbi Gumbel mu fit 200 =
Length of sequences for Forward exp tail mu fit 100 =
Mumber of sequences for Forward exp tail mu fit 200 =
Tail mass for Forward exponential tail mu fit 0.04(%
[ Search J [ Cancel ] [ Help
L5 S

The results are stored as sequence annotations in the Genbank file format.
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(9 0|21 36250 pir | 13534 titin - human

1 200k 400k GO0k EEEIIIIIk

L

40569 40575 40580 40585

im

IhllllIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII
— - } + } J + } + t t }
1.2m

1.4m 1 .Em 1.8m 2m 2.2m

- Ervelope of darmain lacakion

....................................................................... 40590 40395 406k 40603 40610 40815 4062
Rl
Marme Walue
- @) Annotations [MyDocument_3.gb] *
-G signal (0, 5461
[+ W signal 9751,.9856
W signal 10471..10549
[+ W signal 13660, 13717
[+ W signal 36707..36752
[+ W signal 37307..37475
=W signal 40556, . 406473
- Bocuracy per residus 8.02474e-01
- Bias 1.38025e-0z
- Conditional e-value 1.346534e-01

40579, . 40645

- HVIM Fegion o04,,.858
- Independent e-value 1.34634e-01
- QIIEryY seqUence fibroneckin_1.2_1
- SCare -3.513604
[=}- M signal 63633, 63703
- Bocuracy per residus F.36235e-01
- Bias 4,17314e-03

(D The Phmmer search works only with single-sequence databases.

uMUSCLE

UGENE contains graphical ports of the Robert C. Edgar's MUSCLE tool for multiple alignment.

1 MUSCLE4 is not supported since UGENE version 1.7.2.

The package is integrated completely, so there is no need in extra files for using it. It is possible to run several multiple alignment tasks in

parallel, check the progress and cancel the running tasks safely.

1 The k-mer clustering part of the MUSCLE algorithm was optimized for multicore systems by Timur Tleukenov, Novosibirsk State

Technical University.

® MUSCLE Aligning
® Aligning Profile to Profile with MUSCLE
® Aligning Sequences to Profile with MUSCLE

MUSCLE Aligning

To run the classic MUSCLE use the Align Align with MUSCLE context menu item in the Alignment Editor.

it L, TACCACTAATATT A
: T = 7~ T T T A& A& T A& & T T
= align » [T Align with MUSCLE

[y Statistics 3

M
Wiew J [m
K

Align sequences to praofile wikh MUSCLE

Align profile ko profile wikh MUSCLE

Advanced r Align with kalign


http://www.drive5.com/muscle
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The dialog contains the list of MUSCLE modes: MUSCLE default, Large alignment, Refine only.

“: Align with MUSCLE R

Mode |MUSCLE default -

Mode details:
The default settings are designed to give the best accuracy

Command line: muscle

Advanced options

Do not re-arrange sequences (-stable)

|:| Max iterations 2
[] Max time {minutes) 5
[] Translate to amino when aligning

Translation table: | 1. The Standard Genetic Code

Region to align
@ Whole alignment

() Column range 1= - 604 =

Align ][ Cancel H Help

By default UGENE does not rearrange sequence order in an alignment, but the original MUSCLE package does. To enable
sequence rearrangement uncheck the Do not re-arrange sequences (-stable) option in the dialog.

One of the improvements to the original MUSCLE package is the ability to align only a part of the model. When the Column range item is
selected the region of the specified columns is only passed to the MUSCLE alignment engine. The resulted alignment is inserted into the
original one with gaps added or removed on the region boundaries.

1 Tovisually select the column range to align, make a selection in the alignment editor first. Then invoke the MUSCLE plugin. Its
column range boundary values will automatically match the given selection.

Aligning Profile to Profile with MUSCLE

The Align Align profile to profile with MUSCLE context menu item allows to align an existing profile to an active alignment. During this
process the MUSCLE does not realign the profiles, but inserts columns with gaps characters only (‘—' characters). For example, the
alignment in the picture below could be used as a profile:
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Consensus
ATGGCACATCCCtCaCA+cTAGGaTTCCAAGACGC+CcTCaC+
lIZI' -: ‘:' E:‘ I:C 1:2 1:-' 1:’.' 1:5 2:3 2‘2 2:4 2:? 2:5 3:3 3‘2 ’I-' ’I’ 3:5 -':3 :-—:’
Loach [1aTleecacaTcccacacaaTTAlgEATTCCAA ccTcacc
Tuna [1aTEEcAcATCCCTCBlcABlcTABEATTCCAA CACTTCACT
Trout [1ATIEGECACATCCCTCACAACTAGGEGATTCCAA ceccTcceT
Eel [1ATGEBCACATCCCTCACACTABETTTCCAA CACCTCACC

The same profile after profile-to-profile alignment:

Consensus CCctcaCAactAGGEttT+CAAGAcCGCagCcTCacCca
1:3 1:2 1:- 1:’ 1:3 2:3 2‘2 2:-— 2:’ 2:3 3:3 3‘2 3‘-' 3" ":‘: :" :" : %

Loach cccalcaldanfiTalEB@aTTceaaffalc -lceTtcalce-

Tuna cccTclEcAl@CTAGGATTCCAAGAT -leTTcaleT -

Trout cccrcaldancTalBl@aTicc A aldalc -ccTcccT -

Eel cccTcaca@cTalGETTTCCAAGAC ccTcacc

|Seahorse EccrcacaacTa TTiTCcaAalfac

| Salamander EcalTcacaaTTalBETTTTCAABAC

|Frog CEcaTecacaaTTABETTTTCAABAC

| Panda CCCTTTCAAACAGGCCTTCAAGATGCAACTTCCCC

There are two gap columns inserted into the source profile, and two gap columns inserted into the added one. Therefore the profiles columns
kept intact and the alignments haven’t been changed.

1 Aligning a profile to the active alignment you will modify the original alignment file, since it will contain 2 profiles after the operation
is completed.

Aligning Sequences to Profile with MUSCLE

Another feature provided by the plugin is aligning a set of unaligned sequences to an existing profile. To use this feature select the Align
Align sequences to profile with MUSCLE context menu item.

This option is not available in the original MUSCLE package (v3.7) and is a new functionality for original MUSCLE users. In this mode each
sequence from the input file is aligned to the active profile separately and is merged to the result alignment only after all sequences are
processed. For example, the alignment in the picture above can be used as a profile again. And the added profile can be used as a set of
sequences. The result of such sequences-to-profile alignment is presented on the picture below:

Consensus
ATGGcaCatCCctcaCAactAGGttT+CAAGAcCcGCagccTcacCca
D T S S S
Loach [1AT aAlc A ccacalcaaTTa aATTtccaaldalc Sele A Bk - -
Tuna [1AT ACA ccTtclgcalgcTa ATTCCAAlGAT chgnc el - -
Trout [1AT ACA CCTCACAACTA ATTCCAAlEAC cclcc el - -
Eel [1AT ACA cctcacaf@cTa TTTCccaalgac e Alee] - -
Seahorse [1AT CCTCACAACTA TTTTCAAlGAC A
Salamander [ 1 AT calTcacaaTTA TTTTCAAGAC A
Frog [1AT CAlTcaAcaATTA TTTTCAAGAC A
\Panda IL1AT CETTTCcAAAcA ccrrcaan@alT Al-lAcTTCCCCC

The original alignment is not modified, only columns with gap (—') character can be inserted.
The second profile was considered as a set of sequences and therefore is modified.

Note that if a file with another alignment is used as a source of unaligned sequences, the gap characters are removed and each input
sequence is processed independently.

This method is quite fast, for example an alignment of 3000 sequences (1000 bases each) to the existing profile takes about 5 minutes on
the usual Core2Duo computer.

ClustalWw

Clustal is a widely used multiple sequence alignment program. It is used for both nucleotide and protein sequences. ClustalW is a
command-line version of the program.
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Clustal home page: http://www.clustal.org

If you are using Windows OS, there are no additional configuration steps required, as ClustalW executable file is included to the UGENE
distribution package. Otherwise:

® |Install the Clustal program on your system.
® Set the path to the ClustalW executable on the External tools tab of UGENE Application Settings dialog.

Now you are able to use Clustal from UGENE.

Open a multiple sequence alignment file and select the Align with ClustalW item in the context menu or in the Actions main menu. The Align
with ClustalW dialog appears (see below), where you can adjust the following parameters:

Gap opening penalty — cost of opening up a new gap in the alignment. Increasing this value will make gaps less frequent.
Gap extension penalty — cost of every item in a gap. Increasing this value will make gaps shorter.
Weight matrix — specifies a single weight matrix for nucleotide sequences or series of matrices for protein sequences.

For nucleotide sequences the weight matrix selected defines the scores assigned to matches and mismatches (including 1UB
ambiguity codes), it can take values:

® |UB — default scoring matrix used by BESTFIT for the comparison of nucleic acid sequences. X's and N's are treated as
matches to any IlUB ambiguity symbol. All matches score 1.9; all mismatches for IUB symbols score 0.

® CLUSTALW — previous system used by ClustalW, in which matches score 1.0 and mismatches score 0. All matches for
IUB symbols also score 0.

For protein sequences it describes the similarity of each amino acid to each other. The following values are available:

® BLOSUM — BLOcks of Amino Acid SUbstitution Matrices first introduced in a paper by Henikoff and Henikoff. These
matrices appear to be the best available for carrying out data base similarity (homology searches).

®* PAM — Point Accepted Mutation matrices introduced by Margaret Dayhoff. These have been extremely widely used since
the late ‘70s.

® GONNET — these matrices were derived using almost the same procedure as the Dayhoff one (above) but are much more
up to date and are based on a far larger data set. They appear to be more sensitive than the Dayhoff series.

¢ |D — identity matrix which gives a score of 1.0 to two identical amino acids and a score of zero otherwise.

Iteration type — specifies the iteration type to use. During the iteration step each sequence is removed in turn and realigned. It is kept
if the resulting alignment is better than the one has been made before. This process is repeated until the score converges or until the
maximum number of iterations is reached. Available values are:

®* NONE — specifies not to use iterations.
®* TREE — specifies to iterate at each step of the progressive alignment.
®* ALIGNMENT — specifies to iterate on the final alignment.

Max iterations — maximum number of iterations.
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s Align with Clustalw P

Advanced options
Gap opening penalty
Gap extension penalty

Weight matrix

Iteration type

Out sequences order

Help Cancel Align

The following parameters are only available for protein sequences:

Gap separation distance — tries to decrease the chances of gaps being too close to each other. Gaps that are less than this distance
apart are penalized more than other gaps. This does not prevent close gaps; it makes them less frequent, promoting a block-like
appearance of the alignment.

Hydrophilic gaps off — increases the chances of a gap within a run of hydrophilic amino acids.
No end gap separation penalty — treats end gaps just like internal gaps to avoid gaps that are too close.

Residue-specific gaps off — amino acid specific gap penalties that reduce or increase the gap opening penalties at each position in
the alignment or sequence. For example, positions that are rich in glycine are more likely to have an adjacent gap than positions that
are rich in valine.

MAFFT

Originally, MAFFT is a multiple sequence alignment program for unix-like operating systems. However, currently it is available for Mac OS X,
Linux and Windows. It is used for both nucleotide and protein sequences.

MAFFT home page: http://mafft.cbrc.jp/alignment/software
To make MAFFT available from UGENE:

® Install the MAFFT program on your system.
® Set the path to the MAFFT executable on the External tools tab of UGENE Application Settings dialog.

For example, on Windows you need to specify the path to the mafft.bat file.

To use MAFFT open a multiple sequence alignment file and select the Align with MAFFT item in the context menu or in the Actions main
menu. The following dialog appears:
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e Align with MAFFT o

Advanced options

Gap opening penalty
Offset (works like gap extension penalty)

Maximum number of iterative refinement
Help Cancel Align

The following parameters are available:
Gap opening penalty — Gap opening penalty at group-to-group alignment.
Offset (works like gap extension penalty) — offset value, which works like gap extension penalty, for group-to-group alignment.
Maximum number of iterative refine — specifies the number of cycles of iterative refinement to perform.

T-Coffee

T-Coffee is a multiple sequence alignment package.

T-Coffee home page: T-Coffee
To make T-Coffee available from UGENE see the External Tools.

To use T-Coffee open a multiple sequence alignment file and select the Align with T-Coffee item in the context menu or in the Actions main

menu. The following dialog appears:

s Align with T-Coffee —

Advanced options
Gap opening penalty
Gap extension penalty

Number of iterations

Help Cancel Align

The following parameters are available:

Gap opening penalty — indicates the penalty applied for opening a gap. The penalty must be negative.
Gap extension penalty — indicates the penalty applied for extending a gap.

Number of iterations — specifies the number of iterations.

Bowtie

Bowtie is a popular short read aligner. Click this link to open Bowtie homepage. Bowtie is embedded as an external tool into UGENE.

Open Tools DNA Assembly submenu of the main menu.
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[ Tools ] Window Help

it Sanger data analysis L
7 NGS data analysis - Reads quality control...
=  BLAST 2
. ] ] L=t Genome de novo assembly...,
-2 Multiple sequence alignment | =
. .= Map reads to reference...
= Clening L - _
) L=t Build index for reads mapping...
Prirmer r

Select the Align short reads item to align short reads to a DNA sequence using Bowtie. Or select the Build index item to build an index for a
DNA sequence which can be used to optimize aligning of the short reads to the sequence.

® Bowtie Aligning Short Reads
¢ Building Index for Bowtie

Bowtie Aligning Short Reads

When you select the Tools DNA Assembly Align short reads item in the main menu, the Align Short Reads dialog appears. Set value of the
Align short reads method parameter to Bowtie. The dialog looks as follows:

. Y
[ align Sequencing Reads @lﬂj
Alignment method Bowtie - l
Reference sequence E
Result file name E
Library |Single-end + | [] Prebuilt index SAM output

Short reads
Path Type Order
[ Add ] [ Remove
Parameters Flags
ode 2 [ o o
[ Maq error (~magerr) 70 : [] Mo Mag rounding (--nomaground)
Mo forward orientation {—nofw

[ Seed length {-seedlen) 28 ] : :

[ Mo reverse-complement orientation {--norc)
[] Maximum of backiracks {—maxbts) 300

[] Try as hard (—tryhard)

Descriptors memory usage (—chunkmbs) |64 7] Best alignments (—best)
[[] seed (-seed) o [ all alignments (--all)
[ Start ] [ Cancel ] [ Help
e W & = 1 4 A

There are the following parameters:

Reference sequence — DNA sequence to align short reads to. This parameter is required.
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Result file name — file in SAM format to write the result of the alignment into. This parameter is required.
Library - single-end or paired-end reads.

Prebuilt index — check this box to use an index file instead of a source reference sequence. The index is a set of 6 files with suffixes
.1.ebwt, .2.ebwt, .3.ebwt, .4.ebwt, .rev.1.ebwt, and .rev.2.ebwt. The index is created during the alignment. Also you can build it
manually.

SAM output — always save the output file in the SAM format (the option is disabled for Bowtie).

Short reads — each added short read is a small DNA sequence file. At least one read should be added.
1 Short reads length for Bowtie can’t be more than 1024.
You can also configure other parameters. They are the same as in the original Bowtie (you can read detailed description of the parameters
on the Bowtie manual page).
Select one of the following alignment modes:

The -n alignment mode:

When the -n mode is selected, Bowtie determines which alignments are valid according to the following policy. Alignments may have
no more than N mismatches (where N is a number 0-3) in the first L bases (where L is a number 5 or greater, set with Seed length) on
the high-quality (left) end of the read. The sum of the Phred quality values at all mismatched positions (not just in the seed) may not
exceed E (set with Maq error). Where qualities are unavailable (e.g. if the reads are from a FASTA file), the Phred quality defaults to
40.

The -v alignment mode:

In -v mode, alignments may have no more than V mismatches, where V may be a number from 0 through 3. Quality values are
ignored. The -v mode is mutually exclusive with the -n mode.

The following parameters are available:

Magq error (-magerr) — maximum permitted total of quality values at all mismatched read positions throughout the entire alignment, not
just in the “seed”. The default is 70. By default, Bowtie rounds quality values to the nearest 10 and saturates at 30. Note that the
rounding can be disabled with No Mag rounding.

Seed Length (—seedlen) — the number of bases on the high-quality end of the read to which the -n applies. The lowest permitted
setting is 5 and the default is 28.

Maximum of backtracks (-maxbts) — the maximum number of backtracks (default: 125 without Best, 800 with Best). A “backtrack” is
the introduction of a speculative substitution into the alignment.

Descriptors memory usage (—chunkmbs) — the number of megabytes of memory a given thread is given to store path descriptors in
the Best flag. Default: 64. This parameter is available if the Best flag is checked.

Seed (-seed) — pseudo-random number generator.
The following flags are available:

Colorspace (—color) — the input is read in colorspace, colors are encoded as characters A/C/G/T (A=blue, C=green, G=orange,
T=red).

No Magq rounding (-nomaground) — Maq (Mapping and Assembly with Quality) accepts quality values in the Phred quality scale, but
internally rounds values to the nearest 10, with a maximum of 30. By default, Bowtie also rounds this way. No Maqg rounding prevents
this rounding in Bowtie.

No forward orientation (—nofw) — do not attempt to align against the forward reference strand.
No reverse-complement orientation (—norc) — do not attempt to align against the reverse-complement reference strand.
Try as hard (-tryhard) — try as hard as possible to find valid alignments when they exist, including paired-end alignments.

Best alignments (-best) — make Bowtie guarantee that reported singleton alignments are “best” in terms of stratum (i.e. number of
mismatches, or mismatches in the seed for the case of -n mode) and in terms of the quality values at the mismatched position(s).

All alignments (-all) — report all valid alignments per read or pair. Validity of alignments is determined by the alignment policy
(combined effects of -n mode, -v mode, Seed length, and Magq error).

Select the required parameters and press the Start button.
Building Index for Bowtie
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To build Bowtie index select the Tools NGS data analysis Build index for reads mapping item in the main menu. The Build Index dialog
appears. Set the Align short reads method parameter to Bowtie.

The dialog looks as follows:

[0 Build Index 2 [

Align short reads method Bowtie - ]

Reference sequence

Index file name

[7] colorspace

There are the following parameters:
Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.
Index file name — a file to save the created index to. This parameter is required.

Colorspace (—color) — the input is read in colorspace, colors are encoded as characters A/C/G/T (A=blue, C=green, G=orange,
T=red).

Bowtie 2

Bowtie 2 is a popular ultrafast and memory-efficient tool for aligning sequencing reads to long reference sequences. Click this link t0
open Bowtie 2 homepage. Bowtie 2 is embedded as an exteral tool into UGENE.

Open Tools Align to reference submenu of the main menu.

[ Tools ] Window Help

=t Sanger data analysis ¢
L=t NGS5 data analysis L Reads quality control...
~ BLAST .
_ _ L=t Genome de novo assembly...
. Multiple sequence alignment FiEE
) .= Map reads to reference...
= Cloning IR
. .= Build index for reads mapping...
Primer r

Select the Align short reads item to align short reads to a DNA sequence.

Or select the Build index item to build an index for a DNA sequence which can be used to optimize aligning of
the short reads to the sequence:

® Bowtie 2 Aligning Short Reads
® Building Index for Bowtie 2

Bowtie 2 Aligning Short Reads

When you select the Tools Align to reference Align short reads item in the main menu, the Align Sequencing Reads dialog appears. Set
value of the Align short reads method parameter to Bowtie 2. The dialog looks as follows:
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' N
[ align Sequencing Reads @ﬂ_hj
Alignment method Bowtie2 - ]
Reference sequence E]
Result file name E]
Library |Single-end = | [] Prebuilt index SAM output

Short reads
Path Type Order
[ Add ] [ Remove
Parameters Flags
Mode [ Mo unpaired alignments (—-no-mixed)
Mumber of mismatches 0 = [7] Mo discordant alignments (—no-discordant)
[7] seed length (1) 20 : [] Mo forward orientation (—naf)
[T] Add columns to allow gaps (—dpad) | 15 : [] Mo reverse-complement orientation {--norc)
[7] pisallow gaps {--gbar) 1 : [ Mo overlapping mates (-—-no-overlap)
[ seed (—seed) 0 : [7] Mo mates containing ene another {(—no-contain)
[ Start ] [ Cancel ] [ Help ]
L A

There are the following parameters:
Reference sequence — DNA sequence to align short reads to. This parameter is required.
Result file name — file in SAM format to write the result of the alignment into. This parameter is required.
Library - single-end or paired-end reads.

Prebuilt index — check this box to use an index file instead of a source reference sequence. The index is a set of 6 files with suffixes
.l.ebwt, .2.ebwt, .3.ebwt, .4.ebwt, .rev.1.ebwt, and .rev.2.ebwt. The index is created during the alignment. Also you can build it
manually.

SAM output — always save the output file in the SAM format (the option is disabled for Bowtie).
Short reads — each added short read is a small DNA sequence file. At least one read should be added.

You can also configure other parameters. They are the same as in the original Bowtie 2 (you can read detailed description of the parameters
on the Bowtie 2 manual page).

Select one of the following alignment modes:

The --end-to-end alignment mode:

By default, Bowtie 2 performs end-to-end read alignment. That is, it searches for alignments involving
all of the read characters. This is also called an "untrimmed" or "unclipped" alignment.

When the --local option is specified, Bowtie 2 performs local read alignment. In this mode, Bowtie 2
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might "trim" or “clip" some read characters from one or both ends of the alignment if doing so
maximizes the alignment score.

The following parameters are available:

Number of mismatches (--N) — sets the number of mismatches to allowed in a seed alignment during multiseed alignment. Can be set
to 0 or 1. Setting this higher makes alignment slower (often much slower) but increases sensitivity.

Seed length (-L) — Sets the length of the seed substrings to align during multiseed alignment. Smaller values make alignment slower
but more senstive.

Add columns to allow gaps (--dpad) — "Pads" dynamic programming problems by <i nt > columns on either side to allow gaps.
Disallow gaps (—gbar) — disallow gaps within <i nt > positions of the beginning or end of the read.
Seed (-seed) — use <i nt > as the seed for pseudo-random number generator.

The following flags are available:

No unpaired alignments (—no-mixed) — by default, when bowt i €2 cannot find a concordant or discordant alignment for a pair, it then
tries to find alignments for the individual mates. This option disables that behavior.

No discordant alignments (—no-discordant) — by default, bowt i e2 looks for discordant alignments if it cannot find any concordant
alignments. A discordant alignment is an alignment where both mates align uniquely, but that does not satisfy the paired-end
constraints. This option disables that behavior.

No forward orientation (—nofw) — if - - nof wis specified, bowt i €2 will not attempt to align unpaired reads to the forward (Watson)
reference strand.

No reverse-complement orientation (—norc) — if - - nor ¢ is specified, bowt i €2 will not attempt to align unpaired reads against the
reverse-complement (Crick) reference strand.

No overlapping mates (—no-overlap) — if one mate alignment overlaps the other at all, consider that to be non-concordant.
No mates containing one another (—no-contain) — if one mate alignment contains the other, consider that to be non-concordant.

Select the required parameters and press the Start button.

Building Index for Bowtie 2

To build Bowtie 2 index select the Tools NGS data analysis Build index for reads mapping item in the main menu. The Build Index dialog
appears. Set the Align short reads method parameter to Bowtie 2.

The dialog looks as follows:

([0 Build Index -2 [ |

Align short reads method Bowtie? - ]

Reference sequence

™~
Index file name E]

Start ][ Cancel H Help ]

L A

There are the following parameters:
Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.

Index file name — a file to save the created index to. This parameter is required.

BWA

BWA is a fast light-weighted tool that aligns relatively short reads to a reference sequence. Click this link to open BWA homepage. BWA is
embedded as an external tool into UGENE.
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Open Tools DNA assembly submenu of the main menu.

[ Tools ] Window Help

E:it Sanger data analysis r
7 NGS data analysis i’ Reads quality control...
= BLAST b
. ] ] .= Genome de novo assembly...
-5 Multiple sequence alignment |
i .=t Map reads to reference...
= Clening - . - .
) L=t Build index for reads mapping...
Primer r

Select the Align short reads item to align short reads to a DNA sequence using BWA. Or select the Build index item to build an index for a
DNA sequence which can be used to optimize aligning of short reads.

¢ Aligning Short Reads with BWA
® Building Index for BWA

Aligning Short Reads with BWA

When you select the Tools DNA Assembly Align short reads item in the main menu, the Align Short Reads dialog appears. Set value of the
Align short reads method parameter to BWA. The dialog looks as follows:

* Align Sequencing Reads 3

Alignment method | BWA 2]

£

Reference sequence [ ] |:|

Result file name [ ] |:|

Library |:Single-end s | o
Short reads
Path Type Order
| Add | | Remove

Base Options | Advanced

O Max #diff (-n) 0 Max gap opens (-0) [ 1 ‘%|
@ Missing prob (-n) [0.04 B Index algorithm (-a) | autodetect o)
seed length (-]) (32 % Besthits(-R) 30 B

ae)

[J Long-scaled gap penalty for long deletions (-L)
[ Non-iterative mode (-N)

| Help | Cancel |[ Start
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There are the following parameters:
Reference sequence — DNA sequence to align short reads to. This parameter is required.
Result file name — file in SAM format to write the result of the alignment into. This parameter is required.
Library - single-end or paired-end reads.
Prebuilt index — check this box to use an index file instead of a source reference sequence. Also you can build it manually.
SAM output — always save the output file in the SAM format (the option is disabled for BWA).
Short reads — each added short read is a small DNA sequence file. At least one read should be added.

You can also configure other parameters. They are the same as in the original BWA (you can read detailed description of the parameters on
the BWA manual page). Select one of the following parameters, that correspond to the -n option in the original BWA.

Max #diff (-n) — maximum edit distance. An integer value should be input.
Missing prob (-n) — the fraction of missing alignments given 2% uniform base error rate. A float value is used.

Seed length (-I) — take the subsequence of the specified length as seed. If the specified length is larger than the query sequence,
seeding will be disabled. For long reads, this option is typically ranged from 25 to 35.

Max gap opens (-0) — maximum number of gap opens.
Index algorithm (-a) — algorithm for constructing BWA index.
It implements three different algorithms:

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

* bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.

Best hits (-R) — proceed with suboptimal alignments if there are no more than specified number of equally best hits. This option only
affects paired-end mapping. Increasing this threshold helps to improve the pairing accuracy at the cost of speed, especially for short
reads (~32bp).

Long-scaled gap penalty for long deletion (-L) — long-scaled gap penalty for long deletion.

Non-iterative mode (-N) — disable iterative search. All hits with no more than Max #diff differences will be found. This mode is much
slower than the default.

You can also configure the following advanced parameters:
Enable long gaps — checking this box allows one to set the Max gap extentions parameter.
Max gap extensions (-e) — maximum number of gap extensions.
Indel offset (-i) — disallow insertions and deletions within the specified number of base pairs towards the ends.
Max long deletion extensions (-d) — disallow a long deletions within the specified number of base pairs towards the 3" -end.
Max queue entries (-m) — maximum queue entries.

Barcode length (-B) — length of barcode starting from the 5°-end. When the specified length is positive, the barcode of each read will
be trimmed before mapping and will be written at the BC SAM tag. For paired-end reads, the barcode from both ends are
concatenated.

Threads (-t) — number of threads.

Max seed differences (-k) — maximum edit distance in the seed.

Mismatch penalty (-M) — BWA will not search for suboptimal hits with a score lower than the specified value.
Gap open penalty (-O) — gap open penalty.

Gap extension penalty (-E) — gap extension penalty.

Quality threshold (-q) — parameter for read trimming.

Select the required parameters and press the Start button.
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Building Index for BWA

To build BWA index select the Tools NGS data analysis Build index for reads mapping item in the main menu. The Build Index dialog
appears. Set the Align short reads method parameter to BWA.

The dialog looks as follows:

[0 Build Index 2 [ |

Align short reads method BVUA - ]

Index file name

Reference seguence E]
]

Index algorithm (-a)

[T colorspace (-0

There are the following parameters:
Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.
Index file name — file to save index to. This parameter is required.
Index algorithm (-a) — Algorithm for constructing BWA index. Available options are:
It implements three different algorithms

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

® bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.

Colorspace (—color) — the input is read in colorspace, colors are encoded as characters A/C/G/T (A=blue, C=green, G=orange,
T=red).

BWA-SW

BWA is a fast light-weighted tool that aligns relatively short reads to a reference sequence. Click this link to open BWA homepage. BWA-SW
share similar features such as long-read support and split alignment. BWA-SW is embedded as an external tool into UGENE.

Open Tools Align to reference submenu of the main menu.

[ Tools ] Window Help

E:jt Sanger data analysis r
7 NGS data analysis i Reads quality control...
= BLAST Y

. ) =2 Genome de novo assembly...
. Multiple sequence alignrment FEs

. L= Map reads to reference...
=% Cloning - . - .

) .=t Build index for reads mapping...
Primer r

Select the Align short reads item to align short reads to a DNA sequence using BWA-SW. Or select the Build index item to build an index for
a DNA sequence which can be used to optimize aligning of short reads.

® Aligning Short Reads with BWA-SW
® Building Index for BWA-SW
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Aligning Short Reads with BWA-SW

When you select the Tools Align to reference Align short reads item in the main menu, the Align Sequencing Reads dialog appears. Set
value of the Align short reads method parameter to BWA-SW. The dialog looks as follows:

i ™
m Align Sequencing Reads @Iﬂ
Alignment method BWA-SW - ]
Reference seguence E]
Result fle name E]
Library | Single-end SAM output
Short reads
Path Type Order
| |
]
[ Add l [ Remove
Base Options
Index algorithm {-a) Mumber of threads (-t) 3 =
Score for a match (-a) 1 = Size of chunk of reads (-s) 1000000 5
Mismatch penalty {-b) 3 = Score threshold (divided by match score) (1) 30 =
Gap open penalty (-q) 5 = Z-hest () 1 =
Gap extention penalty (+) 2 = Mumber of seeds to start rev alginment () 5 =
Band width (-w) 50 = Mask level (-2 0.50 =
[] prefer hard dipping in SAM output {-H)
MOTE: bwa-sw performs alignment of long sequencing reads (Sanger or 454). It accepts reads only
in FASTA or FAST(Q format. Reads should be compiled into single file. i
[ Start J [ Cancel I [ Help
| |
L -y

There are the following parameters:
Reference sequence — DNA sequence to align short reads to. This parameter is required.
Result file name — file in SAM format to write the result of the alignment into. This parameter is required.
SAM output — always save the output file in the SAM format (the option is disabled for BWA).
Short reads — each added short read is a small DNA sequence file. At least one read should be added.
You can also configure other parameters.

Index algorithm (-a) — algorithm for constructing BWA-SW index.
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It implements three different algorithms:

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

* bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.

Score for a match (-a) — score of a match.

Mismatch penalty (-b) — mismatch penalty.

Gap open penalty (-q) — gap open penalty.

Gap extention penalty (-r) — Gap extension penalty. The penalty for a contiguous gap of size k is g+k®*r.
Band width (-w) - Band width in the banded alignment.

Number of threads (-t) - Number of threads in the multi-threading mode.

Size of chunk of reads (-s) - Maximum SA interval size for initiating a seed. Higher -s increases
accuracy at the cost of speed.

Score threshold (divided by much score) (-T) - minimum score threshold.
Z-best (-z) - Z-best heuristics. Higher -z increases accuracy at the cost of speed.

Number of seeds to start rev alignment (-N) - Minimum number of seeds supporting the resultant
alignment to skip reverse alignment.

Mask level (-c) - Coefficient for threshold adjustment according to query length. Given an I-long query, the threshold for a hit to be
retained is a*max{T,c*log(l)}.

Prefer hard clipping in SAM output (-H) - use hard clipping in the SAM output. This option may dramatically reduce the redundancy of
output when mapping long contig or BAC sequences.

Select the required parameters and press the Start button.

Building Index for BWA-SW

To build BWA-SW index select the Tools NGS data analysis Build index for reads mapping item in the main menu. The Build Index dialog
will appears. Set the Align short reads method parameter to BWA-SW.

The dialog looks as follows:

i ™y

Align short reads method [EWA—SW - ]

Reference sequence

Index file name

Index algorithm (-a)

[ colorspace ()

Start ] [ Cancel
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There are the following parameters:
Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.
Index file name — file to save index to. This parameter is required.
Index algorithm (-a) — Algorithm for constructing BWA index. Available options are:
It implements three different algorithms

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

* bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.

Colorspace (—color) — the input is read in colorspace, colors are encoded as characters A/C/G/T (A=blue, C=green, G=orange,
T=red).

BWA-MEM

BWA is a fast light-weighted tool that aligns relatively short reads to a reference sequence. Click this link to open BWA homepage. BWA-ME
M is generally recommended for high-quality queries as it is faster and more accurate. BWA-MEM also has better performance than
BWA-backtrack for 70-100bp lllumina reads.

Open Tools Align to reference submenu of the main menu.

Tools | Window Help

L2t Sanger data analysis r |

7t NGS data analysis i Reads quality contral...

—  BLAST .

. ) L=t Genome de novo assembly...
. Multiple sequence alignrment FEs
| . L= Map reads to reference...
= Cloning e
) ,i= Build index for reads mapping...
Primer r

Select the Align short reads item to align short reads to a DNA sequence using BWA-MEM. Or select the Build index item to build an index
for a DNA sequence which can be used to optimize aligning of short reads.

® Aligning Short Reads with BWA-MEM
® Building Index for BWA-MEM

Aligning Short Reads with BWA-MEM

When you select the Tools Align to reference Align short reads item in the main menu, the Align Sequencing Reads dialog appears. Set
value of the Align short reads method parameter to BWA-MEM. The dialog looks as follows:
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= Align Sequencing Reads m

Alignment method |BWA—MEM

Reference sequence |

[t Lo

Result file name |

Library |Single-end v|

short reads

Path Type Order

Add | Removel

Algorithm | scoring Options | Other |

Min seed length (-k) Im Band width (-w) Im
Dropoff (-d) m Internall seeds length (-r) m
skip seeds thresheld (-c) Im Drop chain threshold {-D) Im
Rounds of mate rescues (-m) m Number of threads (-t) m

I skip pairing (-P)

NOTE: bwa mem accepks reads only in FASTA or FASTQ format. Reads should be
compiled into a single File For each mate end.

Help | Cancel Start

There are the following parameters:

Reference sequence — DNA sequence to align short reads to. This parameter is required.
Result file name — file in SAM format to write the result of the alignment into. This parameter is required.
Prebuilt index — check this box to use an index file instead of a source reference sequence. Also you can build it manually.
SAM output — always save the output file in the SAM format (the option is disabled for BWA).
Short reads — each added short read is a small DNA sequence file. At least one read should be added.
You can also configure other parameters.
Index algorithm (-a) — algorithm for constructing BWA index.
It implements three different algorithms:

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

® bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.
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Number of threads (-t) — number of threads.

Min seed length (-k) — minimum seed length. Matches shorter than INT will be missed. The alignment speed is usually insensitive to
this value unless it significantly deviates 20.

Band width (-w) — band width. Essentially, gaps longer than INT will not be found. Note that the maximum gap length is also affected
by the scoring matrix and the hit length, not solely determined by this option.

Dropoff (-d) — off-diagonal X-dropoff (Z-dropoff). Stop extension when the difference between the best and the current extension score
is above [i-j|*A+INT, where i and j are the current positions of the query and reference, respectively, and A is the matching score.
Z-dropoff is similar to BLAST'’s X-dropoff except that it doesn’t penalize gaps in one of the sequences in the alignment. Z-dropoff not
only avoids unnecessary extension, but also reduces poor alignments inside a long good alignment.

Internall seeds length (-r) - trigger re-seeding for a MEM longer than minSeedLen*FLOAT. This is a key heuristic parameter for tuning
the performance. Larger value yields fewer seeds, which leads to faster alignment speed but lower accuracy.

Skip seeds threshold (-c) - discard a MEM if it has more than INT occurence in the genome. This is an insensitive parameter.
Drop chain threshold (-D) - drop chains shorter than FLOAT fraction of the longest overlapping chain.

Rounds of mate rescues (-m) - perform at most INT rounds of mate rescues for each read.

Skip mate rescue (-S) - skip mate rescue.

Skip pairing (-P) - in the paired-end mode, perform SW to rescue missing hits only but do not try to find hits that fit a proper pair.
Score for a match (-A) - matching score.

Mismatch penalty (-B) - mismatch penalty. The sequence error rate is approximately: {.75 * exp[-log(4) * B/AJ}.

Gap open penalty (-O) - gap open penalty.

Gap extention penalty (-E) - gap extension penalty. A gap of length k costs O + k*E (i.e. Gap open penalty is for opening a zero-length
gap).

Penalty for clipping (-L) - clipping penalty. When performing SW extension, BWA-MEM keeps track of the best score reaching the end
of query. If this score is larger than the best SW score minus the clipping penalty, clipping will not be applied. Note that in this case, the
SAM AS tag reports the best SW score; clipping penalty is not deducted.

Penalty unpaired (-U) - penalty for an unpaired read pair. BWA-MEM scores an unpaired read pair as scoreReadl+scoreRead2-INT a
nd scores a paired as scoreReadl+scoreRead2-insertPenalty. It compares these two scores to determine whether we should force
pairing.

Score threshold (-T) - don’t output alignment with score lower than score threshold. This option only affects output.

Select the required parameters and press the Start button.

Building Index for BWA-MEM

To build BWA-SW index select the Tools NGS data analysis Build index for reads mapping item in the main menu. The Build Index dialog
will appears. Set the Align short reads method parameter to BWA-MEM.

The dialog looks as follows:

[¥] Build Index P [

Align short reads method B A-MEM - I

Reference sequence B
]

Index file name

Index algorithm (-a) is - I

[ Colorspace (-0

Start H Cancel H Help
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There are the following parameters:
Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.
Index file name — file to save index to. This parameter is required.
Index algorithm (-a) — Algorithm for constructing BWA index. Available options are:
It implements three different algorithms

® is — designed for short reads up to ~200bp with low error rate (<3%). It does gapped global alignment w.r.t. reads, supports
paired-end reads, and is one of the fastest short read alignment algorithms to date while also visiting suboptimal hits.

* bwtsw — is designed for long reads with more errors. It performs heuristic Smith-Waterman-like alignment to find
high-scoring local hits. Algorithm implemented in BWA-SW. On low-error short queries, BWA-SW. is slower and less
accurate than the is algorithm, but on long reads, it is better.

® div — does not work for long genomes.

Colorspace (—c) — the input is read in colorspace, colors are encoded as characters A/C/G/T (A=blue, C=green, G=orange, T=red).

UGENE Genome Aligner

The UGENE Genome Aligner is a fast short read aligner. It aligns DNA sequences of various lengths to the reference genome with
configurable mismatch rate.

It is available from the Tools DNA assembly submenu of the main menu.

Tools | Window Help

L=t Sanger data analysis r |
7 NGS data analysis - Reads quality control..,
~  BLAST .
. ) L= Genome de novo assembly...
. Multiple sequence alignment |
| ) L=t Map reads to reference...
= Clening L - :
) L= Build index for reads mapping...
Primer r

Select the Align short reads item to align short reads to a DNA sequence or Build index item to build an index for a DNA sequence which can
be used to optimize aligning short reads to the sequence.

® Aligning Short Reads with UGENE Genome Aligner
¢ Building Index for UGENE Genome Aligner
® Converting UGENE Assembly Database to SAM Format

Aligning Short Reads with UGENE Genome Aligner

When you select the Tools DNA Assembly Align short reads item in the main menu, the Align Short Reads dialog appears. Set the Align
short reads method parameter to UGENE Genome Aligner. The dialog looks as follows:

243


http://seqanswers.com/wiki/BWA-SW
http://ugene.unipro.ru/benchmarks/UGENE_Genome_Aligner_SPO_2011.pdf

Unipro UGENE Manual, Version 1.26

'd - ™y
[ align Sequencing Reads M

Alignment method UGEME Genome Aligner - ]
Reference sequence E
Result file name E
Library |Single-end [7] Prebuilt index SAM output
Short reads
Path Type Order
Add ] [ Remove

Comman parameters Advanced parameters Index parameters

[ Mismatches allowed

@ Mismatches number i
Percentage of mismatches 1
Align options

|:| Use GPU-optimization
[ align reverse complement reads
Use "best™mode during the alignment

[] omit reads with qualities lower than 20

[ Start ][ Cancel H Help

L &

The following parameters are available:
Reference sequence — DNA sequence to align short reads to. This parameter is required.

Result file name — file in UGENE database format or SAM format (if the box SAM output check), to write the result of the alignment
into. This parameter is required.

Prebuilt index — check this box to use an index file instead of a reference sequence. Also you can build it manually.

SAM output — checking this box allows one to save output files in the SAM format. The default format of output files is the UGENE
database format (ugenedb).

Short reads — each added short read is a small DNA sequence file. At least one read should be added.

1 The Aligning Short Reads with UGENE Genome Aligner has no limitation on short reads length.

Common parameters:

Mismatches allowed — check this box to allow mismatches between the reference sequence and a short read. Select one of the
following:
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® Mismatches number to set the number of mismatched nucleotides allowed. This parameter can take values: 1, 2 and 3.
® Percentage of mismatches to set the number of mismatches in percents. Note, that in this case the absolute number of
mismatches can vary for different reads. This parameter can take values: 1 - 10 %.

Align options:
® Use GPU-optimization — use an openCL-enabled GPU during the alignment (the corresponding hardware should be

available on your computer).
® Align reverse complement reads — use both: a read and its reverse complement during the alignment.

® Use “best”-mode during the alignment — report only about best alignments (in terms of mismatches).
® Omit reads with qualities lower than — omit all reads with qualities lower than the specified value. Reads that have no

qualities are not omited.

Advanced parameters:

Maximum memory for short reads — maximum memory usage for short reads. This parameter allows one to decrease the load on the
computer on one side and to increase the computer speed of the task on the other side.

® Total memory usage — shows the total memory usage.
® System memory size — shows the total system memory size.
Index parameters:
Reference fragmentation — this parameter influences the number of parts the reference will be divided. It is better to make it bigger,

but it influences the amount of memory used during the alignment.

® |Index memory usage size — shows the index memory usage.
® Directory for index files — temporary directory for saving index files.

You can choose a temporary directory for saving index files for the reference that will be built during the alignment. If you need to run
this algorithm one more time with the same reference and with the same reference fragmentation parameter, you can use this prebuilt

index that will be located in the temporary directory.

Building Index for UGENE Genome Aligner

You can build an index to optimize short reads alignment using UGENE Genome Aligner. To open the Build Index dialog, select the Tools
NGS data analysis Build index for reads mapping item in the main menu. Set value of the Align short reads method parameter to UGENE

Genome Aligner.

The dialog looks as follows:

([0 Build Index )

Align short reads method LIGEME Genome Aligner - ]

Reference seguence E]
==

Index file name

Reference fragmentation

Total memaory usage:

System memaory size:

The parameters are the following:

Reference sequence — DNA sequence to which short reads would be aligned to. This parameter is required.

Index file name — file to save index to. This parameter is required.

Reference fragmentation — this parameter influences the amount of parts the reference will be devided. It is better to make it bigger,
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but it influences the amount of memory used during the alignment.
Total memory usage — shows the total memory usage.

System memory size — shows the total system memory size.

Converting UGENE Assembly Database to SAM Format

To convert UGENE data base to SAM format click on the Tools->DNA Assembly->Convert UGENE assembly database to SAM format conte
xt main menu item. The following dialog will appear:

i B
[1] convert UGENE Assembly Database to SAM Format m

Assembly database: | E]
Result SAM file: E]

[ Convert J[ Cancel ][ Help

L A

Select assembly and result files and click on the Convert button.

CAP3

CAP3 (CONTIG ASSEMBLY PROGRAM Version 3) is a sequence assembly program for small-scale assembly with or without quality
values. Click this link to open CAP3 homepage. CAP3 is embedded as an external tool into UGENE.

Open Tools DNA assembly submenu of the main menu.

AL VWindow  Help

- DNA assembly @ i Align short reads...
Test runner “i2: Build index...
“) SITECON d "iz: Convert UGENE Assembly data base to SAM format...

2= Multiple alignment  ®

o

*  (Contig assembly with CAP3

Select the Contig assembly with CAP3 item to use the CAP3.

The Contig Assembly With CAP3 dialog appears.
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p
[T contig Assembly with CAP3

Base Advanced

Input files (long DNA reads to assembly)

=)
Add

Result contig

E)

\ [ Run ]’ Cancel ” Help ] W

L ”y

You can add or remove input files using Add and Remove buttons. To remove all files click the Remove all button. Input files are files with a
long DNA reads in FASTA, FASTQ, SCF or ABI formats. At least one input file should be added. Input a Result contig name and press the R
un button. CAP3 produces assembly results in the ACE file format (".ace”). The file contains one or several contigs assembled from the input
reads.

1 The quality scores for FASTA sequences can be provided in an additional file. The file must be located in the same folder as the
original sequences and have the same name as FASTA file, but another extension: .qual.

Also you can change the following advanced parameters:

r ™
[0 Contig Assembly with CAP3 [
Advanced

Clipping for poor regions Length and percent identity of an overlap
Base quality cutaff for dipping (<) |[12 = Overlap length cutoff (-0) 40 =
Clipping range (-y) 100 = Overlap percent identity cutoff (-p) 90 =
Quality difference score of an averlap Other parameters
Max number of word matches (-t) 300 =
Base quality cutoff for differences (-b) 20 = =
Band expansion size (-a) 20 =
Max gscore sum at differences (-d) 200 = Max gap length in any overlap (-f) 20 =

Assembly reverse reads {-r)

Similarity score of an overlap

Match score factor (-m) 2 =

Mismatch score factar (-n) -5 =

Gap penalty factor (-a) 8 =

Cverlap similarity score cutoff (=) 900 =
| [ Run ] [ Cancel ] [ Help W
L "y
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Clipping for poor regions parameters:

Clipping of a poor end region of a read is controlled by parameters Base quality cutoff for clipping (-c) (the specified value should be
more than 5), and Clipping range (-y) (the specified value should be more than 5).

Quiality difference score of an overlap parameters:

Base quality cutoff for differences (-b) — if an overlap contains a difference at bases of quality values q1 and g2, then the score at the
difference is max(0, min(gl, g2) - b), where b is the specified value. The specified value should be more than 15. The difference score
of an overlap is the sum of scores at each difference.

Max gscore sum at differences (-d) — remove an overlap if its difference score is greater than the specified value. The specified value
should be more than 20.

Similarity score of an overlap parameters:
The following parameters are used to calculate the similarity score of an overlapping alignment:

Match score factor (-m) — a match at bases of quality values g1 and g2 is given a score of m * min(ql, g2), where m is the
specified value. The specified value should be more than 0.

Mismatch score factor (-n) — a mismatch at bases of quality values q1 and g2 is given a score of n * min(gql, g2), where n is the
specified value. The specified value should be less than 0.

Gap penalty factor (-g) — a base of quality value g1 in a gap is given a score -g * min(gl, g2), where g is the specified value; g2
is the quality value of the base in the other sequence right before the gap. The specified value should be more than 0.

The similarity score is caclulated as the sum of scores of each match, each mismatch and each gap. Based on this value and the
following value some overlaps are removed:

Overlap similarity score cutoff (-s) — remove overlaps with similarity scores less than the specified value. The specified value
should be more than 250.

Length and percent identity of an overlap parameters:
Overlap length cutoff (-0) — minimum length of an overlap (in base pairs). The specified value should be more than 15 base pairs.
Overlap percent identity cutoff (-p) — minimum percent identity of an overlap. The specified value should be more than 65%.
Other parameters:

Maximum number of word matches (-t) — an upper limit of word matches between a read and other reads. Increasing the value would
result in more accuracy, however this could slow down the program. The specified value should be more than 0.

Band expansion size (-a) — a number of bases to expand a band of diagonals for an overlapping alignment between two sequence
reads. The specified value should be more than 10.

Max gap length in any overlap (-f) — reject overlaps with a gap longer than the specified value. A small value may cause the program
to remove true overlaps and to produce incorrect results. This option may be used by the user to split reads from alternative splicing
forms into separate contigs. The specified value should be more than 1.

Assembly reverse reads (-r) — consider reads in reverse orientation for assembly. The default value is “checked”.

SPAdes

SPAdes — St. Petersburg genome assembler. Click this link to open SPAdes homepage. SPAdes is embedded as an external tool into
UGENE.

Open Tools NGS data analysis.

Window Help

4.k Sanger data analysis L [Go! | - > AEG SW ogm = =
L=t NGS data analysis " Reads quality contral...
= BLAST =
_ ] L=t Genome de novo assembly...
: Multiple sequence alignment L
_ L=t Map reads to reference...
A e Clening L3N
_ .=t Build index for reads mapping...
¢ Primer »

Select the Genome de novo assembly item to use the SPAdes.
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The Assemble Genomes dialog will appear.

m Assemble Genomes @

Assembly method SPAdes hd ]

Output directory E]

Library |Single-end -

Properties Left reads Right reads

# Type Orientation Path Path

Add ] [ Remove Add Remove

Base Options

Dataszet type [Mulh’ Cell A ]

Mumber of threads (-t} & =

Running mode [Error Correction and Assembly hd ]

M limit GEB 250 =
k-mer sizes () auto emary limi (-m)

Start ][ Cancel ][ Help

The following parameters are available:
Output directory - SPAdes stores all output files in output directory, which is set by the user.
Library - to run SPAdes choose one of the following libraries:

® Single-end

® Paired-end

® Paired-end (Interplaced)

® Paired-end (Unpaired files)
® Sanger

® PacBio

Left reads - file(s) with left reads.

Right reads - file(s) with right reads.

For each dataset in the paired-end libraries you can change type and orientation.
Datasest type - dataset type.

Running mode - running mode.

k-mer sizes (-k) - k-mer sizes.

Number of threads (-t) - number of threads.

Memory limit GB (-m) - memory limit.

Weight Matrix

The Weight Matrix plugin is a tool for solving the problem of a sequence annotating. As well as for the SITECON, the main use case of the
plugin is recognition of potential transcription factor binding sites on basis of the data about conservative conformational and physicochemical
properties revealed with the binding sites sets analysis.
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The Weight Matrix contains a lot of position frequency matrices (PFM ‘s) and position weight matrices (PWM ‘s, also known as position
specific score matrices — PSSM ‘s). The matrices came from two wide-known open archives: JASPAR, which contains frequency matrices,
and UniPROBE containing weight matrices.

Also the Weight Matrix plugin provides a tool for creating specific position frequency and weight matrices from an existing alignment or from a
file with several sequences. The created matrix can be used as a profile for the search as well as the JASPAR and UNIPROBE ones.

To search for transcription factor binding sites in a DNA sequence select the Analyze Search TFBS with matrices context menu item. The W
eight matrix search dialog will appear:

" Weight Matrix Search I. 2 ﬁ,l
Matrix: E]

Score: r,l 85%

Search JASPAR dambase] [Build new matrix View matrix

Weight algorithm |Berg and von Hippel

- I

Strands Region
@ Both strands Whole sequence
() Direct strand il - 199950

(71 Reverse complement strand

Matrix Minimal score Algorithm Load list. ..

Save list. ..
Load folder...

Clear list

Range Matrix Strand Score

Clear results | [Save as annotations

Results found: 0.

Addtoqueue] [ Search ] [ Close ] Help

b A

In the search dialog you must specify a file with PWM or PFM. You can do so by pressing the browse button and selecting the file.
Also you can use the special interface to choose a JASPAR matrix by pressing the Search JASPAR database button.

Alternative way to specify the position weight/frequency matrix is to create a specific one from an alignment or a file with several sequences
with the build a new matrix tool.

After the profile (the matrix) is loaded, you can adjust the threshold value. The threshold sets the minimal identity score for a result to pass.
The more the result score is, the more it is homologically related to the aligned region. By changing the threshold you can filter low- scoring
results.

If the loaded matrix is a position frequency matrix, you must also specify the algorithm to build the corresponding position weight matrix which
will represent the transcription factor. There are four algorithms available.
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Weight algorithm |Berg and von Hippel w
Strands Berg and von Hippel |
Both strand Match
@ MLG

Fa T T S| -

Also you can add a selected matrix with the specified Minimal score and the Algorithm to the matrices list. To do it, select the matrix and
other options and press the Add to queue button. The plugin will search with all matrices specified in the list.

You can use the Save list button to export the list of matrices to a *.csv file. Later the list can be loaded from the file using the Load list button

The rest options are standard sequence search options: the strand and the sequence region where to search for matches.

After specifying the necessary options press the Search button. The found results will appear in the dialog table. The corresponding results
identity scores are in the Score column.

Range Matrix Skrand Scare -
199944,,199949 MADZ71.1.pfm Direct strand 31.26%
199943,,199945 MADZ71.1.pfm Direct strand G2, 39%
199942 ,,199947 MADZ71.1.pfm Direct strand S5, 92
199941,,199945 MADZ71.1.pFm Direct strand 26,86%:
199940,,199945 MADZ71.1.pfm Direct strand 26, 86%
199939,,199944 MADZ71.1.pfm Direct strand 14.07%:
199935,,199943 MADZ71.1.pfm Direct strand S7.60% ¥

Also you can see the matrix by using the View matrix button:

i - '
%, View Matrix =
0 3 79 40 66 48 65 11 65 O
94 % 4 3 1 2 5 2 3 3
i ¢ 32 4 1 0 5 3 28 &8
| 2 19 11 50 29 47 2 8 1 g
1| 1] [ b
THAT I AG
[ Close J [ Help ]

L A

The regions found by the weight matrix algorithm can be saved as annotations to the DNA sequence in the Genbank format by pressing the
Save as annotations button.

After saving, the file with resulting annotations will be automatically added to the current project, and the annotations will be added to the
original sequence.

Note that in case of selecting JASPAR or UNIPROBE matrix, the resulting annotations will contain the given matrix properties.
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-

“4 Create Annotation

Search JASPAR. C

Weight algorithm * Save annotation(s) to

Strands Existing table -

@ Both strands

D'E,J

@ Create new table |
(") Direct stra

o  Annotation parameters
) Reverse comy pa

Group name <auto=
Matrix | Annotation name  misc_feature a:fﬁ
MADD44 1. pfm

Create H Cancel

% Weight Matrix Search | v PG
Matrix:  C:jworkfugene/data/position_weight_matrix/JASPAR /plantsMADD44. 1.pfm E]
Score: | o U 85%

199950

Load list
Save list

Load folder

&
oA
2
[ »

Clear list
Range : Matrix Strand Score
199824..199832 MADD44.1.pfm Direct strand
199397..199405 MADD44.1.pfm Direct strand 85.75%
Clear results ] [Sa'n.re as annumtiuns]
Results found: 1379.
[Addtoqueue] [ Search ] [ Close ] [ Help

See also:

® Searching JASPAR Database
® Building New Matrix

Searching JASPAR Database

Press the Search JASPAR database button in the Weight matrix search dialog. The following dialog will appear:
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-

% Weight Matrix Search | 7 28 |

Matrix: D

[ . Lol

% Search JASPAR Databasze

Mame : D Class Family i |
I» vertebrates
I= urochordates
4 plants E |
squamaosa MADDE2 1 Other AlphaHe... MADS I
myb.Ph3  MADDSE 1 Helix-Turn-Helix  Myb
|idl MAD120.1 Zinc-coordinati...  BetaBetaAlpha-zinc finger |
Hl bZIP911  MAODDST 1 ZipperType Leucine Zipper
bBIPA10 MADDSE.1 Zipper-Type Leucine Zipper
abid MAl123.1 Beta-Hairpin-Ri...  AP2 MBD-like
TGALA Mal129.1 Zipper-Type Leucine Zipper
PEMD MADLZ2T .1 Zipper-Type Leucine Zipper
PEF MADDES 1 Zinc-coordinati...  Dof il
RARIET A RAANNST 1 Fincrnardinat Dinf
acc AAC18941 [
I E
class Zinc-coordinating
collection CORE
comment
|

Results found: 0.

Addtoqueue] [ Search ] [ Close ] [ Help

L o

Here the matrices are divided into categories and you can read detailed information of a matrix which is represented by its properties. It could
help you to choose the matrix properly.

1 The matrices provided with UGENE are located in the SUGENE/data/position_weight_matrix folder.

Building New Matrix

To create a position weight or frequency matrix from an alignment or a file with several sequences, press the Build new matrix button in the
Weight matrix search dialog, or select the Tools Search for TFBS Build weight matrix main menu item:
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Tools | Window Help

1 E::t Sanger data analysis L g, v 11 v | BE§
it NGS data analysis r ok
= BLAST 4
- Multiple sequence alignment 4 1:k 1.:5k Z:k
1" Cloning ¢
: Primer ¢
i Search for TFBS ; Build SITECON model... [T
HMMER tools ’ Build weight matrix... |
Build dotplot... % ToK 2K
Random sequence generator...

The Build weight or frequency matrix dialog will appear:

Inputfile |

m Build Weight or Frequency Matrix @I&J

Output file
Statistic options
Statistic type: @ Mononudeic (7 Dinudeic
Matrix options

Matrix type: i@ Frequency matrix (71 Weight matrix

Weight algorithm |Berg and von Hippel

Start ][ Cancel H Help

b

The following parameters are available:
Input file — an alignment or a file with several sequences to build the matrix from. The parameter is mandatory.
Output file — the resulting matrix will be saved in this file. The parameter is mandatory.

Statistic type — defines the way in which the statistics will be collected. The Mononucleic option is basically good for small alignments,
and the Dinucleic option must give more appropriate results for big alignments.

Matrix type — defines the type of the resulting matrix.
If the Frequency matrix option is selected then the frequency matrix will be created and saved into the resulting file.

If the Weight matrix option is selected then the intermediate frequency matrix will be created and then transformed into a weight matrix
on basis of the selected Weight algorithm. Then the weight matrix will be saved into the resulting file.

For some input files the colored “Alignment Logo” appears at the bottom of the dialog. It gives the representation of the selected alignment.
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-

Build Weight or Frequency Matrix

Input file

Cutput file
Statistic options

Statistic type: @ Mononudeic

Matrix options

)
L]
L]

() Dinudeic

() Weight matrix

] [ Cancel

] [ Help

I Matrix type: @ Frequency matrix
Weight algorithm |Berg and von Hippel
|
|
| | — Gn' | | = |
| start
L _

1 The “Alignment logo” appears when:

® The input file format is *.pfm, *.aln or it is a file with several sequences;

® The size of the input file is small enough.

To start the operation, press the Start button. The matrix will be created and saved. If the Build weight or frequency matrix dialog was
invoked from the Weight matrix search dialog, then the matrix also will be chosen as the current profile.

Primer3

The Primer3 plugin is a port of the Primer3 tool. It is intended to pick primers from a DNA sequence.

To use the Primer3, open a DNA sequence and select the Analyze Primer3 context menu item. The dialog will appear:
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‘r:»«. Primer Designer T |-

Main General Settings I Internal Oligo I Penalty Weights RT-PCR Seguence Quality I Result Settings

Excluded regions ||

Targets

Product size ranges | 150-250 100-300 301-400 401-500 501-600 601-700 701-850 851-1000 Mispriming/Repeat library
MNumber to return 5 2| Max 3 stability 2,00 =

Max repeat mispriming 12.00 % Pair max repeat mispriming 24.00 =

Max template mispriming 12,00 %1 Pair max template mispriming 24,00 =

Start codon position

Pick left primer [ Pick hybridization probe (internal oligo) Pick right primer
or use left primer below or use oligo below or use right primer below (5' to 3' on opposite strand)
Region |Whole sequence 1| = 199950

Save setﬁngs] [Load setﬁngs] [ Reset form ] [ Pick primers

All available parameters are the same as in the original Primer3.

However there is one additional feature available which is not originally a part of Primer3 tool. It allows user design primers for RT-PCR
experiments by choosing which exons/introns to span with the primer product. This feature is described in detailed below. When you select
the parameters you can save and load settings with a help of the corresponding buttons in the right corner of the dialog.

® RTPCR Primer Design

RTPCR Primer Design

This feature allows to search for primer pairs that span introns on the genomic sequence or exon junctions on the mRNA sequence.

Note that RT-PCR design is only available for mMRNA/cDNA sequences with annotated exons. There are several ways to obtain the cDNA for
a corresponding DNA sequence.

® From NCBI or ENSEMBL database.
For example, one can download the TMPRSS2 transcript variant 1 from NCBI Genbank using identifier NM_001135099.1.
This can be also done from UGENE using option Access remote database or Search NCBI Genbank.

® Align the genomic and cDNA sequences using spliced aligner.
For this option one must have both genomic and cDNA sequences.
In UGENE the spliced alignment can be performed using the Spidey tool.
To run the alignment open the genomic sequence and select action Align Align to mRNA sequence.
The generated exon annotations can be then exported using action Export Export sequence of selected annotations

To design primers for your mMRNA sequence and go to the RT-PCR tab of the Primer Designer dilaog:
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Y Primer Designer - (L2 [

| Main I General Settings Internal Oliga I Penalty Weights RTPCR Sequence Quality | Result Settings

Design primers for RT-PCR. analysiz
mRMNA sequence

Exon annotation name:  exon

Minimum exon junction overlap size
AtSside(bp): 5 |5

At3side (bp) 5 [=

Exon range: ||

Primer product must span at least one intron on the corresponding genomic DNA

Max number of pairs to query: 1000 |5

Region |Whole sequence + 1= 199950
Save set‘h’ngs] [Load sethngs] [ Reset form ] [Pickprimers

The following parameters are available:
Exon annotation name

To detect exon boundaries UGENE searches for exonic annotations. This option allows to set custom name for annotations denoting
exons. Default value is "exon"

Minimum exon junction overlap size

If checked, then only the pairs with at least one of the primers overlapping exon junction in the mRNA sequence will be selected.
At 5' side (bp)

Minimum overlap size on the 5' side of the exon junction. Default is 5 bp.

At 3' side (bp)

Minimum overlap size on the 3' side of the exon junction. Default is 5 bp.

Exon range

This option allows to limit the sequence region, where the primers are searched for. For example, setting value "3-5" will limit the
search to a sequence region consisting of exons 3,4,5 of the transcript, as defined by the order in the sequence. Default value is an
empty string, which means that there are no limitations.

Span at least one intron

This option makes sure that primer product should span an intron on the genomic sequence i.e the forward and reverse primers must
be located in different exons. The option is enabled by default.

Max numbers of pairs to query

The algorithm applied in RT-PCR primer design first searches for all available primers in a given sequence. Then it filters the detected
pairs to make sure that they satisfy the selected configuration. This option allows to set the maximum number of pairs for the initial
search query. Larger number will result in increased sensitivity, but also in a longer running time. Default value is 1000.

Important: using the RT-PCR primer design tab will reset the values set in the Exlcuded regions and Targets of the Main configuration tab.
Additionally if the Exon range option is set, the defined sequence region will be ignored.
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Spliced Alignment (MRNA to genomic)

UGENE allows to align spliced mRNA/cDNA sequence to genomic sequences.
The default underlying algorithm which is used for the alignment is an external tool called Spidey.
Before running the alignment make sure that Spidey is available and validated in the list of External Tools.

To perform the alignment of a mMRNA sequence to a genomic sequence open the the genomic sequence in the Sequence View. Next activate
context menu item Align -> Align to sequence to mRNA.

* L L
*
g Goto position... Ctrl+G M I
TTqd [} Select sequence region... Ctrl+&4 RARTGGTGCATCTGACTCCTGAGGAGARCTCTGC
+— : + + + + :
!5 | Ay Mew annotation... Ctrl+M 55 80 65 70 75 a0
ARAC FrAaCCACGTAGACTGAGGACTCCTCTTCAGACE
Copy 3
Select 3 M
A M
......... Add , [ ——————————————
Analyze L
Align b Align sequence to mRMNA
Clening b Align selected sequence regions...
Export > Align selected sequence regions (amino acids)...
Edit sequence b Align selected annotations...
Remove Align selected annotations (aming acids)...
‘__f._/_jj Rulers... 4
fllly Statistics

In the list of sequences select the corresponding mMRNA sequence and click OK.

The following dialog will appear:

' Y
[¥] save result to annotation M

T

Group Name  exon £

Description
@ Existing table

[ (5-' MC_001363 features [murine.gb] - ] @

() Create new table

lUse autn-annotations tahle

[ Create ][ Cancel ][ Help

e 4

Here you can set up a file to store annotations. It could be either an existing annotation table object or a new annotation table or
auto-annotations table (if it is possible). Also you can modify the group name parameter and add a description.

The resulting alignment will be saved as an annotation with the corresponding name:
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External Tools

The External Tools plugin allows one to launch an external tool from UGENE.

To use an external tool from UGENE, the tool needs to be installed on the system and the path to it should
be properly configured. However, there is no need in the additional configuration, if you've installed the
UGENE Full Package, as it already contains all the tools by default.

Otherwise, if you've installed the UGENE Standard Package, you would need to configure an external tool in order to use it. Note that in this
case you can download the package with all the external tools from this page.

To learn how to configure an external tool, read below.
® Configuring External Tool

Configuring External Tool

To configure an external tool:

1. Make sure the tool is installed on your system.
2. Set a path to the tool executable file in UGENE. It can be set on the External Tools tab of the Application Settings dialog.

If the path hasn’t been set for a tool, UGENE menu items that launch the tool are displayed in italic. For example, on the image below a path
for the ClustalW external tool has been set, and paths for MAFFT and T-Coffee has not:
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§ I it " hecle@dcrldaaTtTa
-7 Align » | [M Align with MUSCLE

= Tree » m Align sequences to profile with MUSCLE
T il statistics » |[M)| Align profile to profile with MUSCLE

T View » | K| Align with Kalign

1 Export k m Align with Clustalw

1 Advanced v Bl Align with MAFFT...

: Consensus mode. .., by Algn with TCoffee. ..

I .
Query Designer

The Query Designer allows a molecular biologist to analyze a nucleotide sequence using different algorithms (Repeats finder, ORF finder,
Weight matrix matching, etc.) at the same time imposing constraints on the positional relationship of the results obtained from the algorithms.

A user-friendly interface is used to create a schema of the algorithms and constraints.

U My Project UGENE
File  Actions  Settings Tools  Window  Help

@ = B L7} E % » S8 Wiew mode,
|U] Query Designer, - ORF-Repeats |:”§|r>_—<|

=
o -

= El L A4k k # | - Property Editor

g Smems ISLD 120..40000 bp 2l [Lob:

| (E—r abe
o oD ORF : Finds Open ]

Reading Frames {ORFs)

in supplied nucleotide

'f ORF sequence, stores found
Theelements ... . reqgions as annokations,
¥ Primer representing
algori Prakein sequences are
---------- skipped if any.
<= Repeats PR ¥
ORFr are DAY reguence
% Restriction site | || Detects 1008 idenbigal f oo Diakecks 1009 identical oo regions thal couis

potentiall ancode a
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------ a good mdication of the

Y

AEE Pattern

ORF (“ORF") Order: 2 presence of 3 gene i Fhe
Sitecon
® Finds ORFs in both Parameters
strands using the 1. The
; R e e — i Wal
W Smith-Waterms Standard Genetic Code. - ame e
Detects only ORFs not Allow al..e codons  False
I Weight matrix shorter than 100 bps Require stop codon False
I (=] Constraints Annotate as ORF
. End-Start Max length 10..bp
8..5000 bp 0..5000 bp Min length 100 bp

N 4
. Start-End 0..5000 bp Redquire init codon  true
+ Search in bao...ds
. End-End 1.

. . Genetic code ..ode
The constraints imposed on the results
. Sart-Start of the algorithms calculations.

|

< 4

| (;j 2 Tasks | | L] 3 Log | Mo active tasks &' [

Alternatively, you can create / edit a schema using a text editor.

When the schema has been created and all its parameters have been set you can run it for a nucleotide sequence. The results are saved as
a set of annotations to the specified file in the Genbank format. Also when you have query designer scheme you can analyze a nucleotide
sequence from the sequence view with a help of this schema. Call the Analyze->Analyze with query schema context menu item for this.

To learn more about the Query Designer read the Query Designer Manual.

Plasmid Auto Annotation

Plasmid Auto Annotation feature allows to automatically annotate possible functional elements of the given sequence such as promoters,
terminators, origin of replication, known genes, common primers and other features. Conceptually this functionality is similar to the one

offered by PlasMapper software. The database for plasmid auto-annotation is based on the following resource.

To activate Plasmid Auto Annotation upon your sequence use the menu item Analyze Annotate plasmid and custom features. In the appeare
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d dialog one can selected the features to search in sequence.

i !
*:«« Plasmid Auto Annotations I. @ ﬁ]
Selected features
Promoter Qrigin
Terminator Primer
Gene Other features

Regulatory

[ Annotate H Cancel ][ Help

The detected plasmid features are stored as automatic annotations and can be controlled through
corresponding menu. Refer Automatic Annotations Highlighting to learn more.

The database containing features and their sequences is located in a subfolder of UGENE data folder: data/custom_annotations/
plasmid_features.txt.

ClustalO

Clustal is a widely used multiple sequence alignment program. It is used for both nucleotide and protein sequences.Clustal Omega is the
latest addition to the Clustal family. It offers a significant increase in scalability over previous versions, allowing hundreds of thousands of
sequences to be aligned in only a few hours. It will also make use of multiple processors, where present.

Clustal home page: http://www.clustal.org

If you are using Windows OS, there are no additional configuration steps required, as ClustalO executable file is included to the UGENE
distribution package. Otherwise:

¢ |Install the Clustal program on your system.
® Set the path to the ClustalW executable on the External tools tab of UGENE Application Settings dialog.

Now you are able to use ClustaOl from UGENE.

Open a multiple sequence alignment file and select the Align with ClustalO item in the context menu or in the Actions main menu. The Align
with ClustalO dialog will appear (see below), where you can adjust the following parameters:

Number of iterations — number of (combined guide tree/HMM) iterations.
Max number guidetree iterations — maximum guide tree iterations.

Max number of HMM iterations —maximum number of HMM iterations.
Number of CPUs being used - number of processors to use.

Set options automatically - set options automatically (might overwrite some of your options).
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[T Align with Clustal Omega 2 3o

Iteration

[] Mumber of iterations 1
Max number guidetree iterations i]
Max number of HMM iterations ]

Miscellaneous

4k

Mumber of CPUs being used a

[7] set options automatically

[ Align J[ Cancel ][ Help

Kalign Aligning
Kalign is a fast and accurate multiple sequence package designed to align large numbers of protein sequences.
Kalign home page: KAlign

To use Kalign open a multiple sequence alignment file and select the Align with Kalign item in the context menu or in the Actions main menu.
The following dialog appears:

% Align with Kalign 2 [

Advanced options

[] Gap open penalty 217.00
[] Gap extension penalty 39,40
[] Terminal gap penalty 292.60
[7] Bonus score 28.30

[] Translate to amino when aligning

Output file 1. The Standard Genetic Code

Align ][ Cancel H Help

L A

The following parameters are available:
Gap opening penalty — indicates the penalty applied for opening a gap. The penalty must be negative.
Gap extension penalty — indicates the penalty applied for extending a gap.
Terminal gap penalty — the penalty to extend gaps from the N/C terminal of protein or 5'/3' terminal of nucleotide sequences.
Bonus score - a bonus score that is added to each pair of aligned residues.

Translate to amino when aligning - translates an alignment to amino when aligning.
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Shared Database

The rational storage of biological data is an ever-present issue. It is not only about large data sizes, but also about the requirement of
simultaneous access to them by several scientists. For instance, a few researchers from a lab may need to work on the same data, like a set
of primers or data produced by sequencing. That information has to be updated and synchronized between different users and kept in a
common storage. That is what UGENE Shared Database is intended for.

To start sharing data via UGENE you need to deploy a public database server. MySQL servers are currently supported. See this paragraph f
or details about the required server configuration.

After that any UGENE user (who knows the correct login/password, however) can connect to the database. The connected database is
shown in the Project View as a document exactly the same way as if the data were located on the local computer.

As described in this paragraph the users can have a read-only access to the database or be able to modify its content. A user with a
read-only access can:

® Browse the data in the database
® Open the data in the UGENE views
® Export the data to the local computer

Users with write access, in addition, can:

® Add new objects to the database

® Create new folders to order the data in the database

* Modify the folders hierarchy inside the database (using drag'n'drop)
® Rename objects and folders

® Delete existed objects

® Delete folders

All UGENE instances connected to a database constantly monitors the state of the database and shows changes, made by other users.

UGENE accesses large remote data, such as NGS assemblies, so that only a viewed part of them is loaded to a client computer.
So, if you store the assembly data on a server, the data can be browsed in the UGENE Assembly Browser on a local computer
almost instantly, without the need to copy the data on the computer or use the hard disk space.

For details see the documentation below:

® Configuring Database

® Connecting to a Shared Database

® Adding Data to the Database

® Database in the Project

® Deleting Data

® Drag'n'drop in the Database

® Exporting Objects from the Database

Configuring Database
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To make use of a shared database follow the steps below:

1. Deploy a MySQL database server

We recommend you to download MySQL binaries from the official site. Note that UGENE supports MySQL versions 5.5 and higher.
Here you can also find instructions on how to install and launch a MySQL server instance for each platform.

2. Create an empty database

Log in to the MySQL server as a user with administrative privileges (you must be able to create databases and users, and to grant
privileges to the created users). In the MySQL console or in your favorite SQL browser execute the following command:
> CREATE DATABASE ‘your_database_name’;

3. Create database users

You may probably want to limit possible influence on the shared database by the UGENE users who will use it. In this case create a
distinct MySQL user for each UGENE user (or a group of users). In order to do this, execute the following commands:

> CREATE USER "user_nickname™ IDENTIFIED BY 'user_password’;

Decide whether the created user is allowed to modify the database content or only to view it. In the first case execute the command
below:

> GRANT ALL PRIVILEGES ON your_database_name.* TO "user_nickname @'%' IDENTIFIED BY ‘user_password';

and in the second case execute:

> GRANT SELECT ON your_database_name.* TO “user_nickname @'%' IDENTIFIED BY ‘user_password';

4. Use the database from a UGENE instance

The database with "your_database_name" is now available from a UGENE instance (version 1.14 or higher). It's time to try it out and
fill it with some initial data. To do it, open UGENE and connect to the database. As we need to add the data to the database,

use "user_nickname" and "user_password" of a user with privileges to modify the database. As soon as connection is established, a
dd the required data to the database.

From now on the data will be available for all users from this and other UGENE instances who connected to the same database.

Connecting to a Shared Database

To start using the shared database you need to have a running public MySQL database server. Usually the system administrator of your
department does it. You should ask him or her to give you the access to a MySQL database. Particularly, you need a few parameters to
connect to the database: the IP-address of the server (the computer where a MySQL server is running), a user name for the MySQL
database and a password. You can also install a MySQL server by yourself on any public computer you have an access to (even on your
workstation), following the steps described in the Configuring Database section.

To connect to the database use the File->Connect to shared database main menu item. The following dialog appears:

il ™y

LUGEME public database Add

Delete

Edit

Connect Disconnect

To add new connection click on the Add button. The following dialog appears:
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Connection name: |

Database location Authentication data

Host: Login:

Port: Password:

Database: Remember me [

Ok ] [ Cancel ] [

Here you need to specify Host (IP-address of the server), Port (number of the port used by the MySQL server) and Database (name of the
database). You may also fill Login and Password fields. Otherwise, you are asked to input them every time you are establishing this
connection until you check the Remember me box. Click on the OK button, then the connection is created and the appropriate item appears
in the previous Shared Database Connections dialog.

If you want to use already existing connection choose the appropriate item in the Shared Database Connections dialog and press the Conne
ct button. This can also be done by double clicking the item. If the specified database is empty, UGENE has to initialize it. This routine is
done only once. In this case you get an appropriate message box, asking whether to initialize the database or not. If you choose Yes the
database is populated with UGENE data structures, if No it remains empty and UGENE does not connect to it.

If you want to delete some connection select it in the Shared Database Connections dialog and click on the Delete button. You may also edit
connection parameters using the Edit button.

An established connection can be terminated by pressing the Delete button. The same effect is produced by removing the database
document item from Project View.

Adding Data to the Database

To add data to the database use the Add->Import to the database context menu item of the database in the project tree view. Also you can
drag'n'drop it to a shared database folder.

1 -+ Ustne - (cvuss62 ¢ cvUssTe

‘%«g File Actions Settings Tocls Window Help

B o B & G2 % Ga Za Ca Za (Got] &, ~

Project Lol N
& | Name filter -
=
= | Objects
—i |: J 1 EH I.-;!jl
4 |3
I ] Add * |ls  Import to the database...
S X Edit * | Addfolder.
» Export/Import r
4 m Remove selected items Drel
> TR

3 GFF

> 3 Genbank
> 3 MMDB
> 3 MSF

The following dialog will appear:
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Import to the nm_&lg

Item to import Import to Add files
Add folder

General options

Remove

Import [ Cancel ] ’ Help ]

Here you can add to the database files, folders or other objects from the current Project View. To do this use corresponding buttons. After
specifying your data click on the Import button. The data will be imported and appear in the database data tree. Also you can change import
settings. To do this click on the General options button. The following dialog will appear:

i '
Database Import Default Options L2 S|

Destination folder: |

Files and folders options

Process directories recursively

Keep folders structure

[] Create a subfolder for the top level folder
Create a subfolder for each file

[] Impart unrecognized files

Multi-sequence files import policy

@ Import as separate sequences

(7} Merge into a single sequence

Mumber of ‘unknown' symbaols (? for nudlsic or X for aming) between parts: | 10 bases

() Join into alignment

Documents and objects options
Create a subfolder for each document

| ok || cancel || Heb

Available parameters are described below:

Process directories recursively - if this option is checked, the import procedure recreates the hierarchy of the imported directories and
all their sub-directories in the database. Otherwise, only the content of the directories, specified for import, is uploaded to the Destinati
on folder without taking into account any sub-directories.

Create a subfolder for each file - if this option is checked, for each file uploaded to the database a new folder is created, having the
same name as the file, and the file content is placed in the folder. Otherwise, the file data are imported into the Destination folder.
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Import as separate sequences - if this option is selected and an uploaded file contains several sequences, they are represented by
distinct sequence objects in the database after the import is done.

Merge into a single sequence - if this option is selected and an uploaded file contains several sequences, they are merged into a single
sequence object in the database after the import is done.

Join into alignment - if this option is selected and an uploaded file contains several sequences, they are joined into a multiple sequence
alignment object in the database after the import is done.

Create a subfolder for each document - if this option is checked, for each document or object uploaded to the database a new folder is
created, having the same name as the file, and the data are placed in the folder. Otherwise, the data are imported into the Destination
folder.

Database in the Project

The database in UGENE Project View looks like as a tree with folders and objects:

4 my_database
4 |\ 1CRM.prt
o5 [3d] 1CRN
Y4 [5] LCRM chain 1 SEQUENCE
{}? [a] 1CREM chain 1 annotation
2 21Q5.prt
» I ABIF
4 0 ACE
4 | BLOBOC3.ace
% [s] Contig2_ref
I[F [as] Contigl
% [s] Contigl_ref
.[}P [as] Contig2
= I K26.ace
» I Assembly
CLUSTALW
EMEL
FASTA
FASTO)
Genbank
MSF

Recycle bin

#0000

You can add a new folder to the database tree. To do that use the Add->Add folder database context menu item. To add a subfolder to some
existing folder use the Add->Add folder folder context menu item. To delete an object or a folder press the Delete button or drag'n'drop it to
the Recycle bin.

In this version of UGENE objects in the database are read-only. Nevertheless, there is a workaround to edit them. First, you need export the
objects to files on your computer using the Export/Import object context menu. Then you can change that files locally, upload them to
database and, finally, delete the originals.

If new data are added to the database by another user or removed from it, UGENE detects this and shows updates automatically in Project
View.

Deleting Data

To remove an object or a folder select it and press the Delete button or drag it to the Recycle bin folder.

All removed items are located in the Recycle bin folder.
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To delete all files from Recycle bin click on the Empty recycle bin context menu item of the Recycle bin.
To restore objects from the Recycle bin select them and call the Restore selected items context menu item.

When the database is updated outside, UGENE shows these changes on your computer automatically.

You cannot delete any object from Recycle bin if it is opened on the other computer. This situation can appear if the object was
being viewed by another user when you moved it to Recycle Bin.

Drag'n'drop in the Database

In the database tree you can drag'n'drop objects between folders, folders between folders. Also you can drag'n'drop other objects and
documents from project to the database.

Exporting Objects from the Database

The objects in the database can not be altered though they can be deleted. To edit the objects you need to export them to the project, then
make you modifications locally and replace existing originals. More detailed information about exporting you can find here.
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UGENE Public Storage

UGENE provides the free-to-use public bioinformatics data storage. This storage keeps DNA sequences of several popular genomes such as
human, mouse, drosophila melanogaster, etc. and hundreds of plasmid sequences.

Follow the instructions for accessing the storage:

1. Use the menu File -> Connect to shared database (or press the Ctrl+L shortcut).

[7] uGENE - .-q'r—

[Fiie]hctions Settings  Tocls  Window Help

Ii, Mew project...

Mew document from text...

Access remote database...

Connect to shared database... Ctrl+L
Search MCBI Genbank...

Open... Ctrl+0
Open as... Ctrl+Shift+ 0

& e @

g0

Recent Files r

Recent Projects k

Exit

2. Choose the predefined "UGENE public database" item and click the Connect button.

-
[¥] shared Databases Connections

UGEME public database Add

Delete

g

1 Edit

2

/

Disconnect Close ]

Help

3. Browse the storage content.
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Project x

Name fiter Read-only access
Objects
4 | g UGEME public database
% Recycle bin
a3 JENDMES
> Arabidopsis thaliana (TAIR 10)
+ I3 C. elegans (cef)
» I3 Drosophila melanogaster (dm3)
4 [ Escherichia coli str, K-12 substr, MG16...
= [H]INFO =i
Yy [s] NC_000913
@ [a] NC_D00913 features
Hurman (hgl9)
Hurman Irmmunodeficiency Virus (HIV..
Mouse (mm)
Mycobacterium tuberculosis (MC_000...
Salmonella Enterica(MC_016856.1)
Yibrio cholerae (MC_002505)
» I Yeast (Saccharormyces cerevisiae) (sac...
» |} Zebrafish (Danio rerie) (danRerT)
- I plasmids

000000

3

The storage document is marked with the lock icon £, It means that the storage provides the read-only access. Any data
modifications are unavailable for such type of access (importing, removing or replacing of data).

Each genome folder contains the INFO text object. It is the information about the genome or its source.

You can export the data to your computer for working with the data locally.

There are hundreds of plasmids in the storage. Use the name filter for fast navigating and searching an interesting plasmid:

Praoject x

b}
Name ﬁlte{pfr-luc| J
Objects

“% [s] AF058756_Cloning vector pFR-Luc, compl...
(};-' [a] AFD58756_Cloning vector pFR-Luc, compl...

The list of available genomes:

Human (hg19)

Mouse (mm9)

Arabidopsis thaliana (TAIR 10)

C. elegans (ce6)

Drosophila melanogaster (dm3)

Escherichia coli str. K-12 substr. MG1655 K12(NC_000913.3)
Human Immunodeficiency Virus (HIV-2)
Mycobacterium tuberculosis (NC_000962.3)
Salmonella Enterica(NC_016856.1)

Vibrio cholerae (NC_002505)

Yeast (Saccharomyces cerevisiae)(sacCer3)
Zebrafish (Danio rerio) (danRer7)
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UGENE Command Line Interface

UGENE command line interface (CLI) was developed keeping in mind the following principles:

®* To make it as easy as popular shell commands.
® To include all significant UGENE features.
® To allow users to add their own commands.

To use UGENE CLI make sure to add the path to the UGENE executable to your %PATH% environment variable.

The general syntax is the following:

ugene [[--task=]task_nane] [--task_paraneter=value ...] [-task_paraneter value ...]
[--option[=value]] [-option[ value]]

Here:
task_name — task to execute, it can be one of the predefined tasks or a task you have created.
task_parameter — parameter of the specified task. Some parameters of a task are required, like in and out parameters of some tasks.
option — one of the CLI options.

See the example below:

ugene align --in=CO.aln -out result.aln -log-level-details

® CLI Options
® CLI Predefined Tasks

® Format Converting Sequences
Converting MSA
Extracting Sequence
Finding ORFs
Finding Repeats
Finding Pattern Using Smith-Waterman Algorithm
Adding Phred Quality Scores to Sequence
Local BLAST Search
Local BLAST+ Search
Remote NCBI BLAST and CDD Requests
Annotating Sequence with UQL Schema
Building Profile HMM Using HMMER2
Searching HMM Signals Using HMMER2
Aligning with MUSCLE
Aligning with ClustalW
Aligning with ClustalO
Aligning with Kalign
Aligning with MAFFT
Aligning with T-Coffee
Building PFM
Searching for TFBS with PFM
Building PWM
Searching for TFBS with Weight Matrices
Building Statistical Profile for SITECON
Searching for TFBS with SITECON
Fetching Sequence from Remote Database
Gene-by-Gene Report
Reverse-Complement Converting Sequences
Variants Calling

® Generating DNA Sequence
® Creating Custom CLI Tasks

CLI Options

--help | -h [<option_name> | <task_name>]

Shows help information. For example:
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ugene --help ## Shows general UGENE CLI hel p.
ugene -h
ugene --hel p=<opti on_nane> ## Shows hel p for the <option_nane> option.

ugene -h <option_nanme>

ugene - - hel p=<t ask_nane> ## Shows hel p for the <task_nanme> task.
ugene -h <task_nane>

--task=<task_name> [<task_parameter>=value ...]

Specifies the task to run. A user-defined UGENE workflow schema can be used as a task name. For example:

ugene --task=align --in=CO.aln -out result.aln

ugene --task=C:\nyschema.uw --in=CO.aln --out=res.aln

--log-no-task-progress

A task progress is shown by default when a task is running. This option specifies not to show the progress.
--log-level="[<categoryl>=]<levell> [, ...]"

Sets the log level per category. If a category is not specified, the log level is applied to all categories.

The following categories are available:

® “Algorithms”

® “Console”

® “Core Services”
® “Input/Output”

* “Performance”

® “Remote Service”
® “Scripts”

® “Tasks”.

The following log levels are available: TRACE, DETAILS, INFO, ERROR or NONE.
By default, loglevel=ERROR.

For example:

ugene --1o0g-1evel =NONE

ugene --1o0g-1level =" Tasks=DETAI LS, Consol e=DETAI LS"

--log-format="<format_string>"
Specifies the format of a log line.

Use the following notations: L - level, C - category, YYYY or YY - year, MM - month, dd - day, hh - hour, mm - minutes, ss - seconds,
zzz - milliseconds.

By default, logformat="[L][hh:mm]".
--license
Shows license information.
--lang=language_code
Specifies the language to use (e.qg. for the log output). The following values are available:

® CS (Czech)
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® EN (English)
® RU (Russian)

--log-color-output

If log output is enabled, this option make it colored: ERROR messages are displayed in red, DETAILS messages are displayed in
green, TRACE messages are displayed in blue.

--session-db

Session database is stored in the temporary file that is created for every UGENE run. But it can supplied with the command line
argument. If the supplied file does not exest it will be created. The session database file is removed after closing of UGENE.

For example:

ugene --session-db=D:/sessi on. ugenedb

--version
Shows version information.
--tmp-dir=<path_to_file>
Path to teporary folder.
--ini-file=<path_to_file>
Loads configuration from the specified .ini file. By default the UGENE.ini file is used.
--genome-aligner

UGENE Genome Aligner is an efficient and fast tool for short read alignment. It has 2 work modes: build index and align short reads
(default mode).
If there is no index available for reference sequence it will be built on the fly.

Usage: ugene --genome-aligner { --option[=argument] }

The following options are available:

--build-index Use this flag to only build index for reference sequence.
--reference Path to reference genome sequence
--short-reads Path to short-reads data in FASTA or FASTQ format

--index Path to prebuilt index (base file name or with .idx extension). If not set, index is searched in system temporary directory. If
--build-index option is applied, index will be saved to specified
path.

--result Path to output alignment in UGENEDB or SAM format (see --sam)

--memsize Memory size (in Mbs) reserved for short-reads. The bigger value the faster algorithm works. Default value depends on
available system memory.

--ref-size Index fragmentation size (in Mbs). Small fragments better fit into RAM, allowing to load more short reads. Default value is 10.
--n-mis Absolute amount of allowed mismatches per every short-read (mutually exclusive with --pt-mis). Default value is 0.

--pt-mis Percentage amount of allowed mismatches per every short-read (mutually exclusive with --n-mis). Default value is 0.
--rev-comp Use both the read and its reverse complement during the aligning.

--best Report only about best alignments (in terms of mismatches).

--omit-size Omit reads with qualities lower than the specified value. Reads which have no qualities are not omitted. Default value is 0.
--sam Output aligned reads in SAM format. Default value is false.

For example:
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Buil d index for reference sequence:
ugene --genone-aligner --build-index --reference=/path/to/ref

Align short reads using existing index:
ugene --genone-aligner --reference=/path/to/ref --short-reads=/path/to/reads
--result=/path/to/result

CLI Predefined Tasks

Using current version of UGENE you can perform the following tasks by running a simple command:

Format Converting Sequences

Converting MSA

Extracting Sequence

Finding ORFs

Finding Repeats

Finding Pattern Using Smith-Waterman Algorithm
Adding Phred Quality Scores to Sequence
Local BLAST Search

Local BLAST+ Search

Remote NCBI BLAST and CDD Requests
Annotating Sequence with UQL Schema
Building Profile HMM Using HMMER2
Searching HMM Signals Using HMMER2
Aligning with MUSCLE

Aligning with ClustalW

Aligning with ClustalO

Aligning with Kalign

Aligning with MAFFT

Aligning with T-Coffee

Building PFM

Searching for TFBS with PFM

Building PWM

Searching for TFBS with Weight Matrices
Building Statistical Profile for SITECON
Searching for TFBS with SITECON
Fetching Sequence from Remote Database
Gene-by-Gene Report
Reverse-Complement Converting Sequences
Variants Calling

Generating DNA Sequence

Format Converting Sequences

Task Name: convert-seq
Converts a sequence from one format to another.
Parameters:
in — input sequence file. [String, Required]
out — name of the output file. [String, Required]
format — format of the output file. [String, Optional]
The following values are available:

® fasta

® fastq

® genbank
* gff

® raw
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Example:

ugene convert-seq --in=human_T1.fa --out=human_T1. gbk --format =genbank

Converting MSA

Task Name: convert-msa
Converts a multiple sequence alignment file from one format to another.
Parameters:
in — input multiple sequence alignment file. [String, Required]
out — name of the output file. [String, Required]
format — format of the output file. [String, Optional]
The following values are available:

® clustal (default)
* fasta

® mega

®* msf

® nexus

® phylip-interleaved
® phylip-sequential
¢ stockholm

Example:

ugene convert-nsa --in=CBS. sto --out=CBS --format=nsf

Extracting Sequence
Task Name: extract-sequence
Extracts annotated regions from an input sequence.
Parameters:
in — semicolon-separated list of input files. [String, Required]
out — output file. [String, Required]
annotation-names — list of annotations names which will be accepted or filtered. [String, Optional]
annotation-names-file - file with annotation names, separated with whitespaces which will be accepted or filtered. [String, Optional]

accumulate - accumulate all incoming data in one file or create separate files for each input. In the latter case, an incremental
numerical suffix is added to the file name (using ‘True' by default). [Boolean]

accept-or-filter — if set to true, accepts only the specified annotations, if set to false, accepts all annotations except the specified ones.
[Boolean, Optional]

complement — complements the annotated regions if the corresponding annotation is located on the complement strand. [Boolean,
Optional]

extend-left — extends the resulting regions to the left for the specified number of base symbols. [Number, Optional]
extend-right — extends the resulting regions to the right for the specified number of base symbols. [Number, Optional]
gap-length — inserts a gap of the specified length between the merged annotations.

transl - translates the annotated regions. [Boolean, Optional]

Example:
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ugene extract-sequence --in=sars.gb --out=res.fa --annotation-nanes=gene

Finding ORFs
Task Name: find-orfs

Searches for Open Reading Frames (ORFs) in nucleotide sequences and saves the regions found as annotations.
Parameters:

in — semicolon-separated list of input files. [String, Required]

out — output file with the annotations. [String, Required]

name — name of the annotated regions. [String, Optional, Default: “ORF”]

min-length — ignores ORFs shorter than the specified length. [String, Optional, Default: 100]

require-stop-codon — ignores boundary ORFs that last beyond the search region (i.e. have no stop codon within the range). [Boolean,
Optional, Default: false]

require-init-codon — allows ORFs starting with any codon other than terminator. [Boolean, Optional, Default: true]

allow-alternative-codons — allows ORFs starting with alternative initiation codons, accordingly to the current translation table.
[Boolean, Optional, Default: false]

Example:

ugene find-orfs --in=human_T1l.fa --out=result.gb --require-init-codon=false

Finding Repeats
Task Name: find-repeats
Searches for repeats in sequences and saves the regions found as annotations.
Parameters:
in — semicolon-separated list of input files. [String, Required]
out — output file with the annotations. [String, Required]
name — name of the annotated regions. [String, Optional, Default: “repeat_unit”]
min-length — minimum length of the repeats. [Number, Optional, Default: 5]
identity — percent identity between repeats. [Number, Optional, Default: 100]
min-distance — minimum distance between the repeats. [Number, Optional, Default: 0]
max-distance — maximum distance between the repeats. [Number, Optional, Default: 5000]
inverted — if true, searches for the inverted repeats. [Boolean, Optional, Default: false]

Example:

ugene find-repeats --in=nurine.gbh --out=nurine_repeats.gb --identity=99

Finding Pattern Using Smith-Waterman Algorithm
Task Name: find-sw

Searches for a pattern in a nucleotide or protein sequence using the Smith-Waterman algorithm and saves the regions found as
annotations.
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Parameters:
in — input sequence file. [String, Required]
out — output file with the annotations. [String, Required]
name — name of the annotated regions. [String, Optional, Default: “misc_feature”]
ptrn — subsequence pattern to search for (e.g. AGGCCT). [String, Required]
score — percent identity between the pattern and a subsequence. [Number, Optional, Default: 90]
matrix — scoring matrix. [String, Optional, Default: “Auto”]
Among others the following values are available:

® blosum62
®* dna

® rma

® dayhoff
® gonnet

® pam250
® etc.

The matrices available are stored in the SUGENE\data\weight_matrix directory.
filter — results filtering strategy. [String, Optional, Default: “filter-intersections”]
The following values are available:

® filter-intersections
®* none

Example:

ugene find-sw --in=human_T1.fa --out=sw.gb --ptrn=TGCT --filter=none

Adding Phred Quality Scores to Sequence
Task Name: join-quality

Adds Phread quality scores to a sequence and saves the result to the output FASTQ file.
Parameters:

in — input sequence file. [String, Required]

quality — input Phred quality scores file. [String, Required]

out — output FASTQ file. [String, Required]

Example:

ugene join-quality --in=e_coli.fa --quality=e_coli.qual --out=res.fastq

Local BLAST Search

Task Name: local-blast

Performs a search on a local BLAST database using old version of the NCBI BLAST.

@ BLAST is used as an external tool and must be installed on your system.

Parameters:

toolpath — path to the blastall executable. By default, the path specified in the Application Settings is applied. [String, Optional,
Default: “default”]
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tmpdir — directory for temporary files. By default, the path specified in the Application Settings is applied. [String, Optional, Default:
“default”]

in — semicolon-separated list of input sequence files. [String, Required]
dbpath — path to the BLAST database files. [String, Required]
dbname — base name of the BLAST database files. [String, Required]
out — output Genbank file, the results of the search are stored as annotations. [String, Required]
name — name of the annotations. [String, Optional, Default: “blast result”]
p — type of the BLAST search. [String, Optional, Default: “blastn”]
The following values are available:

® blastn
® blastp
® blastx
® thblastn
® tblastx

e — expectation value threshold. [Number, Optional, Default: 10]

Example:

ugene | ocal -blast --in=input.fa --dbpath=. --dbnane=nydb --out=output.gb

Local BLAST+ Search

Task Name: local-blast+

Performs a search on a local BLAST database using BLAST+.

@ BLAST+ is used as an external tool and must be installed on your system.

Parameters:

toolpath — path to an appropriate BLAST executable (e.g. blastn, blastp, etc.). By default, the path specified in the Application Settings
is applied. [String, Optional, Default: “default”]

tmpdir — directory for temporary files. By default, the path specified in the Application Settings is applied. [String, Optional, Default:
“default”]

in — semicolon-separated list of input sequence files. [String, Required]
dbpath — path to the BLAST database files. [String, Required]
dbname — base name of the BLAST+ database files. [String, Required]
out — output Genbank file, the results of the search are stored as annotations. [String, Required]
name — name of the annotations. [String, Optional, Default: “blast result”]
p — type of the BLAST search. [String, Optional, Default: “blastn”]
The following values are available:

® blastn
® blastp
® blastx
® thlastn
® tblastx

e — expectation value threshold. [Number, Optional, Default: 10]

Example:
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ugene local -blast+ --in=input.fa --dbpath=. --dbname=nydb --out=output.gb

Remote NCBI BLAST and CDD Requests

Task Name: remote-request
Performs remote requests to the NCBI. Saves the results as annotations.
Parameters:
in — semicolon-separated list of input files. A file can be of any format containing sequences or alignments. [String, Required]
db — database to search in. [String, Optional, Default: “ncbi-blastn”]
The following databases are available:

® “ncbi-blastn” for nucleotide sequences
® “nchi-cdd” for amino acid sequences
® “ncbi-blastp” for amino acid sequences

out — output Genbank file. [String, Required]

eval — specifies the statistical significance threshold for reporting matches against database sequences. [Number, Optional, Default:
10]

hits — maximum number of hits, that will be shown. [Number, Optional, Default: 10]

name — name of the result annotations. If not set, name will be specified with the “cdd” result or the “blast” result. [String, Optional,
Default: “cdd” or “blast”]

short — optimizes search for short sequences. [Boolean, Optional, Default: false]

blast-output — path to the file with the NCBI-BLAST output (only for the “ncbi-blastp” and “ncbi-blastn” databases). [Boolean, Optional,
Default: the file is not saved]

Example:

ugene renote-request --in=seq.fa --db=nchi-blastp --out=res.gb

Annotating Sequence with UQL Schema
Task Name: query

Annotates a sequence in compliance with a UGENE Query Language (UQL) schema. This allows to analyze a sequence using
different algorithms at the same time imposing constraints on the positional relationship of the results.

To learn more about the UQL schemas read the Query Designer Manual.
Parameters:
in — semicolon-separated list of input sequence files. [String, Required]
out — output Genbank file with the annotations. [String, Required]
schema — UQL schema. [String, Required]
merge — if true, merges regions of each result into a single annotation. [Boolean, Optional, Default: false]
offset — if merge is set to true, specified left and right offsets for merged annotations. [Number, Optional, Default: 0]

Example:

ugene query --in=input.fa --out=result.gb --schema=Repeat sWthORF. uqgl

Building Profile HMM Using HMMER2
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Task Name: hmm2-build
Builds a profile HMM using the HMMER?2 tools.
Parameters:
in — semicolon-separated list of input multiple sequence alignment files. [String, Required]
out — output HMM file. [String, Required]
name — name of the profile HMM. [String, Optional, Default: “hmm_profile”]
calibrate — enables/disables calibration. [Boolean, Optional, Default: true]
seed — random seed, a non-negative integer. [Number, Optional, Default: 0]

Example:

ugene hmmR-build --in=CBS.sto --out=CBS. hhrm

Searching HMM Signals Using HMMER2

Task Name: hmm2-search

Searches each input sequence for the significantly similar sequence that matches to all specified profile HMM using the HMMER?2 tool.
Parameters:

seq — semicolon-separated list of the input sequence files. [String, Required]

hmm — semicolon-separated list of the input HMM files. [String, Required]

out — output file with annotations. [String, Required]

name — name of the result annotations. [String, Optional, Default: “hmm_signal”]

e-val — e-value that can be used to exclude low-probability hits from the result. [Number, Optional, Default: 1e-1]

score — score based filtering which is an alternative to e-value filtering to exclude low-probability hits from the result. [Number,
Optional, Default: -1000000000]

Example:

ugene hmmR-search --seq=CBS_seq.fa --hnm=CBS. hmm - - out =CBS_hnmm gb

Aligning with MUSCLE

Task Name: align

Performs multiple sequence alignment with MUSCLE algorithm and saves the resulting alignment to file. Source data can be of any
format containing sequences or alignments.

Parameters:
in - Input alignment [Url datasets]
max-iterations - Maximum number of iterations (using 2 by default) [Number]

mode - Selector of preset configurations, that give you the choice of optimizing accuracy, speed,or some compromise between the
two. The default favors accuracy (using 'MUSCLE default' by default) [Number]

range - Whole alignment or column range e.g. 1..100 (using ‘'Whole alignment' by default) [String]
stable - Do not rearrange aligned sequences (using '‘True' by default) [Boolean]
format - Document format of output alignment (using ‘clustal’ by default) [String]

out - Output alignment [String]

Example:

ugene align --in=test.aln --out=test_out.aln --format=clustal
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Aligning with ClustalW

Task Name: align-clustalw

Multiple sequence alignment with ClustalW.

(D ClustalW is used as an external tool and must be installed on your system.

Parameters:

toolpath — path to the ClustalW executable. By default, the path specified in the Application Settings is applied. [String, Optional,
Default: “default”]

tmpdir — directory for temporary files. [String, Optional]

in — semicolon-separated list of input files. [String, Required]
out — output file. [String, Required]

format — format of the output file. [String, Optional]

Example:

ugene align-clustalw --in=CO.aln --out=CA.sto --format=stockhol m

Aligning with ClustalO
Task Name: align-clustalo

Create alignment with ClustalO. ClustalO is a general purpose multiple sequence alignment program for proteins.

@ ClustalO is used as an external tool and must be installed on your system.

Parameters:
in - Input alignment [Url datasets]
format - Document format of output alignment (using ‘clustal' by default) [String]
out - Output alignment [String]
max-guidetree-iterations - Maximum number guidetree iterations (using '0' by default) [Number]
max-hmm-iterations - Maximum number of HMM iterations (using '0' by default) [Number]
iter - Number of (combined guide-tree/HMM) iterations (using '1' by default) [Number]
toolpath - ClustalO location (using the path specified in UGENE by default) [String]
auto - Set options automatically (might overwrite some of your options) (using 'False' by default) [Boolean]
tmpdir - Directory to store temporary files (using UGENE temporary directory by default) [String]

Example:

ugene align-clustalw --in=test.aln --out=test_out.aln --format=clustal

Aligning with Kalign
Task Name: align-kalign

Multiple sequence alignment with Kalign.
Parameters:

in — semicolon-separated list of input files. [String, Required]

281


http://ugene.unipro.ru/documentation/manual/plugins/external_tool_support.html#external-tool-support
http://ugene.unipro.ru/documentation/manual/plugins/external_tool_support.html#external-tool-support

Unipro UGENE Manual, Version 1.26

out — output file in the ClustalW format. [String, Required]

Example:

ugene align-kalign --in=CO.aln --out=CO _aligned.aln

Aligning with MAFFT

Task Name: align-mafft

Multiple sequence alignment with MAFFT.

(D MAFFT is used as an external tool and must be installed on your system.

Parameters:

toolpath — path to the MAFFT executable. By default, the path specified in the Application Settings is applied. [String, Optional,
Default: “default”]

tmpdir — directory for temporary files. [String, Optional]

in — semicolon-separated list of input files. [String, Required]

out — output file. [String, Required]

format — format of the output file. [String, Required]

op — penalty for opening a gap. [Number, Optional]

ep — penalty for extending a gap. [Number, Optional]

maxiterate — maximum number of cycles of iterative refinement. [Number, Optional]

Example:

ugene align-mafft --in=CA.aln --out=CA _aligned.aln

Aligning with T-Coffee
Task Name: align-tcoffee

Create alignment with T-Coffee. T-Coffee is a collection of tools for computing, evaluating and manipulating multiple alignments of
DNA, RNA, Protein Sequences.

(D T-Coffee is used as an external tool and must be installed on your system.

Parameters:

gap-ext-penalty - Gap Extension Penalty. Positive values give rewards to gaps and prevent the alignment of unrelated segments
(using '0' by default) [Number]

gap-open-penalty - Gap Open Penalty. Must be negative, best matches get a score of 1000 (using -50' by default) [Number]

iter-max - Number of iteration on the progressive alignment: 0 - no iteration (default), -1 - Nseq iterations (using ‘0" by default) [Number]
toolpath - T-Coffee location (using the path specified in UGENE by default) [String]

tmpdir - Directory to store temporary files (using UGENE temporary directory by default) [String]

in - Input alignment [Url datasets]

format - Document format of output alignment (using ‘clustal’ by default) [String]

out - Output alignment [String]

Example:
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Building PFM

Task Name: pfm-build

Builds a position frequency matrix from a multiple sequence alignment file.

Parameters:

in — semicolon-separated list of input MSA files. [String, Required]

out — output file. [String, Required]

type — type of the matrix. [Boolean, Optional, Default: false]

The following values are available:

® true (dinucleic type)
® false (mononucleic type)

Dinucleic matrices are more detailed, while mononucleic ones are more useful for small input data sets.

Example:

ugene pfmbuild --in=CO.aln --out=result.pfm

Searching for TFBS with PFM

Task Name: pfm-search

--in=test.aln --out=test_out.aln --fornmat=clustal

Searches for transcription factor binding sites (TFBS) with position weight matrices (PWM) converted from input position frequency
matrices (PFM) and saves the regions found as annotations.

Parameters:

seq — semicolon-separated list of input sequence files to search TFBS in. [String, Required]

matrix — semicolon-separated list of the input PFM. [String, Required]

out — output Genbank file.

name — name of the annotated regions. [String, Optional, Default: “misc_feature”]

type — type of the matrix. [Boolean, Optional, Default: false]

The following values are available:

® true (dinucleic type)
® false (mononucleic type)

Dinucleic matrices are more detailed, while mononucleic ones are more useful for small input data sets.

algo — algorithm used to convert a PFM to a PWM. [String, Optional, Default: “Berg and von Hippel’]

The following values are available:

Berg and von Hippel
Log-odds

Match

NLG

score — minimum percentage score to detect TFBS. [Number, Optional, Default: 85]

strand — strands to search in. [Number, Optional, Default: 0]

The following values are available:

283



Unipro UGENE Manual, Version 1.26

® 0 (both strands)
® 1 (direct strand)
® -1 (complement strand)

Example:

ugene pfmsearch --seq=in.fa --matrix=MA0265. 1. pf n1 MA0266. 1. pf m - - out =res. gb

Building PWM
Task Name: pwm-build

Builds a position weight matrix from a multiple sequence alignment file.
Parameters:

in — semicolon-separated list of input MSA files. [String, Required]

out — output file. [String, Required]

type — type of the matrix. [Boolean, Optional, Default: false]

The following values are available:

® true (dinucleic type)
® false (mononucleic type)

Dinucleic matrices are more detailed, while mononucleic ones are more useful for small input data sets.
algo — algorithm used to build the matrix. [String, Optional, Default: “Berg and von Hippel”]
The following values are available:

® Berg and von Hippel

® |Log-odds
® Match
®* NLG
Example:
ugene pwmbuild --in=CO.aln --out=result.pwn

Searching for TFBS with Weight Matrices

Task Name: pwm-search

Searches for transcription factor binding sites (TFBS) with position weight matrices (PWM) and saves the regions found as
annotations.

Parameters:
seq — semicolon-separated list of input sequence files to search TFBS in. [String, Required]
matrix — semicolon-separated list of the input PWM. [String, Required]
out — output Genbank file.
name — name of the annotated regions. [String, Optional, Default: “misc_feature”]
min-score — minimum percentage score to detect TFBS. [Number, Optional, Default: 85]
strand — strands to search in. [Number, Optional, Default: 0]

The following values are available:

® 0 (both strands)
® 1 (direct strand)
® -1 (complement strand)
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Example:

ugene pwm search --seq=i nput.fa --nmatrix=Aro80. pwny Aft1. pwm --out =res.gb

Building Statistical Profile for SITECON

Task Name: sitecon-build
Builds a statistical profile for SITECON. It can be later used to search for TFBS.
Parameters:
in — semicolon-separated list of input DNA multiple sequence alignment files. An input file must not contain gaps. [String, Required]

out — output file. If several input files have been supplied, then a sitecon profile is built for each input file, i.e. several output files (with
different indexes) are generated. [String, Required]

wsize — window size. The window is a region of the alignment used to build the profile. It is picked up from the center of the alignment
and occupies the specified length. The edges of the alignment beyond the window are not taken into account. The recommended
length is a bit less than the alignment length, but not more than 50 bp. [Number, Optional, Default: 40]

clength — length of a random synthetic sequence used to calibrate the profile. [Number, Optional, Default: 2000000]

rseed — random seed used to calibrate the profile, e.g. to generate the random synthetic sequence. Use the same value to get the
same calibration results twice on the same data. By default, new random seed is generated each time a calibration occurs. [Number,
Optional, Default: 0]

walg — specifies to use the Algorithm 2 weight algorithm. In most cases it is not required, but in some cases it can increase the
recognition quality. [Boolean, Optional, Default: false]

Example:

ugene sitecon-build --in=CO .aln --out=result.sitecon

Searching for TFBS with SITECON

Task Name: sitecon-search

Searches for transcription factor binding sites (TFBS) with SITECON and saves the regions found as annotations.
Parameters:

in — semicolon-separated list of input sequence files to search TFBS in. [String, Required]

inmodel — input SITECON profile(s). If several profiles have been supplied, searches with all profiles one by one and outputs merged
set of annotations for each input sequence. [String, Required]

out — output Genbank file. [String, Required]
annotation-name — name of the annotated regions. [String, Optional, Default: “misc_feature”]

min-score — recognition quality threshold. The value must be between 60 and 100. Choosing too low threshold will lead to recognition
of too many TFBS recognised with too low trustworthiness. Choosing too high threshold may result in no TFBS recognised. [Number,
Optional, Default: 85]

min-errl — setting for filtering results, minimal value of Error type I. [Number, Optional, Default: 0]
max-err2 — setting for filtering results, maximum value of Error type Il. [Number, Optional, Default: 0.001]
strand — strands to search in. [Number, Optional, Default: 0]

The following values are available:

® 0 (both strands)
® 1 (direct strand)
® -1 (complement strand)

Example:
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ugene sitecon-search --in=input.fa --innodel =profile.sitecon --out=res.gh

Fetching Sequence from Remote Database

Task Name: fetch-sequence

Fetches a sequence from a remote database. The supported databases are accesed via alias.

Database Alias

NCBI Genbank (DNA) genbank

NCBI Genbank (protein) genbank-protein

Protein Data Bank pdb

SwissProt swissprot

Uniprot uniprot
Parameters:

db — database alias to read from. [String, Required]
id — semicolon-separated list of resource IDs in the database. [String, Required]
save-dir — directory to store sequence files loaded from the database. [String, Optional]

Example:

ugene fetch-sequence --db=PDB --i d=3INS; 1CRN

Gene-by-Gene Report

Task Name: gene-by-gene

Suppose you have genomes and you want to characterize them. One of the ways to do that is to build a table of what genes are in each
genome and what are not there.

1. Create a local BLAST db of your genome sequence/contigs. One db per one genome.

2. Create a file with sequences of genes you what to explore. This file will be the input file for the scheme

3. Setup location and name of BLAST db you created for the first genome.

4. Setup output files: report location and output file with annotated (with BLAST) sequence. You might want to delete the "Write
Sequence" element if you do not need output sequences.

5. Run the scheme

5* Run the scheme on the same input and output files changing BLAST db for each genome that you have.

As the result you will get the report file. With "Yes" and "No" field. "Yes" answer means that the gene is in the genome. "No" answer MIGHT
mean that there is no gene in the genome. It is a good idea to analyze al
| the "No" sequences using annotated files. Just open a file and find a sequence with a name of a gene that has "No" result.

Parameters:
in - Input sequence file [Url datasets]
final-name - Annotation name used to compare genes and reference genomes (using ‘blast_result' by dafault) [String]

exist-file - If a target report already exists you should specify how to handle that. Merge two table in one. Overwrite or Rename existing
file (using 'Merge' by default) [String]

ident - Identity between gene sequence length and annotation length in per cent. BLAST identity (if specified) is checked after (using
'90.0' percents by default) [Number]
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out - Output report file [String]

blast-out - Location of BLAST output file [String]

search-type - Type of BLAST searches (using 'blastn’ by default) [String]
db-name - Name of BLAST DB [String]

blast-path - Path to BLAST DB [String]

expected-value - This setting specifies the statistical significance threshold for reporting matches against database sequences (using
'10.0' by default) [Number]

gapped-aln - Perform gapped alignment (using 'use' by default) [Boolean]

blast-name - Name for annotations (using 'blast_result' by default) [String]

tmpdir - Directory for temporary files (using UGENE temporary directory by default) [String]
toolpath - External tool path (using the path specified in UGENE by default) [String]
out-type - Type of BLAST output file (using XML (-m 7)" by default) [String]

Example:

ugene gene-by-gene --in=human_T1.fa --out=human_T1_report

Reverse-Complement Converting Sequences

Task Name: revcompl

Convert input sequence into its reverse, complement or reverse-complement counterpart and write result sequence to file
Parameters:

type - Type of operation. Available are 'Reverse Complement', 'Complement' and 'Reverse' (using 'Reverse Complement' by default)
[String]

in - Input file [Url datasets]

accumulate - Accumulate all incoming data in one file or create separate files for each input. In the latter case, an incremental
numerical suffix is added to the file name (using 'True' by default) [Boolean]

format - Output file format (using ‘fasta’ by default) [String]
split - Split each incoming sequence on several parts (using '1' by default) [Number]
out - Output file [String]

Example:

ugene revconpl --in=human_T1.fa --out=human_T1_result.fa --fornmat=fasta
--type=reverse

Variants Calling
Task Name: snp
Call variants for an input assembly and a reference sequence using SAMtools mpileup and bcftool
Parameters:
bam - Input sorted BAM file(s) [Url datasets]
ref - Input reference sequence [Url datasets]
wout - Out file with variations [String]

bN - A/IC/G/T only [Boolean]
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bl - List of sites [String]

ml - BED or position list file [String]

bg - Per-sample genotypes [Boolean]

mC - Mapping quality downgrading coefficient [Number]
bT - Pair/trio calling [String]

mB - Disable BAQ computation [Boolean]

me - Gap extension error [Number]

mE - Extended BAQ computation [Boolean]
bF - Indicate PL [Boolean]

vw - Gap size [Number]

m6 - lllumina-1.3+ encoding [Boolean]

bi - INDEL-to-SNP Ratio [Number]

bA - Retain all possible alternate [Boolean]

vD - Max number of reads per input BAM [Number]
md - Max number of reads per input BAM [Number]
mL - Max INDEL depth [Number]

va - Alternate bases [Number]

v2 - BaseQ bias [String]

vd - Minimum read depth [Number]

v4 - End distance bias [Number]

v3 - MapQ bias [Number]

Q - Minimum RMS quality [Number]

vl - Strand bias [Number]

mQ - Minimum base quality [Number]

mq - Minimum mapping quality [Number]

bd - Min samples fraction [Number]

bl - N group-1 samples [Number]

bU - N permutations [Number]

bG - No genotype information [Boolean]

ml - No INDELs [Boolean]

mo - Gap open error [Number]

mP - List of platforms for indels [String]

vp - Log filtered [Boolean]

bP - Prior allele frequency spectrum. [String]
bQ - QCALL likelihood [Boolean]

mr - Pileup region [String]

bs - List of samples [String]

mh - Homopolymer errors coefficient [Number]

bt - Mutation rate [Number]

Unipro UGENE Manual, Version 1.26
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mA - Count anomalous read pairs [Boolean]
VW - A/C/G/T only [Number]

Example:

ugene snp --bamrtest.bam--ref=test_ref.fa --wout=test_ out. vcf

Generating DNA Sequence
Task Name: generate-dna

Generates a random DNA sequence with specified nucleotide content
Parameters:

algo - Algorithm for generating (using 'GC Content' by default) [String]

content - Specifies if the nucleotide content of generated sequence(s) will be taken from reference or specified manually (A, G, C, T
parameters) (using ‘manual’ by default) [String]

count - Number of sequences to generate (using '1' by default) [Number]

length - Length of the resulted sequence(s) (using '1000' bp by default) [Number]
a - Adenine content (using '25' percents by default) [Number]

¢ - Cytosine content (using '25' percents by default) [Number]

g - Guanine content (using '25' percents by default) [Number]

t - Thymine content (using '25' percents by default) [Number]

ref - Path to the reference file (could be a sequence or an alignment) [String]

seed - Value to initialize the random generator. By default (seed = -1) the generator is initialized with the system time (using '-1' by
default) [Number]

wnd-size - Size of window where set content (using '1000' by default) [Number]

accumulate - Accumulate all incoming data in one file or create separate files for each input. In the latter case, an incremental
numerical suffix is added to the file name (using 'True' by default) [Boolean]

format - Output file format (using 'fasta’ by default) [String]
split - Split each incoming sequence on several parts (using '1' by default) [Number]
out - Output file [String]

Example:

ugene generate-dna --1ength=2000 --a=45 --out=test.fa

Creating Custom CLI Tasks

The predefined tasks are actually the Workflow Designer schemas stored in the SUGENE/data/cmdline directory.

Follow the instructions in the Workflow Designer Manual on how to create a schema and to run it from the command line.
You may also find useful the following video tutorial devoted to the creating of a custom console command:

® Creating custom console command (MUSCLE alignment with various output format)
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APPENDIXES

® Appendix A. Supported File Formats
® Specific File Formats
® UGENE Native File Formats
® Other File Formats

Appendix A. Supported File Formats

1 UGENE is able to read and write files compressed with Unix/Linux gzip utility. You don’'t have to unpack the files.

® Specific File Formats
® UGENE Native File Formats
® Other File Formats

Specific File Formats

File format File extension Read Write Comment
ABIF *.abl, *.abi, *.abif + - A chromatogram file
format.

See also: Chromatogra

m Viewer

ACE *.ace, + - A file format for storing
data about genomic
contigs.

See also: Alignment
Editor

Bairoch *.bairoch + + A file format to store
enzymes.

See also: Restriction
Analysis

BAM *.bam + - Binary compressed SAM
format.

See also: Assembly

Browser

ClustalWw *.aln + + A multiple sequence
alignments (MSA) file
format.

See also: Alignment
Editor

EBWT *.ebwt + + A Bowtie prebuilt index
file.

See also: Bowtie

EMBL *.em, *.emb, *.embl + - A rich format for storing
sequences and their
annotations.

See also: Sequence
View
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FASTA

FASTQ

Genbank

GFF

HMM

MMDB

MSF

Mega

Newick

*fa, *.mpfa, *.fna, *.fsa,
* fas, *.fasta, *.sef *.seqs

* fastq

*.gb, *.gbk, *.gen,
*.genbank

*hmm

*.prt

* . msf

*.meg, *.meg.gz

*.nwk, *.newick
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One of the oldest and
simplest sequence file
format.

See also: Sequence
View

A file format used to
store a sequence and its
corresponding  quality
scores.

It was originally
developed at  the
“Wellcome Trust Sanger
Institute”.

See also: Sequence
View

A rich format for storing
sequences and
associated annotations.

See also: Sequence
View

The Gene Finding
Format (GFF) format is
used to store features
and annotations.

See also: Sequence
View

A file format to store
HMM profiles.

See also: HMM2, HMM
3

ASN.1 format used by
the Molecular Modeling
Database (MMDB).

See also: 3D Structure
Viewer

A multiple sequence
alignments file format.

See also: Alignment
Editor

A multiple sequence
alignments file format.

See also: Alignment
Editor

A tree file format.

See also: Building
Phylogenetic Tree, Phyl
ogenetic Tree Viewer
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Nexus

PDB

pDRAW32

PFM

Phylip

PWM

Raw

SAM

SCF

SITECON

*.nex *.nxs

*.pdb

* pdw

*.pfm

*.phy

*.pwm

*.seq

*.sam

*.scf

*.sitecon
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A multiple alignment and
phylogenetic trees file
format.

See also: Alignment
Editor, Building
Phylogenetic Tree, Phyl
ogenetic Tree Viewer

The Protein Data Bank
(PDB) format allows to
view the 3D structure of
the sequence.

See also: 3D Structure
Viewer

A sequence file format
used by pDRAW32
software.

See also: Sequence
View

A file format for a
position frequency
matrix.

See also: Weight Matrix

A multiple alignment file
format.

See also: Alignment
Editor

A file format for a
position weight matrix.

See also: Weight Matrix
A raw sequence format.

See also: Sequence
View

The Sequence
Alignment/Map (SAM)
format is a generic
alignment format for
storing read alignments
against reference
sequences.

See also: Assembly
Browser, Bowtie, UGEN
E Genome Aligner

It is a Standard
Chromatogram Format.

See also: Chromatogra
m Viewer

A file format to store
TFBS profile.

See also: SITECON
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Stockholm *.sto + + A multiple sequence
alignments file format.

See also: Alignment

Editor

Swiss-Prot * Xt *.sw + - An annotated protein
sequence in format of
t h e
UniProtKB/Swiss-Prot
database.

See also: Sequence

View
Vector NTI Sequence *.gb *.gp + + A rich format for storing
sequences and

associated annotations,
produced by Vector NTI
software.

See also: Sequence
View

VCF *.vef + + The VCF specifies the
format of a text file used
for storing gene
sequence variations.

See also: Assembly

Browser

UGENE Native File Formats

File format File extension Read Write Comment

Dotplot *.dpt + + Stores a dotplot of a
sequence.

See also: Dotplot

UGENE database file *.ugenedb + + UGENE database files
stores information for
imported BAM or SAM
files and can be used for
converting this
information into a SAM
file.

See also: Import
BAM/SAM File

Short Reads FASTA *.srfa, *.srfasta + + A multiple sequence
alignments file format.

See also: Alignment

Editor
UGENE Workflow *.uwl + + Human-readable format
Language to store workflows,

created in UGENE Work
flow Designer.

See also: Workflow
Designer
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UGENE Query *.ugl +
Language
Workflow element for *.etc +

command line tool

Other File Formats

File format / extension

*.csv

*.html

image formats: *.bmp, *.jpg, *.png, *.tiff, *.svg, etc.; *.pdf

*txt

Comment

Unipro UGENE Manual, Version 1.26

Human-readable format
to store schemas,
created in UGENE Quer
y Designer.

See also: Query
Designer

Format for storing
workflow elements that
can launch an external
command line tool.

See also: Workflow
Designer

Example of usage: annotations can be exported to this format;
the Weight Matrix matrices list can also be saved to this format.

For example it is used to store reports.

These formats are used throughout the program to save

screenshots, etc.

It is possible to view and modify plain text files in UGENE.
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Tutorials

® Using BioMart with UGENE

Environment requirements

Installing UGENE extension on Mozilla Firefox
Opening data found using BioMart in UGENE
Opening BioMart data in UGENE by ID
Opening selected data in UGENE

Using BioMart with UGENE

The BioMart system enables scientists to perform advanced querying of a wide range of biological data sources through a single web
interface, regardless of the data sources geographical locations.

This tutorial describes how data found through the BioMart web interface can be easily opened for further analysis in UGENE by a couple of
mouse-clicks.

® Environment requirements

® Installing UGENE extension on Mozilla Firefox
® Opening data found using BioMart in UGENE
® Opening BioMart data in UGENE by ID

® Opening selected data in UGENE

Environment requirements

Currently UGENE extension is available for Mozilla Firefox web browser only. Please make sure to launch UGENE before using the
extension!

Follow the instructions below to install the extension.

Installing UGENE extension on Mozilla Firefox

To install UGENE extension on Mozilla Firefox open Add-ons Manager and select Install Add-on From File item in the settings menu:
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Firefox ™| E X
% Add-ons Manager

# vl | Search all add-ons

Check for Updates
View Recent Updates

( Install Add-on From File...)

You den't have any v Update Add-ons Automatically

Beset All Add-ons to Update Autornatically

]

&

Learn

In the browse dialog select ugene.xpi file that you can find in the Firefox directory of the UGENE Web Browsers Extensions Package that
there is on the Download page.

Opening data found using BioMart in UGENE
For now there are two options to open data found using BioMart in UGENE:

® Open data by ID, for example, by an Ensembl ID.
® Open selected data.

Opening BioMart data in UGENE by ID

Let's open web site:
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E=AEE

L] C [ www.biomartorg

bio:§

U

smart

Community Publications News

Bio Portal ; 45 databases in 4 continents and growing

Version 0.8

LK - 23
lISA - B

F

Proceed to Portal »
Proceed to Portal »

Proceed to Portal »

Project

Click, for example, on the Proceed to Bio Portal link. The following page will appear:

o e
: BioMart Portal x

= C' [ central.biomart.org

/ sk BioMart x

J

e
BioMart Central Portal

Home

Examples: KRAF,

—
Gene retrieval Variant retrieval Sequence retrieval ID converter

Cancer genes

Ensembl

Ensembl Bacteria

Ensembl Fungi

Ensembl Metazoa

Ensembl Plants

Ensembl Protists !

Mouse Genome Informatics

VEGA

m

Click on the map to view the list of databases
DATABASE SEARCH

Search by type Search by organism Search by database name (A-Z)

+ Genome

+ Gene annotation

¢ Pratein sequence and sfructure
+ Interaction and pathways

+ Gene expression

Notice that an example Ensembl ID below the search bar is highlighted (it has a light blue background).

Current version of the UGENE extension allows detecting the following types of identification numbers:

1. Ensemble Gene ID
2. Ensembl Protein ID
3. PDBID
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Right-click on the ID and select Open in UGENE item in the context menu:

BioMart Central Portal

Home

IDENTIFIER SEARCH

I.nGn |

Examples: KRAS, ENSGOaoastasLn
Open link in new tab

Open link in new window
Open link in incognite window _

Save link as... converter

Gene retrieval Vari

Copy link address

0 Openinvene

Inspect element

Cancer genes
Ensembl
Ensembl Bacteria
Ensembl Fungi
Ensembl Metazoa
Ensembl Plants
Ensembl Protists
Mouse Genome Informatics
VEGA

The sequence with the selected ID will be opened in UGENE.

Opening selected data in UGENE

Imagine that you have browsed for required data (e.g. a sequence with annotations) and opened, for example, an html view for the data in a
web browser. Now you would like to open the data in UGENE to analyze them in more detail. Or, alternatively, maybe you would like to
analyze a certain sequence part.

In this case you select the required data in the web browser window. the Open selected in UGENE item should now appear in the context
menu:
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@ Ensembl genome browser % % |

C | [ www.ensembl.org/Homo_sapiens/Export/Output/Gene?db=core;flank3_display=0;flank5_disp [ {} =

Login - Register

(YR £ - Search Humar...

BLAST/BLAT | BioMart | Ti

Human (GRCh37) » Location: 2:145 324, 002-145,337,001 Gene: AC010090.1 Transcript: AC010090.1-001

Gene-based displays

~ Gene summary

- Splice variants (1)

~ Supporting evidence

- Sequence

I~ External references

~ Regulation

B- Comparative Genomics

|— Genomic alignments

BE- Gene tree (image)
Gene tree (text)
Gene tree (alignment)
Gene gainfloss tree

I Orthologues

 Paralogues

— Protein families

Phenotype

- Genetic Variation

- Variation table

Export Gene Data

>ENSG00000232606:ENST00000413525 cdna:KNOWN_1incRNR
AGCTICACATGT GAGATARATGCACTCARAGATTCCTCACAAGTAGCTCTITTGEAGCTIC
AGATGIGRAATGGATCATTCCTCAATCTGTAATAGACCCTICTGTGAAGCTCTTCAATCA
AL CCAGRAGAATTCAAGAGTITCCARCACCTAAGRAGTGGTATTTGGCARATGGTGGGCCRR
AGGAATARAGRAGECAT GCARR ACTCTTGACAGRAGACATTCAGRRATTGATTIGATATC
AGATACRAGERAGALA AT A TGCCAGT AL GRAAR LA TECATTTITCARGATTARATTCGGCATT
TETTACTTAATAGCATTTGTCATATTCCAATTTTTCATATGTAGTARATTCATTTCARAT
CR

>ENSG00000232606 :ENST00000413525 cds:KNOWN_lincRNL

>ENSG00000232606:ENST00000413525 ENSEQQOQ0L1T65550 exon:KNOWN 1incRNA

AGCTICACATGT GRAGATARATGCACTCALAGATTCCTCACAAGTRAGCTCTTITGEAGCTIC
AGATGTGAAATGGATCATTCCTCAATCTGTAATAGACCCTTCTGTGAAGCTCTTCAATCR
RBRCCAGRGRATTCRAG

>ENSG00000232606 :ENST00000413525 ENSEQ0001709530 exon:ENOWN 1incRNR

AGTTTCCAACACCTARGAGTGGTATTTGGCARATGETGGGCCARAGEARTARAGARGGCH
TGCARARCTCTTGACAGAAGACATTCAGAARTTGAT T TGATATCAGATACRAGGAGARLR

TATGCCAGTAAGAAAATGCATTTTTCAAGATTAAATTCGGCATTTGITACTTAATAGCAT
TTGTCATATTCCARTTTTTCATATCTA
>ENSE00000232¢ Copy
GTGARRTTGRGGGE

I Variation image
— Structural variation
B External data
L Personal annotation
E- ID History AGGAACCTGAGGT
L Gene history ARGGCTGTCAATC

= AGACRAGCTGT

#¥ Configure this page TGACAACCCTTA
CTCTCTATTGRAT
18 Add your data GAARRAALCATTAG

Print...
Search Google for '>ENSG00000232606:EMST00000413525..."

Open selection in UGENE

Inspect element

ARGAATTGATATATTTTALALAGIAATGATCCICATAGI TACALCITAT T TAGGGATTAT

Export data GITTGIAGATCATGTARTGAGTTTTRAATAAGTTTGTITTCCAGTARRGCAGTRAGRCAGLG

TTACCTCTGETAAGGARARAATARAGAAGATCTATTCTGAAATTAGTTTTTGTGTCACAT
TTTTAATTGATTTGGTGCCACATTTCCAGTTGGACATTTCTAGGTTAATTTTTTTTTATT
ATACTTGAAGTTTTAGGGTACACGTGCACALCGTGCAGGT TACATATGTATACATGTGCC
ATGTTGETGTGCTGCACCCATTAACTCGTCATTTAACATTAGGTATATCTCTCTAGTTTA
ATTTTTAAGARACTCTAGAATTTTCAATGGECTATTTAGT TTGGAGAAGCAGTGARTCCT

A A AL AR ACTAA T AR AT T AT TTACR A TTTAT T AL ATATAEACTATET

The selected data will be opened in UGENE.
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